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Introduction

It’s amazing to think that AutoCAD came into being over two decades ago,
at a time when most people thought that personal computers weren’t
capable of industrial-strength tasks like CAD. (The acronym stands for
Computer-Aided Drafting, Computer-Aided Design, or both, depending on
whom you talk to.) It’s almost as amazing that, more than 20 years after its
birth, AutoCAD remains the king of the microcomputer CAD hill by a tall
margin. Many competing CAD programs have come to challenge AutoCAD;
many have fallen, and a few are still around. One hears rumblings that the
long-term future of CAD may belong to special-purpose, 3D-based software
such as the Autodesk Inventor and Revit programs. Whether those rumblings
amplify into a roar remains to be seen, but for the present and the near future
anyway, AutoCAD is where the CAD action is.

In its evolution, AutoCAD has grown more complex, in part to keep up with
the increasing complexity of the design and drafting processes that AutoCAD
is intended to serve. It’s not enough just to draw nice-looking lines anymore.
If you want to play CAD with the big boys and girls, you need to organize the
objects you draw, their properties, and the files where they reside in appro-
priate ways. You need to coordinate your CAD work with other people in
your office who will be working on or making use of the same drawings. You
need to be savvy about shipping drawings around via the Internet.

AutoCAD 2007 provides the tools for doing all these things, but it’s not always
easy to figure out which hammer to pick up or which nail to bang on first.
With this book, you have an excellent chance of creating a presentable,
usable, printable, and sharable drawing on your first or second try without
putting a T square through your computer screen in frustration.

What's Not in This Book

Unlike many other For Dummies books, this one does tell you to consult the
official software documentation sometimes. AutoCAD is just too big and com-
plicated for a single book to attempt to describe it completely.

www.it-ebooks.info


http://www.it-ebooks.info/

2

AutoCAD 2007 For Dummies

AutoCAD is also too big and complicated for us to cover every feature. We
don’t address advanced topics like database connectivity, customization, 3D
object creation, and programming in the interest of bringing you a book of a
reasonable size — one that you’ll read rather than stick on your shelf with
those other thousand-page tomes!

Autodesk likes to keep its users (and us authors!) guessing about new fea-
tures in future versions of the software. For the previous edition of this book,
we removed the chapter on 3D in order to make room for a new “A Lap
around the CAD Track” chapter. We figured that, really, most people were
using AutoCAD for 2D drafting, and anyway, there possibly were (gasp!)
better, more modern programs for doing 3D than our beloved 20-plus-year
old classic.

Wouldn’t you know it? Autodesk has revamped its 3D features so thoroughly
that they’re not only logical and intuitive — they’re downright fun! So with
this edition, we restore a mostly all-new 3D chapter. Something had to go to
accommodate, so this time we’ve removed the previous edition’s chapter on
sheet sets, replacing it with a sidebar in Chapter 13. Of course, now we'’re
expecting the next version of AutoCAD to revamp the sheet set feature so
thoroughly that it’s not only logical and intuitive, it’ll be downright fun. And
then we’ll have to find something else to cut!

This book focuses on AutoCAD 2007 and addresses its slightly less-capable,
much lower-cost sibling, AutoCAD LT 2007. We do occasionally mention dif-
ferences with previous versions, going back to the highly popular AutoCAD
Release 14, so that everyone has some context and upgraders can more read-
ily understand the differences. We also mention the important differences
between full AutoCAD and AutoCAD LT, so that you’ll know what you — or
your LT-using colleagues — are missing. This book does not cover the disci-
pline-specific features in AutoCAD-based products such as Autodesk
Architectural Desktop, except for some general discussion in Chapter 1, but
most of the information in this book applies to the general-purpose AutoCAD
features in the AutoCAD 2007-based versions of those programs as well.

Who Are — and Aven’t — You?

AutoCAD has a large, loyal, and dedicated group of long-time users. This book
is not for the sort of people who have been using AutoCAD for a decade, who
plan their vacation time around Autodesk University, or who consider 1,000-
page-plus technical tomes about AutoCAD as pleasure reading. This book is
for people who want to get going quickly with AutoCAD, but who also know
the importance of developing proper CAD techniques from the beginning.
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However, you do need to have some idea of how to use your computer
system before tackling AutoCAD — and this book. You need to have a com-
puter system with AutoCAD or AutoCAD LT (preferably the 2007 version). A
printer or plotter and a connection to the Internet will be big helps, too.

You also need to know how to use Windows to copy and delete files, create a
folder, and find a file. You need to know how to use a mouse to select (high-
light) or to choose (activate) commands, how to close a window, and how to
minimize and maximize windows. Make sure that you’re familiar with the
basics of your operating system before you start with AutoCAD.

How This Book Is Organized

Appearances can be deceptive. For example, if you saw the apparently
random piles of stuff that covered the authors’ desks while they were writing
this book, you might wonder how they could possibly organize a paragraph,
let alone an entire book. But each of us (given some concerted thought)
knows exactly where to put our hands on that list of new dimension vari-
ables, or that bag of /4" binder clips, or the rest of that bagel and cream
cheese we started at coffee break.

We hope you'll find that the book also reflects some concerted thought about
how to present AutoCAD in a way that’s both easy-to-dip-into and smoothly-
flowing-from-beginning-to-end.

The organization of this book into parts — collections of related chapters —
is one of the most important, uh, parts of this book. You really can get to
know AutoCAD one piece at a time, and each part represents a group of
closely related topics. The order of parts also says something about priority;
yes, you have our permission to ignore the stuff in later parts until you've
mastered most of the stuff in the early ones. This kind of building-block
approach can be especially valuable in a program as powerful as AutoCAD.

The following sections describe the parts that the book breaks down into.

Part I: AutoCAD 101

Need to know your way around the AutoCAD screen? Why does AutoCAD
even exist, anyway? What are all the different AutoCAD-based products

that Autodesk sells, and should you be using one of them — for example,
AutoCAD LT — instead of AutoCAD? Is everything so slooow because it’s
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supposed to be slow, or do you have too wimpy a machine to use this wonder
of modern-day computing? And why do you have to do this stuff in the first
place?

Part [ answers all these questions — and more. This part also includes what
may seem like a great deal of excruciating detail about setting up a new draw-
ing in AutoCAD. But what’s even more excruciating is to do your setup work
incorrectly and then feel as though AutoCAD is fighting you every step of the
way. With a little drawing setup work done in advance, it won’t.

Part II: Let There Be Lines

In this part, it’s time for some essential concepts, including object properties
and CAD precision techniques. We know that you're raring to make some
drawings, but if you don’t get a handle on this stuff early on, you’ll be termi-
nally confused when you try to draw and edit objects. If you want to make
drawings that look good, plot good, and are good, read this stuff!

After the concepts preamble, the bulk of this part covers the trio of activities
that you'll probably spend most of your time in AutoCAD doing: drawing
objects, editing them, and zooming and panning to see them better on the
screen. These are the things that you do in order to create the geometry —
that is, the CAD representations of the objects in the real world that you're
designing. This part of the book ends by explaining how to navigate around
in an AutoCAD 3D model, and how to change its visual appearance on-screen.
By the end of Part I, you should be pretty good at geometry, even if your
ninth-grade math teacher told you otherwise.

Part I11: If Drawings Could Talk

CAD drawings do not live on lines alone — most of them require quite a bit of
text, dimensioning, and hatching in order to make the design intent clear to
the poor chump who has to build your amazing creation. (Whoever said “a
picture is worth a thousand words” must not have counted up the number

of words on the average architectural drawing!) This part shows you how to
add these essential features to your drawings.

After you've gussied up your drawing with text, dimensions, and hatching,
you’ll probably want to create a snapshot of it to show off to your client, con-
tractor, or grandma. Normal people call this process printing, but CAD people
call it plotting. Whatever you decide to call it, we show you how to do it.
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Part 1U: Share and Share Alike

A good CAD user, like a good kindergartner, plays well with others. AutoCAD
encourages this behavior with a host of drawing- and data-sharing features.
Blocks, external reference files, and raster images encourage reuse of parts
of drawings, entire drawings, and bitmap image files. AutoCAD’s Internet
features enable sharing of drawings well beyond your hard disk and local
network.

The drawing and data-sharing features in AutoCAD take you way beyond
old-style, pencil-and-paper design and drafting. After you've discovered how
to apply the techniques in this part, you’ll be well on your way to full CAD-
nerdhood (you may want to warn your family beforehand).

Part U: The Part of Tens

This part contains guidelines that minimize your chances of really messing
up drawings (your own or others”) and techniques for swapping drawings
with other people and accessing them from other computer programs.
There’s a lot of meat packed into these two chapters — juicy tidbits from
years of drafting, experimentation, and fist-shaking at things that don’t work
right — not to mention years of compulsive list-making. We hope that you
find that these lists help you get on the right track quickly and stay there.

Icons Used in This Book

\\J

This icon tells you that herein lies a pointed insight that can save you time
and trouble as you use AutoCAD. In many cases, tip paragraphs act as a
funnel on AutoCAD’s impressive but sometimes overwhelming flexibility:
After telling you all the ways that you can do something, we tell you the way
that you should do it in most cases.

The Technical Stuff icon points out places where we delve a little more
deeply into AutoCAD’s inner workings or point out something that most
people don’t need to know about most of the time. These paragraphs defi-
nitely are not required reading the first time through, so if you come to one of
them at a time when you’ve reached your techie detail threshold, feel free to
skip over it.
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edge. Failure to heed its message may have unpleasant consequences for you
and your drawing — or maybe for both of you.

There’s a lot to remember when you’re using AutoCAD, so we’ve remembered
to remind you about some of those things that you should be remembering.
These paragraphs usually refer to a crucial point earlier in the chapter or in
a previous chapter. So if you’re reading sequentially, a remember paragraph
serves as a friendly reminder. If you're not reading sequentially, this kind of
paragraph may help you realize that you need to review a central concept or
technique before proceeding.

This icon points to new stuff in AutoCAD 2007. It’s mostly designed for those
of you who are somewhat familiar with a previous version of AutoCAD and
want to be alerted to what’s new in this version. New AutoCAD users starting
out their CAD working lives with AutoCAD 2007 will find this stuff interesting,
too — especially when they can show off their new book-learnin’ to the griz-
zled AutoCAD veterans in the office who don’t yet know about all the cool,
new features.

This icon highlights differences between AutoCAD LT and AutoCAD. If you're
using AutoCAD LT, you’ll find out what you're missing compared to “full”
AutoCAD. If your friend is using LT, you’ll know where to look to find stuff in
AutoCAD to brag about.

A Few Conventions — Just in Case

You can probably figure out for yourself all the information in this section,
but here are the details just in case.

Text you type into the program at the command line, in a dialog box, in a text
box, and so on appears in boldface type. Examples of AutoCAD prompts
appear in a special typeface, as does any other text in the book that
echoes a message, a word, or one or more lines of text that actually appear
on-screen. Sequences of prompts that appear in the AutoCAD command line
area have a shaded background, like so:

Specify lower left corner or [ON/OFF] <0.0000,0.0000>:
(Many of the figures — especially in Chapters 6 and 7 — also show AutoCAD

command line sequences that demonstrate AutoCAD’s prompts and example
responses.)
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Often in this book, you see phrases such as “choose File>Save As from the
menu bar.” The funny little arrow (=) separates the main menu name from
the specific command on that menu. In this example, you open the File menu
and choose the Save As command. If you know another way to start the same
command (in this example, type SAVEAS and press Enter), you're welcome to
do it that way instead.

Many AutoCAD commands have shortcut (fewer-letter) versions for the bene-
fit of those who like to type commands at the AutoCAD command prompt. In
this book, we format command names in uppercase letters. If a command has
a shortcut, we include the shortcut in parentheses at the first reference to
the command so that you become familiar with the shortcuts and can use
them if you want to. So when you see an instruction like “run the DIMLINEAR
(DLI) command to draw a linear dimension,” it means “for a linear dimension,
type DIMLINEAR (or DLI for short) at the command line, and then press the
Enter key.”
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In this part . . .

A utoCAD is more than just another application pro-
gram,; it’s a complete environment for drafting and
design. So if you're new to AutoCAD, you need to know
several things to get off to a good start — especially how
to use the command line area and set up your drawing
properly. These key techniques are described in this part
of the book.

If you've used earlier versions of AutoCAD, you’ll be most
interested in the high points of the new release, including
some newer interface components. The lowdown on
what’s new is here, too.
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Chapter 1

Introducing AutoCAD
and AutoCAD LT

In This Chapter
Getting the AutoCAD advantage
Using AutoCAD and DWG files
Meeting the AutoCAD product family
Using AutoCAD LT instead of AutoCAD
Upgrading from a previous version

WElcome to the community whose members are the users of one of the
weirdest, wackiest, and most wonderful computer programs in the
world: AutoCAD. Maybe you're one of the few remaining holdouts who contin-
ues to practice the ancient art of manual drafting with pencil and vellum. Or
maybe you’re completely new to drafting and yearn for the wealth and fame
(would we lead you on?) of the drafter’s life. Maybe you’re an engineer or archi-
tect who needs to catch up with the young CAD hotshots in your office. Or
maybe you’re a full-time drafter whose fingers haven’t yet been pried away
from your beloved drafting board. Maybe you tried to use AutoCAD a long time
ago but gave up in frustration or just got rusty. Or maybe you currently use an
older version, such as AutoCAD 2000 or even (if you like antiques) Release 14.

Whatever your current situation or motivation, we hope that you enjoy the
process of becoming proficient with AutoCAD. Drawing with AutoCAD is chal-
lenging at first, but it’s a challenge worth meeting. CAD rewards those who
think creatively about their work and look for ways to do it better. You can
always find out more, discover a new trick, or improve the efficiency and
quality of your drawing production.

AutoCAD first hit the bricks in the early 1980s, around the same time as the

first IBM PCs. It was offered for a bewildering variety of operating systems,
including CP/M (ask your granddad about that one!), various flavors of UNIX,
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and even Apple’s Macintosh. By far, the most popular of those early versions
was for MS-DOS (your dad can tell you about that one). Eventually, Autodesk
settled on Microsoft Windows as the sole operating system for AutoCAD.
AutoCAD 2007 works with Windows XP — Professional, Home, and Tablet PC
editions — and Windows 2000.

Because of AutoCAD’s MS-DOS heritage and its emphasis on efficiency for
production drafters, it’s not the easiest program to master, but it has gotten
easier and more consistent. AutoCAD is pretty well integrated into the
Windows environment now, but you still bump into some vestiges of its MS-
DOS legacy — especially the command line (that text area lurking at the
bottom of the AutoCAD screen — see Chapter 2 for details). But even the
command line — oops! command window — has gotten kinder and gentler in
AutoCAD 2007. This book guides you around the bumps and minimizes the
bruises.

Why AutoCAD?

AutoCAD has been around a long time — since 1982. AutoCAD ushered in the
transition from really expensive mainframe and minicomputer CAD systems
costing tens of thousands of dollars to merely expensive microcomputer CAD
programs costing a few thousand dollars.

AutoCAD is, first and foremost, a program to create technical drawings.: draw-
ings in which measurements and precision are important because these kinds
of drawings often get used to build something. The drawings you create with
AutoCAD must adhere to standards established long ago for hand-drafted
drawings. The up-front investment to use AutoCAD is certainly more expen-
sive than the investment needed to use pencil and paper, and the learning
curve is much steeper, too. Why bother? The key reasons for using AutoCAD
rather than pencil and paper are

v~ Precision: Creating lines, circles, and other shapes of the exactly correct
dimensions is easier with AutoCAD than with pencils.

v Modifiability: Drawings are much easier to modify on the computer
screen than on paper. CAD modifications are a lot cleaner, too.

v~ Efficiency: Creating many kinds of drawings is faster with a CAD
program — especially drawings that involve repetition, such as floor
plans in a multistory building. But that efficiency takes skill and prac-
tice. If you’re an accomplished pencil-and-paper drafter, don’t expect
CAD to be faster at first!

Figure 1-1 shows several kinds of drawings in AutoCAD 2007.

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 1: Introducing AutoCAD and AutoCAD LT

Figure 1-1:
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Why choose AutoCAD? AutoCAD is just the starting point of a whole industry
of software products designed to work with AutoCAD. Autodesk has helped
this process along immensely by designing a series of programming inter-
faces to AutoCAD that other companies — and Autodesk itself — have used
to extend the application. Some of the add-on products have become such
winners that Autodesk acquired them and incorporated them into its own
products. When you compare all the resources — including the add-ons,
extensions, training courses, books, and so on — AutoCAD doesn’t have
much PC CAD competition.

The Importance of Being DWG

To take full advantage of AutoCAD in your work environment, you need to be
aware of the DWG file format, the format in which AutoCAD saves drawings.

v In some cases, an older version of AutoCAD can’t open a DWG file that’s
been saved by a newer version of AutoCAD.

v A newer version of AutoCAD can always open files saved by an older
version.
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v Some previous versions of AutoCAD can open files saved by the subse-
quent one or two versions. For example, AutoCAD 2004 can open DWG
files saved by AutoCAD 2006. That’s because Autodesk didn’t change the
DWG file format between AutoCAD 2004 and AutoCAD 2006. However,
the drawing file format did change with AutoCAD 2007, so drawings cre-
ated in the current version must be saved in an older format to be open-
able in AutoCAD 2006 and earlier.

v You can use the Save As option in newer versions to save the file to
some older DWG formats. In fact, AutoCAD 2007 will save as far back as
AutoCAD Release 14, which was released in 1997!

Table 1-1 shows which versions (described later in this chapter) use which

DWG file formats.
Table 1-1 AutoCAD Versions and DWG File Formats
AutoCAD Version AutoCAD LT Version Release Year DWEG File
Format

AutoCAD 2007 AutoCAD LT 2007 2006 Acad 2007
AutoCAD 2006 AutoCAD LT 2006 2005 Acad 2004
AutoCAD 2005 AutoCAD LT 2005 2004 Acad 2004
AutoCAD 2004 AutoCAD LT 2004 2003 Acad 2004
AutoCAD 2002 AutoCAD LT 2002 2001 Acad 2000
AutoCAD 2000i AutoCAD LT 2000i 2000 Acad 2000
AutoCAD 2000 AutoCAD LT 2000 1999 Acad 2000
AutoCAD Release 14~ AutoCAD LT 98 & 97 1997 Acad R14
AutoCAD Release 13 AutoCAD LT 95 1994 Acad R13
AutoCAD Release 12 AutoCAD LT Release 2 1992 Acad R12

Working with AutoCAD is easier when your co-workers and colleagues in other
companies all use the same version of AutoCAD and AutoCAD-related tools.
That way, your DWG files, add-on tools, and even the details of your CAD
knowledge can be mixed and matched among your workgroup and partners.
In the real world, you may work with people — at least in other companies —
who use AutoCAD versions as old as Release 14.
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AutoCAD-based applications

Autodesk has expanded AutoCAD into a whole
product line of programs with AutoCAD as a
base and specialized, discipline-specific add-
ons built on top and included as one complete
product. As an AutoCAD 2007 user, you'll be
looking for the 2007-compatible versions of
these tools, which should appear a few months
after AutoCAD 2007 ships. These discipline-
specific flavors of AutoCAD include Autodesk
Architectural Desktop, Autodesk Building
Systems (Mechanical, Electrical, and Plumb-
ing), AutoCAD Mechanical, Autodesk Map 3D,
Autodesk Land Desktop, Autodesk Survey, and
Autodesk Civil 3D.

To make matters even more confusing,
Autodesk also offers two flavors of Autodesk
Revit (Revit Building and Revit Structure) and
Autodesk Inventor, software applications that
compete with Architectural Desktop and

Mechanical, respectively. Revit and Inventor
are not based on AutoCAD; they sacrifice
AutoCAD compatibility in favor of a more fun-
damental design- and 3D-oriented approach to
CAD. Whether they ultimately replace the tradi-
tional AutoCAD-based applications remains to
be seen. While many architectural firms have
not made the leap to Revit, their mechanically-
oriented colleagues do seem to be favoring
Inventor over Mechanical Desktop.

In addition to the products from Autodesk, thou-
sands of AutoCAD add-on products — both dis-
cipline-specific and general-purpose — are
available from other software developers.
These companion products are sometimes
called third-party applications. Visit http: / /
partnerproducts.autodesk.com for
more information about what's available.

15

@\\\NG-’ Many programs claim to be DWG compatible — that is, capable of converting
data to and from AutoCAD’s DWG format. But achieving this compatibility is
a difficult thing to do well. Even a small error in file conversion can have
results ranging in severity from annoying to appalling. If you exchange DWG
files with people who use other CAD programs, be prepared to spend time
finding and fixing translation problems. This is even more of an issue when

there’s a new DWG format, as there is for AutoCAD 2007.

Seeing the LT

AutoCAD LT is one of the best deals around, a shining example of the old
80/20 rule: roughly 80 percent of the capabilities of AutoCAD for roughly 20
percent of the money. (Actually, with recent price creep, it’s now more like a
75/25 rule!) Like AutoCAD, AutoCAD LT runs on mainstream Windows com-
puters and doesn’t require any additional hardware devices. With AutoCAD
LT, you can be a player in the world of AutoCAD, the world’s leading CAD pro-
gram, for a comparatively low starting cost.
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AutoCAD LT is a very close cousin to AutoCAD. Autodesk creates AutoCAD LT
by starting with the AutoCAD program, taking out a few features to justify
charging a lower price, adding a couple of features to enhance ease of use
versus full AutoCAD, and testing the result. As a result, AutoCAD LT looks and
works much like AutoCAD. The drawing screen and menus of the two programs
are nearly identical. (LT is missing a few commands from the AutoCAD menus.)

In fact, the major difference between the programs has nothing to do with the
programs themselves. The major difference is that AutoCAD LT lacks support
for several customization and programming languages that are used to develop
AutoCAD add-ons. So almost none of the add-on programs or utilities offered
by Autodesk and others are available to LT users.

AutoCAD LT also has only limited 3D support. You can view and edit 3D
objects in AutoCAD LT, so you can work with drawings created in AutoCAD
that contain 3D objects. However, you cannot create true 3D objects in LT.

The lack of 3D object creation in LT is not as big a negative for many users as
you may think. Despite a lot of hype from the computer press and CAD ven-
dors (including Autodesk), 3D CAD remains a relatively specialized activity.
The majority of people use CAD programs to create 2D drawings. It’s going to
be interesting to see if AutoCAD 2007’s new 3D capabilities change anything.

Although you may hear claims that AutoCAD LT is easier to master and use
than AutoCAD, the truth is that they’re about equally difficult or easy,
depending on your NQ (nerd quotient). The LT learning curve doesn’t differ
significantly from that of AutoCAD. AutoCAD was originally designed for max-
imum power and then modified somewhat to improve ease of use. AutoCAD
LT shares this same heritage.

Fortunately, the minimal differences between LT and AutoCAD mean that
after you have climbed that learning curve, you’ll have the same great view.
You'll have almost the full range of AutoCAD’s 2D drafting tools, and you’ll be
able to exchange DWG files with AutoCAD users without data loss.

This book covers AutoCAD 2007, but almost all the information in it applies
to AutoCAD LT 2007 as well. The icon that you see at the left of this para-
graph highlights significant differences.

It’s CAD Heaven with 2007

If you're upgrading from AutoCAD 2006 or another recent version and you work
mostly or entirely in 2D, you’re probably already current with system require-
ments. If you want to use AutoCAD 2007’s new and enhanced 3D features pro-
ductively, however, it may be time for some new wheels, as we describe next.
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You should know the following before you upgrade from any older AutoCAD
release:

1 Wash those old Windows: AutoCAD 2007 does not support older ver-
sions of Windows, such as Windows NT, 98, and Me. You must use
Windows XP (Professional, Home, or Tablet PC) or Windows 2000, all
patched with the latest service packs.

v DWG file compatibility: The previous three releases shared a common
DWG file format, but AutoCAD 2007 uses a new format. You have to use
Filew>Save As to create DWG files for users of AutoCAD 2006 and earlier
versions as far back as Release 14. (If you need to go even further
back, you can save to the Release 12 DXF format — see Chapter 17
for instructions.)

v~ Application compatibility: If you use third-party applications with a
previous version of AutoCAD, they may not work with AutoCAD 2007.
AutoCAD 2004, 2005, and 2006 applications, including those developed
with the ARX (AutoCAD Runtime eXtension) and VBA (Visual Basic for
Applications) programming interfaces, work with AutoCAD 2007; but
older ARX and VBA applications don’t work.

Many LSP (AutoLISP) programs written for the last several versions of
AutoCAD work with AutoCAD 2007.

 Increased computer system requirements: For AutoCAD 2007, Autodesk
recommends an 800 MHz Pentium III or better processor, at least 512MB
of RAM, 1024 x 768 or higher display resolution with True Color graphics,
750MB of available hard disk space, an Internet connection, and Microsoft
Internet Explorer 6.0 with Service Pack 1 or later.

v~ Additional requirements for working in 3D: AutoCAD recommends a
3 GHz processor; 2GB of RAM; a workstation-class, OpenGL-capable
graphics card with at least 128 MB of memory; and an additional 2GB
of hard disk space beyond the 750 MB required for installation.

We find even the recommended system requirements on the minimal side.
For example, Mark works at a screen resolution of 1280 x 1024, and Dave
works at 1600 x 1200. The figures in this book were shot at a resolution of
1024 x 768, and as you can see, things can get pretty crowded at that resolu-
tion. We also think 512MB of RAM is on the low side for productive work —
get at least a gigabyte.

Even though AutoCAD 2007 comes out a mere year after AutoCAD 2006, it
sports some substantial and impressive new features, mainly in 3D modeling.
Because AutoCAD 2007 For Dummies is designed as an introductory text, we
don’t cover every in and out of 3D, but we do present some basics. Of course,
3D isn’t all that’s new — how would they get you to upgrade if you work only
in 2D? Among the worthy new or improved features are
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v Save As: As we already mentioned, you can save a DWG all the way back
to Release 14. This is a welcome change from the previous policy of let-
ting users save back to only the two previous releases.

v DWF Underlay: Similar to external references (see Chapter 14) with the
added benefit of eliminating many of the bottlenecks involved with xrefs.
Team workers will be very happy!

If you’re coming from AutoCAD 2005 or even earlier, you may have over-
looked some new features introduced in AutoCAD 2006; these were the big
changes in that version, and all have been tweaked in AutoCAD 2007:

v+ Dynamic input: You can almost forget about the command window —
command line. In addition to the command line, AutoCAD 2007 features
a heads-up interface that displays command names, options, prompts,
and values right next to the crosshairs. (See Chapter 2.)

v Improved object selection: AutoCAD provides more positive feedback
than ever before with its rollover highlighting feature. (See Chapter 7.)

v Dynamic blocks: You no longer need separate blocks for every door or
window size in your drawings. Now you can insert a single block defini-
tion and choose its configuration as you insert it. (See Chapter 14.)

If you have any interest at all in updating your AutoCAD skills by venturing
into the third dimension, now is the time and AutoCAD 2007 is your version.
Even if you're not interested in 3D, there are enough refinements to make
upgrading worth your while. That’s especially the case if you're an LT user,
since many of the full-version-only Express Tools have been incorporated

P into the core program and so are available in LT, too.

No Express service?

If your menu bar doesn't include the Express
menu (it's the third item from the right in Figure
1-1), you should consider installing the Express
Tools from your AutoCAD CD (AutoCAD LT does
not include or support the Express Tools).

When you first install AutoCAD 2007, you
choose between a Typical or a Custom installa-
tion. If you choose Typical, the next screen asks
if you want to install the Express Tools. If you

choose a Custom installation, in the next screen
make sure to check the Express Tools item in
the list of components. If you do not install the
Express Tools during initial setup, you will have
to rerun AutoCAD 2007’s installation routine. If
you haven't installed AutoCAD yet, we strongly
recommend that you choose the Typical instal-
lation option — or, at least, make sure the
Express Tools box is checked during a Custom
installation.
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Chapter 2
Le Tour de AutoCAD 2007

In This Chapter
Touring the AutoCAD 2007 screens
Going bar hopping: title bars, the menu bar, toolbars, and the status bar

Dynamically inputting and commanding the command line
Discovering the drawing area

Making the most of Model and Layout tabs

Practicing with palettes

Setting system variables and dealing with dialog boxes

Using online help

A utoCAD 2007 is a full-fledged citizen of the Windows world, with toolbars,
dialog boxes, right-click menus, a multiple-document interface, and all the
other trappings of a real Windows program. And it’s becoming more and more
Windows-like with each release. One of the last weird but essential holdovers
from the DOS days is the AutoCAD command line. The command line area is
still there (and wouldn’t you know it, officially it’s now known as the command
window), but in AutoCAD 2007, you’ll be less reliant on this “look down here —
now look up here” method of interacting with the program.

AutoCAD 2007, like the fanciest Detroit iron, bristles with heads-up display
features. The dynamic input system puts much of the command line informa-
tion right under your nose (or at least under your crosshairs). And recently
entered data is just a right-click away.

Like the rest of the book, this chapter is written for someone who has used
other Windows programs but has little or no experience with AutoCAD. If you
are experienced with recent versions of AutoCAD, some of this chapter will
be old hat for you — although you may get a shock when you open AutoCAD
2007 for the first time, especially if you choose to enter the 3D Modeling
workspace the first time you start the program.

Most of the new features in AutoCAD 2007 are for creating and viewing objects
in three dimensions. In the previous edition of this book, we actually removed
the 3D chapter on the grounds that AutoCAD’s 3D abilities were pretty clunky
to use, and people who did 3D design were probably using other software
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programs anyway. Times change, and so has AutoCAD. The 3D engine has been
completely rebuilt, stroked, polished, and tuned to the extent that we now
think 3D is a useable feature. We introduce you to AutoCAD’s 3D viewing and
navigation tools in Chapter 9. In this chapter, we focus on 2D drafting which,
after all, is still what the great majority of AutoCAD users do with the software.

AutoCAD Does Window's

Finding your way around AutoCAD 2007 can be an odd experience. You recog-
nize from other Windows applications much of the appearance and workings
of the program, such as its toolbars and pull-down menus, which you use for
entering commands or changing system settings. But other aspects of the
program’s appearance — and some of the ways in which you work with it —
are quite different from other Windows programs. You can, in many cases, tell
the program what to do in at least four ways — pick a toolbar icon, pick from
a pull-down menu, type at the keyboard, or pick from a right-click menu —
none of which is necessarily the best method to use for every task.

Profiling your display

The illustrations and descriptions in this chap-
ter and throughout the book show the default
configuration of AutoCAD — that is, the way the
screen looks if you use the standard version of
AutoCAD (not a flavored version such as
Architectural Desktop) and haven't messed with
the display settings. You can change the
appearance of the screen with settings on the
Display tab of the Options dialog box (choose
Tools=>0ptions=>Display) and by dragging tool-
bars and other screen components.

The main change we've made is to configure the
drawing area background to be white instead of
black, because the figures in the book show up
better that way. You may want to set a white
background on your own system or stay with the
default black background —it's your choice, and
there’s no right or wrong. Some of AutoCAD’s
colors show up better on a white background,
and some are better on a black one.

If you're using a flavored version of AutoCAD, or
if someone has already changed your configu-
ration or added a third-party program to your
setup, your screen may look different from the
figures in this book. You can restore the default
configuration — including display settings —
with the Reset button on the Options dialog
box’s Profiles tab. (AutoCAD LT doesn’t include
the Profiles feature, so LT users are out of luck
here.) But before you click the Reset button,
consider whether the modified configuration
may be useful to someone in the future — like
you! If so, first click the Add To List button to
create a new profile. Enter a name for the new
profile, such as AutoCAD default. Then select
the new profile that you created, click the Set
Current button to make it the current profile, and
finally click the Reset button. In the future, you
can switch between your modified and default
configurations with the Set Current button.
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P As with other Windows programs, the menus at the top of the AutoCAD screen
enable you to access most of the program’s functions and are the easiest-to-
remember method of issuing commands. When you want to get real work done,
you need to combine the pull-down menus with other methods — especially
entering options at the keyboard or choosing them from the right-click menus.
We show you how throughout this book.

And They're Off: AutoCAD’s
Opening Screen

By default, when you start an AutoCAD 2007 session, a dialog box (see
Figure 2-1) asks in which of the two standard workspaces you want to start
your drawing session:

v 3D Modeling: Opens a new drawing file configured for a 3D modeling
environment with navigation, visualization, and modeling tools suitable
for working in 3D.

v AutoCAD Classic: Opens a new drawing configured for a 2D drafting
environment, with drafting and drawing management tools suitable for
working in 2D.

Workspaces
<Ch

AutoCAD 2007

30 Madeling
AutolAD Classic

I Opens with a 30 view usng & 30 b
) drawing template file, Displays [
Flgure 2-1: an interfece designad for v

Will that be
2D or 3D?
Make your
choice here.

B Don't Show me this again

Autodesk

A workspace is a collection of menus, palettes, and toolbars tailored for spe-
cific tasks, such as 3D modeling or 2D drafting. AutoCAD 2007 includes two
workspaces for just those purposes, called 3D Modeling and AutoCAD Classic,
and you can easily create additional workspaces to suit your requirements.
For more information, look up “workspace” in the online help system.
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In this chapter we’re going to focus on drawing rather than modeling — we’ll
look at visualizing and navigating in 3D space in Chapter 9.

If you don’t see the Workstations dialog box shown in Figure 2-1, it means
that you or someone who uses your computer checked that little box that
says Don’t Show Me This Again down there in the lower-left corner. If you
want to restore the Workstations dialog box, choose Tools=>Options, and

on the Systems tab, General Options area, check the box beside Show All

Warning Messages. Then click OK.

The Workstations dialog box appears only when you start an AutoCAD ses-
sion — it’s not there if AutoCAD is already open. If that’s the case and you
want to switch between 2D drafting and 3D modeling, follow these steps:

1. Choose Toolsw>Workspaces>AutoCAD Classic.

Assuming the 3D Modeling workspace is current, a bunch of toolbars
and palettes open and close. You end up with the Tool Palettes and the
Sheet Set Manager displayed at the left and right sides of the screen.
(Don’t worry about what those are for right now — we’ll get to them in
later chapters.)

2. Choose File=>New or open a 2D AutoCAD drawing file.

If you choose to start a new file, the Select Template dialog box opens.
Choose acad.dwt if you want to work in imperial units, or acadiso.dwt, if
you want to work in metric.

To switch back from 3D modeling to a 2D drafting environment, reverse
the procedure as follows:

3. Choose Tools=>Workspaces =>3D Modeling.

After more whizzing and whirring, AutoCAD closes Sheet Set Manager
and opens the Modeling tab of the Tool Palettes and the Dashboard (we
discuss these features in Chapter 9).

4. Choose File=>New or open a 3D AutoCAD model file.

If you choose to start a new file, the Select Template dialog box opens.
Choose acad3d.dwt if you want to work in imperial units, or acadiso3d.
dwt, if you want to work in metric.

For the remainder of this chapter (and nearly all the rest of the book), we
focus on 2D drafting, by far the easier way of getting your feet wet with
AutoCAD.

After you switch to the AutoCAD Classic workspace, AutoCAD displays its
old familiar 2D interface, as shown in Figure 2-2. You can close the Sheet Set
Manager and Tool Palettes for now — we describe how to turn them back on
and how to use them later in this chapter.
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If you have a previous version of AutoCAD on your computer, AutoCAD 2007
displays a Migrate Settings dialog box the first time you run the program.
Unless you're a competent AutoCAD user who is reading this book to find out
about the new features, we recommend that you click Cancel and start fresh.
If you later decide you want to migrate your custom settings, you can do so
by choosing Start=>All Programs=>Autodesk>AutoCAD 2007=>Migrate Custom
Settings and then choosing the installed version from which you want to
migrate settings. Be warned, however, that doing so will overwrite any new
customization you’'ve added to AutoCAD 2007.

Those well-washed Windows

As shown in Figure 2-2, much of the AutoCAD screen is standard Windows
fare — title bars, a menu bar, toolbars, and a status bar.
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A hierarchy of title bars

Like most Windows programs, AutoCAD has a title bar at the top of its pro-
gram window that reminds you which program you’re in (not that you’d ever
mistake the AutoCAD window for, say, Microsoft Word!).

v At the right side of the title bar is the standard set of three Windows
control buttons: Minimize, Maximize/Restore, and Close.

v Each drawing window within the AutoCAD program window has its own
title bar. You use the control buttons on a drawing window’s title bar to
minimize, maximize/restore, or close that drawing, instead of the entire
AutoCAD program.

As in other Windows programs, if you maximize a drawing’s window, it
expands to fill the entire drawing area. (AutoCAD 2007 starts with the draw-
ing maximized in this way.) As shown in Figure 2-2, the drawing’s control but-
tons move onto the menu bar, below the control buttons for the AutoCAD
program window; the drawing’s name appears in the AutoCAD title bar. To
unmaximize (restore) the drawing so that you can see any other drawings
that you have open, click the lower Restore button. The result is as shown in
Figure 2-3: a separate title bar for each drawing with the name and controls
for that drawing.
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Hot-wiring the menu bar

Some standard tips and tricks for Windows are
especially useful in AutoCAD. Control-key short-
cuts for the most popular functions — Ctrl+S to
save, Ctrl+0 to open a file, and Ctrl+P to print—
work the same way in AutoCAD as in most other
Windows programs. Use them!

Also worth exploring are the Alt-key shortcuts,
which are available for all menu choices, not

just the most popular ones. To fly around the
menus, just press and hold the Alt key and then
press the letters on your keyboard that corre-
spond to the underlined letters on the menu bar
and in the menu choices. To bring up the
SAVEAS command, for example, just press and
hold the Alt key, press F for File, and then press
A for Save As.

Matking choices from the menu bar

The menu bar contains the names of all the primary menus in your version of
AutoCAD. As with any program that’s new to you, it’s worth spending a few
minutes perusing the menus in order to familiarize yourself with the com-
mands and their arrangement. (If your menu bar doesn’t include the Express
menu — and note that AutoCAD LT does not include the Express menu — see
the end of Chapter 1 for installation instructions.)

Cruising the toolbars

As in other Windows programs, the toolbars in AutoCAD provide rapid
access to the most commonly used AutoCAD commands. AutoCAD 2007
ships with toolbars in this default arrangement (as shown in Figure 2-4):

1 Standard toolbar: Located just below the menu bar. You find file manage-
ment and other common Windows functions here, plus some specialized
AutoCAD stuff such as zooming and panning.

v~ Styles toolbar: To the right of the Standard toolbar. Used for selecting
and formatting AutoCAD’s text, dimension, and table styles. Chapters 10
and 11 cover these features.

v Workspaces toolbar: Below the Standard toolbar. Used to switch between
or manage workspaces. AutoCAD Classic is the default 2D workspace we
use throughout this book (except for Chapter 9).

v~ Layers toolbar: To the right of the Workspaces toolbar. Includes com-
mands and a drop-down list for manipulating layers, which are AutoCAD’s
fundamental tools for organizing and formatting objects. Chapter 5 con-
tains the layer lowdown.
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v Properties toolbar: To the right of the Layers toolbar. Used for formatting
AutoCAD object properties, such as colors, linetypes, and lineweights. See
Chapter 5 when you're ready to play with AutoCAD’s object properties.

v Draw toolbar: Vertically down the left edge of the screen. Includes the
most commonly used commands from the Draw menu. Chapter 6 covers
most of the items on this toolbar.

v Modify toolbar: Vertically down the right edge of the screen. Includes
the most commonly used commands from the Modify menu. Chapter 7
shows you how to use almost everything on this toolbar.

1 Draw Order toolbar: Vertically below the Modify toolbar. Offers com-
mands for controlling which objects appear on top of which other
objects. If you need this kind of flexibility, look up “DRAWORDER com-
mand” in the AutoCAD online help system.

You can rearrange, open, and close toolbars as in other Windows programs.

v To move a toolbar, point to its border (the double-line control handle at
the leading edge of the toolbar is the easiest part to grab), click, and drag.

v To open or close toolbars, right-click any toolbar button and choose
from the list of available toolbars, as shown in Figure 2-4.

The AutoCAD screen in Figure 2-4 shows the default toolbar arrangement,
which works fine for most people. Feel free to close the Draw Order toolbar;
you aren’t likely to use its features frequently. You may want to turn on a
couple of additional toolbars, such as Object Snap and Dimension, as you dis-
cover and make use of additional features. Throughout this book, we point
out when a particular toolbar may be useful.

If you're not satisfied with just rearranging the stock AutoCAD toolbars, you
can customize their contents or even create new ones. The procedures are
beyond the scope of this book; they involve bouncing among the Interfaces,
Commands, Toolbars, and Properties areas in the Customize User Interface
dialog box in not entirely intuitive ways. Resist slicing and dicing the stock
AutoCAD toolbars until you're at least somewhat familiar with them. If you
want to get creative thereafter, check out this book’s companion volume,
AutoCAD and AutoCAD LT Alldn-One Desk Reference For Dummies.

P AutoCAD toolbar buttons provide tooltips, those short descriptions that
appear in little text boxes when you pause the crosshairs over a toolbar
button. A longer description of the icon’s function appears in the status bar
at the bottom of the screen.
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Looking for Mr. Status Bar

The status bar (see Figure 2-5) appears at the bottom of the AutoCAD
screen. The status bar displays and allows you to change several important
settings that affect how you draw and edit in the current drawing. Some of
these settings won’t make complete sense until you’'ve used the AutoCAD
commands that they influence, but here’s a brief description, with pointers
to detailed descriptions elsewhere in this book of how to use each setting:

v Coordinates of the crosshairs: The coordinates’ readout displays the
current X,Y,Z location of the crosshairs in the drawing area, with respect
to the origin point (whose coordinates are 0,0,0). Chapter 5 describes
AutoCAD’s coordinate conventions and how to use this area of the
status bar.
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P If the coordinates in the lower-left corner of the screen are grayed out,

coordinate tracking is turned off. Click the coordinates so that they
appear in dark numbers that change when you move the crosshairs in
the drawing area.

If dynamic input is enabled, the tooltip at the crosshairs also displays
the current X,Y,Z location of the crosshairs. This constantly active dis-
play is not affected by changes to coordinate tracking in the status bar.

v SNAP, GRID, and ORTHO mode buttons: These three buttons control
three of AutoCAD’s tools for ensuring precision drawing and editing:

e Snap constrains the crosshairs to regularly spaced hot spots,
enabling you to draw objects a fixed distance apart more easily.

e Grid displays a series of regularly spaced dots, which serve as a
distance reference.

e Ortho constrains the crosshairs to horizontal and vertical move-
ment, which makes drawing orthogonal (straight horizontal and
vertical) lines easy.

See Chapter 4 for instructions on how to configure these modes and
Chapter 5 for information about why, when, and how to use them in
actual drawing operations.

+* POLAR tracking mode button: Polar tracking causes the crosshairs to
prefer certain angles when you draw and edit objects. By default, the
preferred angles are multiples of 90 degrees, but you can specify other
angle increments, such as 45 or 30 degrees. See Chapter 5 for instruc-
tions to specify the polar tracking angles that you prefer. Clicking the
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POLAR button toggles polar tracking on or off. Ortho and polar tracking
are mutually exclusive — turning on one mode disables the other.

v Running Object Snap (OSNAP) and Object Snap Tracking (OTRACK)
buttons: Object snap is another AutoCAD tool for ensuring precision
drawing and editing. You use object snaps to grab points on existing
objects — for example, the endpoint of a line or the center of a circle.

¢ When you turn on running object snap, AutoCAD continues to hunt
for object snap points. Chapter 5 contains detailed instructions on
how to use this feature.

e When you turn on object snap tracking, AutoCAD hunts in a more
sophisticated way for points that are derived from object snap
points. Chapter 5 briefly describes this advanced feature.

v Dynamic User Coordinate System (DUCS) button: This one’s for 3D
object creation (and so is not included in AutoCAD LT). We don’t cover
3D modeling in this book. All you need know for now is that when it’s
enabled, you can align your current construction plane with the face of
a 3D solid. (See — wouldn’t you rather have waited ‘til Chapter 9?7)

v Dynamic Input (DYN) button: Dynamic input displays commands, options,
prompts, and user input in a tooltip adjacent to the crosshairs and
enables you to keep focused on what you're drawing. In addition, the
dynamic input tooltip displays what you type in response to prompts.

v Lineweight (LWT) display mode button: One of the properties that you
can assign to objects in AutoCAD is lineweight — the thickness that lines
appear when you plot the drawing. This button controls whether you
see the lineweights on the screen. (This button doesn’t control whether
lineweights appear on plots; that’s a separate setting in the Plot dialog
box.) Chapter 5 gives you the skinny (and the wide) on lineweights.

v MODEL/PAPER space button: As we describe in the section, “Down the
Main Stretch: The Drawing Area,” later in this chapter, the drawing area
is composed of overlapping tabbed areas labeled Model, Layout1, and
Layout2 by default. The Model tab displays a part of the drawing called
model space, where you create most of your drawing. Each of the
remaining tabs displays a paper space layout, where you can compose a
plottable view with a title block. A completed layout will include one or
more viewports, which reveal some or all the objects in model space at a
particular scale.

The MODEL/PAPER status bar button (not to be confused with the Model
tab) comes into play after you click one of the paper space layout tabs.
The MODEL/PAPER button provides a means for moving the crosshairs
between model and paper space while remaining in the particular layout.
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e When the MODEL/PAPER button says MODEL, drawing and editing
operations take place in model space, inside a viewport.

e When the button says PAPER, drawing and editing operations take
place in paper space on the current layout.

Don’t worry if you find model space and paper space a little disorienting
at first. The paper space layout setup information in Chapter 4 and plot-
ting instructions in Chapter 13 will help you get your bearings and navi-

gate with confidence.

v Maximize/Minimize Viewport button (this status bar button appears
on paper space layouts only): When you’re looking at one of the Layout
tabs instead of the Model tab, the status bar displays an additional
Maximize Viewport button. Click this button to expand the current
paper space viewport so that it fills the entire drawing area. Click the
button — now called Minimize Viewport — again to restore the viewport
to its normal size. (Chapter 4 describes viewports.)

+ Communication Center: This button opens a dialog box containing
recent AutoCAD-related headlines that Autodesk thinks you may find
useful. The headlines are grouped into categories called channels: Live
Update Maintenance Patches, Articles and Tips, Product Support
Information, and so on. Each headline is a link to a Web page with more
information, such as how to download a software update or fix a prob-
lem. Click the Settings button in the Communication Center dialog box
to select channels you see in the Communication Center window.

v Lock/Unlock Toolbar Palette Positions: “Now, where did I leave that
Properties palette?” You’'ll never have to ask yourself again — AutoCAD
2007 lets you lock toolbars or palettes (which for some reason they’ve
started calling windows) in position, so you’ll always know where
they are.

v Trusted Autodesk DWG: You see this button when AutoCAD opens a
drawing that was created by AutoCAD or AutoCAD LT. In recent years,
more and more programs have been able to save in DWG format, but in
Autodesk’s eyes, these files are not to be trusted.

1 Manage Xrefs: You won'’t see this combination button and notification
symbol until you open a drawing that contains xrefs (external DWG files
that are incorporated into the current drawing). Chapter 14 tells you
how to use xrefs and what the Manage Xrefs button does.

v~ Associated Standards File: You'll see this button if you've enabled CAD
standards checking and configured a drawing standards (DWY) file.
Clicking this button displays the Check Standards dialog box.

v~ Status Bar Menu: When you click the easy-to-miss, downward-pointing
arrow near the right edge of the status bar, you open a menu with options
for toggling off or on each status bar button. Now you can decorate your
status bar to your taste.
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v Clean Screen: No, it doesn’t squeegee your monitor. Clicking this button
frees up a bit more screen space by first maximizing the AutoCAD
window and then turning off the title bar, toolbars and palettes, and the
Windows task bar. Click the button again to restore those elements.

You can open dialog boxes for configuring many of the status bar button
functions by right-clicking the status bar button and choosing Settings.
Chapters 4 and 5 give you specific guidance about when and how to change
these settings.

A button’s appearance shows whether the setting is turned on or off.
Depressed, or down, means on; raised, or up, means off. If you’re unclear
whether a setting is on or off, click its button; its mode changes and the
new setting is reflected on the command line — <Osnap off>, for example.
Click again to restore the previous setting.

A smoother vide: Dynamic input

One of the tasks faced by every AutoCAD instructor is the frequent need to
badger students to “Watch the Command Line!” because the command line
can be confusing for people who are new to CAD and computers. To anyone
familiar with any other Windows graphic program, the command line is really
tough to take — a throwback to an earlier time, when the knuckles of com-
puter-aided drafters dragged on the ground. The challenge for experienced
AutoCAD users now is going to be “Stop Watching the Command Line!”

When dynamic input is enabled, the crosshairs take on some extra features:
v The coordinates of the current pointer location are always visible at the
crosshairs.
v Typed commands appear in the tooltip adjacent to the crosshairs.

v When a command is started, you can display options by pressing the
down-arrow key on the keyboard.

v Values that you type appear in the tooltip, and the dynamic input system
displays dimensions when you’re drawing things or moving them
around. (Refer to Figure 2-2.)

Dynamic input is enabled by default, so it’s going to be one of the first things
you notice when you get behind the wheel.

If there’s not enough room at the crosshairs to show all command options,

the dynamic input tooltip shows a tiny down-arrow icon. Press the down-
arrow key on your keyboard to see more options (see Figure 2-6).
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|
Figure 2-6:
Dynamic
crosshairs
with all the
options.
|

|
Figure 2-7:
Obey the
command
line.
|

The DYN status bar button controls AutoCAD 2007’s dynamic input system.
You can toggle off dynamic input by clicking this button, but we recommend
you use it — you won’t have to keep looking down at the command line
nearly so often!

Let your fingers do the talking:
The command window

If the title bars, menu bar, status bar, and dynamic input tooltips are the
Windows equivalent of comfort food — familiar, nourishing, and unthreaten-
ing — then the command window, shown in Figure 2-7, must be the steak
tartare or blood sausage of the AutoCAD screen feast. It looks weird, turns
the stomachs of newcomers, and delights AutoCAD aficionados. Despite the
promise of AutoCAD 2007’s heads-up dynamic input, for now at least, the
hard truth is that you have to come to like — or at least tolerate — the com-
mand line if you want to become at all comfortable using AutoCAD.

You should cotton on and cozy up to the command line because the com-
mand line is still AutoCAD’s primary communications conduit with you.
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AutoCAD sometimes displays prompts, warnings, and error messages in the
command window that dynamic input doesn’t show — there simply isn’t
room in the dynamic input tooltip to show as much information as you get at
the command line. True, when using dynamic input, you can press the down-
arrow key to see more options, but then which is less efficient — moving
your eyes down the screen to glance at the command line, or taking your
eyes right off the screen to find the down-arrow key on your keyboard?

The key (board) to AutoCAD success

Despite (or is it because of?) AutoCAD’s long heritage as the most successful
microcomputer CAD software, newcomers are still astonished at the amount
of typing they have to do. Some more modern programs may have much less
dependency on the keyboard than AutoCAD; but as you get used to it, you’ll
find that no other input method gives you as much flexibility as pounding the
ivories . . . oops, wrong keyboard!

Typing at your computer’s keyboard is an efficient way to run some com-
mands and the only way to run a few others. Instead of clicking a toolbar
button or a menu choice, you can start a command by typing its command
name and then pressing the Enter key. Even better, for most common com-
mands, you can type the keyboard shortcut for a command name and press
Enter. Most of the keyboard shortcuts for command names are just one or
two letters — for example, L for the LINE command and CP for the COPY
command. Most people who discover how to use the shortcuts for the com-
mands that they run most frequently find that their AutoCAD productivity
improves noticeably. Even if you're not worried about increasing your pro-
ductivity with this technique, there are some commands that aren’t on the
toolbars or pull-down menus. If you want to run those commands, you have
to type them!

After you've started a command — whether from a toolbar, from a menu, or
by typing — the dynamic input tooltip and the command line are where
AutoCAD prompts you with options for that command. You activate one of
these options by typing the uppercase letter(s) in the option and pressing
Enter.

In many cases, you can activate a command’s options by right-clicking in the

drawing area and choosing the desired option from the menu that appears,
instead of by typing the letter(s) for the option and pressing Enter.
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We like dynamic input. Really, we do. But sometimes it fights with normal
command input, and that can make things really confusing. In the following
chapters we tell you when to be wary.

The following sequence demonstrates how you use the keyboard to run com-
mands and view and select options. If you have dynamic input toggled on,
your results are going to be different from what we say, so we suggest you
click the DYN button to turn it off, temporarily at least. In the following steps,
watch the command line, and pay attention to messages from AutoCAD.

1. Type L and press Enter.

AutoCAD starts the LINE command and displays the following prompt in
the command window:

LINE Specify first point:
2. Click a point anywhere in the drawing area.
The command line prompt changes to:
Specify next point or [Undo]:
3. Click another point anywhere in the drawing area.
AutoCAD draws the first line segment.
4. Click a third point anywhere in the drawing area.
AutoCAD draws the second line segment and prompts:
Specify next point or [Close/Undo] :

The command line now displays two options, Close and Undo, separated
by a slash.

AutoCAD’s command line always displays command options in brackets.
In this case, the Close and Undo options appear in brackets. To activate
an option, type the letter(s) shown in uppercase and press Enter. (You
can type the option letter(s) in lowercase or uppercase.)

5. Type U and press Enter.
AutoCAD undoes the second line segment.
6. Type 3,2 (without any spaces) and press Enter.

AutoCAD draws a new line segment to the point whose X coordinate is 3
and Y coordinate is 2.

7. Click several more points anywhere in the drawing area.
AutoCAD draws additional line segments.

8. Type X and press Enter.
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Xisn’t a valid option of the LINE command, so AutoCAD displays an
error message and prompts you again for another point:

Point or option keyword required.
Specify next point or [Close/Undo] :

Option keyword is programmer jargon for the letter(s) shown in upper-
case that you type to activate a command option. This error message is
AutoCAD’s way of saying “I don’t understand what you mean by typing
X. Either specify a point or type a letter that [ do understand.”

9. Type C and press Enter.

AutoCAD draws a final line segment, which creates a closed figure, and
ends the LINE command. A blank command line returns, indicating that
AutoCAD is ready for the next command:

Command :
10. Press the F2 key.

AutoCAD displays the AutoCAD Text Window, which is simply an enlarged,
scrollable version of the command window, as shown in Figure 2-8.

\\J . .
The normal three-line command window usually shows you what you
need to see, but occasionally you'll want to review a larger chunk of com-
mand line history. (“What was AutoCAD trying to tell me a minute ago?!”)
“E] AutoCAD Text Window - Drawing.dwg =EE
Edit
I (([Command: L -
. INE Specify first
Flgure 2-8: pecify next point 1: <Ortho off>
M h Specify next point or [ ]
y ow Specify next point or [Close/Undo]: U
you \ég Specify next point or [Undo]: 3,2
rown:
g Specify next point or [Close/Undo]:
expands the Specify next point or [C1
pecify next point or [
Colmmand Specify next point or [Close/Undo]: X
Inetoa
Command FPoint or option keyword reguired.
text pecify next point or [Close/Undel: C
window. . >
Command : £ >
|

11. Press the F2 key again.
AutoCAD closes the AutoCAD Text Window.
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AutoCAD is no vin ordinaire

The back and forth needed to get AutoCAD to
draw and complete a line is a great example of
AutoCAD’s power — and its power to confuse
new users. It's kind of like a wine that tastes a
bit harsh initially but ages better than something
more immediately drinkable. And with AutoCAD,
you can still drive yourself home!

In other programs, if you want to draw a line,
you just draw it. In AutoCAD, you have to press
Enter one extra time when you're done just to
tell AutoCAD vyou really are finished drawing.

But the fact that the LINE command remains
active after you draw the first line segment
makes it much faster to draw complicated, mul-
tisegment lines, which is a common activity in a
complex drawing.

This is just one example of how AutoCAD favors
ease of use for power users doing complex
drawings over ease of mastery for beginners,
who frequently forget to hit Enter that extra time
to close out a command.

MBER
@?«
&

Here are a few other tips and tricks for effective keyboarding:

v Use the Esc key to bail out of the current operation. There will be
times when you get confused about what you're doing in AutoCAD

and/or what you’re seeing in the command window or the dynamic input

tooltip. If you need to bail out of the current operation, just press the
Esc key one or more times until you see a blank command line —
Command: at the bottom of the command window, with nothing after it.
As in most other Windows programs, Esc is the cancel key. Unlike many
other Windows programs, AutoCAD keeps you well informed of whether
an operation is in progress. The blank command line indicates that
AutoCAD is resting, waiting for your next command.

v~ Press Enter to accept the default action. Some command prompts

include a default action in angled brackets. For example, the first prompt

of the POLYGON (POL) command is

Enter number of sides <4>:

The default here is four sides, and you can accept it simply by pressing

the Enter key. (That is, you don’t have to type 4 first.)

AutoCAD uses two kinds of brackets when it prompts.

¢ Command options appear in regular square brackets:

[Close/Undo].

To activate a command option, type the letter(s) that appear in
uppercase and then press Enter. The dynamic input tooltip does

not display options in brackets; instead, you press the down-arrow

key to display additional command options in rows next to the
crosshairs (refer to Figure 2-6).
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¢ A Default value or option appears in angled brackets: <>.

To choose the default value or option, simply press Enter. Default
values in angled brackets appear in both the dynamic input tooltip
and the command line prompts.

You don’t always have to press the Enter key to forward your input to
AutoCAD. Depending on what you're doing, you can often right-click and
pick Enter from the top of the shortcut menu. And most efficient of all,
even for the most inept typists, you can use the Spacebar as an Enter
key — as long as you're not entering text.

v Observe the command line. You’'ll discover a lot about how to use the
command line simply by watching it after each action that you take.
When you click a toolbar button or menu choice, AutoCAD types the
name of the command automatically and displays it in the dynamic
input tooltip and at the command line. If you’re watching the command
line, you'll absorb the command names more-or-less naturally.

When AutoCAD types commands automatically in response to your tool-
bar and menu clicks, it usually adds one or two extra characters to the
front of the command name.

e AutoCAD usually puts an underscore in front of the command
name (for example, _LINE instead of LINE). The underscore is an
Autodesk programmers’ trick that enables non-English versions
of AutoCAD to understand the English command names that are
embedded in the menus.

AutoCAD sometimes puts an apostrophe in front of the command
name and any underscore (for example, ‘_ZOOM instead of ZOOM).
The apostrophe indicates a transparent command; you can run the
command in the middle of another command without canceling the
first command. For example, you can start the LINE command, run
the ZOOM command transparently, and then pick up where you
left off with the LINE command.

1 Leave the command line in the default configuration initially. The com-
mand window, like most other parts of the AutoCAD screen, is resizable
and relocateable. The default location (docked at the bottom of the
AutoCAD screen) and size (three lines deep) work well for most people.
Resist the temptation to mess with the command window’s appearance —
at least until you're comfortable with how to use the command line.

v+ Right-click in the command window for options. If you right-click in the
command window, you’ll see a menu with some useful choices, including
Recent Commands — the last six commands that you ran.

v Press the up- and down-arrow keys to cycle through the stack of com-
mands that you’ve used recently. This is another handy way to recall
and rerun a command. Press the left- and right-arrow keys to edit the
command line text that you've typed or recalled.
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Down the main stretch: The drawing area

After all these screen hors d’oeuvres, you're probably getting hungry for the
main course — the AutoCAD drawing area. This is where you do your draw-
ing, of course. In the course of creating drawings, you click points to specify
locations and distances, click objects to select them for editing, and zoom
and pan to get a better view of what you’re working on.

Most of this book shows you how to interact with the drawing area, but you
should know a few things up front.

The Model and Layout tabs (Model and paper space)

One of the initially disorienting things about AutoCAD is that finished draw-
ings can be composed of objects drawn in different spaces, which AutoCAD
indicates with the tabs along the bottom of the drawing area (Model, Layout],
and Layout2 by default).

v Model space is where you create and modify the objects that represent
things in the real world — walls, widgets, waterways, or whatever.

v Paper space is where you create particular views of these objects for
plotting, usually with a title block around them. Paper space comprises
one or more layouts, each of which can contain a different arrangement
of model space views and different title block information.

You can gain a tiny bit more screen space by hiding the model space and
layout tabs. Right-click one of the tabs and choose Hide Layout and Model
tabs. Icons for the model and layout tabs appear on the status bar, replacing
the MODEL button. To restore the default configuration, right-click either of
the status bar icons and choose the Display Layout and Model tabs tooltip.

When you click the Model tab in the drawing area, you see pure, unadulter-
ated model space, as shown in Figure 2-9. When you click one of the paper
space layout tabs (Layoutl or Layout2, unless someone has renamed or
added to them), you see a paper space layout, as shown in Figure 2-10. A
completed layout usually includes one or more viewports, which are windows
that display all or part of model space at a particular scale. A layout also usu-
ally includes a title block or other objects that exist only in the layout and
don’t appear when you click the Model tab. (Think of the viewport as a
window looking into model space and the title block as a frame around the
window.) Thus, a layout displays model space and paper space objects
together, and AutoCAD lets you draw and edit objects in either space. See
Chapter 4 for information about creating paper space layouts and Chapter 13
for the lowdown on plotting them.
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space.
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As we describe in the “Looking for Mr. Status Bar” section in this chapter,
after you've clicked one of the layout tabs, the status bar’s MODEL/PAPER
button moves the crosshairs between model and paper space while remain-
ing in the particular layout. (As shown in Figures 2-9 and 2-10, the orientation
icon at the lower-left corner of the AutoCAD drawing area changes between
an X-Y axis for model space and a drafting triangle for paper space as an addi-
tional reminder of which space the crosshairs currently reside in.) Chapter 4
describes the consequences of changing the MODEL/PAPER setting and
advises you on how to use it.

This back-and-forth with the MODEL/PAPER button or double-clicking is nec-
essary only when you're drawing things while viewing one of the paper space
layouts or adjusting the view of the drawing objects within the viewport. In
practice, you probably won’t draw very much using this method. Instead,
you’ll do most of your drawing on the Model tab and, after you've set up a
paper space layout, click its layout tab only when you want to plot.

Drawing on the drawing area
Here are a few other things to know about the AutoCAD drawing area:

v Efficient, confident use of AutoCAD requires that you continually
glance from the drawing area to the command window (to see those
alliimportant prompts!) and then back up to the drawing area. This
sequence is not a natural reflex for most people, and that’s why the
dynamic input tooltip cursor was introduced. But you still get informa-
tion from the command line that you don’t get anywhere else. Get in the
habit of looking at the command line after each action that you take,
whether picking something on a toolbar, on a menu, or in the drawing
area.

v Clicking at random in the drawing area is not quite as harmless in
AutoCAD as it is in many other Windows programs. When you click
in the AutoCAD drawing area, you're almost always performing some
action — usually specifying a point or selecting objects for editing. Feel
free to experiment, but look at the command line after each click. If you
get confused, press the Esc key a couple of times to clear the current
operation and return to the naked command prompt.

v In most cases, you can right-click in the drawing area to display a menu
with some options for the current situation.

Keeping Tabs on Palettes

Palettes, or modeless dialog boxes as the geekier types prefer to call them,
made their debut in AutoCAD 2004 and were enhanced and expanded in
AutoCAD 2006. There are now more than a dozen palettes (more than a half-
dozen in AutoCAD LT), plus one new super-palette called the Dashboard
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(which is in full AutoCAD only). That one is really set up for 3D, and we
enlighten you in Chapter 9. The more commonly used palettes are

1 Properties and DesignCenter: Used to control object properties and
named objects (layers, blocks, and so on), respectively. Chapter 5 shows
you how.

v Tool Palettes: Resembles a stack of painter’s palettes, except that each
palette holds content (drawing symbols and hatch patterns) and/or com-
mands (not regular AutoCAD commands — what would be the point? —
but macros that make commands do specific things) instead of paints.
Chapters 12 and 14 help you unlock your inner Tool Palette artistry.

v+~ Sheet Set Manager: Provides tools for managing all of a project’s draw-
ings as a sheet set. Chapter 13 gives you some brief theory on why you
might want to use sheet sets and how to do so. (AutoCAD LT does not
support sheet sets.)

v~ External References: Used to attach external files to the current draw-
ing; file types include raster images, Drawing Web Format (DWF) files,
and other drawing files. We discuss attaching external reference files in
Chapter 14.

1 Markup Set Manager: Displays design and drafting review comments
from users of Autodesk DWF Composer. For more information on
markup sets, see the online help.

v+ Info Palette: Autodesk’s version of Mr. Paperclip, the Info Palette pops
up with information about what you’re doing every step of the way.

v QuickCalc: A handy pushbutton scientific calculator. You’ll know if you
need this.

You toggle palettes on and off by clicking their respective buttons near the
right end of the Standard toolbar. Alternatively, several palettes have Ctrl-key
shortcuts. You can toggle these by pressing Ctrl+1 (Properties), Ctrl+2
(DesignCenter), Ctrl+3 (Tool Palettes), Ctrl+4 (Sheet Set Manager), Ctrl+5
(Info Palette), Ctrl+7 (Markup Set Manager), or Ctrl+8 (QuickCalc). Figure 2-11
shows some of these palettes toggled on.

Modeless is just a fancy way of saying that these dialog boxes don’t take over
AutoCAD in the way that modal dialog boxes do. Modal dialog boxes demand
your undivided attention. You enter values, click buttons, or whatever and
then click the OK or Cancel button to close the dialog box. While the modal
dialog box is open, you can’t do anything else in AutoCAD. A modeless dialog
box, on the other hand, can remain open while you execute other commands
that have nothing to do with the dialog box. You return to the modeless
dialog box when or if you need its features.
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Driving Miss AutoCAD

Knowing how to read the command line, as described in the section, “Let
Your Fingers Do the Talking: The Command Window,” is one of the secrets of
becoming a competent AutoCAD user. In reading about and using AutoCAD,
you encounter two additional topics frequently: system variables, which are
AutoCAD’s basic control levers, and dialog boxes, many of which put a friend-
lier face on the system variables.

Under the hood: System variables

System variables are settings that AutoCAD checks before it decides how to
do something. If you set the system variable SAVETIME to 10, AutoCAD auto-
matically saves your drawing file every ten minutes; if you set SAVETIME to
60, the time between saves is one hour. Hundreds of system variables control
AutoCAD’s operations.
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To change the value of a system variable, just type its name at the AutoCAD
command prompt and press Enter. AutoCAD will display the current value
of the system variable setting and prompt you for a new value. Press Enter
alone to keep the existing setting, or type a value and press Enter to change
the setting.

Being able to change system variables by typing their names is a boon to
power users and occasionally a necessity for everybody else. The only prob-
lem is finding or remembering what the names are. In most cases, you’ll be
told what system variable name you need to type — by us in this book or by
the local AutoCAD guru in your office.

To see a listing of all the system variables in AutoCAD and their current set-
tings, use the following steps:
1. Type SETvar and press Enter.

AutoCAD prompts you to type the name of a system variable (if you
want to view or change just one) or a question mark (if you want to see
the names and current settings of more than one).

Enter variable name or [?]
2. Type ? (question mark) and press Enter.
AutoCAD asks which system variables to list:
Enter variable(s) to list <*>:

3. Press Enter to accept the default asterisk (which means “list all system
variables”).

AutoCAD opens a text window and displays the first group of system
variables and their settings:

3DDWFPREC 2.0000

ACADLSPASDOC 0

ACADPREFIX "C:\Documents and..." (read only)
ACADVER "17.0s (LMS Tech)" (read only)
ACISOUTVER 70

AFLAGS 16

ANGBASE 0

ANGDIR 0

APBOX 0

APERTURE 10

AREA 0.0000 (read only)
ATTDIA 0

ATTMODE 1

ATTREQ 1

Press ENTER to continue:
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Not all versions of AutoCAD are going to list the identical system vari-
ables or corresponding values. For example, AutoCAD LT lacks several of
the variables previously listed. Even in the full version of AutoCAD, you
may see a different value for ACADVER if your copy of the program has
had a service release applied.

4. Press Enter repeatedly to scroll through the entire list, or press Esc to
bail out.

AutoCAD returns to the command prompt:

Command :

If you want to find out more about what a particular system variable controls,
see the System Variables section in the Command Reference in the AutoCAD
online help.

The three kinds of system variables are

1 Those saved in the Windows Registry. If you change this kind of system
variable, it affects all drawings when you open them with AutoCAD on
your system.

v Those saved in the drawing. If you change this kind, the change affects
only the current drawing.

v Those that aren’t saved anywhere. If you change this kind, the change
lasts only for the current drawing session.

The System Variables chapter in the online Command Reference tells you
which kind of system variable each one is.

Chrome and gloss: Dialog boxes

Fortunately, you don’t usually have to remember the system variable names.
AutoCAD exposes most of the system variable settings in dialog boxes so that
you can change their values simply by clicking check boxes or typing values
in edit boxes. This approach is a lot more user friendly than remembering an
obscure name like ACADLSPASDOC.

For example, many of the settings on the tabs in the Options dialog box,
shown in Figure 2-12, are in fact system variables. If you use the dialog box
What’s This? help (click the question mark in the Options dialog box’s title
bar and then click an option in the dialog box), the pop-up description not
only describes the setting, but also tells which system variable it corre-
sponds to.

www.it-ebooks.info


http://www.it-ebooks.info/

Figure 2-12:
Options —a
handy way
to change
some
system
variable
settings.
|

Chapter 2: Le Tour de AutoCAD 2007 4 5

% Options
Curment profile: AFD B3 Cument dmwing: Drawing2 dwg
Files | Display | Open and Save | Flot and Publish | System | User Prefecences Crafiing | 30 Maodeling | Selection || Profiles

AutaSnap Settings AutoTrack Settings

[#] Maricer [+] Display polar tracking vector

[#] Magnet Display full-screen tracking vector
[#] Display AutoSnap tooitp Display AutoTrack tooltip

[ Display AutoSnap apenure box

ment Point Acquisition
Controls the display of the AutoSnap aperture box. &4 matic

The aperture box is a box that appears inside the
crosshairs when you snap to an object. (APBOX hift 1o acquire
system variable)

re Size

3 JEIFF J

[ Drafting Tookip Settings... |

Object Snap Optiors

[¥] lgnore hatch objects
E Replace Z value with cument elevation [Llnh‘.s Giyph Settings.. ]
[#] Ignore negative Z object snaps for Dynamic UCS

lCu'r.ems Glyph Settings_ ]

(o J( concs J[ ooy J[ reo ]

Fun with F1

|
Figure 2-13:
Lots of
AutoCAD
help.

The AutoCAD 2007 Help menu, shown in Figure 2-13, offers a slew of online
help options (easily accessed with the F1 key). We describe most of them
here:

i Help F1
% Info Palette
HNew Features Workshop

@ Subscription e-Learning Catalog
¥ Create Support Request
A View Support Requests
48 Edit Subscription Center Profile

Additional Resources r Support Knowledge Base
Online Training Resources
bout =
Abou Online Developer Center [.%

Developer Help
Autodesk User Group International

v Help: The main AutoCAD 2007 online help system, shown in Figure 2-14,
uses the same help engine as the Microsoft Office programs, Internet
Explorer, and other modern Windows applications. As with these other
programs, AutoCAD'’s help is context-sensitive; for example, if you start
the LINE command and just don’t know what to do next, Help will . . . er,
help. Click the Contents tab to browse through the various online refer-
ence manuals, the Index tab to look up commands and concepts, and
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the Search tab to look for specific words. In this book, we sometimes
direct you to the AutoCAD online help system for information about
advanced topics.

v+~ Info Palette: This option opens a Quick Help Info Palette, which is the
Autodesk version of the Microsoft paper clip guy who tries to tell you
what to do in Word or Excel at each step along the way. Like paper clip
guy, Info Palette seems helpful — for 30 seconds. Then you get tired of
the distraction and the wasted screen space.

+” New Features Workshop: This describes the new and enhanced features
in AutoCAD 2007. It’s especially useful for people who are upgrading
from a previous AutoCAD version.

1 Additional Online Resources: Most of the choices in the Online Resources
submenu connect you to various parts of Autodesk’s Web site. The most
useful is Product Support. From the support Web page, you can search the
Autodesk Knowledge Base, download software updates, and get help from
Web- and newsgroup-based discussion groups.

% AutaCAD Pastrio Help |5]=)]=]
= - & & &
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AutoCAD is one program with which you really need to take advantage of
the online help resources. AutoCAD contains many commands, options, and
quirks, and everyone from the greenest beginner to the most seasoned
expert can find out something by using the AutoCAD online help. Take a
moment to peruse the Contents tab of the main help system so that you
know what’s available. Throughout this book, we direct you to pages in the
help system that we think are particularly useful, but don’t be afraid to
explore on your own when you get stuck or feel curious.
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Chapter 3
A Lap Around the CAD Track

In This Chapter

Setting up a simple drawing

Drawing some objects

Zooming and panning in your drawing
Editing some objects

Plotting your drawing

rle previous two chapters introduce you to the AutoCAD world and the
AutoCAD interface. Chapters 4 and 5 present the properties and techniques
that underlie good drafting practice. By now you're probably eager to start
moving the crosshairs around and draw something! This chapter takes you

on a gentle tour of the most common CAD drafting functions: setting up a new
drawing, drawing some objects, editing those objects, zooming and panning

so that you can view those objects better, and plotting (printing) the drawing.

Most of the stuff in this chapter will be mysterious to you. Don’t worry —
we tell you where to look for more information on specific topics. But in this
chapter, you're simply taking AutoCAD out for a test drive to get a taste of
what it can do. Go ahead and kick the tires — and don’t worry about putting
a dent in the fender!

In this chapter, you create a drawing of an architectural detail — a base plate
and column, shown in Figure 3-1. Even if you don’t work in architecture or
building construction, this exercise gives you some simple shapes to work
with and demonstrates commands you can use. And who knows — if the CAD
thing doesn’t work out, at the very least you’ll know how to put your best
footing forward.

Although the drafting example in this chapter is simple, the procedures that
it demonstrates are real, honest-to-CADness, proper drafting practice. We
emphasize from the beginning the importance of proper drawing setup,
putting objects on appropriate layers, and drawing and editing with due con-
cern for precision. Some of the steps in this chapter may seem a bit compli-
cated at first, but they reflect the way that experienced AutoCAD users work.
Our goal is to help you develop good CAD habits and do things the right way
from the very start.

www.it-ebooks.info


http://www.it-ebooks.info/

58

Part I: AutoCAD 101
B AutoCAD 2007 - [My Plate is Base.dwg] R
‘% File Edit View Insert Format Tools Draw Dimension Modify Express Window Help -8 %
DRE AP S «Bes#f-) XXX RERIAER (B || wram o] L[mrirn [v] 3|3
AutoCAD Classiz ]38 & || == |V Q% Tam Hen v]is £ ||| Wy - Blay=r v B
s &
7 2
=5 db
o iy
= =
r +
@ 9]
) 5l
~ @ @ iy
& Iy -
>
5 o
- L1
. L ;
" N s
=Y )] o =..f.
i ]
A !
?
W L]
) [ =}
|
Figure 3-1: L—D *
igure -_ * WAk WY Mocel {Tayout /| Leyouiz |
Howbaseis [Tm——————————————————
[All/Center/Dynamic/Extenca/Frevious/Scale/Window/Cbject] <real time>: ,5x
my plate. | ||ccmmana: A
e |57 31575, 000 sHP] GRID! 0ATHO|[FoLAR, DSHAR|[OTRACK [BUCS [ [LWT [MODEL. Edis -0
P The step-by-step procedures in this chapter, unlike those in most chapters of
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NNG/ If you find that object selection or editing functions work differently from

‘@

how we describe them in this chapter, you or someone else probably
changed the configuration settings on the Option dialog box’s Selection tab.
Chapter 7 describes these settings and how to restore the AutoCAD defaults.

A Simple Setup

¢MBER
S

During the remainder of this chapter, we walk you through creating, editing,
viewing, and plotting a new drawing — refer to Figure 3-1 if you want to get an
idea of what the finished product looks like.

As Chapter 2 advises, make sure that you pay attention to AutoCAD’s feed-
back. Glance at the dynamic input tooltip and especially the command line
area after each step so that you see the messages that AutoCAD is sending
your way and you begin to get familiar with the names of commands and
their options. (If you don’t see any messages next to the crosshairs, click the
DYN button on the status bar.)
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In this first set of steps, you create a new drawing from a template, change some
settings to establish a 1:10 (1 to 10) scale, and save the drawing. As we describe
in Chapter 4, drawing setup is not a simple task in AutoCAD. Nonetheless, draw-
ing setup is an important part of the job, and if you don’t get in the habit of
doing it right, you run into endless problems later on — especially when you try
to plot. (See Chapter 13 for the low-down on plotting your drawings.)

1.

Start AutoCAD by double-clicking its shortcut on the Windows desktop.

If you don’t have an AutoCAD shortcut on your desktop, choose Start
All Programs (Programs in Windows 2000)=>Autodeske>AutoCAD 2007
AutoCAD 2007 (the last two will be AutoCAD LT 2007, if that’s your
version).

The Workspaces dialog box appears. Choose here whether you want to
work in 2D (“AutoCAD Classic”) or 3D (“3D Modeling”). You won’t see
this dialog box if you're running AutoCAD LT, so proceed to Step 3. If you
don’t see this dialog box in regular AutoCAD, see the “And They’re Off:
AutoCAD’s Opening Screen” section in Chapter 2 for instructions on
turning it back on.

. In the left panel of the Workspaces dialog box, choose AutoCAD

Classic, and then click OK.

The main AutoCAD screen appears with a new, blank drawing in it.

. If any palettes such as the Tool Palettes, Sheet Set Manager, or Info

Palette appear, close them.

. Choose File=>New.

The Select Template dialog box appears with a list of drawing templates
(DWT files), which you can use as the starting point for new drawings.
Chapter 4 describes how to create and use drawing templates.

. Select the acad.dwt template, as shown in Figure 3-2, and click the

Open button. (For AutoCAD LT, select acadlt.dwt.)

AutoCAD creates a new, blank drawing with the settings in acad. dwt.
acad.dwt is AutoCAD’s default, plain Jane, drawing template for draw-
ings in imperial units (that is, units expressed in inches and/or feet).
acadiso.dwt (acadltiso.dwt in AutoCAD LT) is the corresponding
drawing template for drawings created in metric units. Chapter 4 con-
tains additional information about these and other templates.

. Choose Format=>Drawing Limits.

Drawing limits define your working area. AutoCAD prompts you to reset
the Model space limits. The command line reads:

Specify lower left corner or [ON/OFF] <0.0000,0.0000>:

. Press Enter to keep 0,0 as the lower-left corner value.

AutoCAD prompts for the upper-right corner. The command line reads:

Specify upper right corner <12.0000,9.0000>:
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8. Type 100,75 (no spaces) and press Enter.

10.

11.

The values you enter appear in the dynamic input tooltip and the com-
mand line.

100 x 75 corresponds to 10 inches by 7.5 inches (a little smaller than an
8.5-x-11-inch piece of paper turned on its long side) times a drawing
scale factor of 10 (because you're eventually going to plot at 1:10 scale).
See Chapter 4 for more information about drawing scales.

. Right-click the SNAP button on the AutoCAD status bar and choose

Settings.

The Snap and Grid tab of the Drafting Settings dialog box appears, as
shown in Figure 3-3. (In AutoCAD LT, the dialog box might look slightly
different.)

Change the values in the dialog box, as shown in Figure 3-3: Snap On
checked, Grid On checked, Snap X Spacing and Snap Y Spacing set to
0.5, and Grid X Spacing and Grid Y Spacing set to 5.

(When Equal X and Y Spacing is checked, changing the X spacing value
causes the Y spacing to automatically update to the same number,
thereby saving you typing.)

Snap constrains your crosshairs to moving in an invisible grid of equally
spaced points (0.5 units apart in this case). Grid displays a visible grid of

little dots on the screen (5 units apart in this case), which you can use
as reference points. The grid doesn’t appear on printed drawings.

Click OK.

You see some grid dots, 5 units apart, in the drawing area. If you move
your mouse around and watch the coordinate display area on the status
bar, you notice that it moves in 0.5-unit increments.
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12. Choose View=>Zoom=>All

AutoCAD zooms out so that the entire area defined by the limits — as
indicated by the grid dots — is visible.

13. Click the Save button on the Standard toolbar or press Ctrl+S.

Because you haven’t saved the drawing yet, AutoCAD opens the Save
Drawing As dialog box.

14. Navigate to a suitable folder by choosing from the Save In drop-down

list and/or double-clicking folders in the list of folders below it.

Remember where you save the file so you can go back to it later.

15. Type a name in the File Name edit box.

For example, type Detail or My Plate is Base.

Depending on your Windows Explorer settings, you may or may not see
the . dwg extension in the File Name edit box. In any case, you don’t
need to type it. AutoCAD adds it for you.

16. Click the Save button.

AutoCAD saves the new DWG file to the folder that you specify.

Whew — that was more work than digging a post hole — and all just to set up
a simple drawing! Chapter 4 goes into more detail about drawing setup and
describes why all these gyrations are necessary.
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Drawing a (Base) Plate

<MBER
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With a properly set up drawing, you’re ready to draw some objects. In this
example, you use the RECTANG (REC) command to draw a steel base plate
and column, the CIRCLE (C) command to draw an anchor bolt, and the POLY-
GON (POL) command to draw a hexagonal nut. (Both the RECTANG and
POLYGON commands create polylines — objects that contain a series of
straight-line segments and/or arc segments.)

AutoCAD, like most CAD programs, uses layers as an organizing principle for
all the objects that you draw. Chapter 5 describes layers and other object
properties in detail. In this example, you create separate layers for the base
plate, the column, and the anchor bolts, which may seem like layer madness.
But when doing complex drawings, you need to use a lot of layers in order to
keep things organized.

Rectangles on the right layers

The following steps demonstrate how to create and use layers, as well as how
to draw rectangles. You also see how to apply fillets to objects and offset
them. (Chapter 5 describes layers in detail, and Chapter 6 covers the REC-
TANG command. Chapter 7 explains the FILLET (F) and OFFSET (O) com-
mands.) Start by creating a Column layer and a Plate layer, and then drawing
a column on the Column layer and drawing a square base plate on the Plate
layer by following these steps:

1. Make sure that you complete the drawing setup in the previous sec-
tion of this chapter and have the drawing open in AutoCAD.
2. Click the Layer Properties Manager button on the Layers toolbar.

The LAYER (LA) command starts and AutoCAD displays the Layer
Properties Manager dialog box as shown in Figure 3-4.

3. Click the New Layer button.

AutoCAD adds a new layer to the list and gives it the default name
Layerl.

4. Type a more suitable name for the layer on which you’ll draw the
column and press Enter.

In this example, type Column.
5. Click the color swatch or name (white) in the Column layer row.

The Select Color dialog box appears.
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6.

10.

11.

Click color 5 (blue) in the single, separate row to the left of the
ByLayer and ByBlock buttons and click OK.

The Standard Colors dialog box closes, and AutoCAD changes the color
of the Column layer to blue.

. Repeat Steps 3 through 6 to create a new layer named Plate, and set

its color to 4 (cyan).

. With layer Plate still highlighted, click the Set Current button (the

green check mark).

Plate becomes the current layer — that is, the layer on which AutoCAD
places objects that you draw from this point forward.

. Click OK to close the Layer Properties Manager dialog box.

The Layer drop-down list on the Layers toolbar displays Plate as the cur-
rent layer.

Now you can draw a rectangular plate on the Plate layer.
Click the Rectangle button on the Draw toolbar.

The RECTANG command starts, and AutoCAD prompts you to specify
the first corner point. The command line shows:

Specify first corner point or
[Chamfer/Elevation/Fillet/Thickness/Width] :

Click in the drawing area at the point 20,20.

By watching the coordinate display on the dynamic input tooltip, you
can see the coordinates of the current crosshairs location. Because snap
is set to 0.5 units, you can land right on the point 20,20. Picking the point
20,20 gives you enough room to work.
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12.

13.

14.

15.

16.

17.

18.

AutoCAD prompts you to specify the other corner point. The down-
arrow icon in the dynamic input tooltip indicates this command has
options you can set, and they appear at the command line:

Specify other corner point or
[Area/Dimensions/Rotation] :

Type @36,36 (without any spaces) and press Enter.

The @ sign indicates that you're using a relative coordinate — that is, 36
units to the right and 36 units above the point that you picked in the pre-
vious step. See Chapter 5 for more information about typing absolute
and relative coordinates.

AutoCAD draws the 36 x 36 rectangle, as shown in Figure 3-5. It’s on the
Plate layer and inherits that layer’s cyan color.

You draw the column next, but first you have to change layers.

Click the Layer drop-down list on the Layers toolbar to display the list
of layers. Click Column to set it as the current layer.

Using the Layer drop-down list saves your having to open the dialog
box, select the layer, click the Set Current button, and click OK.
Becoming an AutoCAD master is all about efficiency!

Press Enter to repeat the RECTANG command.
You can repeat the last command at any time by pressing Enter.
In the next steps, you create a hollow steel column.

At the Specify first corner point prompt, type 32,29 and press
Enter.

At the Specify other corner point prompt, type @12,18 and press
Enter.

A second rectangle is drawn in the middle of the base plate. Next, you
round the corners of the column with the FILLET command and then use
OFFSET to give it some thickness.

Click the Fillet button on the Modify toolbar.

The FILLET command starts, and AutoCAD prompts you to select the
first object. The dynamic input tooltip down-arrow icon is a reminder to
look at the command line to see the options for this command. Apply a
2-inch radius fillet to all four corners as follows.

Type R and press Enter to set a new fillet radius. Type 2 and press
Enter.

AutoCAD next prompts you to select the first object. You could pick each
of the eight lines that need to be filleted, but because the column is a con-
tinuous polyline, a more efficient method, in this case, is to use the FILLET
command’s Polyline option to fillet both ends of all four segments.
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19. Type P to choose the Polyline option.
AutoCAD prompts you to select a 2D polyline.

20. Select the last rectangle.
All four corners of the column are rounded with a 2-inch radius fillet.
Next, offset the polyline to create a %-inch thick steel column.

21. Click the Offset button on the Modify toolbar.

22. At the Specify offset distance prompt, type .75 and press Enter.

23. At the select object to offset prompt, click the rounded rectan-
gle. At the Specify point on side to offset prompt, click any-
where inside the rounded rectangle. Press Enter to complete the
command.

AutoCAD offsets the selected object toward the side where you picked.
24. Press Ctrl+S to save the drawing.

AutoCAD saves the drawing and renames the previously saved version
drawingname.bak — for example, M\y Plate is Base.bak. .bakis
AutoCAD’s extension for a backup file; Chapter 16 describes BAK files
and how to use them.
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Circling your plate

You can use the CIRCLE command to draw a 1%-inch diameter anchor bolt on
an Anchor Bolts layer by following these steps:

1. Repeat Steps 2 through 6 in the previous section to create a new layer

for the anchor bolts. Give the layer the name Anchor Bolts, assign it
the color 3 (green), and set it current.

The Layer drop-down list on the Layers toolbar displays Anchor Bolts as
the current layer.

. Click the Circle button on the Draw toolbar.

The CIRCLE command starts, and AutoCAD prompts you to specify the
center point. The command line shows:

Specify center point for circle or [3P/2P/Ttr (tan tan
radius) ] :

. Click in the drawing area at point 26,26.

AutoCAD asks you to specify the size of the circle. The command line
shows:

Specify radius of circle or [Diameter]:

You decide that you want 1)4-inch diameter anchor bolts. AutoCAD is
asking for a radius. Although you probably can figure out the radius of a
1%-inch circle, specify the Diameter option and let AutoCAD do the hard
work.

The down-arrow icon on the dynamic input tooltip is a reminder to look
at the command line to see what options are available.

. Type D and press Enter to select the Diameter option.

AutoCAD prompts you at the command line:

Specify diameter of circle:

. Type 1.5 and press Enter.

AutoCAD draws the 1%-inch diameter circle. It’s on the Anchor Bolts
layer and inherits that layer’s green color.

6. Press Ctrl+S to save the drawing.

Place your polygon

Every good bolt deserves a nut. Use the POLYGON command to draw a
hexagonal shape on a Nuts layer (well, what else would you call it?). Besides
showing you how to draw polygons, these steps introduce you to a couple of
AutoCAD’s more useful precision techniques: object snaps and ortho.
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1. Repeat Steps 2 through 6 in the “Rectangles on the right layers” sec-

tion’s steps to create a new layer for the nuts and set it current. Give
the layer the name Nuts and assign it the color 1 (red).

The Layer drop-down list on the Layers toolbar displays Nuts as the cur-
rent layer.

You don’t have to create a separate layer for every type of object that
you draw. For example, you can draw both the anchor bolts and nuts on
a layer called Hardware. Layer names and usage depend on industry and
office practices in addition to a certain amount of individual judgment. If
you end up with too many layers, however, lumping two layers together
is much easier than dividing the objects on one layer into two layers if
you end up with too few.

. Click the Polygon button — the one that looks like a plan of the

Pentagon — on the Draw toolbar.
The POLYGON command starts and AutoCAD prompts:
Enter number of sides <4>:

Peek ahead to Figure 3-6 in order to get an idea of how the nut will look
after you draw it. Four-sided nuts can be a little difficult to adjust in the
real world, so we'll stick with the conventional hexagonal sort.

. Type 6 and press Enter.

AutoCAD next prompts you for the center of the polygon:
Specify center of polygon or [Edge]:

As you move the crosshairs around near the anchor bolt, notice that
AutoCAD tends to grab certain points briefly, especially on existing
objects. This behavior is the result of running object snaps and tracking,
which we discuss in Chapter 5. (If AutoCAD does not seem grabby, click
the OSNAP button on the status bar until the command line shows
<Osnap on>.)

. Move the crosshairs close to the anchor bolt you just drew.

A tooltip should show Center and pull the crosshairs to the center of the
anchor bolt circle. You may also see tracking vectors across the screen
from this point — you can ignore those.

. Click when the tooltip reads Center — not Center-Intersection or

something similar — just Center.

The POLYGON command draws regular closed polygons based on an
imaginary circle; the center of this circle is the point you just picked.

AutoCAD prompts:

Enter an option [Inscribed in circle/Circumscribed
about circle] <I>:
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|
Figure 3-6:
Bolts and
nuts...
ready to
anchor.
|

6. Press Enter to accept the default Inscribed In Circle option.

The Inscribed option draws a polygon whose corners touch the circum-
ference of the imaginary circle. (The Circumscribed option draws a poly-
gon whose sides are tangent to the circumference of the circle.)

Specify radius of circle:

7. Turn on ortho mode by clicking the ORTHO button on the status bar
until it looks popped in and you see <Ortho on> on the command line.

Drag the mouse to the right so the top and bottom sides of the polygon
are horizontal, but don’t click yet.

8. Type 1.5 and press Enter.

AutoCAD draws the nut, as shown in Figure 3-6. It’s on the Nuts layer and
inherits that layer’s red color.

Occasionally, ortho and running object snaps interfere with drafting in
AutoCAD. You can disable both features by clicking their status bar
buttons.

9. Turn off ortho mode and running object snaps by clicking the ORTHO
and OSNAP buttons on the status bar until they look popped out and
you see <Ortho off> and <Osnap off> on the command line.

10. Press Ctrl+S to save the drawing.
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Not much of a base plate yet, is it? But don’t worry — we cover creating more
nuts and bolts with editing commands later in this chapter. If your brain is
feeling full, now is a good time to take a break and go look out the window. If
you exit AutoCAD, just restart the program and reopen your drawing when
you’re ready to continue.

Get a Closer Look with Zoom and Pan

The example drawing in this chapter is pretty uncluttered and small, but
most real CAD drawings are neither. Technical drawings usually are jam-
packed with lines, text, and dimensions. CAD drawings often get plotted on
sheets of paper that measure two to three feet on a side — that’s in the hun-
dreds of millimeters, for you metric mavens. Anyone who owns a monitor that
large probably can afford to hire a whole room of drafters and, therefore, isn’t
reading this book. The rest of us need to zoom and pan in our drawings — a
lot. We cover zooming and panning in detail in Chapter 8. Quick definitions
should suffice for now. Zoom means changing the magnification of the dis-
play. When you zoom in, you move closer to the drawing objects so you can
see detail, and when you zoom out, you move farther away so you can see
more of the drawing area. Pan means moving from one area to another with-
out changing the magnification. If you’'ve used the scroll bars in any applica-
tion, you've panned the display.

Zooming and panning frequently enables you to see the details better, draw
more confidently (because you can see what you're doing), and edit more
quickly (because object selection is easier when a zillion objects aren’t on
the screen).

Fortunately, zooming and panning in AutoCAD is as simple as it is necessary.
The following steps describe how to use AutoCAD’s Zoom and Pan Realtime
feature, which is pretty easy to operate and provides a lot of flexibility.
Chapter 8 covers additional zoom and pan options.

To zoom and pan in your drawing, follow these steps:
1. Click the Zoom Realtime button (the one that looks like a magnifying

glass with a plus/minus sign next to it) on the Standard toolbar.

The Realtime option of the ZOOM (Z) command starts. The crosshairs
change to a magnifying glass and AutoCAD prompts you at the command
line:

Press ESC or ENTER to exit, or right-click to display
shortcut menu.
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|
Figure 3-7:
The
Zoom/Pan
Realtime
shortcut
menu.
|

2. Move the crosshairs near the middle of the screen, press and hold the
left mouse button, and drag the crosshairs up and down until the plate
almost fills the screen.

As you can see, dragging up increases the zoom magnification and drag-
ging down decreases it.

3. Right-click in the drawing area to display the Zoom/Pan Realtime
menu, shown in Figure 3-7, and choose Pan from the menu.

The crosshairs change to a hand.

4. Click and drag to pan the drawing until the plate is more or less cen-
tered in the drawing area.

You can use the right-click menu to toggle back and forth between Zoom
and Pan as many times as you like. If you get lost, choose Zoom Original
or Zoom Extents in order to return to a recognizable view.

5. Right-click in the drawing area and choose Exit from the Zoom/Pan
Realtime menu.

The hand cursor returns to the normal AutoCAD crosshairs.

B AutoCAD 2007 - [My Plate is Base.dwg] R
‘% File Edit View Insert Format Teools Draw Dimension Modify Express Window Help -8 %
DEHSADE «DO 27 LR nEhSNE @ |4 vk #
EW||= VO% e £ ||m B — —_—
& &
- B
= dh
o L]
= 88
i 3
@ O
8 a
r [y
o =
2
w2l ]
- L1
i Exit =
B i
4 Pan I .
= ¥ Ipom " e
= 30 Orbit
A Zoam Window ®
. . @ . . ) ) ) Zoom Original "
v Loom Extents L]
’ [ =
I—GA kS
WAk H Y Mokl i !
Fresa ESC or ENTER ©o exit, or right-click to display shortouc menu. =
< ¥
Praze pick button and drag vedically 1o zoom

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 3: A Lap Around the CAD Track 6 ’

Modify to Make It Merrier

When you have a better view of your base plate, you can edit the objects on
it more easily. In the following sections, you use the ARRAY (AR) command to
add more anchor bolts, the STRETCH (S) command to change the shape of
the plate, and the HATCH (H) command to add crosshatching to the column.

\NG/
V?\“

A\\S

Hooray for array

Using the ARRAY command is a great way to generate a bunch of new objects
at regular spacings from existing objects. The array pattern can be either rec-
tangular (that is, columns and rows of objects) or polar (in a circle around a
center point, like the spokes of a wheel around its hub). In this example, you
use a rectangular array to create three additional anchor bolts:

1.

Click the Array button — the one with four squares — on the Modify
toolbar.

The ARRAY command starts and AutoCAD displays the Array dialog box.

2. Click the Rectangular Array button.

. Click the Select Objects button.

The standard AutoCAD object selection and editing sequence — start a
command and then select objects — may seem backward to you until
you get used to it. See Chapter 7 for more information.

The Array dialog box temporarily disappears, and AutoCAD prompts
you to select objects.

. Turn off Snap mode by clicking the SNAP button on the status bar until

it looks popped out and you see <Snap off> on the command line.

Turning off Snap mode temporarily makes selecting objects easier.

. Click the anchor bolt and then click the nut.

If you encounter any problems while trying to select objects, press the
Esc key a couple of times to cancel the command and then restart the
ARRAY command. Chapter 7 describes AutoCAD object selection
techniques.

AutoCAD continues to prompt you at the command line:

Select objects: 1 found, 2 total

. Press Enter to end object selection.

The Array dialog box reappears.
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|
Figure 3-8:
The Array
dialog box,
ready to bolt
your base
plate.
|

7. Click inside the Rows text box and set the value to 2. Press Tab to
move to the Columns Text box and set the value to 2.

The source object is counted in AutoCAD arrays. The preview shows
you've set up a rectangular array of four evenly spaced objects (see
Figure 3-8).

WY Array [B]%]
(3 Rectangular Aray O Polar Amay Select objects
2 objects selected

Rows 2 Cglumns: 2z

Offset distance and direction
Fow offset: 24.0000 = ==
Column offset: 24.0000 :| @]
Angle of amay: o E

(1) By defauh, if the row offset is negative,
S rows are added downward. I the
column offset is negative. columns are
O addedtothe left

8. In the Row Offset text box, type 24. Click inside the Column Offset
text box and type 24.

9. Click the Preview button.

AutoCAD shows you what the array will look like if you accept the cur-
rent settings and displays a small dialog box with Accept, Modify, and
Cancel buttons.

10. If anything looks wrong, click the Modify button, make changes, and
preview again. When everything looks right, click the Accept button.

AutoCAD adds the additional objects to the drawing, as shown in
Figure 3-9.

11. Press Ctrl+S to save the drawing.

Perfect! Except that nutbar engineer has decided the column needs to be 18 x
18 inches instead of 12 x 18 inches. And that means the base plate is too
small, and the anchor bolts are in the wrong place, too. If you were working
on the drawing board, you’d be getting out an eraser and rubbing out all your
efforts. AutoCAD to the rescue!
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|
Figure 3-9:
Buttoned-
down base
plate.
|
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Stretch out

The STRETCH command is powerful but a little bit complicated — it can
stretch or move objects, depending on how you select them. The key to using
Stretch is specifying a crossing selection box properly. (Chapter 7 gives you
more details about crossing boxes and how to use them with the STRETCH
command.)

Follow these steps to stretch the column and base plate:
1. Click the Stretch button — the one with the corner of the rectangle

being stretched — on the Modify toolbar.

The STRETCH command starts and AutoCAD prompts you to select
objects. This is one of those times (and one of those commands) that
really does require you to look at the command line:

Select objects to stretch by crossing-window or
crossing-polygon. ..
Select objects:
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Figure 3-10:
Specifying a
crossing

box for the
STRETCH
command.
|

2. Click a point above and to the right of the upper-right corner of the
plate (Point 1 in Figure 3-10).

3. Move the crosshairs to the left.

The pointer changes to a dashed rectangle enclosing a rectangular green
area, which indicates that you're specifying a crossing box. AutoCAD
prompts you at the command line:

Select objects: Specify opposite corner:

4. Click a point below the plate, roughly through the center of the
column (Point 2 in Figure 3-10).

The crossing box must cut through the plate and column in order for the
STRETCH command to work (refer to Figure 3-10).

AutoCAD prompts you at the command line:

Select objects: Specify opposite corner: 7 found
Select objects:

5. Press Enter to end object selection.

AutoCAD prompts you to specify the base point.

Point 2 Point 1
2 AutaCAD 2007 - [My Plate is Base.dw] ===
"% File Edit View Insert Format [ools Draw Dimension Modify Express Window Help -8 %
loeR aRe s «Be 45 txeq nEhInm @ls " =
R AES Ie L] &£ || m +— —_—
s a#
2 (e Q
= db
o ]
= 88
o +
@ © © °
= a
~ (B
& s
2
w2l ]
- LI
. -
B i
" f
=2
A © © =
®
W =
"
I—D A
M o4k H \"'tddiLEﬂJ’_‘.{ gau‘?f‘
Select cbiecta to scretch by crossing-window or Croasing-polygon... =]
Select chiecta: Specify cppoalie corner: £ »
32 1376, 16,3337, 0.0000 sHaP| GRID! [orTHa PoLsR|[osae oTRaCH [oucs [oen [owT [Mope: ' d* . [0

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 3: A Lap Around the CAD Track

\\J

|
Figure 3-11:
Stretching
the base
plate.
|

6. Turn on Snap mode, ortho mode, and running object snap mode by
clicking the SNAP, ORTHO, and OSNAP buttons on the status bar until
they appear pushed in.

7. Click the lower-right corner of the plate.

This point serves as the base point for the stretch operation. Chapter 7
describes base points and displacements in greater detail.

AutoCAD prompts you at the command line:

Specify second point or <use first point as
displacement>:

8. Move the crosshairs to the right until the dynamic input tooltip shows
a displacement of 6 units to the right and then click in the drawing
space (see Figure 3-11).

AutoCAD stretches the column and plate by the distance that you indi-
cate and moves the anchor bolts that were completely inside the cross-
ing window rectangle, as shown in Figure 3-11.

If your first stretch didn’t work right, click the Undo button on the
Standard toolbar and try again. Stretch is an immensely useful
command — one that makes you wonder how drafters used to do it

all with erasers and pencils — but it does take some practice to get the
hang of those crossing boxes.

9. Press Ctrl+S to save the drawing.

B AutoCAD 2007 - [My Plate is Base.dwg] R
‘% File Edit View Insert Format Teools Draw Dimension Modify Express Window Help -8 %
DEHSADE «DO 27 U REhEuE @ | & vk #
EW||= VO% e £ ||m B — —_—
& &
s~ B
= dh
o o
= 88
i 3
o ® ® 5
2 ] ) 5
~ e i
=] i 5=
=Y ] m|
@ ; 0
- i -
B ] #
" ] i
@ i Nl g
@ a A/
: @ ® -
o L]
4 i r
[ oo 5.0000 < o
I—D A
WAk H Y Mol flayout] {layout2 §
Specify base point or [Ddaplacement] <Diaplacement»: <3nap on»
Specify second point or <use firat point as displacement>: < >
620000, 20,0000, 0.0000 [srar GRID! [orTHe POLAR|[osnae OTRaCK [oucs [ovw [LwT [wope f g - O

www.it-ebooks.info


http://www.it-ebooks.info/

66 Part I: AutoCAD 101

Cross your hatches

Your final editing task is to add some crosshatching to the space between the
inside and outside edges of the column to indicate that the drawing shows a
section of the column. To do so, follow these steps:

1.

Turn off Snap and running object snaps by clicking the SNAP and
OSNAP buttons on the status bar until they look popped out.

. Repeat Steps 2 through 6 from the “Rectangles on the right layer” sec-

tion to create a new layer named Hatch. Set its color to 2 (yellow), and
make it the current layer.

. Click the Hatch button — the one that shows a diagonal line pattern

inside four lines — on the Draw toolbar.

The Hatch And Gradient dialog box appears. (If you're using AutoCAD
LT, you’ll notice that the box is called, simply, Hatch.)

. In the Hatch tab’s Hatch And Pattern area, click the Pattern drop-

down list and select ANSI31.

The ANSI31 pattern fills the selected area with an arrangement of paral-
lel angled lines. In the right side of the dialog box, click Add: Pick Points.
The dialog box temporarily closes.

. Atthe Pick internal point prompt, pick a point between the

inside and outside edges of the column. Zoom in if you need to get
closer.

AutoCAD selects the two filleted polylines.

. Press Enter to end object selection.

The Hatch And Gradient dialog box reappears. To check if the hatch
parameters are correct, click the Preview button.

Looks like the hatch pattern is too fine.

7. Press Esc to return to the Hatch And Gradient dialog box.

8. In the Scale box, set the value to 5. Click Preview again. If it looks

10.

okay, right-click to accept the hatch pattern.

Your finished column and base plate should look like Figure 3-12.

. Choose View>Zoom=>All.

AutoCAD zooms out so that the entire area defined by the limits is visible.

Press Ctrl+S to save the drawing.
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Figure 3-12:
Our column
is hatched.

\\3

B AutoCAD 2007 - [My Plate is Base.dwig) =%
‘% File Edit View Insert Format Tools Draw Dimension Modify Express Window Help -8 %
DEH & A8 <D0~ - XY HREHRIRAE @ || L e v [t [v] | e

Aol AD Claasiz (]38 % || =0 O% om e v ||| ey [l e
s #
7~ K]
=5 db
o iy
= 28
' +
@ © @ o
2 e N
o~ a
® i
]
8l ! o (|
@ 1 1
. i .
::4 i 4
a | v
B h z o
i ]

; © ® .

-
5 | =
= X
WAk [ W Moced {Tayoutd J Leyoutz |

Fick cr preas Eac To return to dialog or <Right-click to acceRt hatoha: :

Command: £ >
73,8162, 35,3421, 0,0000 shaF| GRID| [orTHo POLAR] DsHAF OTRACK [oucs [ovn [uwT [wone: ' d* . [0

After some drawing and editing, you may wonder how you’re supposed to
know when to turn off or on the various status bar modes (Snap, Grid, ortho,
Osnap, and so on). You will start to get an instinctive sense of when each
mode is useful and when it gets in the way. In subsequent chapters of this
book, we give you some more specific guidelines.

Follow the Plot

Looking at drawings on a computer screen and exchanging them with others
via e-mail or Web sites is all well and good. But sooner or later, someone —
maybe you! — will want to see a printed version. Printing drawings — or plot-
ting, as CAD geeks like to call it — is much more complicated than printing a
word processing document or a spreadsheet. That’s because you have to
worry about things such as drawing scale, lineweights, title blocks, and weird
paper sizes. We get into plotting in Chapter 13, but here’s an abbreviated pro-
cedure that helps you generate a recognizable printed drawing.
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Vgs\“‘"i’ The following steps show you how to plot the model space portion of the
8 drawing. As Chapter 4 describes, AutoCAD includes a sophisticated feature

called paper space layouts for creating arrangements of your drawing that you
plot. These arrangements usually include a title block. Because we promised
you a gentle tour of AutoCAD drafting functions, we left the paper space
layout and title block issues for the next chapter. When you're ready for the
whole plotting enchilada, turn to Chapter 4 for information about how to set
up paper space layouts and Chapter 13 for full plotting instructions.

Follow these steps to plot a drawing:

1. Click the Plot button on the Standard toolbar.
AutoCAD opens the Plot dialog box.

2. Click the More Options button (at the bottom-right corner of the
dialog box, next to the Help button).

The Plot dialog box reveals additional settings, as shown in Figure 3-13.
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Mame: <Hang > » Ad... manachrome. o - Z)
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|
Paper size
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i what to plot: At —
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3. In the Printer/Plotter area, select a printer from the Name list.

4. In the Paper Size area, select a paper size that’s loaded in your printer
or plotter.

Anything Letter size (8% x 11 inches) or larger works for this example.
5. In the Plot Area, choose Limits.

This is the entire drawing area, which you specified when you set up the
drawing earlier in this chapter.

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 3: A Lap Around the CAD Track 69

\\3

10.

11.
12.

13.

. In the Plot Offset area, choose Center The Plot.

Alternatively, you can specify offsets of 0 or other amounts in order to
position the plot at a specific location on the paper.

. In the Plot Scale area, deselect the Fit To Paper check box and choose

1:10 from the Scale drop-down list.

1:10 is the scale used to set up the drawing (in the earlier section, “A
Simple Setup”).

. In the Plot Style Table area, click the Name drop-down list and choose

monochrome. cthb.

The monochrome. ctb plot style table ensures that all your lines appear
solid black, rather than as weird shades of gray. See Chapter 13 for infor-
mation about plot style tables and monochrome and color plotting.

. Click Yes when a question dialog box appears, asking, “Assign this

plotstyle table to all layouts?”

You can leave the remaining settings at their default values (refer to
Figure 3-13).

Some printers let you print closer to the edges of the sheet than others.
To find out the actual printable area of your own printer, move the
mouse pointer to the postage stamp-sized partial preview in the middle
of the Plot dialog box and pause. A tooltip appears listing the Paper Size
and Printable Area for the printer and paper size that you selected.

Click the Preview button.

The Plot dialog box disappears temporarily and AutoCAD shows how
the plot will look on paper. In addition, AutoCAD prompts you on the
status bar:

Press pick button and drag vertically to zoom, ESC or
ENTER to exit, or right-click to display
shortcut menu.

Right-click in the preview area and choose Exit.

If the preview doesn’t look right, adjust the settings in the Plot dialog
box and look at the preview again until it looks right.

Click OK.

The Plot dialog box closes. AutoCAD generates the plot and sends it
to the printer. After generating the plot, AutoCAD displays a Plot and
Publish Job Complete balloon notification from the right end of the
status bar. (A Click to View Plot and Publish Details link displays more
information about the plot job.)
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14.

15.

Click the X (close) button in the Plot and Publish Job Complete bal-
loon notification.

The balloon notification disappears.

If you're not happy with the lineweights of the lines on your plot at this
point, fear not. You can use the lineweights feature (Chapter 5) or plot
styles (Chapter 13) to control plotted lineweights.

Press Ctrl+S to save the drawing.

When you make changes to the plot settings, AutoCAD saves them with
the tab of the drawing that you plotted (the Model tab or one of the
paper space layout tabs). Save the drawing after you plot if you want the
modified plot settings to become the default plot settings the next time
you open the drawing.

Congratulations! You successfully executed your first plot in AutoCAD.
Chapter 13 tells you more — much more — about AutoCAD'’s highly flexible
but occasionally perplexing plotting system.
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Developing a setup strategy

Starting a new drawing

Setting up model space

Setting up paper space layouts

Creating and using drawing templates
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51rprisingly, drawing setup is one of the trickier aspects of using AutoCAD.
It’s an easy thing to do incompletely or incorrectly, and AutoCAD 2007
doesn’t provide a dialog box or other simple, all-in-one-fell-swoop tool to help
you do all of it right. And yet, drawing setup is a crucial thing to get right. Setup
steps that you omit or don’t do right will come back to bite you — or at least
gnaw on your leg — later.

Sloppy setup really becomes apparent when you try to plot (print) your
drawing. Things that seemed more or less okay as you zoomed around on the
screen suddenly are completely the wrong size or scale on paper. And noth-
ing brands someone as a naive AutoCAD wannabe as quickly as the inability
to plot a drawing at the right size and scale. Chapter 13 covers plotting proce-
dures, but the information in this chapter is a necessary prerequisite to suc-
cessful plotting. If you don’t get this stuff right, there’s a good chance you’ll
find that . . . the plot sickens.

This chapter describes the decisions you need to make before you set up a
new drawing, shows the steps for doing a complete and correct setup, and
demonstrates how to save setup settings for reuse.

Don’t assume that you can just create a new blank DWG file and start drawing
things. Do read this chapter before you get too deep into the later chapters
in this book. Many AutoCAD drawing commands and concepts depend on
proper drawing setup, so you'll have a much easier time of drawing and edit-
ing things if you’ve done your setup homework. A few minutes invested in
setting up a drawing well can save hours of thrashing around later on.
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After you've digested the detailed drawing setup procedures described in
this chapter, use the Drawing Setup Roadmap on the Cheat Sheet at the front
of this book as a quick reference to guide you through the process.

A Setup Roadmap

You need to set up AutoCAD correctly, partly because AutoCAD is so flexible
and partly because, well, you're doing CAD — computer-aided drafting (or
design). The computer can’t aid your drafting (or design) if you don’t clue it
in on things like system of measure, drawing scale, paper size, and units. In
this context, the following reasons help explain why AutoCAD drawing setup
is important:

v Electronic paper: The most important thing you can do to make using
AutoCAD fun is to work on a correctly set up drawing so that your
screen acts like paper, only smarter. When drawing on real paper, you
constantly have to translate between units on the paper and the real-life
units of the object you're drawing. But when drawing in AutoCAD, you
can draw directly in real-life units — feet and inches, millimeters, or
whatever you typically use on your projects. AutoCAD can then calcu-
late distances and dimensions for you and add them to the drawing. You
can make the mouse pointer jump directly to hot spots on-screen, and
a visible, resizable grid gives you a better sense of the scale of your
drawing. However, this smart paper function works well only if you tell
AutoCAD some crucial parameters for your specific drawing. AutoCAD
can'’t really do its job until you tell it how to work.

v Dead-trees paper: Creating a great drawing on-screen that doesn’t fit
well on paper is all too easy. After you finish creating your drawing on
the smart paper AutoCAD provides on-screen, you then usually have to
plot it on the good, old-fashioned paper that people have used for thou-
sands of years. At that point, you must deal with the fact that people like
to use certain standard paper sizes and drawing scales. (Most people
also like everything to fit neatly on one sheet of paper.) If you set up
AutoCAD correctly, good plotting results automatically; if not, plotting
time can become one colossal hassle.

v~ It ain’t easy: AutoCAD provides templates and Setup Wizards for you,
but the templates don’t work well unless you understand them, and
some of the wizards don’t work well even if you do understand them.
This deficiency is one of the major weaknesses in AutoCAD. You must
figure out on your own how to make the program work right. If you just
plunge in without carefully setting it up, your drawing and printing
efforts are likely to wind up a real mess.
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AutoCAD and paper

In other Windows programs, you can use any
scaling factor you want to squeeze content onto
paper. You've probably printed an Excel spread-
sheet or Web page at some odd scaling factor,
such as 82.5 percent of full size, because that's
what it took to squeeze the content onto a single
sheet of paper while keeping the text as large
as possible.

In drafting, your printout needs to use a specific,
widely accepted scaling factor, such as 1:50 or

others. But the AutoCAD screen does not auto-
matically enforce any one scaling factor or
paper size. If you just start drawing stuff on the
AutoCAD screen to fit your immediate needs, it's
unlikely that the final result will fit neatly on a
piece of paper at a desirable scale.

This chapter tells you how to start your drawing
in such a way that you'll like how it ends up.
With practice, this kind of approach will
become second nature.

/3

' =1'-0", to be useful and understandable to

Fortunately, setting up AutoCAD correctly is a bit like following a roadmap
to a new destination. Although the directions for performing your setup are
complex, you can master them with attention and practice. Even more fortu-
nately, this chapter provides a detailed and field-tested route. And soon,
you’ll know the route like the back of your hand.
P While you're working in AutoCAD, always keep in mind what your final output
should look like on real paper. Even your first printed drawings should look
just like hand-drawn ones — only without all those eraser smudges.

Before you start the drawing setup process, you need to make decisions
about your new drawing. The following three questions are absolutely criti-
cal; if you don’t answer them or your answer is wrong, you’ll probably need
to do lots of reworking of the drawing later:

1+ What drawing units will you use?
v At what scale — or scales — will you plot it?

+ On what size paper does it need to fit?

In some cases, you can defer answering one additional question, but it’s usu-
ally better to deal with it up front: What kind of border or title block does
your drawing require?

If you're in a hurry, it’s tempting to find an existing drawing that was set up
for the drawing scale and paper size that you want to use, make a copy of
that DWG file, erase the objects, and start drawing. Use this approach with
care, though. When you start from another drawing, you inherit any setup
mistakes in that drawing. Also, drawings that were created in much older ver-
sions of AutoCAD may not take advantage of current program features and
CAD practices. If you can find a suitable drawing that was set up in a recent

\NG/
Vg\“
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|
Figure 4-1:
The

Drawing
Units dialog
box.
|

version of AutoCAD by an experienced person who is conscientious about
doing setup right, consider using it. Otherwise, you're better off setting up a
new drawing from scratch.

Choosing your units

AutoCAD is extremely flexible about drawing units; it lets you have them your
way. Usually, you choose the type of units that you normally use to talk about
whatever you're drawing: feet and inches for a building in the United States,
millimeters for a metric screw, and so on.

Speaking of millimeters, there’s another choice you have to make even before
you choose your units of measure, and that’s your system of measure.

Most of the world abandoned local systems of measure generations ago. Even
widely adopted ones like the imperial system have mostly fallen by the way-
side, just like their driving force, the British Empire. Except, of course, in the
United States, where feet, inches, pounds, gallons, and degrees Fahrenheit
still rule.

During drawing setup, you choose two unit characteristics: a type of unit —
Scientific, Decimal, Engineering, Architectural, or Fractional — and a preci-
sion of measurement in the Drawing Units dialog box, shown in Figure 4-1.
(We show you how later in this chapter.) Engineering and Architectural units
are in feet and inches; Engineering units use decimals to represent partial
units, and Architectural units use fractions to represent them. AutoCAD’s
other unit types — Decimal, Fractional, and Scientific — are unitless because
AutoCAD doesn’t know or care what the base unit is. If you configure a draw-
ing to use Decimal units, for example, each drawing unit could represent a
micron, millimeter, inch, foot, meter, kilometer, mile, parsec, the length of the
king’s forearm, or any other unit of measurement that you deem convenient.
It’s up to you to decide.

L Drawing Units 3]%]
Length Angle
Twpe Type
Decimal L Decimal Degrees hal
fAchtectural . Precision;
Decimal k‘ -
Engineering ¢ hdl
Fractional
Scientific [ Clockwise

Inzartion scale
Units to scale inserted content:
Milimeters v

Sample Output

1.5,2.0035.0
3450

[ OK ] [ Cancel | | Direction... | | Help.

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 4: Setup for Success

Enter the metric system

...or, “Let’s forget everything we learned about
measuring stuff and start over again!” All (well,
nearly all) the world is metric. Instead of a
system of linear measure based on twelves, of
volume measure based on sixteens, and of tem-
perature measure based on who knows what,
metric bases all types of measure on tens. Of
course, For Dummies books are in the metric
vanguard because every single For Dummies
title includes a Part of Tens.

The metric system first gained a toe-hold (ten
toes, of course) in France during the Revolution.
Over time it became apparent that some

standardization was called for, and a mere
century-and-a-half later, S| Metric became that
standard. Sl is short for Systeme International
d’Unites. (That's International System of Units,
in English. Isn’t it great to speak more than one
language?)

The U.S.A. may be late coming to the party, but
the U.S. federal government has made a com-
mitment to adopt S| Metric. For more informa-
tion, point your browser to the National Institute
of Standards and Technology’s Special
Publication 814 (http://ts.nist.gov/
ts/htdocs/200/202/pub814.htm).

After you specify a type of unit, you draw things on-screen full size in those
units just as though you were laying them out on the construction site or in
the machine shop. You draw an 8-foot-high line, for example, to indicate the
height of a wall and an 8-inch-high line to indicate the cutout for a doggie
door (for a Dachshund, naturally). The on-screen line may actually be only

2 inches long at a particular zoom resolution, but AutoCAD stores the length

as 8 feet. This way of working is easy and natural for most people for whom
CAD is their first drafting experience, but it seems weird to people who’ve
done a lot of manual drafting. If you're in the latter category, don’t worry;

you’ll soon get the hang of it.

When you use dash-dot linetypes (Chapter 5) and hatching (Chapter 12) in
a drawing, it matters to AutoCAD whether the drawing uses an imperial
(inches, feet, miles, and so on) or metric (millimeters, meters, kilometers,
and so on) system of units. The MEASUREMENT system variable controls

75

whether the linetype and hatch patterns that AutoCAD lists for you to choose
from are scaled with inches or millimeters in mind as the plotting units. MEA-
SUREMENT=0 means inches (that is, an imperial units drawing), whereas
MEASUREMENT=1 means millimeters (that is, a metric units drawing). If you
start from an appropriate template drawing, as described later in this chap-
ter, the MEASUREMENT system variable will be set correctly and you won'’t
ever have to think about it.
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Drawing scale versus the drawing scale factor

CAD users employ two different ways of talking
about a drawing’s intended plot scale: drawing
scale and drawing scale factor.

Drawing scale is the traditional way of describ-
ing a scale — traditional in that it existed long
before CAD came to be. Drawing scales are
expressed with an equal sign or colon; for
example %' = 1'-0", 1:20, or 2:1. Translate the
equal sign or colon as “corresponds to.” In all
cases, the measurement to the left of the equal
sign or colon indicates a paper measurement,
and the number to the right indicates a CAD
drawing and real-world measurement. In other
words, the imperial drawing scale %" = 1'-0"
means that 4" on the plotted drawing corre-
sponds to 1'-0" in the CAD drawing and in the
real world, assuming that the plot was made at
the proper scale. A metric drawing scale is usu-
ally expressed without units, as a simple ratio.

Thus, a scale of 1:20 means one unit on the plot-
ted drawing corresponds to twenty units in the
real world (or the CAD drawing, since you're
drawing everything full size, right?). In architec-
tural and engineering drawings, the numbers
usually refer to millimeters.

Drawing scale factor is a single number that
represents a multiplier, such as 96, 20, or 0.5.
The drawing scale factor for a drawing is the
conversion factor between a measurement on
the plot and a measurement in a CAD drawing
and the real world.

Those of you who did your math homework in
junior high will realize that drawing scale and
drawing scale factor are two interchangeable
ways of describing the same relationship. The
drawing scale factor is the multiplier that con-
verts the first number in the drawing scale into
the second number.

Weighing your scales

The next decision you should make before setting up a new drawing is choos-
ing the scale at which you’ll eventually plot the drawing. This decision gives
you the drawing scale and drawing scale factor — two ways of expressing the
same relationship between the objects in the real world and the objects plot-
ted on paper.
@\\\NG-’ You shouldn’t just invent some arbitrary scale based on your CD-ROM speed
or camera’s zoom lens resolution. Most industries work with a fairly small set
of approved drawing scales that are related to one another by factors of 2 or
10. If you use other scales, you'll, at best, be branded a clueless newbie —
and, at worst, have to redo all your drawings at an accepted scale.

Table 4-1 lists some common architectural drawing scales, using both imper-
ial and metric units. The table also lists the drawing scale factor correspond-
ing to each drawing scale and the common uses for each scale. If you work in
industries other than those listed here, ask drafters or co-workers what the
common drawing scales are and for what kinds of drawings they’re used.
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Table 4-1 Common Architectural Drawing Scales
Drawing Scale Drawing Scale Factor Common Uses
Ye'=1-0" 192 Large building plans
%'=1-0" 96 Building plans
1n'=1-0" 43 House plans
%'=1-0" 24 Plan details
1"=1-0" 12 Details

1:200 200 Large building plans
1:100 100 Building plans

1:50 50 House plans

1:20 20 Plan details

1:10 10 Details

After you choose a drawing scale, engrave the corresponding drawing scale
factor on your desk, write it on your hand (don’t mix those two up, okay?),
and put it on a sticky note on your monitor. You need to know the drawing
scale factor for many drawing tasks, as well as for some plotting. You should
be able to recite the drawing scale factor of any drawing you're working on in
AutoCAD without even thinking about it.

Even if you're going to use the Plot dialog box’s Fit To Paper option, rather than
a specific scale factor, to plot the drawing, you still need to choose a scale to
make text, dimensions, and other annotations appear at a useful size. Choose

a scale that’s in the neighborhood of the Fit To Paper plotting factor, which
AutoCAD displays in the Plot Scale area of the Plot dialog box. For example, if
you determine that you need to squeeze your drawing down about 90 times to
fit on the desired sheet size, choose a drawing scale of % inch = 1'-0" (drawing
scale factor = 96) if you're using architectural units or 1:100 (drawing scale
factor = 100) for other kinds of units.

Most of the time, for most people, there are way too many scales in the lists
you see in the Viewports toolbar and the Plot dialog box. AutoCAD has a
handy dandy Edit Scales List dialog box that lets you remove those imperial
scales if you never work in feet and inches. And vice versa, for the metrically
challenged. To run through your scales, choose Format=>Scale List. If you
make a mistake, the Reset button will restore all the default scales.
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Thinking about paper

With knowledge of your industry’s common drawing scales, you can choose
a provisional scale based on what you're depicting. But you won’t know for
sure whether that scale works until you compare it with the size of the paper
that you want to use for plotting your drawing. Here again, most industries
use a small range of standard sheet sizes. Three common sets of sizes exist,
as shown in Figure 4-2 and Table 4-2.

v ANSI (American National Standards Institute)
v Architectural
v~ ISO (International Standard Organization)

——
Figure 4-2:
Relation- D - A

" andard j T

paper sizes. :ij sizes Architectural sizes ||s‘o sizes

——
Table 4-2 Common Plot Sheet Sizes
Sheet Size Dimensions Comment
ANSI E 34 x 44"
ANSI D 22 x 34 E sheet folded in half
ANSI C 17x22" D sheet folded in half
ANSI B Mx17" C sheet folded in half
ANSI A 8sx 11" B sheet folded in half
Architectural Large £ 36 x 48"
Architectural E 30 x 42"
Architectural D 24 x 36" Large E sheet folded in half
Architectural C 18 x 24" D sheet folded in half
Architectural B 12x 18" C sheet folded in half
Architectural A 9x 12 B sheet folded in half
ISO A0 841 x 1189 mm
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Sheet Size Dimensions Comment

ISO A7 594 x 841 mm A0 sheet folded in half
IS0 A2 420 x 594 mm AT sheet folded in half
IS0 A3 297 x 420 mm AZsheet folded in half
ISO A4 210x 297 mm A3 sheet folded in half

You select a particular set of sheet sizes based on the common practices in
your industry. You then narrow down your choice based on the area required
by what you’re going to draw. For example, most imperial-units architectural
plans are plotted on Architectural D- or E-size sheets, and most metric archi-
tectural plans go on ISO Al or A0 sheets.

If you know the desired sheet size and drawing scale factor, you can calculate
the available drawing area easily. Simply multiply each of the sheet’s dimen-
sions by the drawing scale factor. For example, if you choose an 11-x-17-inch
sheet and a drawing scale factor of 96 (corresponding to a plot scale of %" =
1'-0"), you multiply 17 times 96 and 11 times 96 to get an available drawing
area of 1,632 inches x 1,056 inches (or 136 feet x 88 feet). If your sheet size is
in inches but your drawing scale is in millimeters, you need to multiply by an
additional 25.4 to convert from inches to millimeters. For example, with an
11-x-17-inch sheet and a scale of 1:200 (drawing scale factor = 200), you multi-
ply 17 times 200 times 25.4 and 11 times 200 times 25.4 to get 86,360 x 55,880
mm or 86.36 x 55.88 m — not quite big enough for a football field (American
or European football).

Conversely, if you know the sheet size that you're going to use and the real-
world size of what you’re going to draw, and you want to find out the largest
plot scale you can use, you have to divide, not multiply. Divide the needed
real-world drawing area’s length and width by the sheet’s dimensions. Take
the larger number — either the length result or the width result — and round
up to the nearest real drawing scale factor (that is, one that’s commonly used
in your industry). For example, suppose you want to draw a 60-x-40-foot (or
720-x-480-inch) floor plan and print it on 11-x-17-inch paper. You divide 720 by
17 and 480 by 11 to get 42.35 and 43.64, respectively. The larger number,
43.64, corresponds in this example to the short dimension of the house and
the paper. The nearest larger common architectural drawing scale factor is
48 (corresponding to /4" = 1'-0"), which leaves a little room for the plotting
margin and title block.

The Cheat Sheet at the front of this book includes two tables that list the avail-
able drawing areas for a range of sheet sizes and drawing scales. Use those
tables to help you decide on an appropriate paper size and drawing scale,

and revert to the calculation method for situations that the tables don’t cover.
If you don’t keep a favorite old calculator on your physical desktop, don’t
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despair — AutoCAD 2007 has one lurking on the Standard toolbar — look for
the QuickCalc button. (Hint: It looks like a calculator!)

When you select a sheet size and drawing scale, always leave some extra
room for the following two reasons:

v Most plotters and printers can’t print all the way to the edge of the
sheet — they require a small margin. For example, Dave’s trusty old
Hewlett-Packard LaserlJet 4050 has a printable area of about 8.0 x 10.7
inches on an 8.5-x-11-inch ANSI A-size (letter-size) sheet. (You'll find this
information in the Plot dialog box, as described in Chapter 13.) If you're
a stickler for precision, you can use the printable area instead of the
physical sheet area in the calculations described earlier in this section.

v Most drawings require some annotations — text, grid bubbles, and so
on — outside the objects you're drawing, plus a title block surrounding
the objects and annotations. If you don’t leave some room for the anno-
tations and title block, you’ll end up having to cram things together too
much or change to a different sheet size. Either way, you’ll be slowed
down later in the project when you can least afford it. Figure 4-3 shows
an extreme example of selecting a sheet size that’s too small or, con-
versely, a drawing scale that’s too large. In this example, the building is
too long for the sheet, and it overlaps the title block on both the right
and left sides.

Some industries deal with the “sheet-is-too-small/drawing-scale-is-too-large”
problem by breaking drawings up onto multiple plotted sheets.

Don’t be afraid to start with paper. Experienced drafters often make a quick,
throwaway pencil and paper sketch called a cartoon. A drawing cartoon usu-
ally includes a rectangle indicating the sheet of paper you intend to plot on, a
sketch of the title block, and a very rough, schematic sketch of the thing
you’re going to draw. It helps to scribble down the dimensions of the sheet,
the main title block areas, and the major objects to be drawn. By sketching
out a cartoon, you'll often catch scale or paper size problems before you set
up a drawing, when repairs only take a few minutes — not after you've cre-
ated the drawing, when fixing the problem can take hours.

Defending your border

The next decision to make is what kind of border your drawing deserves. The
options include a full-blown title block, a simple rectangle, or nothing at all
around your drawing. If you need a title block, do you have one, can you
borrow an existing one, or will you need to draw one from scratch? Although
you can draw title block geometry in an individual drawing, you’ll save time
by reusing the same title block for multiple drawings. Your company may
already have a standard title block drawing ready to use, or someone else
who’s working on your project may have created one for the project.
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Figure 4-3:
“This sheet
size is too
small,” said
Goldilocks.
|
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The right way to draw a title block is in a separate DWG file at its normal plot-
ted size (for example, 36 inches long by 24 inches high for an architectural D-
size title block, or 841 mm long by 594 mm high for an ISO Al-size version).
You then insert or xref the title block drawing into each sheet drawing.
Chapter 14 describes how to insert and xref separate DWG files.

All system variables go

As Chapter 2 describes, AutoCAD includes a slew of system variables that con-
trol the way your drawing and the AutoCAD program work. Much of the draw-
ing setup process involves setting system variables based on the drawing
scale, sheet size, and other desired properties of the drawing. You can set
some system variables in AutoCAD dialog boxes, but a few must be entered
at the keyboard. Table 4-3 shows the settings that you most commonly need
to change — or at least check — during drawing setup, along with the names
of the corresponding system variables. Later in the chapter, in the “Making
the Most of Model Space” section, we show you the procedure for changing
these settings.
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Two new settings in AutoCAD 2007’s Drafting Settings dialog box add some

useful features to the drawing grid. You can now set the grid to show the area

defined by the limits or the entire drawing display. And you can set it to
reduce the grid density when you zoom out (no more of those pesky Grid
too small to display messages!). The new system variable GRIDDIS-
PLAY (what else would you call it?) controls these settings. Yet another new
system variable is GRIDMAJOR; this one applies more to working in 3D, and

we cover it in Chapter 9.

Table 4-3

System Variables for Drawing Setup

Setting

Dialog Box

System Variables

Linear units and
precision

Drawing Units

LUNITS, LUPREC

Angular units and

Drawing Units

AUNITS, AUPREC

precision

Grid spacing and Drafting Settings GRIDUNIT, GRIDMODE,

visibility GRIDDISPLAY, GRIDMAJOR

Snap spacing and Drafting Settings SNAPUNIT, SNAPMODE

on/off

Drawing limits None (use keyboard input} ~ LIMMIN, LIMMAX

Linetype scale Linetype Manager LTSCALE, PSLTSCALE,
CELTSCALE

Dimension scale Dimension Style Manager DIMSCALE

A Template for Success

When you start AutoCAD 2007 with its desktop shortcut or from the Windows
Start menu, you're faced with the Workspaces dialog box; here, you choose
whether you want to work in 2D or 3D. In this book (with the exception of
Chapter 9), we're working in 2D, so “AutoCAD Classic” is the workspace to
choose.

When you start in the AutoCAD Classic workspace, AutoCAD creates a new,
blank drawing configured for 2D drafting. Depending on where you live (your
country, not your street address!) and the dominant system of measure used
there, AutoCAD will base this new drawing on one of two default template
drawings: acad.dwt (imperial system of measure as used in the United
States) or acadiso.dwt (metric system, used throughout the rest of the
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galaxy). (In AutoCAD LT, the two default templates are named acadlt.dwt
and acadltiso.dwt.) When you explicitly create a new drawing from within
AutoCAD, the Select Template dialog box, shown in Figure 4-4, appears by
default so that you can choose a template on which to base your new drawing.

3 Select template 2=
Lookin: | (5 Template v i 1 Mews v Tools v
Name
,-rJI I)PTWTemplates
History [Chsheetsets
. [P acad3D.dwt 113K
’_'_j [FFacad Named Plot Styles30.dwt 113K
[")acad -Named Flot Styles.dwt 49K
My Documents Tacad.dwt 54k
I [T acadiso3D.dwt 119K
(’\A\? [ 2cadIS0 tamed Plot Styles3... 119K
Favoriies [ acadIS0 tamed Plot Styles.dwt 49K
. [l acadisa.cwt 51K
‘U,ég [F95anST A (por trait) -Cotor Depe... 83K
[ ANST & (por trait) Mamed Plot... B3k
FTP [¥F arest & -Color Dependent Flot... B4k
|F"'_‘-?+ gm A Named Plot Styles.dwt BAK,
< >
Desktop
F . -
w File name: acad.dwt | [ Open ]v]
Buzzsaw Fles of type: | Drawing Template (" dwt) .V.| c°'°°

A template is simply a drawing whose name ends in the letters DWT, which
you use as the starting point for another drawing. When you create a new
drawing from a template, AutoCAD makes a copy of the template file and
opens the copy in a new drawing editor window. The first time you save the
file, you're prompted for a new filename to save to; the original template file
stays unchanged.

You may be familiar with the Microsoft Word or Excel template documents,
and AutoCAD template drawings work pretty much the same way — because
Autodesk stole the idea from them! (Encouraged, of course, by Microsoft.)

Using a suitable template can save you time and worry because many of the
setup options are already set correctly for you. You know the drawing will
print correctly; you just have to worry about getting the geometry and text
right. Of course, all this optimism assumes that the person who set up the
template knew what he or she was doing.

The stock templates that come with AutoCAD are okay as a starting point,
but you’ll need to modify them to suit your purposes or create your own
from scratch. In particular, the stock AutoCAD templates aren’t set up for the
scales that you’ll want to use. The instructions in the rest of this chapter tell
you how to specify scale-dependent setup information.
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So the only problems with templates are creating good ones and then later
finding the right one to use when you need it. Later in this chapter, in the
“Making Templates Your Own” section, we show you how to create templates
from your own setup drawings. Here we show you how to use an already cre-
ated template, such as one of the templates that comes with AutoCAD 2007 or
from one of your CAD-savvy colleagues. If you're lucky, someone in your office
will have created suitable templates that you can use to get going quickly.

Follow these steps to create a new drawing from a template drawing:

1. Run the NEW command by pressing Ctrl+N or choosing Filec>New.
The Select Template dialog box appears.

The first button on the Standard toolbar runs the QNEW (Quick NEW)
command instead of the ordinary NEW command. Unless you or someone
else has changed the Drawing Template Settings in the Options dialog box,
QNEW does the same thing as NEW. See the “Making Templates Your Own”
section, later in this chapter, for information about how to take advantage
of QNEW.

2. Click the name of the template that you want to use as the starting
point for your new drawing and click the Open button.

A new drawing window with a temporary name, such as Drawing?2 . dwg,
appears. (The template you opened remains unchanged on your hard
disk.)

Depending on which template you choose, your new drawing may open
with a paper space layout tab, not the Model tab, selected. If that’s the
case, click the Model tab (in the lower-left corner of the drawing area)
before changing the settings described in the “Making the Most of Model
Space” section. The “Plotting a Layout in Paper Space” section, later in
this chapter, describes how to set up and take advantage of paper space
layouts.

3. Press Ctrl+S and save the file under a new name.

Take the time to save the drawing to the appropriate name and
location now.

4. Make needed changes.

If you start a drawing using most of the templates that come with
AutoCAD, you need to consider changing the units, limits, grid and snap
settings, linetype scale, and dimension scale. See the “Making the Most
of Model Space” section for instructions.

5. Consider saving the file as a template.

If you’ll need other drawings in the future similar to the current one,
consider saving your modified template as a template in its own right.
See the “Making Templates Your Own” section, later in this chapter.
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The simplest, no-frills templates are acad.dwt (for people who custom-
arily work in imperial units) and acadiso.dwt (for people who custom-
arily work in metric). (The corresponding templates in AutoCAD LT are
named acadlt.dwt and acadltiso.dwt, respectively.) Most of the
remaining templates that come with AutoCAD include title blocks for var-
ious sizes of sheets. In addition, most templates come in two versions —
one for people who use color-dependent plot styles and one for people
who use named plot styles. You probably want the color-dependent ver-
sions. (Chapter 13 describes the two kinds of plot styles and why you
probably want the color-dependent variety.) We warned you that this
drawing setup stuff would be complicated!

If you dig around in the Options dialog box, you may discover a setting that
turns on the old Startup dialog box, which offers several options other than
starting with a template. Among these options are the enticingly named Sefup
Wizards. These so-called wizards were lame when they first appeared; they're
no better now. Autodesk acknowledges as much by making them almost
impossible to find in AutoCAD 2007.

Making the Most of Model Space

Most drawings require a two-part setup:

1. Set up the Model tab, where you'll create most of your drawing.
2. Create one or more paper space layout tabs for plotting.

After you've decided on drawing scale and sheet size, you can perform model
space setup as described in this section.

Setting your units

First, you should set the linear and angular units that you want to use in your
new drawing. The following procedure describes how:
1. Choose Format=>Units from the menu bar.
The Drawing Units dialog box appears, as shown in Figure 4-5.
2. Choose a linear unit type from the Length Type drop-down list.

Choose the type of unit representation that’s appropriate for your work.
Engineering and Architectural units are displayed in feet and inches; the
other types of units aren’t tied to any particular unit of measurement.

You decide whether each unit represents a millimeter, centimeter, meter,
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inch, foot, or something else. Your choice is much simpler if you're
working in metric: Choose Decimal units.

AutoCAD can think in inches! If you're using Engineering or Architectural
units (feet and inches), AutoCAD understands any coordinate you enter
as a number of inches. You use the ’ (apostrophe) character on your key-
board to indicate a number in feet instead of inches.

L Drawing Units 3]%]
Length Angle
Type Type
Decimal hal Dacimal Degress ¥
Precision: Precision:
0.0000 R 0 i
[ Clockwise

Inzartion scale
Units to scale inserted content:

rches w
Sample Output
1.5000,2.0039.0.0000
3.0000<45.0.0000
[ OK ] [ Cancel | | Direction... | | Help.

3. From the Length Precision drop-down list, choose the degree of
precision you want when AutoCAD displays coordinates and linear
measurements.

The precision setting controls how precisely AutoCAD displays coordi-
nates, distances, and prompts in some dialog boxes. In particular, the
Coordinates box on the status bar displays the current coordinates

of the crosshairs using the current precision. A grosser — that is, less
precise — precision setting makes the numbers displayed in the status
bar more readable and less jumpy. So be gross for now; you can always
act a little less gross later.

The linear and angular precision settings only affect AutoCAD’s display
of coordinates, distances, and angles on the status bar, in dialog boxes,
and in the command line and dynamic cursor areas. For drawings stored
as DWG files, AutoCAD always uses maximum precision to store the
locations and sizes of all objects that you draw. In addition, AutoCAD
provides separate settings for controlling the precision of dimension
text — see Chapter 11 for details.

4. Choose an angular unit type from the Angle Type drop-down list.

Decimal Degrees and Deg/Min/Sec are the most common choices.
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The Clockwise check box and the Direction button provide additional
angle measurement options, but you’ll rarely need to change the default
settings: Measure angles counterclockwise and use east as the 0 degree
direction.

5. From the Angle Precision drop-down list, choose the degree of preci-
sion you want when AutoCAD displays angular measurements.

6. In the Drag-and-Drop Scale area, choose the units of measurement for
this drawing.

Choose your base unit for this drawing — that is, the real-world distance
represented by one AutoCAD unit.

7. Click OK to exit the dialog box and save your settings.

Telling your drawing its limits

The next model space setup task is to set your drawing’s limits. You wouldn’t
want it staying out all night and hanging out with just anybody, would you?
The limits represent the rectangular working area that you’ll draw on, which
usually corresponds to the paper size. Setting limits correctly gives you the
following advantages:

v Using default settings, when you turn on the grid (described in the fol-
lowing section), the grid displays in the rectangular limits area. With the
grid on, the grid settings at their defaults, and the limits set correctly,
you see the working area that corresponds to what you’ll eventually be
plotting, so you won’t accidentally sail off the edge of your paper.

v The ZOOM (Z) command’s All option zooms to the greater of the limits
or the drawing extents. (The extents of a drawing consist of a rectangu-
lar area just large enough to include all the objects in the drawing.)
When you set limits properly and color within the lines, ZOOM All gives
you a quick way to zoom to your working area.

v If you plot from model space, you can choose to plot the area defined by
the drawing limits. This option gives you a quick, reliable way to plot
your drawing, but only if you've set limits correctly!

Many CAD drafters don’t set limits properly in their drawings. After you read
this section, you can smugly tell them why they should and how.

You can start the LIMITS command from a menu choice, but all subsequent

action takes place on the command line or the dynamic cursor; despite the
importance of the topic, AutoCAD has no dialog box for setting limits.
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The following procedure shows you how to set your drawing limits:

1. Choose Format~>Drawing Limits from the menu bar to start the LIMITS

command.

AutoCAD prompts you, both with a dynamic cursor tooltip and at the
command line at the bottom of the screen, to reset the model space limits.

Command: LIMITS
Reset Model space limits:
Specify lower left corner or [ON/OFF] <0.0000,0.0000>:

The value at the end of the last line of the command line prompt is the
default value for the lower-left corner of the drawing limits. It appears
according to the units and precision that you selected in the Drawing
Units dialog box — for example, 0'-0" if you selected Architectural units
with precision to the nearest inch.

. Type the lower-left corner of the limits you want to use and press

Enter.

The usual value to enter at this point is 0,0. (Type a zero, a comma, and
then another zero, with no spaces.) You can just press Enter to accept
the default value.

Regardless of what you see in the dynamic input tooltip, when you press
Enter to accept a default value, the value that will be accepted is the one
that shows in the command line, not what you see at the tooltip.

AutoCAD now prompts you for the upper-right corner of the limits.
Specify upper right corner <12.0000,9.0000>:

The initial units offered by AutoCAD correspond to an Architectural

A- size sheet of paper in landscape orientation. (Almost no one uses
Architectural A-size paper; here’s a classic example of a programmer
choosing a silly default that no one has bothered to change in 22 years!)

If you live in a metric-dominant location, the second prompt will read:
Specify upper right corner <420.0000,297.0000>:

These numbers correspond to an ISO A3-size sheet (much more up-to-
date than those silly, old-fashioned imperial settings!).

. Type the upper-right corner of the limits you want to use and press

Enter.

You calculate the usual setting for the limits’ upper-right corner by mul-
tiplying the paper dimensions by the drawing scale factor. For example,
if you're setting up a %" = 1'-0" drawing (drawing scale factor = 96) to be
plotted on a 24-x-36-inch sheet in landscape orientation, the upper-right
corner of the limits should be 36 inches times 96, 24 inches times 96.
Okay, pencils down. The correct answer is 3456,2304 (or 288 feet,

192 feet).
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Alternatively, you can cheat when specifying limits and read the limits
from the tables on the Cheat Sheet in the front of this book.

If you have the grid turned on, AutoCAD redisplays it in the new limits
area after you press Enter.

If you're using Architectural or Engineering units and you want to enter
measurements in feet and not inches, you must add the foot designator
after the number, such as 6'; otherwise, AutoCAD assumes that you
mean inches.

4. Choose View=>Zoom=All.

AutoCAD zooms to the new limits.

Making the drawing area
snap-py (and grid-dy)

AutoCAD’s grid is a set of evenly spaced, visible dots that serve as a visual
distance reference. (As we describe in the preceding section, “Telling your
drawing its limits,” the grid (by default) also indicates how far the drawing
limits extend.) AutoCAD’s snap feature creates a set of evenly spaced, invisi-
ble hot spots, which make the crosshairs move in nice, even increments. Both
grid and snap are like the intersection points of the lines on a piece of grid
paper, but grid is simply a visual reference, whereas snap constrains the
points that you can pick with the mouse. You can — and usually will — set
the grid and snap spacing to different distances.

Set the grid and the snap intervals in the Drafting Settings dialog box with
these steps:

1. Right-click the Snap or Grid button in the status bar and choose
Settings.

The Drafting Settings dialog box appears with the Snap And Grid tab
selected, as shown in Figure 4-6.

The Snap And Grid tab has five parts, but the Snap and Grid sections are
all you need to worry about for most 2D drafting work.

2. Select the Snap On check box to turn on snap.
This action creates default snaps half a unit apart.

3. Enter the Snap X Spacing for the snap interval in the accompanying
text box.

Use the information in the sections preceding this procedure to decide
on a reasonable snap spacing.

If Equal X And Y Spacing is checked, the Y spacing automatically
changes to equal the X spacing, which is almost always what you want.
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4. Select the Grid On check box to turn on the grid.
5. Enter the Grid X Spacing for the grid in the accompanying text box.

Use the information in the sections preceding this procedure to decide
on a reasonable grid spacing.

If Equal X And Y Spacing is checked, the Y spacing automatically
changes to equal the X spacing. As with the snap spacing, you usually
want to leave it that way.

X measures horizontal distance; Y measures vertical distance. The
AutoCAD drawing area normally shows an X and Y icon in case you
forget.

The Snap And Grid tab has been reorganized and added to in AutoCAD
2007. Checking Equal X And Y Spacing forces X and Y spacing to be
equal for both Snap and Grid. The new adaptive grid changes its appar-
ent density as you zoom in and out. And you can choose to display the
grid within the defined limits only, or over the entire graphics display.

. Select Adaptive Grid to control grid density while zooming in and out.

If the adaptive grid is enabled, AutoCAD lowers the density or spacing of
the grid dots as you zoom in and out. The spacing won’t go lower than
what you’ve set, but it may go higher if you're zoomed a long way out of
your drawing. (If it didn’t, you couldn’t see your drawing for the grid dots!)

. Select Display Grid Beyond Limits to control the area over which the

grid displays.
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Selecting this check box makes AutoCAD behave the way it’s always
behaved — that is, the grid is only displayed in the area defined by the
drawing limits. Clearing this check box allows the grid to display over
the entire graphics area, no matter how far you’re zoomed out.

8. Click OK to close the Drafting Settings dialog box.

Making snap (and grid) decisions

You can set your grid spacing to work in one of
two ways: to help with your drawing or to help
you remain aware of how objects will relate to
your plot. For a grid that helps with your draw-
ing, set the grid points a logical number of mea-
surement units apart. For example, you might
set the grid to 30 feet (10 yards) on a drawing of
a (U.S.) football field. This kind of setting makes
your work easier as you draw.

Another approach is to choose a grid spacing
that represents a specific distance, such as 1
inch or 25 millimeters, on your final plot. If you
want the grid to represent 1inch on the plot and
your drawing units are inches, enter the draw-
ing scale factor. For example, in a %" = 1'-0"
drawing, you'd enter the drawing scale factor
of 48. A 48-inch grid interval in your drawing
corresponds to a 1-inch interval on the plot
when you plot to scale. If your drawing units are
millimeters and you want the grid to represent
25 millimeters on the plot, enter the drawing
scale factor times 25. For example, in a 1:50
drawing, you'd enter 25 x 50, or 1250.

In most cases, you'll want to set the snap inter-
val considerably smaller than the grid spacing.
A good rule is to start with a snap spacing in the
range of the size of the smallest objects that
you'll be drawing — 6 inches or 100 millimeters
for a building plan, 0.5 inches or 5 millimeters for
an architectural detail, /s inch or 1 millimeter for
a small mechanical component, and so on.

Leaving the grid on in your drawing all the time
is worthwhile because it provides a visual

reminder of how far apart things are. This visual
reference is especially useful as you zoom in
and out.

You don't always want to leave snap turned on,
however. Some drawings, such as contour
maps, are made up mostly of objects with weird,
uneven measurements. Even drawings with
many objects that fall on convenient spacings
will have some unruly objects that don't. In addi-
tion, you sometimes need to turn off snap tem-
porarily to select objects. Despite these
caveats, snap is a useful tool in most drawings.

Setting the snap spacing to a reasonable value
when you set up a new drawing is a good idea.
Toggle snap off (by clicking the SNAP button on
the status bar or pressing the F9 key) when you
don't need it or find that it's getting in the way.
Toggle snap on before drawing objects that
align with specific spacings, including text and
dimension strings that you want to align neatly.

To use snap effectively, you need to make the
snap setting smaller as you zoom in and work
on more detailed areas, and larger as you zoom
back out. You are likely to find yourself chang-
ing the snap setting fairly frequently. The grid
setting, on the other hand, can usually remain
constant even as you work at different zoom
settings; that keeps you oriented as to how far
zoomed in you are in the drawing.
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You can also click the SNAP button on the status bar to toggle snap on and
off; the same goes for the GRID button and the grid setting.

Setting linetype and dimension scales

Even though you’ve engraved the drawing scale factor on your desk and writ-
ten it on your hand — not vice versa — AutoCAD doesn’t know the drawing
scale until you enter it. Keeping AutoCAD in the dark is fine as long as you're
just drawing continuous lines and curves representing real-world geometry
because you draw these objects at their real-world size, without worrying
about plot scale.

As soon as you start adding dimensions (measurements that show the size of
the things you're drawing) and using dash-dot linetypes (line patterns that
contain gaps in them), you need to tell AutoCAD how to scale the parts of
the dimensions and the gaps in the linetypes based on the plot scale. If you
forget this, the dimension text and arrowheads can come out very tiny or
very large when you plot the drawing, and dash-dot linetype patterns can
look waaaay too big or too small. Figure 4-7 shows what we mean.

S Just Right. _O Q BQ'

The scale factor that controls dash-dot linetypes is found in a system variable
called LTSCALE (as in LineType SCALE). The scaling factor that controls
dimensions is found in a system variable called DIMSCALE. You can change
either of these settings at any time, but it’s best to set them correctly when
you’re setting up the drawing.

The following sequence includes directions for typing system variable and
command names. To set the linetype scale at the keyboard, follow these steps:

1. Type LTSCALE (or LTS) and press Enter.

AutoCAD responds with a prompt, asking you for the scale factor. The
value at the end of the prompt is the current linetype scale setting, as
shown in the following command line example:
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Enter new linetype scale factor <1.0000>:
Type the value you want for the linetype scale and press Enter.

The easiest choice is to set the linetype scale to the drawing scale factor.
Some people, however, find that the dashes and gaps in dash-dot line-
types get a bit too long when they use the drawing scale factor. If you're
one of those people, set LTSCALE to one-half of the drawing scale factor.
(Feel free to experiment with this value; some people prefer a linetype
scale of three-quarters the scale factor. If you're working in metric, try
0.75 times the scale factor instead — just ask your calculator if you don’t
believe us.)

Alternatively, you can set LTSCALE in the Linetype Manager dialog box: Choose
Format=Linetype, click the Show Details button, and type your desired line-
type scale in the Global Scale Factor text box.

To change the dimension scale, use the Dimension Style Manager dialog box.
We describe dimensions in detail in Chapter 11, but you should get in the
habit of setting the dimension scale during drawing setup. To do so, follow
these steps:

1.

Choose Format~>Dimension Style from the menu bar, or enter DIM-
STYLE (or D) at the command line.

The Dimension Style Manager dialog box appears. New drawings contain
the default dimension style named Standard (for English-unit drawings)
or ISO-25 (for metric drawings).

. Click the Modify button.

The Modify Dimension Style dialog box appears.

. Click the Fit tab.

The Fit tab options appear, including an area called Scale For Dimension
Features.

. In the Scale For Dimension Features area, make sure that the radio

button next to the Use Overall Scale Of setting is selected.

. In the text box next to Use Overall Scale Of, type the drawing scale

factor for the current drawing.

We told you that you’d be using that drawing scale factor a lot!

. Click OK to close the Modify Dimension Style dialog box.

The Dimension Style Manager dialog box reappears.

. Click Close.

The Dimension Style Manager dialog box closes. Now when you draw
dimensions, AutoCAD will scale the dimension text and arrowheads
correctly.
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Before you start creating dimensions, create your own dimension style(s) for
the settings that you want to use. Chapter 11 explains why and how.

Entering drawing properties

You need to do one last bit of bookkeeping before you're finished with model
space drawing setup: Enter summary information in the Drawing Properties
dialog box, as shown in Figure 4-8. Choose Filew>Drawing Properties to open
the Drawing Properties dialog box and then click the Summary tab. Enter the
drawing scale you're using and the drawing scale factor, plus any other infor-
mation you think useful.

WY'EaglesMest East Elevation.dwg Properties [B]%]

General | Summary | Statistics | Custom
Title: Eagle’s Mest East Elevation
Subject: 1267 Bowen insurance repairs
Bythor: D Bymes

Keywords:  Eagle’s Nest Entry Roof Gutters

Comments: | Last revised 26-Nov-05

Flot at 1:50 on letter-size paper
LTScale set to 30

Hypedink

bass: h:\drawings®,

oK j[ Cancel |[ Help

Plotting a Layout in Paper Space

As we describe in Chapter 2, paper space is a separate space in each drawing
for composing a printed version of that drawing. You create the drawing
itself, called the model, in model space. You then can create one or more plot-
table views, complete with title block. Each of these plottable views is called
a layout. AutoCAD saves separate plot settings with each layout — and with
the Model tab — so that you can plot each tab differently. In practice, you’ll
probably need to use only one of the paper space layout tabs, especially
when you're getting started with AutoCAD.
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Figure 4-9:
The Create
Layout
Wizard.

A screen image is worth a thousand paper space explanations. If you haven’t
yet seen an example out in the wild, refer to Figures 2-7 and 2-8 in Chapter 2.
You may also want to open a few of the AutoCAD 2007 sample drawings and
click the Model and Layout tabs to witness the variety of ways in which
paper space is used. A good place to start is Program Files\AutoCAD
2007\Sample\Welding Fixture-1.dwg. (For AutoCAD LT, start with
Program Files/AutoCAD LT 2007/sample/Home Floor Plan.dwg.)

After you complete model space setup, you should create a layout for plot-
ting. You don’t need to create the plotting layout right after you create the
drawing and do model space setup; you can wait until after you’ve drawn
some geometry. You should set up a layout sooner, not later, however. If any
scale or sheet size problems exist, it’s better to discover them early.

In AutoCAD 2007, it’s still possible to ignore paper space layouts entirely and
do all your drawing and plotting in model space. But you owe it to yourself to
give layouts a try. You'll probably find that they make plotting more consis-
tent and predictable. They’ll certainly give you more plotting flexibility when
you need it. And you’ll certainly encounter drawings from other people that
make extensive use of paper space, so you need to understand it if you plan
to exchange drawings with anyone else.

Creating a layout

Creating a simple paper space layout is straightforward, thanks to the
AutoCAD 2007 Create Layout Wizard, shown in Figure 4-9. (Yes! Finally, a
useful AutoCAD wizard.) The command name is LAYOUTWIZARD, which is
not to be confused with the WAYOUTLIZARD command for drawing geckos
and iguanas! In any event, you can avoid a lot of typing by choosing
Tools=>Wizards=>Create Layout.

Create Layout - Begin %]

Begi

- < > This wizard provides you the abilty to design a new
Printer ] lzyout,
Faper Size —+ fou can choose a plot device and plot settings,
Oviaritation o insert a title block and specify a viewport setup.
Title Block D" VWhen you have completed the wizard. the settings
o 1] will be saved wih the drawing

ine Viewports
X % To madify these settings, you can use the Page

Pick Location 4 Setup dialog from within the layout.
Firish

Ertter & name for the new layout you are creating.
D-Size Sheet
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Although the Create Layout Wizard guides you step by step through the
process of creating a paper space layout from scratch, it doesn’t eliminate
the necessity of coming up with a sensible set of layout parameters. The
sheet size and plot scale that you choose provide a certain amount of space
for showing your model (see the information earlier in this chapter), and wiz-
ards aren’t allowed to bend the laws of arithmetic to escape that fact. For
example, a map of Australia at a scale of 1 inch = 1 foot won't fit on an 8%-x-
11-inch sheet, no way, no how. In other words, garbage in, garbage (lay)out.
Fortunately, the Create Layout Wizard lends itself to experimentation, and
you can easily delete layouts that don’t work.

Follow these steps to create a layout:

1. Choose Tools~>Wizards- Create Layout, or type LAYOUTWIZARD and
press Enter.

2. Give the new layout a name and click Next.

In place of the default name, Layout3, we recommend something more
descriptive — for example, D-Size Sheet.

3. Choose a printer or plotter to use when plotting this layout and click
Next.

Think of your choice as the default plotter for this layout. You can
change to a different plotter later, or create page setups that plot the
same layout on different plotters.

Many of the names in the configured plotter list should look familiar
because they're your Windows printers (system printers in AutoCAD
lingo). Names with a .pc3 extension represent nonsystem printer dri-
vers. See Chapter 13 for details.

4. Choose a paper size, specify whether to use inches or millimeters to
represent paper units, and click Next.

The available paper sizes depend on the printer or plotter that you
selected in Step 3.

5. Specify the orientation of the drawing on the paper and click Next.

The icon showing the letter A on the piece of paper shows you which
orientation is which.

6. Select a title block or None (see Figure 4-10) and click Next.

If you choose a title block, specify whether AutoCAD should insert it as a
Block — which is preferable in this case — or attach it as an Xref. (We fill
you in on blocks and xrefs in Chapter 14.)

Attaching a title block as an xref is a good practice if your title block
DWG file is in the same folder as the drawing that you're working on.
The Create Layout Wizard’s title blocks live in the Template folder that’s
stored with the AutoCAD Application Data files under your Windows
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user profile, which isn’t — or shouldn’t be — where you keep your pro-
ject files. Thus, in this case, Block is a safer choice.

Create Layout - Title Block %]
Begin Select a fithe block to use for the layout. Select whether the title block wil be
inserted 25 a block or attached as an Xef. The title block will be placed at the
Printer lower left comer of the paper margin.
Paper Size Path: C:\Documents and ...\Architectural Title Block dwg
Orientation More | Preview
ANSI Afitle block (portrait) dwg |
» Title Block ANSI A titie block dwg
; ANS| B titie block dwg
I Define Viewpos || 1121 C yie block dwg
Pick Location ANS| D title block dwg
T -10- ANSI E title block dwg
Figure 4-10: ST Acchitectural Tile Block dwg
Title block !
options in v
the Create & Black Oxet
Layout
Wizard. cBack | Ned> | [ Cancel
|
Q‘\\\NG!

Choose a title block that fits your paper size. If the title block is larger
than the paper, the Create Layout Wizard simply lets it run off the paper.

$‘

If you don’t like any of the supplied title blocks, choose None. You can
always draw, insert, or xref a title block later. See Chapter 14 for informa-
tion about inserting or xrefing a title block.

The list of available title blocks comes from all the DWG files in your
AutoCAD Template folder. You can add custom title block drawings to
this folder (and delete ones that you never use). If you want to know
where to put them, see the “Making Templates Your Own” section, later
in this chapter.

7. Define the arrangement of viewports that AutoCAD should create and
the paper space to model space scale for all viewports. Then click Next.

A paper space layout viewport is a window into model space. You must
create at least one viewport to display the model in your new layout. For
most 2D drawings, a single viewport is all you need. 3D models often
benefit from multiple viewports, each showing the 3D model from a dif-
ferent perspective.

P The default Viewport scale, Scaled to Fit, ensures that all of your model
drawing displays in the viewport but results in an arbitrary scale factor.
Most technical drawings require a specific scale, such as 1:100 or %" =
1-0".

8. Specify the location of the viewport(s) on the paper by picking its cor-
ners. Then click Next.

After you click the Select Location button, the Create Layout Wizard
displays the preliminary layout with any title block that you’'ve chosen.
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Figure 4-11:
The right-
click menu
for a layout
tab.
|

Pick two points to define a rectangle that falls within the drawing area of
your title block (or within the plottable area of the sheet, if you chose no
title block in Step 6).

AutoCAD represents the plottable area of the sheet with a dashed rec-
tangle near the edge of the sheet. If you don’t select a location for the
viewport(s), the Create Layout Wizard creates a viewport that fills the
plottable area of the sheet.

9. Click Finish.

AutoCAD creates the new layout.

Copying and changing layouts

After you create a layout, you can delete, copy, rename, and otherwise manip-
ulate it by right-clicking its tab. Figure 4-11 shows the right-click menu options.

The From Template option refers to layout templates. After you create layouts
in a template (DWT) or drawing (DWG) file, you can use the From Template
option to import these layouts into the current drawing. For details, see the
LAYOUT command’s Template option in the Command Reference section of
online help.
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Many drawings require only one paper space layout. If you always plot the
same view of the model and always plot to the same device and on the same
size paper, a single paper space layout should suffice. If you want to plot your
model in different ways (for example, at different scales, with different layers
visible, with different areas visible, or with different plotted line characteris-
tics), you may want to create additional paper space layouts.

Some different ways of plotting the same model can be handled in a single
paper space layout with different page setups. See Chapter 13 for more
details. If your projects require lots of drawings, you can parlay layouts into
sheet sets — a feature that makes for more sophisticated creation, manage-
ment, plotting, and electronic transfer of multisheet drawing sets. Again, see
Chapter 13 for more information.

If you want to add another viewport to an existing layout, you need to
become familiar with the MVIEW command. (See the MVIEW command in the
Command Reference section of AutoCAD online help.) After you have the con-
cepts down, using the Viewports dialog box (choose Viewr>Viewports=>New
Viewports) and Viewports toolbar can help you create, scale, and manage
viewports more efficiently.

Lost in paper space

After you create a paper space layout, you suddenly have two views of the
same drawing geometry: the view on your original Model tab and the new
layout tab view (perhaps decorated with a handsome title block and other
accoutrements of plotting nobility). It’s important to realize that both views are
of the same geometry. If you change the model geometry on one tab, you're
changing it on all tabs because all tabs display the same model space objects.

When you make a paper space layout current by clicking its tab, you can
move the crosshairs between paper space (that is, drawing and zooming on
the sheet of paper) and model space (drawing and zooming on the model,
inside the viewport) in several ways, including

v Clicking the PAPER/MODEL button on the status bar.

v In the drawing area, double-clicking over a viewport to move the
crosshairs into model space in that viewport or double-clicking outside
all viewports (for example, in the gray area outside the sheet) to move
the crosshairs into paper space.

v Clicking the Maximize/Minimize Viewport button on the status bar (for
more information, see Chapter 2).

v Entering MSPACE (MS) or PSPACE (PS) at the keyboard.
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When the crosshairs are in model space, anything you draw or edit changes
the model (and thus appears on the Model tab and on all paper space layout
tabs, assuming that the given paper space layout displays that part of the
underlying model). When the crosshairs are in paper space, anything you
draw appears only on that one paper space layout tab. It’s as though you were
drawing on an acetate sheet over the top of that sheet of plotter paper — the
model beneath remains unaffected.

This distinction can be disorienting at first. To avoid confusion, stick with the
following approach (at least until you’re more familiar with paper space):

v If you want to edit the model, switch to the Model tab first. (Don’t try to
edit the model in a paper space viewport.)

v If you want to edit a particular plot layout without affecting the model,
switch to that layout’s tab and make sure that the crosshairs are in
paper space.

Making Templates Your Own

You can create a template from any DWG file by using the Save As dialog box.
Follow these steps to save your drawing as a template:

1. Choose File>Save As from the menu bar.

The Save Drawing As dialog box appears, as shown in Figure 4-12.

3 save Drawing As Bx|
Savein: | () Template .v| P E @ X @ Mews v Toos =
: Preview
Name
—f'[ IPTWTemplates
Higtory (JSheetSets
E*5 acad3D.dwt
//' F¥facad Named Plot Styles3D.dwt
F¥E acad -Named Plot Styles.dwt
Iy Documents o acad.dwt
) | ¥ acadiso3D.dwt
c}\\) F¥acadis0 Named Plot Styles30.dwt
Eavortes jaca:lISO amed Plot Styles.dwt
- Ef acadiso.dwt
‘l 37:_1 ¥ ANSI A& (portrait) Color Dependent Plot ...
= E¥HANSI A (portrait) Mamed Flot Styles.dwt
E—— FTP 5 ANST A -Color Dependent Plot Styles.dwt
F ‘;'__-.} [ ANST A -Mamed Plat Styles.cnt
Figure 4-12: ;’jANSI B -Color Dependent Plot Styles, dwt s »
Saving a Deekdap
d . ‘l‘* ’ ] Update sheet and view thumbnails now
rawing as [
d L e -
a template. Buzzsan
Fies cf typs: | AutoCAD Drawing Template (*dwt} o
| §
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2. From the Files Of Type drop-down list, choose AutoCAD Drawing
Template or AutoCAD LT Drawing Template (*.dwt).

3. Navigate to the folder where you want to store the drawing.

AutoCAD 2007’s default folder for template drawings is called Template
and is buried deep in the bowels of your Windows user profile. Save
your templates there if you want them to appear in the AutoCAD’s Select
Template list. You can save your templates in another folder, but if you
want to use them later, you’ll have to navigate to that folder each time to
use them. See the Technical Stuff paragraph that follows this procedure
for additional suggestions.

4. Enter a name for the drawing template in the File Name text box.
5. Click the Save button to save your drawing template.

The drawing is saved as a template. A dialog box for the template
description and units appears.

6. Specify the template’s measurement units (English or Metric) in the
drop-down list.

Enter the key info now; you can’t do it later unless you save the template
to a different name. Don’t bother filling in the Description field. AutoCAD
doesn’t display it later in the Select Template dialog box.

7. Click OK to save the file.

8. To save your drawing as a regular drawing, choose Filez>Save As from
the menu bar.

The Save Drawing As dialog box appears again.

9. From the Files of Type drop-down list, choose AutoCAD 2007 Drawing
(*.dwg).

Choose the AutoCAD LT equivalent, if that’s your version. AutoCAD 2007
uses a new DWG file format. Choose an earlier version if you want to be
able to open your drawing in AutoCAD 2006 or previous.

10. Navigate to the folder where you want to store the drawing.
Use a different folder from the one with your template drawings.
11. Enter the name of the drawing in the File Name text box.
12. Click the Save button to save your drawing.
The file is saved. Now, when you save it in the future, the regular file, not

the template file, gets updated.

AutoCAD 2007 includes a command called QNEW (Quick NEW), which, when
properly configured, can bypass the Select Template dialog box and create a
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new drawing from your favorite template. The first button on the Standard
toolbar — the one with the plain white sheet of paper — runs the newer
QNEW command instead of the older NEW command.

To put the Quick into QNEW, though, you have to tell AutoCAD which default
template to use: Choose Tools=>Options=Files=>Template Settings>Default
Template File Name for QNEW. AutoCAD 2007’s default setting for Default
Template File Name for QNEW is None, which causes QNEW to act just like
NEW (that is, QNEW opens the Select Template dialog box).

AutoCAD 2007 stores template drawings and many other support files under
your Windows user folder. If you want to discover where your Template
folder is, choose Tools>OptionsFiles>Template Settings=>Drawing
Template File Location. In all likelihood, your Template folder lives under a
hidden folder, so you won'’t be able to see it in Windows Explorer at first. If
you want to find the template folder, open Windows Explorer and choose
Tools=>Folder Options=>View. Set the Hidden Files and Folders setting to
Show Hidden Files and Folders, click the OK button, and then choose
ViewoRefresh. (After you snoop around, you may want to switch back to
Do Not Show Hidden Files and Folders.)

If you want to avoid this nonsense, create a folder where you can find it easily
(for example, C: \Acad-templates or F: \Acad-custom\templates ona
network drive). Put the templates that you actually use there and change the
Drawing Template File Location so that it points to your new template folder.

As this chapter demonstrates, there’s quite a bit to drawing setup in AutoCAD.
As with any other initially forbidding task, take it step by step, and soon the
sequence will seem natural. The Drawing Setup Roadmap on the Cheat Sheet
will help you stay on the road and avoid taking the wrong turnoff.
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In this part . . .

Lines, circles, and other elements of geometry make up
the heart of your drawing. AutoCAD offers many dif-
ferent drawing commands, many ways to use them to
draw objects precisely, and many properties for control-
ling the objects’ display and plot appearance. After you
draw your geometry, you’ll probably spend at least as
much time editing it as your design and drawings evolve.
And in the process, you need to zoom in and out and pan
all around to see how the entire drawing is coming
together. Drawing geometry, editing it, and changing the
displayed view are the foundation of the drawing process;
this part shows you how to make that foundation solid.
And for those who want to build a little higher, this sec-
tion ends with an introduction to AutoCAD 2007’s newly
enhanced 3D visualization and presentation features.
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Get Ready to Draw

In This Chapter
Managing layers
Managing other object properties: color, linetype, and lineweight
Copying layers and other named objects with DesignCenter
Typing coordinates at the keyboard
Snapping to object features

Using other precision drawing and editing techniques

CAD programs are different from other drawing programs. You need to
pay attention to little details like object properties and the precision of
the points that you specify when you draw and edit objects. If you just start
drawing objects without taking heed of these details, you'll end up with an
unruly mess of imprecise geometry that’s hard to edit, view, and plot.

This chapter introduces you to the AutoCAD tools and techniques that help
you prevent making CAD messes. This information is essential before you
start drawing objects and editing them, procedures that we describe in
Chapters 6 and 7.

Drawing and Editing with AutoCAD

When you first start using AutoCAD, its most daunting requirement is the
number of property settings and precision controls that you need to pay
attention to — even when you draw a simple line. Unlike many other pro-
grams, it’s not enough to draw a line in a more-or-less adequate location and
then slap some color on it. All those settings and controls can inspire the feel-
ing that you have to find out how to drive a Formula 1 car to make a trip down
the street. (The advantage is that, after you are comfortable in the driver’s
seat, AutoCAD will take you on the long-haul trips and get you there faster.)
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The following are the three keys to good CAD drawing practice:

v Pay attention to and manage the properties of every object that you
draw — especially the layer that each object is on.

v Pay attention to and manage the named objects in every drawing — the
layers, text styles, block definitions, and other nongraphical objects that
serve to define the look of all the graphical objects in the drawing.

v~ Pay attention to and control the precision of every point and distance
that you use to draw and edit each object.

These can seem like daunting tasks at first, but the following three sections
help you cut them down to size.

Managing Your Properties

\\J

All the objects that you draw in AutoCAD are like good Monopoly players:
They own properties. In AutoCAD, these properties aren’t physical things;
they’re an object’s characteristics such as layer, color, linetype, and
lineweight. You use properties to communicate information about the charac-
teristics of the objects you draw, such as the kinds of real-world objects they
represent, their materials, their relative location in space, or their relative
importance. In CAD, you also use the properties to organize objects for edit-
ing and plotting purposes.

You can view — and change — all of an object’s properties in the Properties
palette. In Figure 5-1, the Properties palette shows properties for a line object.

To toggle the Properties palette on and off, click the Properties button on the
Standard toolbar or use the Ctrl+1 key combination. Before you select an
object, the Properties palette displays the current properties — properties
that AutoCAD applies to new objects when you draw them. After you select
an object, AutoCAD displays the properties for that object. If you select more
than one object, AutoCAD displays the properties that they have in common.

Putting it on a layer

Every object has a layer as one of its properties. You may be familiar with
layers — independent drawing spaces that stack on top of each other to
create an overall image — from using drawing programs. AutoCAD, like most
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|
Figure 5-1:
Alinerichin
properties.
|

CAD programs, uses layers as the primary organizing principle for all the
objects that you draw. Layers organize objects into logical groups of things
that belong together; for example, walls, furniture, and text notes usually
belong on three separate layers, for a couple of reasons:

v Layers give you a way to turn groups of objects on and off — both on
the screen and on the plot.

v Layers provide the best way of controlling object color, linetype, and
lineweight.

So, to work efficiently in AutoCAD, you first create layers, assigning them
names and properties such as color and linetype. Then you draw objects on
those layers. When you draw an object, AutoCAD automatically puts it on the
current layer — the layer that you see in the Layers toolbar drop-down list
when no objects are selected.

x

S Line 4
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Color
Layer
Linztype
Linetyp... 1.0000
Plot style |ByColor
Lingwei...
Hyperlink
Thickness | 0.0000

M Bylayer
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Bylaysr

Bylayer

3D Visualization
Material | Bylayer

Geometry

StartX |-4.0000
StartY | 19.5000
StartZ | 0.0000
End X 66.5000
End Y 19,5000
EndZ  |0.0000
DeltaX |70.5000
Delta ¥ | 0.0000
DeltaZ |0.0000
Length | 70.5000
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PROPERTIES
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Before you draw any object in AutoCAD, you should set an appropriate layer
current — creating it first, if necessary, using the procedure described later
in this section. If the layer already exists in your drawing, you can make it the
current layer by choosing it in the Layers toolbar, as shown in Figure 5-2.

www.it-ebooks.info


http://www.it-ebooks.info/

JO8 Partin Let There Be Lines

If you spent any time “on the boards,” as griz-
zled old-timers like to call paper-and-pencil
drafting, you may be familiar with the manual
drafting equivalent of layers. In pin-bar drafting,
you stack a series of transparent sheets, each
of which contains part of the overall drawing —
walls on one sheet, the plumbing system on
another, the electrical system on another, and
so on. You can get different views of the draw-
ing by including or excluding various sheets.

If you're too young to remember pin-bar
drafting— or old enough to prefer notto —you
may remember something similar from a

Looking at layers

textbook about human anatomy. There's the
skeleton on one sheet, the muscles on the next
sheet that you laid over the skeleton, and so on
until you built up a complete picture of the
human body — that is, if your parents didn't
remove some of the more grown-up sections.

CAD layers serve a similar purpose: They
enable you to turn on or off groups of related
objects. But layers do a lot more. You use them
in AutoCAD to control other object display and
plot properties, such as color, linetype, and
lineweight. Take the time to give each of your
drawings a suitably layered look.
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Make sure that no objects are selected before you use the Layer drop-down
list to change the current layer. (Press the Esc key twice to be sure.) If objects
are selected, the Layer drop-down list displays (and lets you change) those
objects’ layer. When no objects are selected, the Layer drop-down list dis-
plays (and lets you change) the current layer.

If you forget to set an appropriate layer before you draw an object, you can
select the object and then change its layer by using either the Properties
palette or the Layer drop-down list.

Accumulating properties

Besides layers, the remaining object properties that you're likely to want to
use often are color, linetype, lineweight, and possibly plot style. Table 5-1
summarizes these four properties.

Table 5-1 Useful Object Properties
Property Controls

Color Displayed color and plotted color or lineweight
Linetype Displayed and plotted dash-dot line pattern
Lineweight Displayed and plotted line width

Plot style Plotted characteristics (see Chapter 13)

Stacking up your layers

How do you decide what to call your layers and
which objects to put on them? Some industries
have developed layer guidelines, and many
offices have created documented layer stan-
dards. Some projects even impose specific
layer requirements. (But be careful; if someone
says, “You need a brick layer for this project,”
that can mean a couple of different things.) Ask

experienced CAD drafters in your office or
industry how they use layers in AutoCAD. If you
can't find any definitive answer, create a chart
of layers for yourself. Each row in the chart
should list the layer name, default color, default
linetype, default lineweight, and what kinds of
objects belong on that layer.
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About colors and lineweights

AutoCAD drafters have traditionally achieved ¢~ Although lineweights may have been

different printed lineweights by mapping vari- assigned to objects in a drawing that you
ous on-screen display colors of drawing objects open, you won't necessarily see them on
to different plotted lineweights. An AutoCAD- the screen. You must turn on the Show/Hide
using company may decide that red lines are to Lineweight button on the AutoCAD status
be plotted thin, green lines are to be plotted bar (the button labeled LWT).

thicker, and so on. Not many people plotted in
color until recently, so few folks minded the fact
that color was used for a different purpose.

v+ 0On a slow computer or in a complex draw-
ing, showing lineweights may cause
AutoCAD to redraw the screen more slowly

More recent versions of AutoCAD have when you zoom and pan.

lineweight as an inherent property of objects

and the layers that they live on. Lineweights are

handy, but they have quirks. Watch for these

problems as you work with them:

v You may need to zoom in on a portion of the
drawing before the differing lineweights
become apparent.

@\\\NG! Long before AutoCAD was able to display lineweights on the screen and

S print those same lineweights on paper, object colors controlled the printed
lineweight of objects. AutoCAD 2000 introduced a more logical system, where
you could assign an actual plotted thickness to objects. As logical as that
method seems, the older method, where the color of objects determines
their plotted lineweight, continues to dominate. You may find yourself work-
ing this way even in AutoCAD 2007, for compatibility with drawings (and
coworkers) that use the old way, as described in the “About colors and
lineweights” sidebar.

AutoCAD gives you two different ways of controlling object properties:

v By Layer: Each layer has a default color, linetype, lineweight, and plot
style property. Unless you tell AutoCAD otherwise, objects inherit the
properties of the layers on which they’re created. AutoCAD calls this
approach controlling properties By Layer.

v By Object: AutoCAD also enables you to override an object’s layer’s
property setting and give the object a specific color, linetype, lineweight,
or plot style that differs from the layer’s. AutoCAD calls this approach
controlling properties By Object.

P If you’ve worked with other graphics programs, you may be used to assigning
properties such as color to specific objects. If so, you'll be tempted to use the
By Object approach to assigning properties in AutoCAD. Resist the tempta-
tion. Did you catch that? One more time: Resist the temptation.
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In almost all cases, it’s better to create layers, assign properties to each layer,
and let the objects on each layer inherit that layer’s properties. Here are some
benefits of using the By Layer approach:

v You can easily change the properties of a group of related objects that
you put on one layer. You simply change the property for the layer, not
for a bunch of separate objects.

v Experienced drafters use the by Layer approach, so if you work with
drawings from other people, you’ll be much more compatible with them
if you do it the same way. You’ll also avoid getting yelled at by irate CAD
managers, whose job duties include haranguing any hapless newbie who
assigns properties By Object.

If you take our advice and assign properties By Layer, all you have to do is
set layer properties in the Layer Properties Manager dialog box, as shown
in Figure 5-3. Before you draw any objects, make sure the Color Control,
Linetype Control, Lineweight Control, and Plot Style Control drop-down lists
on the Properties toolbar are set to ByLayer, as shown in Figure 5-4.

Y Layer Properties Manages B7]
S8 H %, 3 & Cumertlayer: S-DeCorn : Detal conrechan hardam

= Al Stat Hame On | Fresze| Lock| Cotar Linetype Lineweight | Flot Style| Flol] Descrigtion
& Al Used Layers - 0 ; O T mowhit=  CONTINUDUS — Defauht

-3
E-Annc-Crir CENTER —— Dedault q. Center lines
~g= S-fnnc-Lead CONTINUOUS —— Dedault q. Leaders
g S-hono-Nglt CONTINUOUS —— Detfaull e
- S-hn_Symb J CONTINUOUS — Defzult
o ShonoTal () CONTINUOUS — Dstaut
| CONTINUOUS — Default
CONTINUDUS Default
H . CONTINL S —— Deiault e tail connaction hardware
Flgure 5-3: SOetiFine () S — Dednult s Detail fine fines
v —— Dedault 'lf Detail hidden lines
Use |aVer o 5-DellMedm 5 — Detault By Delal meckum lines
H - SDell-Patt S — Dedaull & Delail hatch patlerns
properties < 5-Dell-Kin CONTINUOUS — Default & Delail extra-fine lines:
to control & 3

Object A 14 ayers dhaplayad of 14total layere
properties. [Jrwetiber [« indome byemsin use

[#] Apphy 1o bapers taolbar ok J[ coes | [t

|
— Color control Lineweight control

Figure 5-4: |

Bylayerall | oo =

yLay [ ByLayer | ByLayer _v] ——— Bylayer hdl
the way. |
| |
Linetype control Plot style control

\\J

If the drawing is set to use color-based plot styles instead of named plot
styles (see Chapter 13), the Plot Style Control drop-down list will be inactive
and will display ByColor.
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Figure 5-5:
Adding a
new layer in
the Layer
Properties
Manager
dialog box.
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If you want to avoid doing things the wrong way and getting yelled at by CAD
managers, don’t assign properties to objects in either of these ways:

v Don’t choose a specific color, linetype, lineweight, or plot style from the
appropriate drop-down list on the Properties toolbar and then draw
the objects.

v Don’t draw the objects, select them, and then choose a property from
the same drop-down lists.

If you prefer to do things the right way, assign these properties By Layer, as
we describe in this section.

Creating new layers

If a suitable layer doesn’t exist, you need to create one by using the Layer
Properties Manager dialog box. Follow these steps:

1. Click the Layer button on the Layers toolbar; or type LAYER (or LA) at
the command line and press Enter.

The Layer Properties Manager dialog box appears. A new drawing has
only one layer, Layer 0. You need to add the layers necessary for your
drawing.

2. Click the New Layer button (the little yellow explosion just above the
Status column) to create a new layer.

A new layer appears. AutoCAD names it Layer1, but highlights the name
in an edit box so you can type a new name to replace it easily, as shown

in Figure 5-5.
Y Layer Properties Manager B
S8 B L —
= Stat Hame On | Fresze| Lock| Calar Linetyp= Lineweight | Flot Style| Flot] Descrpion
< Al Used Layers 4 U J O Uy W owhite  Cotinwcus  —— Defmult Y
[ewed 1, O 70 Mwhie  Comimucus  — Default &

< >

Al 2Iayera diplzyed of 2betdl layere
] e éer [] incheate bayers in yse

] Apphy te bayers taoker [ ok J[ coes J[ e ][ e |
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3. Type a name for the new layer.

P Type the layer name with initial caps (only the first letter of words in
uppercase). Layer names written completely in uppercase are much
wider, which means that they often get truncated in the Layers toolbar’s
Layer drop-down list.

4. On the same line as the new layer, click the color block or color name
(white) of the new layer.

The Select Color dialog box appears, as shown in Figure 5-6.

W Select Color B[]

Indiex: Color True Calor Color Books
AutoCAD Color Index (ACT):

. e
Figure 5-6: | mm= CEET CAEEENE
The Select | EEmawssEEEEEEE—————

Color dlalog .IIII=IIIIIIIIII....III.
ENEEEENENEENENEENE R

box' Index color- 43 Red, Green, Blue: 165,145,682

Magenta is E = aEEm

selected EEE
fromthe || ... .
Standard magenta

Colors list.
[__ok J[ canea J[ Hew |
|
The normal AutoCAD color scheme — AutoCAD Color Index (ACI) —
provides 255 colors. So many choices are nice for rendering work but
are overkill for ordinary drafting.
A\

For now, stick with the first nine colors — the ones that appear in a single,
separate row to the left of the ByLayer and ByBlock buttons on the Index
Color tab of the Select Color dialog box for the following reasons:

¢ These colors are easy to distinguish from one another.

¢ Using a small number of colors makes configuring your plot para-
meters easier. (We describe the procedure in Chapter 13.)

AutoCAD (but not AutoCAD LT) provides an even more extravagant set
of color choices than the 255 shown on the ACI tab. In the Select Color
dialog box, the True Color tab offers a choice of more than 16 million
colors, which you can specify by using HSL (Hue Saturation Luminance)
or RGB (Red Green Blue) numbers. The Color Books tab enables you to
use PANTONE and RAL color schemes, which are popular in publishing.
If your work requires tons of colors or close color matching between the
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computer screen and printed output, you're probably familiar with the
relevant color palette and how to use it. If you're using AutoCAD for ordi-
nary drafting or design, stick with the AutoCAD Color Index palette.

. Click a color to select it as the color for this layer and click OK.

The Layer Properties Manager dialog box reappears. In the Name list,
the color for the new layer changes to either the name or the number of
the color that you selected.

AutoCAD’s first seven colors have both assigned numbers and standard
names: 1 = red, 2 = yellow, 3 = green, 4 = cyan, 5 = blue, 6 = magenta, and
7 = white (but it appears black when displayed on a white background).
The remaining 248 colors have numbers only.

. On the same line as the new layer, click the Linetype name of the new

layer.

The default AutoCAD linetype is Continuous, which means no gaps in
the line.

The Select Linetype dialog box appears, as shown in Figure 5-7.

Wi select Linetype 8] %]
Loaded inetypes
Linetype Appeaancs Description
Continuous —— Soldline

ok | [ Cancal | losd.. | [ e |

If you already loaded the linetypes you need for your drawing, the Select
Linetype dialog box displays them in the Loaded Linetypes list. If not,
click the Load button to open the Load or Reload Linetypes dialog box.
By default, AutoCAD displays linetypes from the standard AutoCAD 2007
linetype definition file — acad. 1in for imperial units drawings or
acadiso.lin for metric units drawings. Load the desired linetype by
selecting its name and clicking the OK button.

Unless you have a really good reason (for example, your boss tells you
s0), avoid loading or using any linetypes labeled ACAD_ISO. These line-
types are normally used only in metric drawings and rarely even then.
They overrule everything we're trying to show you about printed
lineweight in what follows, so if at all possible, just say NO to ACAD_ISO.
We promise you’ll probably find it easier to use the linetypes with the
more descriptive names: CENTER, DASHED, and so on.
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7. Click the desired linetype in the Loaded Linetypes list to select it as
the linetype for the layer; then click OK.

The Select Linetype dialog box disappears, returning you to the Layer
Properties Manager dialog box. In the Name list, the linetype for the
selected layer changes to the linetype you just chose.

8. On the same line as the new layer, click the new layer’s lineweight.

The Lineweight dialog box appears, as shown in Figure 5-8.

WY Lineweight [B] %]

Lineweights:

Figure 5-8:

The Original: Default
Lineweight | Mew  Defaut

dialog box. [ ok ][ ceecel | [ Heb
|
9. Select the lineweight you want from the scrolling list and click OK.
P The lineweight 0.00 mm tells AutoCAD to use the thinnest possible

lineweight on the screen and on the plot. We recommend that, for now,
you leave lineweight set to Default and instead map screen color to plot-
ted lineweight, as described briefly in the “About colors and lineweights”
sidebar earlier in this chapter and in greater detail in Chapter 13.

The default lineweight for the current drawing is defined in the
Lineweight Settings dialog box. After you close the Layer Properties
Manager dialog box, choose Format=>Lineweight or enter LWEIGHT
(or LW) at the command line to change the default lineweight.

You use the plot style property to assign a named plot style to the layer,
but only if you're using named plot styles in the drawing. (Chapter 13
explains why you probably don’t want to.) The Plot property controls
whether the layer’s objects appear on plots. Toggle this setting off for
any layer whose objects you want to see on the screen but hide on plots.

10. If you want to add a description to the layer, scroll the layer list to the
right to see the Description column, click twice in the Description box
corresponding to your new layer, and type a description.

\\J

If you choose to use layer descriptions, stretch the Layer Properties
Manager dialog box to the right so that you can see the descriptions
without having to scroll the layer list.
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11. Repeat Steps 2 through 10 to create any other layers that you want.

12. Select the new layer that you want to make current and click the Set
Current button (the green check mark).

The current layer is the one on which AutoCAD places new objects that
you draw.

13. Click OK to accept the new layer settings.

The Layer drop-down list on the Layers toolbar now displays your new
layer as the current layer.

After you create layers, you can set any one of them to be the current layer.
Make sure that no objects are selected and then choose the layer name from
the Layer drop-down list on the Layers toolbar.

After you create layers and draw objects on them, you can turn a layer off or
on to hide or show the objects on that layer. In the Layer Properties Manager
dialog box, the first three icons to the right of the layer name control
AutoCAD’s layer visibility modes.

v Off/On: Click the light bulb icon to toggle visibility of all objects on the
selected layer. AutoCAD does not regenerate the drawing when you turn
layers back on. (We give you the lowdown on regenerations in Chapter 8.)

v Freeze/Thaw: Click the sun icon to toggle off visibility of all objects
on the selected layer. Click the snowflake icon to toggle visibility on.
AutoCAD regenerates the drawing when you thaw layers.

v Lock/Unlock: Click the padlock icon to lock and unlock layers. When a
layer is locked, you can see but not edit objects on that layer.

Off/On and Freeze/Thaw do almost the same thing — both settings let you
make objects visible or invisible by layer. In the old days, turning layers off
and on was often a faster process than thawing frozen layers because thaw-
ing layers always required regenerating the drawing. But modern computers,
modern operating systems, and recent AutoCAD versions make regenerations
much less of an issue on all but the largest drawings. You'll probably find it
makes no appreciable difference whether you freeze and thaw layers or turn
them off and on.

You can turn layers off and on, freeze and thaw them, and lock and unlock
them by clicking the appropriate icons in the Layer drop-down list on the
Layers toolbar.

If you find yourself using lots of layers, you can create layer filters to make
viewing and managing the layer list easier. AutoCAD provides two kinds of
layer filters: group and property. A group filter is simply a subset of layers
that you choose (by dragging layer names into the group filter name or by
selecting objects in the drawing). A property filter is a subset of layers that
AutoCAD creates and updates automatically based on layer property criteria
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that you define (for example, all layers whose names contain the text Wall or
whose color is green). To find out more, click the Help button on the Layer
Properties Manager dialog box and read about the New Property Filter and
New Group Filter buttons.

AutoCAD 2007 adds a set of layer tools to the core of the program. In previ-
ous releases, these were part of the Express Tools that we mentioned in
Chapter 1. You can access all the Layer Tools through the Format menu (see
Figure 5-9) and a subset of them by opening the Layers II toolbar. We find
Layer Isolate and Layer Off particularly useful — you simply click an object

to specify the layer to isolate (that is, turn off all layers except the chosen
one) or turn off. For more information, open the online help system and
choose User’s Guider>Create and Modify Objects=>Control the Properties of
Objects>Work with Layers=>Use Layers to Manage Complexity.

A load of linetypes

Our layer creation procedure demonstrates
how to load a single linetype. But AutoCAD
comes with a whole lot of linetypes, and there
are other ways of working with them. You don't
have to go through the Layer Properties
Manager dialog box to load linetypes. You can
perform the full range of linetype management
tasks by choosing FormatcoLinetype, which dis-
plays the Linetype Manager dialog box. This
dialog box is similar to the Select Linetype
dialog box described in the layer creation pro-
cedure, butitincludes some additional options.

After you click the Load button to display the
Load or Reload Linetypes dialog box, you can
load multiple linetypes in one fell swoop by
holding down the Shift or Ctrl key while you click
linetype names. As in most Windows dialog
boxes, Shift+click selects all objects between
the first and second clicks, and Ctrl+click
enables you to select multiple objects, even if
they aren’t next to each other.

When you load a linetype, AutoCAD copies its
linetype definition— a recipe for how to create
the dashes, dots, and gaps in that particular
linetype — fromthe acad. 1in (imperial units)
or acadiso.lin (metric units) file into the
drawing. The recipe doesn’t automatically
appear in other drawings; you have to load each

linetype that you want to use into each drawing
in which you want to use it. If you find yourself
loading the same linetypes repeatedly into dif-
ferent drawings, consider adding them to your
template drawings instead. (See Chapter 4 for
information about templates and how to create
them.) After you add linetypes to a template
drawing, all new drawings that you create from
that template will start with those linetypes
loaded automatically.

Don’t go overboard on loading linetypes. For
example, you don't need to load all the linetypes
inthe acad.lin (acadlt.1in) file on the
off chance that you might use them all someday.
The resulting linetype list would be long and
unwieldy. Most drawings require only a few
linetypes, and most industries and companies
settle on a half dozen or so linetypes for
common use. Your industry, office, or project
may have guidelines about which linetypes to
use for which purposes.

If you're the creative type and don't mind
editing a text file that contains linetype defini-
tions, you can define your own linetypes.
Choose Contentsc>oCustomization Guide=>
Custom Linetypes in the AutoCAD 2007 online
help system.
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LT users have had to do without the Express Tools because LT doesn’t sup-
port the language they’re programmed in. However, now that these layer
tools are part of the core program, LT users at last have access to the most
useful of the former Express Tools.

Using AutoCAD DesignCenter

DesignCenter is a dumb name for a useful, if somewhat busy, palette. (Chap-
ter 2 describes how to turn on and work with palettes.) The DesignCenter
palette is handy for borrowing data from all kinds of drawings. Whereas the
Properties palette, described earlier in this chapter, is concerned with object
properties, the DesignCenter palette deals primarily with named objects:
layers, linetypes, block (that is, symbol) definitions, text styles, and other
organizational objects in your drawings.

Named objects

Every drawing includes a set of symbol tables, which contain named objects.
For example, the layer table contains a list of the layers in the current draw-
ing, along with the settings for each layer (color, linetype, on/off setting, and
so on). Each of these table objects, be it a layer or some other type, has a
name, so Autodesk decided to call them named objects (duh!).

Neither the symbol tables nor the named objects appear as graphical objects

in your drawing. They’re like hardworking stagehands who keep the show
running smoothly behind the scenes. The named objects include
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v Layers (this chapter)

v Linetypes (this chapter)

v Text styles (Chapter 10)

v Dimension styles (Chapter 11)

v Block definitions and xrefs (Chapter 14)

v Layouts (Chapter 4)
When you use commands such as LAYER, LINETYPE (LT), and DIMSTYLE (D),
you are creating and editing named objects. After you've created named

objects in a drawing, DesignCenter gives you the tools to copy them to other
drawings.

Getting (Design)Centered

The DesignCenter palette (shown in Figure 5-10) consists of a toolbar at the
top, a set of tabs below that, a navigation pane on the left, and a content pane
on the right. The navigation pane displays a tree view with drawing files and
the symbol tables contained in each drawing. The content pane usually dis-
plays the contents of the drawing or symbol table.

Toolbar Navigation pane Tabs Content pane

e

S-DetlCorn S-Detl-Fire S-Detl-Hidd

S-Deth-Fait S-Dethdin

|
Figure 5-10:
The
AutoCAD
Design-
Center
palette.
|
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The four tabs just below the DesignCenter toolbar control what you see in
the navigation and content panes:

v Folders: This tab shows the folders on your local and network drives,
just like the Windows Explorer Folders pane does. Use this tab if the
drawing you want to copy from isn’t currently open in AutoCAD.

v Open Drawings: This tab shows the drawings that are currently open in
AutoCAD. Use this tab to copy named objects between open drawings.

v History: This tab shows drawings that you've recently browsed in
DesignCenter. Use this tab to jump quickly to drawings that you've used
recently on the Folders tab.

v DC Online: This tab shows parts libraries that are available on Autodesk’s
and other companies’ Web sites. This tab is essentially an advertising
vehicle for software companies offering to sell you symbol libraries and
manufacturers encouraging you to specify their products. Browse the
offerings on this tab to see whether any of the online libraries can be
useful in your work.

The toolbar buttons further refine what you see in the navigation and content
panes. A few of these buttons toggle off and on different parts of the panes.

Follow these steps to use DesignCenter:

1. If it isn’t already, open DesignCenter by choosing Tools~>DesignCenter.
You can also click DesignCenter on the Standard toolbar or press Ctrl+2.

2. Load the drawing(s) whose content you want to view or use into the
navigation pane on the left.

If a drawing doesn’t appear on the Open Drawings tab, click the Load
button — the first one on the DesignCenter toolbar — to load it into the
navigation pane.

3. Navigate the symbol tables (such as blocks and layers), viewing their
individual named objects in the content pane on the right.

4. If you need them, drag or copy and paste individual named objects
from the content pane into other open AutoCAD drawings.

Copying layers between drawings

The following steps copy layers from one drawing to another using
DesignCenter. You can use the same technique to copy dimension styles,
layouts, linetypes, and text styles.
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1. Toggle the DesignCenter palette on by clicking the DesignCenter
button on the Standard toolbar or by pressing Ctrl+2.

[\

. Open or create a drawing containing named objects you want to copy.

You can also use the Folders tab, the Load button, or the Search button
to load a drawing into DesignCenter without opening it in AutoCAD.

3. Open or create a second drawing into which you want to copy the
named objects.

4. Click the Open Drawings tab to display your two currently opened
drawings in DesignCenter’s navigation pane on the left.

If you used the Folders tab, the Load button, or the Search button in
Step 2, skip this step; DesignCenter already displays the drawing you
selected on the Folders tab.

5. If DesignCenter doesn’t display the symbol tables indented underneath
the source drawing (the one you opened in Step 2), as shown in Figure
5-10, click the plus sign next to the drawing’s name to display them.

6. Click the Layers table to display the source drawing’s layers in the
content pane.

7. Choose one or more layers in the content pane.

8. Right-click in the content pane and choose Copy from the menu to
copy the layer(s) to the Windows Clipboard.

9. Click in the AutoCAD destination drawing’s window (the drawing that
you opened in Step 3).

10. Right-click and choose Paste from the menu.

AutoCAD copies the layers into the current drawing, using the colors,
linetypes, and other settings from the source drawing.

If the current drawing contains a layer whose name matches the name of one
of the layers you're copying, AutoCAD doesn’t change the current drawing’s
layer definition. For example, if you drag a layer named Doors whose color is
red into a drawing that already includes a layer called Doors whose color is
green, the target drawing’s Doors layer remains green. Named objects from
DesignCenter never overwrite objects with the same name in the destination
drawing. AutoCAD always displays the message Duplicate definitions
will be ignored even if there aren’t any duplicates.

If you're repeatedly copying named objects from the same drawings or fold-
ers, add them to your DesignCenter favorites list. On the Folders tab, right-
click the drawing or folder and choose Add To Favorites from the menu. This
procedure adds another shortcut to your list of favorites.
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v To see your favorites, click the DesignCenter toolbar’s Favorites button.

v To return to a favorite, double-click its shortcut in the content pane.

Precise-liness Is Next to CAD-liness

Drawing precision is vital to good CAD drafting practice, even more than for
manual drafting. If you think CAD managers get testy when you assign proper-
ties by object instead of by layer, wait until they berate someone who doesn’t
use precision techniques when creating drawings in AutoCAD.

In CAD, lack of precision makes later editing, hatching, and dimensioning
tasks much more difficult and time consuming.

v Small errors in precision in the early stages of creating or editing a draw-
ing often have a big effect on productivity and precision later.

v Drawings may guide manufacturing and construction projects; drawing
data may drive automatic manufacturing machinery. Huge amounts of
money, even lives, can ride on a drawing’s precision.

In recognition of these facts, a passion for precision permeates the profes-
sion. Permanently. Precision is one of the characteristics that separatesCAD
from ordinary illustration-type drawing work. The sooner you get fussy about
precision in AutoCAD, the happier everyone is.

CAD precision versus accuracy

We often use the words precision and accu-
racyinterchangeably, but we think it's useful to
maintain a distinction. When we use the word
precision, we mean controlling the placement
of objects so they lie exactly where you want
them to lie in the drawing. For example, lines
whose endpoints meet must meet exactly, and a
circle that's supposed to be centered on the
coordinates 0,0 must be drawn with its center
exactly at 0,0. We use accuracy to refer to the
degree to which your drawing matches its real-
world counterpart. An accurate floor planis one
in which the dimensions of the CAD objects
equal the dimensions of the as-built house. In a

sense, then, it's not the drawing that should be
accurate — it's the house!

CAD precision usually helps produce accurate
drawings, but that's not always the case. You
can produce a precise CAD drawing that's inac-
curate because you started from inaccurate
information (for example, the contractor gave
you a wrong field measurement). Or you might
deliberately exaggerate certain distances to
convey the relationship between objects more
clearly on the plotted drawing. Even where you
must sacrifice accuracy, aim for precision.
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In the context of drawing objects, to use precision means to designate points
and distances exactly, and AutoCAD provides a range of tools for doing so.
Table 5-2 lists the more important AutoCAD precision techniques, plus the
status bar buttons that you click to toggle some of the features off and on.

P Precision is especially important when you’re drawing or editing geometry —
the lines, arcs, and so on that make up whatever you'’re representing in the
CAD drawing. Precision placement usually is less important with notes, lead-
ers, and other annotations that describe, not show.

Table 5-2

Precision Techniques

Technique

Status Bar
Button

Description

Coordinate entry

Enables you to type exact x,y
coordinates.

Object snap overrides

Enables you to pick points on existing
objects (lasts for one point pick).

Running object snaps

OSNAP

Enables you to pick points on existing
objects (lasts for multiple point picks).

Snap

SNAP

Enables you to pick points on an
imaginary grid of equally spaced hot
spots.

Ortho

ORTHO

Enables you to constrain the
crosshairs to move at an angle of 0,
90, 180, or 270 degrees from the pre-
vious point.

Direct distance entry

Enables you to point the crosshairs in
a direction and type a distance.

Object snap tracking

O0TRACK

Helps the crosshairs locate points
based on multiple object snap points.

Polar tracking

POLAR

Makes the crosshairs prefer certain
angles.

Polar snap

Causes the crosshairs to prefer cer-
tain distances along polar tracking
angles.

WING/
&

Before you draw objects, always check the status bar’s SNAP, ORTHO,

POLAR, OSNAP, and OTRACK buttons and set the buttons according to your

precision needs.

www.it-ebooks.info


http://www.it-ebooks.info/

124

Part II: Let There Be Lines

v A button that looks pushed in indicates that the feature is on.

v A button that looks popped up indicates that the feature is off.

Keyboard capers: Coordinate entry

The most direct way to enter points precisely is to type numbers at the key-
board. AutoCAD uses these keyboard coordinate entry formats:

v Absolute Cartesian (x,y) coordinates in the form x,y (for example: 7,4)
v Relative x,y coordinates in the form @x,y (for example: @3,2)

v Relative polar coordinates in the form @distance<angle (for example:
@6+<45)

Cartesian coordinates are named for French philosopher Rene Descartes (who
reasoned, “I think, therefore I am.”). In his Discourse on Method Descartes
came up with the idea of locating any point on a planar surface by measuring
its distance from a pair of axes (that’s axes as in more than one axis, not the
thing for chopping wood). In this book, we refer to Cartesian coordinates as
%,y coordinates.

AutoCAD locates absolute x,y coordinates with respect to the 0,0 point of the
drawing — usually its lower-left corner. AutoCAD locates relative x,y coordi-
nates and relative polar coordinates with respect to the previous point that
you picked or typed. Figure 5-11 demonstrates how to use all three coordi-
nate formats to draw a pair of line segments that start at absolute coordi-
nates 2,1; go 3 units to the right and 2 units up; then go 4 units at an angle of
60 degrees.

AutoCAD also understands absolute polar coordinates in the form
distance<angle, but this format is almost never useful.

You can view coordinate locations by moving the crosshairs around in the
drawing area and reading the Coordinates area at the left of the status bar.
Depending on AutoCAD 2007’s dynamic input settings, you may also see the
coordinate locations next to the crosshairs. The x,y coordinates should
change as you move the crosshairs. If the coordinates don’t change, click the
Coordinates area until the command line says <Coords on>. Although it’s not
apparent at first, there are, in fact, two <Coords on> display modes: absolute
coordinates and polar coordinates. If you start a command such as LINE (L),
pick a point, and then click the Coordinates area a few times, the display
changes from coordinates off to live absolute coordinates (x,y position) to live
polar coordinates (distance and angle from the previous point). The live polar
coordinates display mode is the most informative most of the time.
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}@\NG-’ When you type coordinates at the command line, do not add any spaces
S because AutoCAD interprets them as though you’ve pressed Enter. This

“Spacebar = Enter” weirdness is a productivity feature that’s been in
AutoCAD forever. It’s easier to find the spacebar than the Enter key when
you'’re entering lots of commands and coordinates in a hurry.

If you're working in architectural or engineering units, the default unit of
entry is inches, not feet.

v To specify feet, you must enter the symbol for feet after the number. For
example:
6' for 6 feet
v You can enter a dash to separate feet from inches, as architects often do.

6'-6" is 6 feet, 6 inches.
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v Both the dash and the inch mark are optional when you’re entering coor-
dinates and distances.

AutoCAD understands 6'6" and 6'6 as the same as 6'-6".

v If you're typing a coordinate or distance that contains fractional inches,
you must enter a dash — not a space — between the whole number of
inches and the fraction.

6'6-1/2 (or 6'-6-1/2) represents 6 feet, 6% inches.

v~ If all this dashing about confuses you, enter partial inches by using deci-
mals instead.

6'6.5 is the same as 6'6-1/2 to AutoCAD, whether you’re working in
architectural or engineering units.

Grab an object and make it snappy

After you've drawn a few objects precisely in a new drawing, the most effi-
cient way to draw more objects with equal precision is to grab points, such as
endpoints, midpoints, or quadrants, on the existing objects. AutoCAD calls
this object snapping because the program pulls, or snaps, the crosshairs to a
point on an existing object. The object snapping feature in general, and object
snap points in particular, often are called osnaps.

I'd like to make just one point
AutoCAD provides two kinds of object snapping modes.

v Object snap overrides: An object snap override is active for a single pick.

v Running object snaps: A running object snap stays in effect until you
turn it off.

Here’s how you draw precise lines by using object snap overrides:

1. Open a drawing containing some geometry.

2. Turn off running osnap mode by clicking the OSNAP button on the
status bar until the button appears to be pushed out and the words
<Osnap off> appear on the command line.

Although you can use object snap overrides while running object snap
mode is turned on, you should turn off running osnap mode while you're
getting familiar with object snap overrides. After you've gotten the hang
of each feature separately, you can use them together.

a\\J
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3. Start the LINE command by clicking the Line button on the Draw
toolbar.

AutoCAD prompts you to select the first endpoint of the line.
Specify first point:

4. Hold down the Shift key, right-click anywhere in the drawing area,
and release the Shift key.

If you find the Shift+right-click sequence awkward, you can avoid it by
using the Object Snap toolbar instead. To turn the toolbar on, point to
any toolbar button, right-click, and choose Object Snap. Now you can
activate an object snap override by clicking its toolbar button.

If you Shift+right-click, the object snap menu appears, as shown in
Figure 5-12.
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# Parallel

¢ Node
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7, None

1, Osnap Settings...

5. Choose an object snap mode, such as Endpoint, from the object snap
menu.

The object snap menu disappears, and the command line displays an
additional prompt indicating that you’ve directed AutoCAD to seek out,
for example, endpoints of existing objects.

_endp of:
6. Move the crosshairs slowly around the drawing, pausing over various
lines and other objects without clicking yet.

When you move the crosshairs near an object with an endpoint, a col-
ored square icon appears at the endpoint, indicating that AutoCAD can
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snap to that point. If you stop moving the crosshairs for a moment, a
tooltip displaying the object snap mode (for example, Endpoint)
appears to reinforce the idea.

7. When the Endpoint object snap square appears on the point you want
to snap to, click.

AutoCAD snaps to the endpoint, which becomes the first point of the
new line segment that you're about to draw. The command line prompts
you to select the other endpoint of the new line segment.

Specify next point or [Undo]:

When you move the crosshairs around the drawing, AutoCAD no longer

seeks out endpoints because object snap overrides last only for a single
pick. Use the object snap right-click menu again to snap the other end of
your new line segment to another point on an existing object.

8. Use the “press Shift, right-click, release Shift” sequence described in
Step 4 to display the object snap menu, and then choose another
object snap mode, such as Midpoint, from the object snap menu.

The command line displays an additional prompt indicating that you've
directed AutoCAD to seek, for example, midpoints of existing objects.

_mid of:

When you move the crosshairs near the midpoint of an object, a colored
triangle appears at the snap point. Each object snap type (endpoint, mid-
point, intersection, and so on) displays a different symbol. If you stop
moving the crosshairs, the tooltip text reminds you what the symbol
means. Figure 5-13 shows what the screen looks like during this step.

9. Draw additional line segments by picking additional points. Use the
object snap right-click menu to specify a single object snap type
before you pick each point.

Try the Intersection, Perpendicular, and Nearest object snaps. If your
drawing contains arcs or circles, try Center and Quadrant.

10. When you’re finished experimenting with object snap overrides, right-
click anywhere in the drawing area and choose Enter from the menu
<MBER to end the LINE command.

<« There’s a difference between right-clicking and Shift+right-clicking in the
drawing area.

¢ Right-clicking displays menu options for the current command (or
common commands and settings when no command is active).

e Shift+right-clicking always displays the same object snap menu.
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Figure 5-13:
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About to object-snap to midpoint

Run with object snaps
Often, you use an object snap mode (such as Endpoint) repeatedly. Running

object snaps address this need. These steps set a running object snap:
1. Right-click the OSNAP button on the status bar.
2. Choose the Settings option.

The Object Snap tab on the Drafting Settings dialog box appears, as
shown in Figure 5-14.

3. Select one or more object snap modes by checking the appropriate
boxes.

4. Click OK to close the dialog box.
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|
Figure 5-14:
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object
features is
an osnap.
|
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You click the OSNAP button on the status bar to toggle running object snap
mode off and on. After you turn on running object snap, AutoCAD hunts for
points that correspond to the object snap modes you checked in the Drafting
Settings dialog box. As with object snap overrides, AutoCAD displays a spe-
cial symbol — such as a square for an endpoint object snap — to indicate
that it has found an object snap point. If you keep the crosshairs still,
AutoCAD also displays a tooltip that lists the kind of object snap point.

Use object snap overrides or running object snaps to enforce precision by
making sure that new points you pick coincide exactly with points on existing
objects. In CAD, it’s not good enough for points to almost coincide or to look
like they coincide. You lose points, both figuratively and literally, if you don’t
use object snaps or one of the other precision techniques covered in this
chapter to enforce precision.

Most, but not all, object snap overrides have running object snap equivalents.

For example, Endpoint, Midpoint, and Center work as either overrides or run-
ning object snaps, but Mid Between 2 Points only works in override mode.

Other precision practices

The following are some other AutoCAD precision techniques (refer to Table 5-2,
earlier in this chapter):

v Snap: If you turn on snap mode, AutoCAD constrains the crosshairs to

an imaginary rectangular grid of points at the spacing that you've speci-
fied. Follow these steps to turn on snap mode:
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1. Right-click the SNAP button on the status bar.
2. Choose the Settings option.

The Snap and Grid tab on the Drafting Settings dialog box appears.
3. Enter a snap spacing in the Snap X Spacing field and click OK.

Click the SNAP button on the status bar or Press F9 to toggle snap mode
off and on. To use snap effectively, change the snap spacing frequently —
changing to a smaller spacing as you zoom in and work on smaller areas.
You often need to toggle snap off and on because selecting objects and
some editing tasks are easier with snap off.

+ Ortho: Ortho mode constrains the crosshairs to move at right angles
(orthogonally) to the previous point. Click the ORTHO button on the
status bar or Press F8 to toggle ortho mode off and on. Because techni-
cal drawings often include lots of orthogonal lines, you may use ortho
mode a lot.

v Direct distance entry: This point-and-type technique is an easy and effi-
cient way to draw with precision. You simply point the crosshairs in a par-
ticular direction, type a distance at the command line, and press Enter.
AutoCAD calls it direct distance entry (or DDE) because it avoids the indi-
rect keyboard method of specifying a distance by typing relative or polar
coordinates. (We describe this older method earlier in this chapter.) You
can use DDE any time the crosshairs are anchored to a point and the com-
mand line or dynamic cursor prompts you for another point or a distance.
You’ll usually use DDE with ortho mode turned on to specify a distance in
an orthogonal direction (0, 90, 180, or 270 degrees). You also can combine
DDE with polar tracking to specify distances in nonorthogonal directions
(for example, in angle increments of 45 degrees).

v Object snap tracking: This feature extends running object snaps so that
you can locate points based on more than one object snap point. For
example, you can pick a point at the center of a square by tracking to
the midpoints of two perpendicular sides.

v Polar tracking: When you turn on polar tracking, the crosshairs jump
to increments of the angle you selected. When the crosshairs jump, a
tooltip label starting with Polar: appears. Right-click the POLAR button
on the status bar and choose the Settings option to display the Polar
Tracking tab on the Drafting Settings dialog box. Select an angle from
the Increment Angle drop-down list and then click OK. Click the POLAR
button on the status bar or press F10 to toggle polar tracking mode off
and on.

v Polar snap: You can force polar tracking to jump to specific incremental
distances along the tracking angles by changing the snap type from grid
snap to polar snap. For example, if you turn on polar tracking and set it
to 45 degrees and turn on polar snap and set it to 2 units, polar tracking
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jumps to points that are at angle increments of 45 degrees and distance
increments of 2 units from the previous point. Polar snap has a similar
effect on object snap tracking.

To activate polar snap, follow these steps:
1. Right-click the SNAP button on the status bar.
2. Choose the Settings option.
The Snap and Grid tab on the Drafting Settings dialog box appears.

3. Click the Polar Snap radio button, type a distance in the Polar
Distance text box, and then click OK.

When you want to return to ordinary rectangular snap, as described
at the beginning of this list, select the Grid Snap radio button in the
Drafting Settings dialog box.

v Temporary overrides: Settings such as SNAP, ORTHO, and POLAR

remain on until you turn them off. You can also use temporary overrides,
which last only as long as you hold down their key or key combination.
For example, with ortho turned off, holding down the Shift key puts
AutoCAD into a temporary ortho mode for as long as you press Shift. For
additional information, look up “temporary override keys” in the online
help system.

If you're new to AutoCAD, its wide range of precision tools probably seems
overwhelming at this point. Rest assured that there’s more than one way to
skin a cat precisely (with cats, accuracy is unimportant), and not everyone
needs to understand all the ways. You can make perfectly precise drawings
with a subset of AutoCAD’s precision tools. We recommend these steps:

1.

Get comfortable with typing coordinates, ortho mode, direct distance
entry, and object snap overrides.

. Become familiar with running object snaps and try Snap mode.

. After you have all these precision features under your belt, feel free to

experiment with polar tracking, polar snap, and object snap tracking.

It’s easy to confuse the names of the snap and object snap (osnap) features.
Remember that snap limits the crosshairs to locations whose coordinates are
multiples of the current snap spacing. Object snap (osnap) enables you to
grab points on existing objects, whether those points happen to correspond
with the snap spacing or not.
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In This Chapter

Drawing with the AutoCAD drawing commands

Lining up for lines and polylines

Closing up with rectangles and polygons

Rounding the curves with circles, arcs, splines, and clouds

Dabbling in ellipses and donuts

Making your points
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A s you probably remember from your crayon and coloring book days,
drawing stuff is fun. CAD imposes a little more discipline, but drawing
AutoCAD obijects is still fun. In computer-aided drafting, you usually start by
drawing geometry — shapes such as lines, circles, rectangles, and so on —
that represent the real-world object that you're documenting. This chapter
shows you how to draw geometry.

After you've created some geometry, you'll probably need to add some
dimensions, text, and hatching, but those elements come later (in Part III of
this book). Your first task is to get the geometry right; then you can worry
about labeling things.

Drawing geometry properly in AutoCAD depends on paying attention to object
properties and the precision of the points that you specify to create the
objects. We cover these matters in Chapter 5, so if you eagerly jumped to this
chapter to get right to the fun stuff, take a moment to review that chapter first.
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Introducing the AutoCAD
Drawing Commands

For descriptive purposes, this chapter divides the drawing commands into
three groups:

v~ Straight lines and objects composed of straight lines
v Curves

v Points

Table 6-1 offers an overview of most of the drawing commands in AutoCAD,
without the 3D-related commands. It describes the commands’ major options
and shows you how to access them from the command line, the Draw menu,
and the Draw toolbar. (Don’t worry if not all the terms in the table are famil-
iar to you; they become clear as you read through the chapter and use the
commands.)

Table 6-1 AutoCAD Drawing Commands
Button Command Major Options Toolbar Button  Draw Menu
/ LINE Start, end points Line Line
RAY Start point, point None Ray
through which
ray passes
XLINE Two points on line Construction Construction
line line
: PLINE Vertices Polyline Polyline
O POLYGON Number of Polygon Polygon
sides, inscribed/
circumscribed
RECTANG Two corners, Rectangle Rectangle
D dimensions, area,
rotation
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Button Command Major Options Toolbar Button  Draw Menu
ARC Various methods Arc Arc; sub-
of definition menu for
definition
methods
CIRCLE Three points, two Circle Circle; sub-
@ points, tangent menu for
definition
methods
REVCLOUD Arc length Revision Cloud  Revision
Cloud
DONUT Inside, outside None Donut
diameters
(\/ SPLINE Convert polylineor ~ Spline Spline
create new
O ELLIPSE Arc, center, axis Ellipse Ellipse; sub-
menu for
definition
methods
. POINT Point style Point Point; sub-
menu for
definition
methods
\\J
Many of the choices on the AutoCAD Draw menu open submenus containing
several variations on each drawing command.
AutoCAD’s drawing commands are highly interactive. You need to read and
respond to the prompts at the dynamic tooltip next to the crosshairs or the
command line. (If command line sounds to you like a military operation, not
an AutoCAD essential concept, see Chapter 2.) Many of the command options
that you see in command line prompts are available as well by pressing the
up- and down-arrow keys to display the options at the dynamic tooltip. You
can also right-click and select command options from the context-specific
shortcut menu.
@‘“\NG! AutoCAD’s Dynamic Input system displays a lot of the information that you
S used to have to look down to the command window to see. To use Dynamic

Input, make sure the DYN button on the status bar is pressed in. Don’t turn the
command window off just yet though, especially if you're new to AutoCAD. We
recommend that you keep the command window open and docked at all times.
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P So what’s the best course: to enter drawing commands from the command
line or to choose them from the menus or toolbars? We suggest that you start
a drawing command the first few times by clicking its button on the Draw
toolbar — until you remember its command name. After you click the button,
fasten your eyes on the command window so that you see the name of the
command and its command line options. Use the keyboard or the right-click
menus to select options. After you’re acquainted with a drawing command
and decide that you like it enough to use it often, find out how to type its key-
board shortcut.

a\\J
A few drawing commands, such as DONUT (DO), aren’t on the Draw toolbar;
you have to type those or choose them from the Draw menu.

The Straight and Narrow: Lines,
Polylines, and Polygons

As we harp on a bunch of times elsewhere in this book, CAD programs are for
precision drawing, so you’ll spend a lot of your AutoCAD time drawing objects
composed of straight-line segments. This section covers these commands:

v LINE (L): Draws a series of straight line segments; each segment is a
separate object.

v PLINE (PL): Draws a polyline — a series of straight and/or curved line
segments; all the segments remain connected to each other as a single
object.

1+ RECTANG (REC): Draws a polyline in the shape of a rectangle.

v POLYGON (POL): Draws a polyline in the shape of a regular polygon
(that is, a closed shape with all sides equal and all angles equal).

The following additional straight-line drawing commands also are available in
AutoCAD:

v RAY: Draws a semi-infinite line (a line that extends infinitely in one
direction).

v XLINE (XL): Draws an infinite line (a line that extends infinitely in both
directions).

P The RAY and XLINE commands are used to draw construction lines that guide
the construction of additional geometry. Drawing construction lines is less
common in AutoCAD than in some other CAD programs. AutoCAD’s many
precision techniques often provide more efficient methods than construction
lines of creating new geometry.
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Toe the line

The LINE command in AutoCAD draws a series of one or more connected line
segments. Well, it appears to draw a series of connected segments. In fact,
each segment, or piece of a line with endpoints, is a separate object. This con-
struction doesn’t seem like a big deal until you try to move or otherwise edit
a series of segments that you drew with the LINE command; you must select
every piece separately. To avoid such a hassle, use polylines (described later
in this chapter), not lines and arcs, when you want the connected segments
to be a single object.

If you're used to drawing lines in other programs, you may find it confusing at
first that AutoCAD’s LINE command doesn’t stop after you draw a single seg-
ment. AutoCAD keeps prompting you to specify additional points so that you
can draw a series of (apparently) connected segments. When you’re finished
drawing segments, just press the Enter key to finish the LINE command.

Unlike a lot of AutoCAD drawing commands, LINE doesn’t offer a bunch of
potentially confusing options. There’s a Close option to create a closed poly-
gon and an Undo option to remove the most recent segment that you drew.

Like all drawing commands, LINE puts the line segments that it draws on the
current layer and uses the current color, linetype, lineweight, and plot style
properties.

v Make sure that you've set these properties correctly before you start
drawing. (We recommend that you set color, linetype, lineweight, and
plot style to ByLayer.) See Chapter 5 for information on setting the cur-
rent properties with the Properties toolbar.

v When you're doing real drafting as opposed to just experimenting, make
sure that you use one of AutoCAD’s precision tools, such as object snaps,
typed coordinates, or tracking, to ensure that you specify each object
point precisely. Chapter 5 describes these tools.

Follow these steps to draw a series of line segments by using the LINE
command:

1. Set the desired layer current, and set other object properties that you
want applied to the line segments that you’ll draw.
2. Click the Line button on the Draw toolbar.
AutoCAD starts the LINE command and prompts you.
Specify first point:
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3. Specify the starting point by clicking a point or typing coordinates.

Remember to use one of the precision techniques described in Chapter 5
if you're doing real drafting. For the first point, object snap, snap, track-
ing, and typing coordinates all work well.

AutoCAD prompts you to specify the other endpoint of the first line seg-
ment. The command line shows:

Specify next point or [Undo]:

You can also see command prompts at the Dynamic Input tooltip beside
the crosshairs by pressing the down-arrow key. The arrow icon on the
dynamic cursor tooltip is your indicator that there are options available.

4. Specify additional points by clicking or typing.

Again, use one of the AutoCAD precision techniques if you're doing real
drafting. For the second and subsequent points, all the techniques men-
tioned in the previous step work well, plus ortho and direct distance
entry.

After you specify the third point, AutoCAD adds the Close option. The
command line shows:

Specify next point or [Close/Undo] :
5. When you're finished drawing segments, end with one of these steps:

¢ Press Enter, or right-click anywhere in the drawing area, and
choose Enter to leave the figure open.

¢ Type C and press Enter, or press the down arrow on your keyboard
and choose Close from the menu (as shown in Figure 6-1), to close
the figure.

AutoCAD draws the final segment. The command prompt indicates that
the LINE command is finished:

Command :

Connect the lines with polyline

The LINE command is fine for some drawing tasks, but the PLINE command is
a better, more flexible choice in many situations. The PLINE command draws
a special kind of object called a polyline. You may hear CAD drafters refer to a
polyline as a pline because of the command name. (By the way, PLINE is pro-
nounced to rhyme with beeline — in other words, it sounds like the place you
stand when you’ve drunk a lot of beer at the ball game.)
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The most important differences between the LINE and PLINE commands are
these:

v The LINE command draws a series of single line segment objects. Even
though they appear on the screen to be linked, each segment is a sepa-
rate object. If you move one line segment, the other segments that you
drew at the same time don’t move with it. The PLINE command, on the
other hand, draws a single, connected, multisegment object. If you
select any segment for editing, your changes affect the entire polyline.
Figure 6-2 shows how the same sketch drawn with the LINE and the
PLINE commands responds when you select one of the objects.

Use the PLINE command instead of LINE in most cases where you need
to draw a series of connected line segments. If you're drawing a series of
end-to-end segments, there’s a good chance that those segments are log-
ically connected — for example, they might represent the outline of a
single object or a continuous pathway. If the segments are connected
logically, it makes sense to keep them connected in AutoCAD. The most
obvious practical benefit of grouping segments together into a polyline
is that many editing operations are more efficient when you use poly-
lines. When you select any segment in a polyline for editing, the entire
polyline is affected.

A\

v The PLINE command can draw curved segments as well as straight ones.
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v You can add width to each segment of a polyline. Polyline segment width
is visually similar to lineweight, except that polyline segment width can
be uniform or tapered. The ability to create polyline segments with line
widths was more important in the old days before AutoCAD had
lineweight as an object property. People used to draw polylines with a
small amount of width to show the segments as somewhat heavier than
normal on plots. Nowadays, it’s easier and more efficient to achieve this
effect with object lineweights (as described in Chapter 5) or plot styles
(as described in Chapter 13).

After you create a polyline, you can adjust its segments by grip editing any of
the vertex points. (The little squares on the vertices in Figure 6-2 are called
grips; see Chapter 7 for details on grip editing.) For more complicated poly-
line editing tasks, you can use the PEDIT (PE) command to edit the polyline,
or you can convert the polyline to a collection of line and arc segments by
using the EXPLODE (X) command — although you lose any width defined for
each segment when you explode a polyline.

Drawing polylines composed of straight segments is pretty much like drawing
with the LINE command, as demonstrated in the following procedure. The
PLINE command has lots of options, so watch the prompts! Use the down-
arrow key to see the options listed at the crosshairs, or right-click to display
the PLINE shortcut menu, or simply read the command line.

T Pling dillerences.dwg ===

v

| Line PLine

M 4|k | M\ Mocel {Layout] fLayoutZ

Line Polyline
(each segment s (all segments
a separate object) form one object)
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To draw a polyline composed of straight segments, follow these steps:

1. Set the desired layer current, and set other object properties that you
want applied to the polyline object that you’ll draw.

2. Click the Polyline button — the one that looks like a fishhook — on
the Draw toolbar.

AutoCAD starts the PLINE command and prompts you.
Specify start point:
3. Specify the starting point by clicking a point or typing coordinates.

AutoCAD displays the current polyline segment line-width at the com-
mand line and prompts you to specify the other endpoint of the first
polyline segment.

Current line-width is 0.0000
Specify next point or
[Arc/Halfwidth/Length/Undo/Width] :

4. If the current line width isn’t zero, change it to zero by typing W,
Enter, 0, Enter, 0, Enter (as shown in the following command line
sequence).

Specify next point or
[Arc/Halfwidth/Length/Undo/Width]: W

Enter Specify starting width <0.0000>: 0

Enter Specify ending width <0.0000>: O

Enter Specify next point or
[Arc/Halfwidth/Length/Undo/Width] :

Despite what you may think, a zero-width polyline segment is not the
AutoCAD equivalent of writing with invisible ink. Zero width means “dis-
play this segment, using the normal, single-pixel width on the screen.”

5. Specify additional points by clicking or typing.

After you specify the second point, AutoCAD adds the Close option to
the prompt. The command line shows:

Specify next point or
[Arc/Close/Halfwidth/Length/Undo/Width] :

In addition, you can view and choose options from the Dynamic Input
menu, as shown in Figure 6-3.

6. After you finish drawing segments, either press Enter (to leave the
figure open) or type C and press Enter (to close it).

AutoCAD draws the final segment. The blank command line indicates
that the PLINE command is finished.

Command :
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In the following procedure, we spice things up a bit and give you a preview of
coming (curvy) attractions by adding an arc segment to a polyline.

Just so you know, curved segments in polylines are circular arcs — pieces of
circles that you can draw with the AutoCAD ARC (A) command. AutoCAD can
draw other kinds of curves, including ellipses and splines, but not within the
PLINE command.

To draw a polyline that includes curved segments, follow these steps:

1. Repeat Steps 1 though 5 of the previous procedure.

2. When you’re ready to add one or more arc segments, type A and
press Enter to select the Arc option.

The prompt changes to show arc segment options. Most of these
options correspond to the many ways of drawing circular arcs in
AutoCAD; see the “Arc-y-ology” section, later in this chapter. The com-
mand line shows:

Specify endpoint of arc or
[Angle/CEnter/CLose/Direction/Halfwidth/Line/R
adius/Second pt/Undo/Width] :

3. Specify the endpoint of the arc by clicking a point or typing
coordinates.

AutoCAD draws the curved segment of the polyline. The prompts con-
tinue to show arc segment options.

Specify endpoint of arc or
[Angle/CEnter/CLose/Direction/Halfwidth/Line/R
adius/Second pt/Undo/Width] :
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Your options at this point include
¢ Specifying additional points to draw more arc segments.

¢ Choosing another arc-drawing method (such as Center or
Second pt).

¢ Returning to drawing straight-line segments with the Line option.
In this example, we return to drawing straight-line segments.

P Perhaps the most useful of the alternative arc-drawing methods is Second
pt. You can use it to gain flexibility in the direction of the arc, but at the
cost of losing tangency of contiguous segments. Sometimes it’s best not
to go off on a tangent, anyway.

4. Type L and press Enter to select the Line option.

Specify endpoint of arc or
[Angle/CEnter/CLose/Direction/Halfwidth/Line/R
adius/Second pt/Undo/Width]: L

The prompt changes back to showing straight-line segment options.

Specify next point or
[Arc/Close/Halfwidth/Length/Undo/Width] :

5. Specify additional points by clicking or typing.

6. After you're finished drawing segments, either press Enter or type C
and press Enter.

Command :

Figure 6-4 shows some of the things that you can draw with the PLINE com-
mand by using straight segments, arc segments, or a combination of both.

A MV

N\ N\
Figure 6-4: |
A plethora |4
of polylines. l
[
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The LINE and PLINE commands work well for drawing a series of end-to-end
single lines, but what if you want to draw a series of double lines to repre-
sent, for example, the edges of a wall or roadway? Here are some options:

v Use the AutoCAD MLINE (ML) command to draw multilines — series of
two or more parallel straight lines. The AutoCAD multiline feature was
full of limitations when it debuted over a decade ago, and despite some
minor tweaks in AutoCAD 2006, it hasn’t improved significantly since
then. Look up the “MLINE” and “MLSTYLE” commands in AutoCAD’s
online help system if you'd like to tangle with this feature, but be pre-
pared to spend time experimenting and struggling.

v In AutoCAD LT only, use the DLINE (DL), or Double Line, command to
draw pairs of parallel line and/or arc segments. AutoCAD LT doesn’t
include the MLINE command, which, given MLINE’s problems, probably
is more of a blessing than a limitation. AutoCAD, on the other hand,
doesn’t include the DLINE command. (Score one for the little brother!)

v Use the PLINE command to draw a single set of connected line and/or
arc segments, and then use the Offset command to create one or more
sets of parallel segments. Chapter 7 covers the Offset command.

Square off with rectangle

You can use the PLINE or LINE command to draw a rectangle segment by seg-
ment. In most cases, though, you'll find it easier to use the special-purpose
RECTANG command. The following procedure demonstrates how:

1. Set the desired layer current, and set other object properties that you
want applied to the rectangle that you’ll draw.
2. Click the Rectangle button on the Draw toolbar.

AutoCAD starts the RECTANG command and prompts you to specify a
point for one corner of the rectangle. The command line shows:

Specify first corner point or
[Chamfer/Elevation/Fillet/Thickness/Width] :

You can add fancy effects with the additional command options. The
default options work best for most purposes. Look up “RECTANG com-
mand” in the AutoCAD help system if you want to know more about the
options.

3. Specify the first corner by clicking a point or typing coordinates.

AutoCAD prompts you to specify the other corner of the rectangle — the
one that’s diagonally opposite from the first corner.

Specify other corner point or
[Area/Dimensions/Rotation] :
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4. Specify the other corner by clicking a point or typing coordinates.

P If you know the size of the rectangle that you want to draw (for example,
100 units long by 75 units high), type relative coordinates to specify the
dimensions (for example, @100,75). (Chapter 5 describes how to type
coordinates.)

AutoCAD draws the rectangle.

Unlike the neglected MLINE command, the RECTANG command has improved
considerably since its debut. You can now specify a rotation angle and — very
handy for space planners — you can provide one dimension and an area. REC-
TANG will calculate the length of the other side and draw the rectangle.

Choose your sides with polygon

Rectangles and other closed polylines are types of polygons, or closed figures
with three or more sides. The AutoCAD POLYGON command provides a quick
way of drawing regular polygons — polygons in which all sides and angles are
equal. (If regular polygons seem a little square, maybe that’s because a square
is a special case of a regular polygon!)

The following procedure demonstrates the POLYGON command:
1. Set the desired layer current, and set other object properties that you
want applied to the polygon that you’ll draw.
2 2. Click the Polygon button on the Draw toolbar.

AutoCAD starts the POLYGON command and prompts you to enter the
number of sides for the polygon.

Enter number of sides <4>:

3. Type the number of sides for the polygon that you want to draw and
press Enter.
The command line prompts you to specify the center point of the
polygon.

Specify center of polygon or [Edge]:
You can use the Edge option to draw a polygon by specifying one side,

instead of the center and radius of an imaginary inscribed or circum-
scribed circle. The imaginary circle method is much more common.

4. Specify the center point by clicking a point or typing coordinates.

The command line prompts you to specify whether the polygon will be
inscribed in (that is, the corners touch the circumference of the circle) or
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circumscribed about (that is, the sides are tangent to the circle) an imagi-
nary circle whose radius you will specify in the following step:

Enter an option [Inscribed in circle/Circumscribed
about circle] <I>:

. Type I or C and press Enter.

The command line prompts you to specify the radius of imaginary circle.

Specify radius of circle:

. Specify the radius by typing a distance or clicking a point.

AutoCAD draws the polygon.

If you type a distance or you click a point with ortho turned on, the poly-
gon will be aligned orthogonally, as shown in Figure 6-5.

Figure 6-5 shows the results of drawing plenty of polygons — a practice
known as polygony, which, as far as we know, is still legal everywhere.

RS
o O ()

(Throwing) Curves

Although straight-line segments predominate in many CAD drawings, even
the most humdrum, rectilinear design is likely to have a few curves. And if
you’re drawing car bodies or Gaudi buildings, your drawings will be almost
nothing but curves! This section shows you how to use the following
AutoCAD curve-drawing commands:
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v CIRCLE (C): Draws circles (you were expecting rectangles, maybe?).

v ARC: Draws circular arcs — arcs cut from circles, not from ellipses,
parabolas, or some other complicated curve.

v ELLIPSE (EL): Draws ellipses and elliptical arcs.

v SPLINE (SPL): Draws smoothly flowing curves of a variety of shapes.

v DONUT: Draws filled-in annular rings and circles.

v REVCLOUD: Draws free-form “clouds,” the most common application of

which is to indicate revised areas in the drawing.

The following sections describe each command.

Going full circle

AutoCAD offers an easy way to draw circles, and it also offers . . . other ways.
The easy way is to define the center point of the circle and then to define the
radius or diameter. You can also define a circle by entering one of the follow-
ing options of the command (for those other ways):

v 3P (3-Point): Specify any three points on the circumference.
v 2P (2-Point): Specify the endpoints of a diameter of the circle.

v Ttr (Tangent-Tangent-Radius): Specify two lines or other objects that
are tangent to the circle and then specify its radius.

Whether these additional circle-drawing methods are useful or superfluous
depends on the kinds of drawings that you make and how geometry is
defined in your industry. Get familiar with the default center point/radius
method and then try the other methods to see whether they may be helpful
to you. If you find yourself going around in circles, you can always draw them
the default way and move them into position with other geometry.

1. Set the desired layer current, and set other object properties that you
want applied to the circle that you’ll draw.
2. Click the Circle button on the Draw toolbar.

AutoCAD starts the CIRCLE command and prompts you to specify the
center point of the circle. Press the down arrow on your keyboard to see
the options at the dynamic cursor. The command line shows:

Specify center point for circle or [3P/2P/Ttr (tan tan
radius) ] :

The prompts show the methods other than “center point plus radius”
that you can use to draw circles in AutoCAD. (No, tan tan radius is
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not a mathematician’s dance.) Look up “CIRCLE command” in the online
help if you think you may have a use for these less common circle-drawing
methods.

. Specify the center point by clicking a point or typing coordinates.

Use one of the precision techniques described in Chapter 5 if you're
doing real drafting. Object snap, snap, and typing coordinates all work
well for specifying the center point.

AutoCAD then prompts you to specify the circle’s radius.
Specify radius of circle or [Diameter]:

Type D and press Enter if you prefer to enter the diameter rather than
the radius and you’ve forgotten your two-times tables — or, more seri-
ously, if the diameter is easier to specify with the cursor or to type
exactly than the radius is.

. Specify the radius by typing a distance or clicking a point.

AutoCAD draws the circle, as shown in Figure 6-6.

S,

Cen.-Rad.

2Point

3Point
¥
)

|
Ttr

Arc-y-ology

Arcs in AutoCAD are, quite simply, pieces of circles. As with circles, AutoCAD
offers you an easy way to define arcs. Just specify three points on-screen to
define the arc, easy as one-two-three. These points tell AutoCAD where to
start the arc, how much to curve it, and where to end it.
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Sounds pretty easy, right? So where’s the problem? The trouble is that you
often must specify arcs more exactly than is possible by using this method.
AutoCAD helps you specify such arcs, too, but the procedure ain’t easy.

You can start your arc by specifying the center of the arc or the start point.
If you choose the Center option, AutoCAD prompts you for the center point
first and the start point second. AutoCAD defines arcs counterclockwise, so
pick a start point in a clockwise direction from the end point. After you spec-
ify the center and start point, AutoCAD presents several options you can
choose, including the following:

v~ Angle: This option specifies the included angle that the arc sweeps out.
A 180-degree angle, for example, is a semicircle.

v Length of chord: This option specifies the length of an imaginary
straight line connecting the endpoints of the arc. Most people use this
option seldom or never.

v Endpoint: This option specifies where the arc ends. It’s the default
option and is often the easiest to use.

If you specify the start point as the first option, you can choose among the
following three command line options as well:

v Center: This option prompts you for the arc’s center point and then fin-
ishes with the three options listed previously.

v End: This option specifies the endpoint of the arc. You then need to define
the angle the arc covers, its direction, its radius, or its center point.

v Second point: This is the default option. The second point you choose is
not the endpoint; instead, it’s a point on the arc that, along with the start
and endpoints, defines how much the arc curves. After you enter the
second point, you must enter an endpoint to complete the arc.

To get a feel for how these permutations can be strung together to create dif-
ferent arc-drawing methods, choose Draw=>Arc and look at the impressive
submenu that unfurls, as shown in Figure 6-7.

The following example shows how you draw an arc with the default start
point/second point/endpoint method:

1. Set the desired layer current, and set other object properties that you
want applied to the arc that you’ll draw.
f,. 2. Click the Arc button on the Draw toolbar.

AutoCAD starts the ARC command and prompts you to specify the first
endpoint of the arc. The command line shows:

Specify start point of arc or [Center]:
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3. Specify the start point by clicking a point or typing coordinates.
AutoCAD prompts you to specify a second point on the arc.
Specify second point of arc or [Center/End]:

4. Specify a second point on the arc by clicking a point or typing
coordinates.

P The second point lies somewhere along the curve of the arc. AutoCAD
determines the exact curvature of the arc after you choose the final end-
point in the following step. To align the second point with an existing
object, use an object snap mode.

AutoCAD prompts you to specify the other endpoint of the arc; as you
move the cursor around, AutoCAD shows how the arc will look.

Specify end point of arc:

5. Specify the other endpoint of the arc by clicking a point or typing
coordinates.

AutoCAD draws the arc, as shown in Figure 6-7.
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As you may recall, pressing Enter repeats the last command. What often
throws new AutoCAD users is that Enter does not repeat the options of the
last command. If you go through the command prompts or the Draw menu to
draw an arc using the Center, Start, End option, for example, pressing Enter is
not going to repeat that method — it’s going to repeat the ARC command in
its default form, and the three points you pick will probably not give you the
arc you meant to draw.

Solar ellipses

An ellipse is like a warped circle with a major (long) axis and a minor (short)
axis. These axes determine the ellipse’s length, width, and degree of curva-
ture. An elliptical arc is an arc cut from an ellipse.

The AutoCAD ELLIPSE command provides a straightforward way of drawing
an ellipse: You specify the two endpoints of one of its axes and then specify
an endpoint on the other axis. But like the ARC command, the ELLIPSE com-
mand offers a bunch of other options:

v Arc: This option generates an elliptical arc, not a full ellipse. You define
an elliptical arc just as you do a full ellipse. The following methods for
creating an ellipse apply to either.

v Center: This option requires that you define the center of the ellipse and
then the endpoint of an axis. You can then either enter the distance of
the other axis or specify that a rotation around the major axis defines
the ellipse. If you choose the latter, you can enter (or drag the ellipse to)
a specific rotation for the second axis that, in turn, completely defines
the ellipse.

v Rotation: With this option, you specify an angle, which defines the cur-
vature of the ellipse — small angles make fat ellipses (0 degrees creates
a circle, in fact), and large angles make skinny ellipses. The name of the
option, Rotation, has something to do with rotating an imaginary circle
around the first axis. If you can figure out the imaginary circle business,
then you have a better imagination than we do.

The following command line example creates an ellipse by using the default
endpoints of the axes method. Figure 6-8 shows an ellipse and an elliptical arc.

Command: ELLIPSE

Specify axis endpoint of ellipse or [Arc/Center]: pick or
type the first endpoint of one axis

Specify other endpoint of axis: pick or type the other
endpoint of one axis

Specify distance to other axis or [Rotation]: pick or type
the endpoint of the other axis

www.it-ebooks.info


http://www.it-ebooks.info/

152

TE(,‘/, %,

Part II: Let There Be Lines

A\

|
Figure 6-8:
An ellipse
and

elliptical

arc.
|

You can create elliptical arcs (as opposed to the circular arcs that the
AutoCAD ARC command draws) by using the Arc option of the ELLIPSE com-
mand; it’s perfect for drawing those cannonball trajectories! Alternatively,
you can draw a full ellipse and use the TRIM or BREAK command to cut a
piece out of it.

L.

Splines: The sketchy, sinuous curves

Most people use CAD programs for precision drawing tasks: straight lines,
carefully defined curves, precisely specified points, and so on. AutoCAD is not
the program to free your inner artist — unless your inner artist is Mondrian.
Nonetheless, even meticulously created CAD drawings sometimes need free-
form curves. The AutoCAD spline object is just the thing for the job.

You can use AutoCAD splines in two ways:

v~ Eyeball the location and shape of the curve and don’t worry too much
about getting it just so. That’s the free-form, sketchy, not-too-precise
approach that we describe here.

v Specify their control points and curvature characteristics precisely.

Beneath their easygoing, informal exterior, AutoCAD splines are really highly
precise, mathematically defined entities called NURBS curves (NonUniform
Rational B-Spline curves). Mathematicians and some mechanical and indus-
trial designers care a lot about the precise characteristics of the curves they
work with. For those people, the AutoCAD SPLINE and SPLINEDIT (SPL) com-
mands include a number of advanced options. Look up “spline curves” in the
AutoCAD online help if you need precision in your splines.
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Drawing splines is straightforward, if you ignore the advanced options. The
following procedure draws a free-form curve with the SPLINE command:

1. Set the desired layer current, and set other object properties that you
want applied to the spline that you’ll draw.
(\J 2. Click the Spline button on the Draw toolbar.

AutoCAD starts the SPLINE command and prompts you to specify the
first endpoint of the spline. The command line shows:

Specify first point or [Object]:
3. Specify the start point by clicking a point or typing coordinates.
AutoCAD prompts you to specify additional points.
Specify next point:
4. Specify additional points by clicking or typing coordinates.

After you pick the second point, press the down-arrow key to display
additional options at the dynamic cursor. The command line shows:

Specify next point or [Close/Fit tolerance] <start

tangent>:
\\J ]

Because you’re drawing a free-form curve, you usually don’t need to use
object snaps or other precision techniques when picking spline points.

5. Press Enter after you’ve chosen the final endpoint of your spline.
AutoCAD prompts you to specify tangent lines for each end of the spline.

Specify start tangent:
Specify end tangent:

The Specify start tangent and Specify end tangent prompts
can control the curvature of the start and end points of the spline. In
most cases, just pressing Enter at both prompts to accept the default
tangents works fine.

6. Press Enter twice to accept the default tangent directions.
AutoCAD draws the spline.

Figure 6-9 shows some examples of splines.

A\\S

After you've drawn a spline, you can grip edit it to adjust its shape. See
Chapter 7 for information about grip editing. If you need finer control over
spline editing, look up the “SPLINEDIT” command in the AutoCAD online help.
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Donuts: The circles with a difference

Creating a donut is a simple way to define a single object that consists of two
concentric circles with the space between them filled.

When you start the DONUT command, AutoCAD prompts you for the inside
diameter and the outside diameter — the size of the hole and the size of the
donut, as measured across their widest points. After you’'ve entered these
values, AutoCAD prompts you for the center point of the donut. But one
donut is rarely enough, so AutoCAD keeps prompting you for additional
center points until you press Enter (the AutoCAD equivalent of saying, “no
really, I'm full now!”).

The following example draws a regulation-size donut, with a 1.5-inch hole and
3.5-inch outside diameter. Figure 6-10 shows two kinds of donuts.

Command: DONUT

Specify inside diameter of donut <0.5000>: 1.5

Specify outside diameter of donut <1.0000>: 3.5

Specify center of donut or <exit>: pick or type the center
point of one or more donuts

Specify center of donut or <exit>:

You can use the DONUT command to create a filled circle — also known as a
jelly-filled donut. Just specify an inside diameter of 0.

Revision clouds on the horizon

It’s customary in many industries to submit a set of drawings at a stage of
completion and then submit them again later with revisions — corrections,
clarifications, and requested changes. Often, the recipients like to locate
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Figure 6-10:
Donuts,
plain and
jelly-filled.
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changed stuff easily. A common drafting convention in many industries is to
call attention to revised items by drawing free-form clouds around them. The
REVCLOUD command makes quick work of drawing such clouds.

Plain Jelly-Filled

Drawing revision clouds is easy, after you understand that you click with the
mouse only once in the drawing area. That one click defines the starting
point for the cloud’s perimeter. After that, you simply move the cursor
around, and the cloud takes shape. When you return to near the point that
you clicked in the beginning, AutoCAD automatically closes the cloud.

The following command line example shows you how to draw a revision
cloud. Figure 6-11 shows what revision clouds look like.

Command: REVCLOUD

Minimum arc length: 0.5000 Maximum arc length: 0.5000
Style: Normal

Specify start point or [Arc length/Object/Style] <Object>:
pick a point along the perimeter of your future
cloud

Guide crosshairs along cloud path... sweep the cursor
around to define the cloud's perimeter

You don’t need to click again. Simply move the cursor around without click-
ing. AutoCAD draws the next lobe of the cloud when your cursor reaches the
Minimum arc length distance from the end of the previous lobe.

Continue moving the cursor around until you return to the point where you
clicked first.

Revision cloud finished.
Here are a few tips for using revision clouds:

v It’s a good idea to put revision clouds on their own layer so that you can
choose to plot with or without the clouds visible.
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v You'll probably find it easier to control the shape of revision clouds if
you turn off ortho mode before you start the command.

v You may need to add a triangle and number, as shown in Figure 6-11, to
indicate the revision number. A block with an attribute is a good way
to handle this requirement: Chapter 14 covers blocks and attributes.

If the revision cloud’s lobes are too small or too large, erase the cloud, restart
the REVCLOUD command, and use the command’s Arc Length option to
change the minimum and maximum arc lengths. The default minimum and
maximum lengths are 0.5 (or 15 in metric drawings) multiplied by the DIM-
SCALE (DIMension SCALE) system variable setting. If you make the minimum
and maximum lengths equal (which is the default), the lobes will be approxi-
mately equal in size. If you make them unequal, there will be more variation
in lobe size — you’ll get “fluffier” clouds. Fortunately, all of these options are
more than most nonmeteorologists will need. If you've set DIMSCALE prop-
erly during your drawing setup procedure (see Chapter 4), REVCLOUD
should do a pretty good job of guessing reasonable default arc lengths.

A A

Min. arc length = 0.5 Min. arc length = 0.5 Min. arc length = 1.0
Max. arc length = 0.5 Max. arc length = 1.0 Max. arc length = 1.0

Scoring Points

WING/
&

We thought about not covering points in this book, but we didn’t want you
complaining that AutoCAD 2007 For Dummies is pointless.

The word point describes two different things in AutoCAD:

v A location in the drawing that you specify (by typing coordinates or
clicking with the mouse)

v An object that you draw with the POINT (PO) command
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Throughout this chapter and most of the book, we tell you to specify points —
that’s the location meaning. This section tells you how to draw point objects.

A point object in AutoCAD can serve two purposes:

v~ Points often identify specific locations in your drawing to other people
who look at the drawing. A point can be something that displays on the
screen, either as a tiny dot or as another symbol, such as a cross with a
circle around it.

+ You can use points as precise object snap locations. Think of them as
construction points. For example, when you're laying out a new building,
you might draw point objects at some of the engineering survey points
and then snap to those points as you sketch the building’s shape with
the polyline command. You use the NODe object snap mode to snap to
AutoCAD point objects. In this guise, points usually are for your use in
drawing and editing precisely. Other people who view the drawing prob-
ably won’t even be aware that the point objects are there.

What makes AutoCAD point objects complicated is their almost limitless range
of display options, provided to accommodate the two different kinds of pur-
poses just described (and possibly some others that we haven’t figured out
yet). You use the Point Style dialog box, shown in Figure 6-12, to specify how
points should look in the current drawing.

DDPTYPE is the command that opens the Point Style dialog box. You can
access it from the menus by choosing Format=>Point Style. The top portion of
the dialog box shows the available point display styles. Most of the choices
do pretty much the same thing. Just click one of the squares that says “hey,
that’s a point!” to you.

LI
Figure 6-12: e EENE = ® -
The Point sl ol

Style dialog H
box controls e '
the way ” E .
point T
objects || ¥
appear on- I

screen. || f— ¢
— (T W Moo o T ]
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The first choice, a single-pixel dot, is hard to see on the screen, and the second
choice, invisible (a stealth point?), is impossible to see. Avoid these choices if
you want your point objects to show up on the screen and on plots. The single-
pixel dot, which is the default display style, works well if you use point objects
as object snap locations and don’t want the points obtrusive on plots.

The remaining settings in the Point Style dialog box control the size at which
points appear on the screen at different zoom resolutions. The default set-
tings often work fine, but if you're not satisfied with them, click the Help
button to find out how to change them.

After you specify the point style, placing points on-screen is easy; the follow-
ing example shows you how.

Command: POINT

Current point modes: PDMODE=0 PDSIZE=0.0000

Specify a point: pick or type the coordinates of a
location in the drawing

PDMODE and PDSIZE in the command prompt are system variables that cor-
respond to the point display mode and display size options in the Point Style
dialog box. If you want to know exactly how the system variables correspond
to the dialog box choices, you have all the makings of a successful CAD nerd.
Click the Help button in the Point Style dialog box to find out more (about the
system variables — not about yourself).

If you start the POINT command from the Draw toolbar or the Draw>Point=>
Multiple Point menu, it will repeat automatically — that is, the command line
will prompt you repeatedly to Specify a point. When you're finished
drawing points, press Esc to finish the command for good. If the command
doesn’t repeat automatically and you want to draw more points, press the
Enter key to repeat the POINT command and pick another location on the
screen. Repeat as required: Enter, pick, Enter, pick, Enter pick . . . by now you
should’ve gotten the point.
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Edit for Credit

In This Chapter

Using command-first editing

Selecting objects with maximum flexibility
Moving, copying, and stretching objects
Manipulating whole objects

Changing pieces of objects

Editing with grips

Editing object properties

Ejiting objects is the flip side of creating them, and in AutoCAD, you
spend a lot of time editing — far more than drawing objects from
scratch. That’s partly because the design and drafting process is by its
nature repetitive, and also because CAD programs make it easy to edit
objects cleanly.

‘X@N\BEH When you edit objects in AutoCAD, you need to be just as concerned about
& specifying precise locations and distances as you are when you originally
create the objects. Make sure that you're familiar with the precision tech-

niques described in Chapter 5 before you apply the editing techniques from
this chapter to real drawings.

Commanding and Selecting

AutoCAD offers two main styles of editing:

v Command-first editing

v Selection-first editing
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Within the selection-first editing style, you have an additional choice of edit-
ing that uses actual, named commands and direct manipulation of objects
without named commands. The following sections cover these editing styles.

AutoCAD refers to command-first editing as verb-noun editing, and to selec-
tion-first editing as noun-verb editing. When you see this terminology — for
example, in the Options dialog box or the online help system — don’t worry,
you haven’t dropped back into your fifth-grade English class!

Command-first editing

With command-first editing, you enter a command and then click the objects
on which the command works. This style of editing may seem backwards to
you at first unless you're a longtime user of AutoCAD. Command-first editing
works well for power users who are in a hurry and who are willing to memo-
rize most of the commands they need to do their work. It’s also the only way
to use some of the editing commands. It’s no surprise that command-first
editing is the default style of editing in AutoCAD.

Selection-first editing

In selection-first editing, you perform the same steps — in the same order —
as in most Windows applications: Select the object first, and then choose the
command.

Selection-first editing tends to be easier to master and makes AutoCAD more
approachable for new and occasional users.

Direct manipulation is a refinement of selection-first editing in which you per-
form common editing operations by using the mouse to grab the selected
object and perform an action on it, such as moving all or part of it to a differ-
ent place in the drawing. No named command is involved; the act of moving
the mouse and clicking the mouse buttons in certain ways causes the editing
changes to happen. AutoCAD supports direct manipulation through a power-
ful but somewhat complicated technique called grip editing. Grips are the
little square handles that appear on an object when you select it. You can use
the grips to stretch, move, copy, rotate, or otherwise edit the object. These
grip-editing techniques can make selection-first editing almost as powerful as
command-first editing.
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Choosing an editing style

This chapter emphasizes command-first editing. (We also discuss grip editing
at the end of the chapter.) AutoCAD is fundamentally a command-first pro-
gram. AutoCAD started out offering only command-first editing and later
added selection-first methods; AutoCAD 2007 inherits this ancestral trait. We
emphasize command-first editing for the following reasons:

v It’s the default AutoCAD editing style.

v It works consistently with all editing commands — some editing com-
mands remain command-first only.

v~ It provides added object selection flexibility, which is useful when you
work on complicated, busy drawings.

After you know how to do command-first editing, you can simply reverse the
order of many editing operations to do them selection-first style instead. But
if you don’t get familiar with command-first editing in the beginning, you’ll be
completely bewildered by some very useful AutoCAD commands that work
only in the command-first style, such as FILLET (F) and STRETCH (S).
(Commands such as these ignore any already selected objects and prompt
you to select objects.)

Much of the information in this chapter assumes that you're using the default
AutoCAD selection settings. If object selection or grip editing works differ-
ently than we describe in this chapter, check the settings on the Options
dialog box’s Selection tab. The seven check box settings listed next and
shown in Figure 7-1 should be turned on. (All other check box settings should
be turned off.)

v~ Selection Preview When a Command Is Active

v Selection Preview When No Command Is Active

v Noun/Verb Selection

v Implied Windowing

v Object Grouping

v Enable Grips

v Enable Grip Tips
For information on what these options do, click the small question mark

button beside the Close button at the top-right corner of the Options dialog
box, and then click one of the options.
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Part of AutoCAD’s editing flexibility comes from its object selection flexibility.
For example, command-first editing offers 16 selection modes! (We describe
the most useful ones in this chapter.) Don’t worry though; you can get by
most of the time with three selection modes:

v Selecting a single object

v Enclosing objects in a window selection box (pick left corner and then
right corner)

v Including part or all objects in a crossing selection box (pick right
corner and then left corner)

One-by-one selection

The most obvious way to select objects is to pick (by clicking) them one at a
time. You can build up a selection set cumulatively with this pick-one-object-
at-a-time selection mode, but this cumulative convention may be different
from what you're used to. In most Windows programs, if you select one
object and then another, the first object is deselected, and the second one
selected. Only the object you select last remains selected. In AutoCAD, all the
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objects you select, one at a time, remain selected and are added to the selec-
tion set, no matter how many objects you pick. (You can change this behav-
ior to make AutoCAD work like Windows does by turning on the Use Shift to
Add to Selection option on the Option dialog box’s Selection tab, but we sug-
gest that you don’t change it.) Most editing commands affect the entire group
of selected objects.

Selection boxes left and vight

Selecting objects one at a time works great when you want to edit a small
number of objects, but many CAD editing tasks involve editing lots of objects.
Do you really want to pick 132 lines, arcs, and circles, one at a time?

Like most Windows graphics programs, AutoCAD provides a selection
window feature for grabbing a bunch of objects in a rectangular area. As you
may guess by now, the AutoCAD version of this feature is a bit more powerful
than the similar feature in other Windows graphics programs and, therefore,
slightly confusing at first. AutoCAD calls its version implied windowing.

If you click a blank area of the drawing — that is, not on an object — you’re
implying to AutoCAD that you want to specify a selection window, or box. If
you move the crosshairs to the right before picking the other corner of the
selection box, you're further implying that you want to select all objects that
reside completely within the selection box. If you move the crosshairs to the
left before picking the other corner of the selection box, you're implying that
you want to select all objects that reside completely or partially within the
selection box.

The AutoCAD terminology for these two kinds of selection boxes gets a little
confusing:

v The move-to-the-right, only-select-objects-completely-within-the-box
mode is called window object selection.
v The move-to-the-left, select-objects-completely-or-partially-within-the-

box mode is called crossing object selection.

Fortunately, AutoCAD gives you visual cues that there’s a difference. As you
move to the right, the window box appears as a rectangle with blue fill and a
solid border. As you move to the left, the crossing box appears as a rectangle
with green fill and a dashed border.

Figures 7-2 and 7-3 show a window box and a crossing box in action.
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Selection box

You can mix and match selecting individual objects, specifying a window box,
and specifying a crossing box. Each selection adds to the current selection
set, allowing you to build up an enormously complicated selection of objects
and then operate on them with one or more editing commands.

You can press the Shift key in combination with any of the three standard
selection modes — single object, window box, and crossing box — to remove
already selected objects from the selection set. This feature is especially
useful when you’re building a selection set in a crowded drawing; you can
select a big batch of objects by using Window or Crossing, and then hold
down the Shift key while selecting to remove the objects that you want to
exclude from the editing operation.

WWW.
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Perfecting Selecting

N

When you edit in command-first mode, you have all the selection options
described in the previous section — single object, window box, and crossing
box — plus a slew of others. If you type ? and press Enter at any Select
objects prompt, AutoCAD lists all the selection options at the command
line.

Window/Last/Crossing/BOX/ALL/Fence/WPolygon/CPolygon/
Group/ Add/Remove/Multiple/Previous/Undo/AUto/
SIngle/SUbobject/Object

Subobject and Object are new selection objects in AutoCAD 2007 (but not

AutoCAD LT), but they apply specifically to 3D solids. For more information
on working in 3D, see Chapter 9.
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Pressing ? at a Select objects prompt has no impact on the dynamic
input crosshairs display. You can see the options if you press the F2 key, but
that takes a lot more screen space than the command line window. If your
command line area is not visible, type COMMANDLINE and press Enter, or
use the Ctrl+9 key combination to turn it on.

Table 7-1 summarizes the most useful command-first selection options.

Table 7-1 Some Useful Command-First Selection Options

Option Description

Window All objects within a rectangle that you specify by picking two points

Last The last object you drew that's still visible in the drawing area

Crossing AII objects_within or crossing a rectangle that you specify by pick-
ing two points

ALL All objects on layers that aren’t frozen or locked, and that are in the

current space (model space or paper space)

Fence All objects touching an imaginary polyline whose vertices you
specify by picking points

WPolygon All objects within a polygonal area whose corners you specify by
picking points

CPolygon All objects within or crossing a polygonal area whose corners you
specify by picking points

Previous The previous selection set that you specified

To use any of the command-first selection options at the Select objects
prompt, type the uppercase letters corresponding to the option and press
Enter. After you're finished selecting objects, you must press Enter again to
tell AutoCAD that you've finished selecting objects and want to start the edit-
ing operation.

AutoCAD’s Selection preview features (new in AutoCAD 2006) remove any
doubt about which objects you're selecting. Rollover highlighting displays indi-
vidual objects with a thick dashed lineweight as the crosshairs are moved
over them. Area selection displays a transparent, colored highlight over multi-
ple selections using window and crossing options. You can enable and disable
both features on the Selection tab of the Options dialog box (see Figure 7-1).
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The following example demonstrates how to use the ERASE (E) command in
command-first mode with several different selection options. The selection
techniques used in this example apply to most AutoCAD editing commands.

1.

Press Esc to make sure that no command is active and no objects are
selected.

If any objects are selected when you start an editing command, the com-
mand, in most cases, will operate on those objects (selection-first edit-
ing) instead of prompting you to select objects (command-first editing).
For the reasons that we describe earlier in this chapter, you should use
the command-first editing style until you're thoroughly familiar with it.
Later, you can experiment with selection-first editing if you like. (Just
reverse the sequence of commanding and selecting that we describe in
this chapter.)

. Click the Erase button on the Modify toolbar.

AutoCAD displays the select objects prompt at the command line
and the dynamic input tooltip.

. Select two or three individual objects by clicking each one.

AutoCAD adds each object to the selection set. All the objects you select
remain ghosted. AutoCAD displays the Select objects prompt.

. Specify a window selection box that completely encloses several

objects.

Move the crosshairs to a point below and to the left of the objects, click,
release the mouse button, move the crosshairs above and to the right of
the objects, and click again.

All objects that are completely within the box are selected.

. Specify a crossing selection box (Crossing) that encloses a few objects

and cuts through several others.

Move the crosshairs to a point below and to the right of some of the
objects, click, release the mouse button, move the crosshairs above and
to the left of some of the objects, and click and release again.

All objects that are completely within or cross through the box are
selected.

. Type WP and press Enter to activate the WPolygon selection option.

AutoCAD prompts you to pick points that define the selection polygon.

. Pick a series of points and press Enter.

Figure 7-4 shows an example. After you press Enter, AutoCAD selects all
objects that are completely within the polygon.

. Press Enter to end object selection.

AutoCAD erases all the selected objects.
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Notice how you were able to use a combination of object selection methods
to build up a selection set and then press Enter to execute the command on
the selected objects. Most AutoCAD editing commands work this way in
command-first mode.

If, after erasing a selection set, you immediately realize that you didn’t really
mean to do away with so many objects, you can use the Undo button on the
Standard toolbar to restore all of them. But AutoCAD has one additional
unerase trick up its sleeve — the aptly named OOPS command. When you
type OOPS and press Enter, AutoCAD restores the last selection set that you
erased — even if you’'ve run other commands after ERASE.

Ready, Get Set, Edit!

The following sections cover the most important AutoCAD editing com-
mands, using command-first editing mode.

Table 7-2 offers an overview of AutoCAD’s most frequently used editing com-

mands. We list their major options and show you how to run the commands
using the toolbars, the menu, or the keyboard.
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Table 7-2 AutoCAD Modify Commands
Button  Command  Major Options Toolbar  Modify
Button Menu
(ﬁ ERASE — Erase Erase
oy COPY Base point, Displacement Copy Copy
A|h MIRROR Keep/Erase source objects Mirror Mirror
OFFSET Distance, through point, Offset Offset
(& erase, layer
OO  ARRAY Rectangular, polar Array Array
oo
] MOVE Base point, Displacement Move Move
ROTATE Specify angle, reference angle,  Rotate Rotate
c ) copy
______ SCALE Scale factor, reference, copy Scale Scale
—;x STRETCH Base point, displacement Stretch Stretch
LENGTHEN Delta, percent, total, dynamic None Lengthen
/ TRIM Projection, edge Trim Trim
/ EXTEND Projection, edge Extend Extend
BREAK At point, second point, Break Break
| | pick two points
JOIN Select lines, arcs, splines, Join Join
>4 polylines, elliptical arcs
(— CHAMFER  Distance, angle, polyline, multiple Chamfer  Chamfer
(continued)
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Table 7-2 (continued)

Button  Command  Major Options Toolbar  Modify
Button Menu

7  FILLET Radius, polyline, multiple Fillet Fillet

’;.{; EXPLODE Select objects Explode  Explode

Whether you start an AutoCAD editing command by clicking a toolbar
button, choosing a pull-down menu command, or typing a command name, in
almost all cases, the command prompts you for points, distances, and
options at the command line. Read the prompts during every step of the com-
mand, especially when you’re figuring out how to use a new editing com-
mand. Otherwise, you're unlikely to complete the command successfully.

AutoCAD’s dynamic input system displays command options at the
crosshairs. When you see a dynamic input tooltip with an up/down arrow
icon, press the down-arrow key on the keyboard to display the command
options in a menu. You then can use the mouse to select an option (see
Figure 7-5). Pressing the up-arrow key displays previous input.

W AutaCAD 2007 - [Drawingf.dwg) =%
‘% File Edit View Insert Format Tools Draw Dimension Modify Express Window Help -8 %
DWH&ARS D0 »F XXX RNEHIUE @ |5 il 4
EW||= VO% e £ ||m B — —_—
s &
g i
=5 db
o L
= 88
s 4
@ 4]
8 3
~ [y
& o
>
= =l
- L1
. -
24 4
4 .
S o’
i ]
A !
V W
A -
I r
— A
WAk [ W Medd flavou] .‘L«ﬂ;u.IZf'
Co d: CFF3ET -
Cur t gectinga: Erase source=Ne Layer=Source OFFSETGAPTIFE=0D
v
Specify offaet diatance or /Erase/Layer] <Through>: < >
64,2721, 32 4132, 0.0000 SHAF| GRID! ORTHD| POLAR| 0SHAF) OTRACK] DUCS| [oen LWT [MonE ' d* . [0

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 7: Edit for Credit

MBER
@&
&

As we describe in Chapter 5, maintaining precision when you draw and edit is
crucial to good CAD work. If you've used a drawing program and are accus-
tomed to moving, stretching, and otherwise editing objects by eye, you'll
need to suppress that habit when you edit in AutoCAD. Nothing ruins a draw-
ing faster than approximate editing, in which you shove objects around until
they look okay, without worrying about precise distances and points.

The big three: Move, Copy, and Stretch

Moving, copying, and stretching are, for many drafters, the three most
common editing operations. AutoCAD obliges this need with the MOVE (M),
COPY (CO or CP), and STRETCH (S) commands.

Base points and displacements

The MOVE, COPY, and STRETCH commands all require that you specify how
far and in what direction you want the objects moved, copied, or stretched.
After you've selected the objects to be edited and started the command,
AutoCAD prompts you for two pieces of information:

Specify base point or [Displacement] <Displacement>:
Specify second point or <use first point as displacement>:

In a not-so-clear way, these prompts say that two possible methods exist for
you to specify how far and in what direction you want the objects copied,
moved, or stretched:

v The most common way is to pick or type the coordinates of two points
that define a displacement vector. AutoCAD calls these points the base
point and the second point (hence, it’s called the base point method).
Imagine an arrow pointing from the base point to the second point —
that arrow defines how far and in what direction the objects get copied,
moved, or stretched.

v~ The other way is to type an X,Y pair of numbers that represents a dis-
tance rather than a point. This distance is the absolute displacement
that you want to copy, move, or stretch the objects (thus it’s called the
displacement method).

How does AutoCAD know whether your response to the first prompt is a base
point or a displacement? It depends on how you respond to the second
prompt. (Is that confusing, or what?) First, you pick a point on-screen or
enter coordinates at the Base point prompt. Next, there are a couple of
possibilities:

v If you then pick or type the coordinates of a point at the second point
prompt, AutoCAD says to itself, “Aha — displacement vector!” and
moves the objects according to the imaginary arrow pointing from the
base point to the second point.
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v If you press Enter at the second prompt (without having typed any-
thing), AutoCAD says, “Aha — displacement distance,” and uses the X,Y
pair of numbers that you typed at the first prompt as an absolute dis-
placement distance.

What makes this displacement business even more confusing is that
AutoCAD lets you pick a point at the first prompt and press Enter at the
second prompt. AutoCAD still says, “Aha — displacement distance,” but now
it treats the coordinates of the point you picked as an absolute distance. If
the point you picked has relatively large coordinates, the objects can get
moved way outside the normal drawing area as defined by the limits. The
objects fly off into space, and you probably won’t notice at first because
you’re zoomed into part of your normal drawing area; it just looks to you like
the objects have vanished! In short, be careful when you press Enter during
the MOVE, COPY, and STRETCH commands. Press Enter in response to the
second prompt only if you want AutoCAD to use your response to the first
prompt as an absolute displacement. If you make a mistake, click the Undo
button to back up and try again. You can use Zoom Extents (described in
Chapter 8) to look for objects that have flown off into space.

Move

The following steps demonstrate command-first editing with the MOVE com-
mand, using the base point method of indicating how far and in what direc-
tion to move the selected objects. This procedure also gives detailed
recommendations on how to use precision techniques when you edit.

1. Press Esc to make sure that no command is active and no objects are
selected.

2. Click the Move button on the Modify toolbar.
The command line displays the Select objects prompt.

3. Select one or more objects.

You can use any of the object selection techniques described in the
“Perfecting Selecting” section, earlier in this chapter.

4. Press Enter when you’re finished selecting objects.
AutoCAD displays the following prompt:
Specify base point or [Displacement] <Displacement>:
5. Specify a base point by clicking a point or typing coordinates.

This point serves as the tail end of your imaginary arrow indicating how
far and in what direction you want the objects moved. After you pick a
base point, it’s fairly easy to see what’s going on because AutoCAD dis-
plays a temporary image of the object that moves around as you move
the crosshairs. Figure 7-6 shows what the screen looks like.
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Displacement

Specify a base point somewhere on or near the object(s) that you're
moving. You can use an object snap mode to choose a point exactly on
one of the objects.

AutoCAD displays the following prompt:

Specify second point or <use first point as
displacement>:

6. Specify the second point by clicking a point or typing coordinates.

The second point serves as the arrow end of your imaginary displacement
arrow. After you specify the second point, AutoCAD moves the objects.

Don’t press Enter alone at this prompt! If you do, AutoCAD treats the X,Y
coordinates of the first point you picked as an absolute displacement,
and the objects fly off in an unpredictable fashion. We repeat: Don’t press
Enter alone at this prompt! Pressing Enter without picking a point or
typing coordinates at this prompt is one of the most common errors new
AutoCAD users make, and it can really pollute your drawing with
unwanted objects.
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These are common precision techniques for specifying the second point:

v Use an object snap mode to pick a second point exactly on another
object in the drawing.

v Type a relative or polar coordinate, as described in Chapter 5. For exam-
ple, if you type @6,2, AutoCAD moves the objects 6 units to the right and
2 units up. If you type @3<45, AutoCAD moves the objects 3 units at an
angle of 45 degrees.

Use direct distance entry to move objects in an orthogonal or polar tracking
direction. See Chapter 5 for instructions.

Copy

The COPY command works almost identically to the MOVE command, except
that AutoCAD leaves the selected objects in place and moves new copies of
them to the new location. The COPY command creates multiple copies by
default. If you want only one copy, press Enter after placing it in the drawing.

The COPY command includes an Undo option with which you can roll back
multiple copies within a single COPY operation.

Copy between drawings

You can’t copy objects from one drawing to another with the COPY com-
mand. Instead, you use the COPYCLIP command, together with its companion
command, PASTECLIP.

COPYCLIP and PASTECLIP use the Windows clipboard to store temporarily
drawing objects from one file so they can be pasted into another file. The
Standard toolbar contains Cut, Copy, and Paste tools, the three standard clip-
board buttons you find in every Windows program.

It’s easy to confuse the COPY and COPYCLIP commands, especially since
AutoCAD calls them both Copy in its menus.

v COPY is AutoCAD’s primary command for copying objects within a
drawing. Choose Copy on the Modify menu for this command.

v COPYCLIP — along with related commands like CUTCLIP and
PASTECLIP — is AutoCAD’s version of copy and paste via the Windows
Clipboard. Choose Copy on the Edit menu for this command.

(You can use the Windows Clipboard cut-and-paste method to copy or move

objects within a single drawing, but using the AutoCAD COPY and MOVE
commands usually gives you better control and precision.)
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Table 7-3 summarizes AutoCAD’s Clipboard-related commands, along with the
equivalent choices on the right-click menu and the Standard toolbar.

Table 7-3 AutoCAD Clipboard Commands
Crosshairs Menu Choice Command Name  Toolbar Button Name
Cut CUTCLIP Cut (Ctrl+X)
Copy COPYCLIP Copy (Ctrl+C)
Copy with Base Point COPYBASE None (Ctrl+Shift+C)
Paste PASTECLIP Paste (Ctrl+V)
Paste as Block PASTEBLOCK None (Ctrl+Shift+V)
Paste to Original Coordinates ~ PASTEORIG None

Stretch

The STRETCH command is superficially similar to COPY and MOVE,; it has
the same inscrutable base point and displacement prompts, and it shifts
objects — or parts of objects — to other locations in the drawing. But it also
has important differences that often confound new AutoCAD users to the
point where they give up trying to figure out how to use STRETCH. That’s a
mistake because STRETCH is a valuable command. With it, you can perform
editing operations in seconds that would take many minutes with other com-
mands. Here are the things you need to know to make STRETCH your friend:

v To use STRETCH, you must select objects by using a crossing selection
box (or crossing polygon), as described in the section, “Perfecting
Selecting,” earlier in this chapter. See Figure 7-7.

Before Stretch After Stretch

\ >
) 1 Disp| ¢
Pick pt. 2 N isplacemen

= Crossing
window
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v STRETCH operates on the defining points of objects — endpoints of a
line, vertices of a polyline, the center of a circle, and so on — according
to the following rule: If a defining point is within the crossing selection
box that you specify, AutoCAD moves the defining point and updates the
object accordingly.

For example, if your crossing selection box surrounds one endpoint of a
line but not the other endpoint, STRETCH moves the first endpoint and
redraws the line in the new position dictated by the first endpoint’s new
location. It’s as though you have a rubber band tacked to the wall with
two pins, and you move one of the pins.

v STRETCH can make lines longer or shorter, depending on your crossing
selection box and displacement vector. In other words, the STRETCH
command really combines stretching and compressing.

v You usually want to turn on ortho or polar tracking mode before stretch-
ing. Otherwise, you'll end up stretching objects in strange directions, as
shown in Figure 7-8.

Before Stretch After Non-Orthogonal Stretch
Pick pt. 1
A
I
|
I
|
|
I
N
1
I
— \ . ,fr
Pick pt. 2 \‘\ Displacement
'— Crossing
window

The following steps describe how to stretch lines:
1. Draw some lines in an arrangement similar to the dark lines shown in
Figure 7-9.

Start your stretching with simple objects. You can work up to more com-
plicated objects — polylines, circles, arcs, and so on — after you’'ve lim-
bered up with lines.

2. Press Esc to make sure that no command is active and no objects are
selected.
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3. Click the Stretch button on the Modify toolbar.

The command line displays the Select objects prompt with a warn-
ing to use the Crossing or CPolygon object selection mode.

Select objects to stretch by crossing-window or
crossing-polygon. ..
Select objects:

4. Specify a crossing selection box that encloses some, but not all, end-
points of the lines.

Figure 7-9 shows a sample crossing selection box that completely
encloses the two vertical lines on the right side of the figure. This cross-
ing selection box cuts through the four horizontal lines, enclosing only
one endpoint of each.

You specify a crossing selection box by picking a point, moving your
mouse to the left, and picking a second point.
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5. Press Enter to end object selection.
AutoCAD displays the following prompt:
Specify base point or [Displacement] <Displacement>:

6. Specify a base point by object snapping to a point on an existing
object or by typing absolute X,Y coordinates.

This step is just like Step 5 in the Move procedure earlier in this chapter.
AutoCAD displays the following prompt:

Specify second point or <use first point as
displacement>:

7. Toggle ortho mode on and then off by clicking the ORTHO button on
the status bar; try moving the crosshairs around first with ortho mode
on and then with it off to see the difference.

Figure 7-9 shows what the screen looks like as you move the crosshairs
around with ortho off.

8. Toggle ortho mode on and then specify the second point — usually by
using direct distance entry, object snapping to a point on an existing
object, or typing relative X,Y coordinates.

This step is just like Step 6 in the Move procedure earlier in this chapter.
After you pick the second point, AutoCAD stretches the objects. Notice
that the STRETCH command moved the two vertical lines because the
crossing selection box contained both endpoints of both lines. STRETCH
lengthened or shortened the four horizontal lines because the crossing
selection box enclosed only one endpoint of each.

The STRETCH command takes some practice, but it’s worth the effort. Draw
some additional kinds of objects and practice stretching with different cross-
ing selection box locations as well as different base points and second points.

More manipulations

The commands in this section — ROTATE (RO), SCALE (SC), ARRAY (AR), and
OFFSET (O) — provide other ways (in addition to MOVE, COPY, and
STRETCH) of manipulating objects or creating new versions of them. The pro-
cedures for each command assume that you're familiar with the object selec-
tion and editing precision techniques presented in the MOVE, COPY, and
STRETCH procedures (see the previous sections in this chapter).

Rotate

The ROTATE command swings one or more objects around a point that you
specify. Follow these steps to use the ROTATE command:
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1. Press Esc to make sure that no command is active and no objects are
selected.

2. Click the Rotate button on the Modify toolbar.
3. Select one or more objects and then press Enter to end object selection.

AutoCAD prompts you for the base point for rotating the selected
objects:

Specify base point:
4. Specify a base point by clicking a point or typing coordinates.

The base point becomes the point about which AutoCAD rotates the
objects. You also have to specify a rotation angle.

Specify rotation angle or [Copy/Reference] <0>:

5. Specify a rotation angle by typing an angle measurement and pressing
Enter, or just press Enter to accept the default value shown in angle
brackets.

Alternatively, you can indicate an angle on the screen by moving the
crosshairs until the Coordinates section of the status bar indicates the
desired angle and then clicking. If you choose this alternative, you will
need to use ortho mode or polar tracking to indicate a precise angle (for
example, 90 or 45 degrees) or an object snap to rotate an object so that
it aligns precisely with other objects.

After you specify the rotation angle by typing or picking, AutoCAD
rotates the objects into their new position. The ROTATE command’s
copy option makes a rotated copy while leaving the source object in
place.

Scale

If you read all our harping on drawing scales and drawing scale factors in
Chapter 4, you may think that the SCALE command performs some magical
scale transformation on your entire drawing. No such luck. It merely uni-
formly scales one or more objects up or down by a factor that you specify.
Here’s how it works:

1. Press Esc to make sure that no command is active and no objects are
selected.

2. Click the Scale button on the Modify toolbar.

3. Select one or more objects and then press Enter to end object selection.

AutoCAD prompts you for the base point about which it will scale all the
selected objects.

Specify base point:
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AutoCAD does not scale each object individually around its own base
point (because most AutoCAD drawing objects don’t have individual
base points). Instead, AutoCAD uses the base point that you specify to
determine how to scale all objects in the selection set. For example, if
you select a circle to scale, pick a point outside the circle as the base
point, and then specify a scale factor of 2, AutoCAD not only makes the
circle twice as big, but also moves the circle twice as far away from the
base point that you specified.

4. Specify a base point by picking a point or typing coordinates.

The base point becomes the point about which the objects are scaled.
AutoCAD prompts you for the scale factor.

Specify scale factor or [Copy/Reference] <1.0000>:
5. Type a scale factor and press Enter.

AutoCAD then scales the objects by the factor that you type, using the
base point that you specified. Numbers greater than one increase the
objects’ sizes. Numbers smaller than one decrease the objects’ sizes.

Just like the ROTATE command, the SCALE command also has a copy option
with which you can make enlarged or reduced duplicates of selected objects
without altering the source objects. And both the SCALE and ROTATE com-
mands remember the last scale factor or rotation angle entered throughout
the drawing session.

Changing the drawing scale factor of a drawing after you've drawn it is a
tedious and complicated process in AutoCAD. In brief, you need to change
the scale-dependent system variables described in Chapter 4, and then scale
some, but not all, drawing objects. You don’t scale the real-world geometry
that you've drawn, because its measurements in the real world remain the
same. You do scale objects such as text and hatching that have a fixed height
or spacing regardless of drawing scale factor. (The SCALETEXT command can
help with this operation; see Chapter 10 for more information.) Because of
these complications, try to make sure that you choose a proper scale and set
up the drawing properly for that scale before you begin drawing. See Chapter 4
for details.

Array

The ARRAY command is like a supercharged COPY: You use it to create a rec-
tangular grid of objects at regular X and Y spacings or a polar wheel of
objects at a regular angular spacing. For example, you can use rectangular
arrays to populate an auditorium with chairs or a polar array to draw bicycle
spokes.
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The following steps describe how to create a rectangular array, which you’ll
probably do more often than creating a polar array:

1. Press Esc to make sure that no command is active and no objects are
selected.

OO 2. Click the Array button on the Modify toolbar.
00O The Array dialog box appears, as shown in Figure 7-10.
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3. Click the Select Objects button and then select one or more objects.
Press Enter to end object selection and return to the Array dialog box.

4. Make sure that the Rectangular Array radio button is selected.

If rectangular arrays seem too square, choose the cool Polar Array radio
button instead and experiment with the other array option.

5. Fill in the five text boxes: Rows, Columns, Row Offset, Column Offset,
and Angle Of Array.

The Rows and Columns numbers include the row and column of the
original objects themselves. In other words, entries of 1 don’t create any
new objects in that direction. The Row Offset and Column Offset mea-
surements are the distances between adjacent rows and columns. The
Angle Of Array is the rotation angle of the rectangular array; when the
angle is 0 degrees, the array is aligned with the crosshairs.

6. Click the Preview button.

AutoCAD shows what the array will look like by using your current set-
tings and displays a dialog box with Accept, Modify, and Cancel buttons.

7. Click the Accept button if you’re satisfied with the array or the Modify
button if you want to change the array parameters.
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Offset

You use Offset to create parallel copies of lines, polylines, circles, arcs, or
splines. Follow these steps to use Offset:

1. Click the Offset button on the Modify toolbar.

AutoCAD displays the current command settings and prompts you for
the offset distance — the distance from the original object to the copy
you’re creating:

Current settings: Erase source=No Layer=Source
OFFSETGAPTYPE=0

Specify offset distance or [Through/Erase/Layer]
<Through>:

. Type an offset distance and press Enter.

Alternatively, you can indicate an offset distance by picking two points
on the screen. If you choose this method, you should normally use
object snaps to specify a precise distance from one existing object to
another.

AutoCAD prompts you to select the object from which you want to
create an offset copy:

Select object to offset or [Exit/Undo] <Exit>:

. Select a single object, such as a line, polyline, or arc.

Note that you can select only one object at a time with the OFFSET com-
mand. AutoCAD asks where you want the offset object.

Specify point on side to offset or
[Exit/Multiple/Undo] <Exit>:

. Point to one side or the other of the object and then click.

It doesn’t matter how far away from the object the crosshairs are when
you click. You're simply indicating a direction.

AutoCAD repeats the Select object prompt, in case you want to
offset other objects by the same distance.

Select object to offset or [Exit/Undo] <Exit>:

. Go back to Step 3 if you want to offset another object, or press Enter if

you’re finished offsetting objects for now.

Figure 7-11 shows the OFFSET command in progress.
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If you want to offset a series of connected lines (for example, a rectangular
house plan outline or one side of a pathway on a map), make sure that you
either draw it as a polyline or convert the individual line and/or arc segments
into a polyline with the PEdit command. If you draw a series of line segments
with the Line command and then try to offset it, you have to pick each seg-
ment and offset it individually. Even worse, the corners usually aren’t finished
off in the way that you’d expect because AutoCAD doesn’t treat the segments
as connected. You avoid all these problems by offsetting a polyline, which
AutoCAD does treat as a single object. Figure 7-11 shows an offset polyline.
See Chapter 6 for more information about the differences between lines and
polylines.

Slicing, dicing, and splicing

The commands in this section — TRIM (TR), EXTEND (EX), BREAK (BR),
FILLET (F), CHAMFER (CHA), and JOIN (J) — are useful for shortening and
lengthening objects, for breaking them in two, and for putting them back
together again.
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Trim and Extend

TRIM and EXTEND are the twin commands for making lines, polylines, and
arcs shorter and longer. They’re the yin and yang, the Laurel and Hardy, the
Jack Sprat and his wife of the AutoCAD editing world. The two commands
and their prompts are almost identical, so the following steps cover both. We
show the prompts for the TRIM command; the EXTEND prompts are similar:

1. Click the Trim or Extend button on the Modify toolbar.

AutoCAD prompts you to select cutting edges that will do the trimming
(or, if you chose the EXTEND command, boundary edges for extend-
ing to).

Current settings: Projection=UCS, Edge=None

Select cutting edges
Select objects or <select all>:

2. Press Enter to select all drawing objects to act as the knife for trimming
objects or the wall to which objects will be extended, or select individ-
ual objects by picking them. Press Enter to end object selection.

Figure 7-12 shows a cutting edge (for TRIM) and a boundary edge
(for EXTEND).

AutoCAD prompts you to select objects that you want to trim or extend.

Select object to trim or shift-select to extend or
[Fence/Crossing/Project/Edge/eRase/Undo] :

3. Select a single object to trim or extend. Choose the portion of the
object that you want AutoCAD to trim away or the end of the object
that’s closer to the extend-to boundary.

AutoCAD trims or extends the object to one of the objects that you
selected in Step 2. If AutoCAD can’t trim or extend the object — for
example, if the trimming object and the object to be trimmed are
parallel — the command line displays an error message such as
Object does not intersect an edge.

TRIM and EXTEND normally allow you to select only one object at a time
for trimming or extending. An exception is that you can type F and press
Enter to use the Fence object selection mode (refer to Table 7-1). Fence
is useful for trimming or extending a large group of objects in one fell
SWOOp.

The command line continues to prompt you to select other objects to
trim or extend.

Select object to trim or shift-select to extend or
[Fence/Crossing/Project/Edge/eRase/Undo] :
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4. Choose additional objects, or press Enter when you're finished trim-
ming or extending.

If you accidentally trim or extend the wrong object and you're still in the
TRIM or EXTEND command, type U and press Enter to undo the most
recent trim or extend.

The example in Figure 7-12 shows trimming to a single cutting edge, in which
the end of the trimmed lines gets lopped off. Another common use of the
TRIM command is for trimming out a piece of a line between two cutting
edges. In the two-cutting-edges scenario, TRIM cuts a piece out of the middle
of the trimmed line. The default option for selecting cutting edges or bound-
aries is ALL, which works well in this scenario. Press Enter and everything
becomes a cutting edge (mind you don’t cut yourself!) or a boundary. Fence
and Crossing selection options are also accessible from the command line or
dynamic input tooltip.
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The LENGTHEN (LEN) command provides other useful ways to make lines,
arcs, and polylines longer (or shorter). You can specify an absolute distance
(or delta) to lengthen or shorten by, a percentage to lengthen or shorten by,
or a new total length. Look up “LENGTHEN command” in AutoCAD’s help
system for more information.

Break

The BREAK command isn’t what you use before heading out for coffee. It’s for
creating gaps in lines, polylines, circles, arcs, or splines. BREAK also comes in
handy if you need to split one object into two without actually removing any
visible material.

If you want to create regularly spaced gaps in an object — so that it displays
dashed, for instance — don’t use BREAK. Use an AutoCAD dash-dot linetype
instead. See Chapter 5 for more linetype information.

The following example shows how you BREAK an object:

1. Click the Break button on the Modify toolbar.
AutoCAD prompts you to select a single object that you want to break.
Select object:
2. Select a single object, such as a line, polyline, or arc.

The point you pick when selecting the object serves double duty: It
selects the object, of course, but it also becomes the default first break
point (that is, it defines one side of the gap that you’ll create). Thus, you
should either use one of the AutoCAD precision techniques, such as an
object snap, to pick the object at a precise point, or use the First
point option (described in the next step) to repick the first break point.

AutoCAD prompts you to specify the second break point or to type F
and press Enter if you want to respecify the first break point:

Specify second break point or [First point]:

3. If the point that you picked in the preceding step doesn’t also corre-
spond to a break point (see the previous tip), type F and press Enter to
respecify the first break point, and then pick the point with an object
snap or other precision technique.

If you do type F and press Enter and then respecify the first break point,
AutoCAD prompts you to select the second break point.

Specify second break point:

4. Specify the second break point by picking a point or typing
coordinates.

AutoCAD cuts a section out of the object, using the first and second
break points to define the length of the gap.
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Figure 7-13:
Cleaning up
those
corners with
FILLET and
CHAMFER.

If you want to cut an object into two pieces without removing anything, click
the Break At Point button on the Modify toolbar. You first select the object
and then choose a second point that defines where AutoCAD breaks the
object in two. You can then move, copy, or otherwise manipulate each sec-
tion of the original object as a separate object.

Fillet and Cham(fer

Whereas TRIM, EXTEND, and BREAK alter one object at a time, the FILLET
and CHAMFER commands require a pair of objects. As Figure 7-13 shows,
FILLET creates a curved corner between two lines, whereas CHAMFER cre-
ates an angled, straight corner. (In case you wondered, it’s pronounced FILL-
et, not fill-AY. Saying that you know how to fill-AY may get you a job in a
butcher shop, but it will get you strange looks in a design office.)

L rrr

Original lines Filleted lines Chamfered lines Lines filleted
with zero radius

The following steps describe how to use the FILLET command. The CHAMFER
command works similarly except that, instead of specifying a fillet radius,
you specify either two chamfer distances or a chamfer length and angle.

1. Click the Fillet button on the Modify toolbar.

AutoCAD displays the current fillet settings and prompts you to select
the first object for filleting or specify one of three options.

Current settings: Mode = TRIM, Radius = 0.0000
Select first object or [Undo/Polyline/Radius/Trim/
Multiple] :

2. Type R and press Enter to set the fillet radius.

AutoCAD prompts you to specify the fillet radius that it uses for future
fillet operations.

Specify fillet radius <0.0000>:
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3. Type a fillet radius and press Enter.

The number you type will be the radius of the arc that joins the two
lines.

Select first object or [Undo/Polyline/Radius/Trim/
Multiple]:

4. Select the first line of the pair that you want to fillet.
AutoCAD prompts you to select the second object for filleting.
Select second object or shift-select to apply corner:
5. Select the second line of the pair that you want to fillet.
AutoCAD fillets the two objects, drawing an arc of the radius that you

specified in Step 3.

You can fillet two lines and specify a radius of zero to make them meet at a
point. If you have lots of lines to fillet, whether with a zero or nonzero radius,
use the FILLET command’s Multiple option to speed the process.

Holding down the Shift key before picking the second line automatically gives
you a clean intersection, the same as if you'd explicitly set the fillet radius
to 0. The CHAMFER command has the same Shift-select option.

Join

Use the JOIN command to fill gaps in lines, arcs, elliptical arcs, splines and
polylines. If the lines are collinear, or the arcs, splines, polylines or elliptical
arcs are on a similarly curved path, JOIN will create a single new entity to
replace the existing separate pieces, as shown in Figure 7-14.

The following steps describe how to use the JOIN command:

1. Click the Join button on the Modify toolbar.
AutoCAD prompts you to select the source object.
Select source object:
2. Select the object whose properties you want the joined line to assume.

AutoCAD prompts according to the object type selected. If you select a
line, the command prompt shows

Select lines to join to source:
3. Continue selecting collinear lines to join to the original source line.

AutoCAD continues prompting for additional collinear lines until you
press Enter to end object selection.

Select lines to join to source:
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Figure 7-14:
Joining
sundered
pieces.
|
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4. Press Enter to end the command.

AutoCAD joins the selected objects into a single object. The new object
will inherit relevant properties of the source object.

Get a Grip

A\

Although command-first editing is the most flexible and widespread editing
style in AutoCAD, it’s not the only way. Grip editing is a useful adjunct to com-
mand-first editing, especially when you want to modify just one or two objects.
You may have encountered grip editing when using other kinds of graphics pro-
grams. Even if you're an experienced user of other graphics programs, you've
never seen grips used in quite the way that AutoCAD uses them.

Anything that you can do with grip editing can be done with command-first
editing as well. In some situations, grip editing is a little more efficient or con-
venient than command-first editing, but command-first editing always gets
the job done. If you master only one style of editing, make it command-first
style. In other words, feel free to skip this section — at least until you’re com-
fortable with command-first editing.
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About grips

Grips are those little square or triangular handles that appear on an object
after you select it.

In their simplest guise, AutoCAD grips work similar to the little squares on
graphical objects in other Windows programs. But in AutoCAD, instead of
clicking and dragging a grip, you must click, release the mouse button, move
the crosshairs, and click again at the new location. (By separating the selection
of beginning and ending points into two different operations, AutoCAD allows
you to use different techniques — such as different object snap modes — to
select each point.)

AutoCAD grips are, for sophisticated users, better than the grips found in
most other programs because you can do so much more with them. You can,
for example, use AutoCAD grips to move, stretch, or copy an object. You also
can use them to rotate an object, scale it to a different size, or mirror an
object — that is, create one or more backward copies. Grips also act as visi-
ble object snaps, or little magnets that attract the crosshairs.

A gripping example

The following sections cover in detail the five grip-editing modes —
STRETCH, MOVE, ROTATE, SCALE, and MIRROR (MI). Follow these steps to
explore the grip-editing modes:

1. Press Esc to make sure that no command is active and no objects are
selected.

AutoCAD displays a blank command prompt — that is, no command is
currently active.

Command :
2. Click an object on-screen to select it and display its grips.

Grips — solid blue squares on the selected object — appear at various
points on the object. Note that the AutoCAD command prompt remains
blank; you haven’t started a command or grip-editing operation yet.

3. Click another object.

Both the newly selected object and the previously selected object dis-
play grips.
4. Click one of the grips on either object.

The blue square turns to a red square. This grip is now hot, or ready for
a grip-editing operation.
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Grip-editing options now appear on the command line. The first option
to appear is STRETCH.

. Press the spacebar repeatedly to cycle through the five grip-editing

options on the command line.

BN SITRGHLCETRAS

Specify stretch point or [Base point/Copy/Undo/eXit]:

* % MOVE * %

Specify move point or [Base point/Copy/Undo/eXit]:

** ROTATE **

Specify rotation angle or [Base point/Copy/Undo/
Reference/eXit]:

2 GCAILTE

Specify scale factor or [Base point/Copy/Undo/
Reference/eXit]:

** MIRROR **

Specify second point or [Base point/Copy/Undo/eXit]:

The grip-editing option displayed on the command line and the dynamic
input tooltip changes as you press the spacebar. If you move the
crosshairs (without picking) in between each press of the spacebar, the
appearance of your selected object changes as you display each option.
As you can see, each of the grip-editing operations resembles the ordi-
nary AutoCAD command of the same name. Choosing STRETCH, for
example, causes a stretched version of the object to appear on-screen.

Pressing the spacebar a bunch of times is a good way to become familiar
with the grip-editing modes, but there’s a more direct way to choose a
particular mode. After you click a grip to make it hot, right-click to dis-
play the grip-editing menu. That menu contains all the grip-editing
options plus some other choices, as shown in Figure 7-15.

If dynamic input is enabled (via the DYN status bar button), pressing the
down-arrow key while cycling through the grip-editing options displays a
dynamic menu at the crosshairs from which you can choose options
specific to the current grip-editing function.

. Press the spacebar until STRETCH (or the option you want) reappears

as the grip-editing option.

. Move the hot grip in the direction in which you want to stretch

(or otherwise manipulate) your object.

AutoCAD dynamically updates the image of the object to show you what
the modified object will look like before you click the final location.

. Click again to finish the grip-editing operation.

The selected object with the hot grip updates.

. Click the same grip that you chose in Step 4 (now in a different loca-

tion) to make it hot.
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Figure 7-15:
The grip-
editing
cursor
menu (as
opposed to
the curse-
editing
gripper
menu).
|

'_!! AuloCAD 2007 - [Gorta Getta Grip.dwg)]
&
ODRE AR w0 »sF WA REhELE @ | & el #
T W Q% e £ ||m B — —_—
s #
7 K]
=5 db
a@r i
= 28
' +
@ O
& 5]
~ [
& -
>
EY |
- L1
. -
::4 — 1 i
3 i
= - o
= |~
A E !
’ - Reforency [T
T ‘/.- et ' =
O—-—d= ¥
W AP [ W Mece [Teyon [ vz
=+ ROTAT E ** -~
Specify retation angle or [Base point/Copy/UndosReference/eXic]: £ »
122520, 2 7211 . 0.0000 SHAF| GRID| OATHO| POLAR| [oste OTRACK DUCS| [ovn LWT [wope e

10. This time, move the crosshairs near one of the grips on the other
object. When you feel the magnetic pull of the grip on the other
object, click again to connect the hot grip with the other grip.

The object point represented by the hot grip now coincides exactly with
the grip on the other object.

11. Press Esc to deselect all objects and remove all grips.

Figure 7-16 shows a hot (red) endpoint grip of a line being connected to the
cold (blue) endpoint grip of another line. The ghosted diagonal line shows
the original position of the line being edited, and the continuous vertical line
shows the new position. Using a grip in this way as a visible object snap
offers the same advantage as using single-point object snaps, as described in
Chapter 5: It ensures precision by making sure that objects meet exactly.

You can experiment with all the grip-editing options to find out how they
affect a selected object.

Because MOVE and STRETCH are the most useful grip-editing modes, we
cover them more specifically.
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Figure 7-16:
Using grips
to connect
two objects.
|

Red (hot) Blue (cold)
grip grip

Move it!

Back in the days of manual drafting, moving objects was a big pain in the
eraser. You had to erase the stuff you wanted to move and redraw the objects
in their new location. In the process, you usually ended up erasing parts of
other stuff that you didn’t want to move and left smudged lines and piles of
eraser dust everywhere. CAD does away with all the fuss and muss of moving
objects, and AutoCAD grip editing is a great way to make it happen. The fol-
lowing steps describe how to move objects:

1. Select one or more objects.

Use any combination of the three editing modes — single object,
window box, or crossing box — described in the “Grab It” section, ear-
lier in this chapter.

2. Click one of the grips to make it hot.

At this point in your editing career, it doesn’t matter which grip you
click. As you become more familiar with grip editing, you’ll discover that
certain grips serve as better reference points than others for particular
editing operations.

3. Right-click anywhere in the drawing area and choose Move from the
crosshairs menu.
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4. Move the crosshairs to a different location and click.

As you move the crosshairs around, AutoCAD displays the tentative new
positions for all the objects, just as it does for the regular Move com-
mand, as shown in Figure 7-6. After you click, the objects assume their
new positions.

5. Press Esc to deselect all objects and remove all grips.

Copy, or a kinder, gentler Move

If you were paying attention during the section “A Gripping Example,” earlier
in the chapter, you may have noticed while pressing the spacebar that copy
was not among the five grip-editing modes. Why not? Because every grip
mode includes a copy option (as the command-line prompts shown in the
section, “A Gripping Example,” earlier in this chapter indicate). In other
words, you can STRETCH with copy, MOVE with copy, ROTATE with copy,
SCALE with copy, and MIRROR with copy.

The copy option leaves the selected objects in place and does the editing
operation on a new copy of the objects.

By far the most common use for the copy option is with the MOVE grip-editing
mode. If you think about “MOVE with copy” for about two seconds, you’ll
realize that it’s just a complicated way of saying “copy.” The following steps
show how to copy objects quickly by using grip editing:

1. Select one or more objects.

2. Click any one of the grips to make it hot.

3. Right-click anywhere in the drawing area and choose Move from the
menu.

If you want to copy objects in the normal sense of the word copy, you
must choose the MOVE grip-editing mode first. Otherwise, you’ll be
copying with the STRETCH grip-editing mode.

4. Right-click again and choose Copy from the menu.
5. Move the crosshairs to a different location and click.
After you click, new objects appear in the new location.

6. Move the crosshairs to additional locations and click there if you want
to make additional copies.

7. Press Esc twice — once to end the copying operation and once to des-
elect all objects and remove all grips.
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A warm-up Stretch

In AutoCAD, stretching is the process of making objects longer or shorter.
The STRETCH grip-editing operation is really a combination of stretching and
compressing, but the programmers probably realized that STRETCHAND-
COMPRESS didn’t exactly roll off the tongue.

The STRETCH grip-editing mode works differently from the other modes. By
default, it affects only the object with the hot grip on it, not all objects with
grips on them. You can override this default behavior by using the Shift key
to pick multiple hot grips. Follow these steps to get acquainted with using the
STRETCH grip-editing mode to stretch one or more objects:

1. Turn off ortho mode by clicking the ORTHO button on the status bar
until the button appears to be pushed out and the words <Ortho
of £> appear on the command line.

Ortho mode forces stretch displacements to be orthogonal — that is,
parallel to lines running at 0 and 90 degrees. During real editing tasks,
you’ll often want to turn on ortho mode, but while you get acquainted
with stretching, leaving ortho mode off makes things clearer.

2. Select several objects, including at least one line.
3. On one of the lines, click one of the endpoint grips to make it hot.

All the objects remain selected, but as you move the crosshairs, only the
line with the hot grip changes. Figure 7-17 shows an example.

Original location  Displacement vector

Figure 7-17:
Dragging a ."' /
line's - o
endpointin V

the middle

of the . //
STRETCH /
grip-editing B
operation.
|

Drag endpoint to new location
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Figure 7-18:
Stretching
multiple
objects with
multiple hot
grips.
|

. Click a new point for the hot endpoint grip.

The line stretches to accommodate the new endpoint location.

. On the same line, click the midpoint grip to make it hot.

As you move the crosshairs, the entire line moves. Using the STRETCH
grip-editing mode with a line’s midpoint stretches the entire line to a
new location.

. Click a new point for the hot midpoint grip.

The line moves to the new midpoint location.

. Hold down the Shift key. On one of the lines, click one of the endpoint

grips to make it hot.

. Still holding down the Shift key, click one of the endpoint grips on a

different line to make it hot.

Two grips on two different lines are now hot because you held down the
Shift key and then clicked both grips.

You can create more hot grips by holding down the Shift key and clicking
more grips.

. Release the Shift key and re-pick any one of the hot grips.

Releasing the Shift key signals that you're finished making grips hot. Re-
picking one of the hot grips establishes it as the base point for the
stretch operation (see Figure 7-18).

Multiple hot grips

s
-
/

The hot grip used as a base point
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Polishing those properties

When you think of editing objects, you probably
think first about editing their geometry: moving,
stretching, making new copies, and so on.
That's the kind of editing we cover in this
chapter.

Another kind of editing is changing objects’
properties. As we describe in Chapter 5, every
objectin an AutoCAD drawing has a set of non-
geometrical properties, including layer, color,
linetype, and lineweight. Sometimes, you need
to edit those properties — when you acciden-
tally draw something on the wrong layer, for
example. Three common ways of editing
objects’ properties in AutoCAD are:

v~ The Properties palette: This is the most flex-
ible way to edit properties. Select any
object (or objects), right-click in the draw-
ing area, and choose Properties from the
menu. The Properties palette displays a tab-
ular grid that lists the names and values of
all properties. Click in the value cell to
change a particular property.

v~ Layers and Properties toolbars: Another
way to change properties is to select
objects and then choose from the drop-
down lists (Layer, Color, and so on) on the
Layers and the Properties toolbars. See
Chapter 5 for more information.

Match Properties: You can use the Match
Properties button on the Standard toolbar —
the button with the paintbrush on it — to
paint properties from one object to another.
Match Properties works similarly to the
Format Painter button in Microsoft applica-
tions. Match Properties works even when
the objects reside in different drawings.

Change Space: We introduced the con-
cepts of model space and paper space in
Chapter 4. Sometimes you add some geom-
etry to paper space and then realize it
should have been in model space, or vice
versa. The old CHSPACE Express Tool is
now part of core AutoCAD — you'll find it
on the Modify menu. And for the first time,
this tool is available to LT users.

\\J

10. Click a new point for the grip.

All the objects with hot grips stretch based on the displacement of the
grip that you clicked in Step 9.

11.

Turn on ortho mode by clicking the ORTHO button on the status bar

until the button appears to be pushed in and the words <Ortho on>
appear on the command line. Repeat Steps 2 through 10 to see the
effect of ortho mode on stretching.

For most real-world editing situations, you’ll want to turn on ortho or polar
tracking mode before stretching. Ortho mode is good for all kinds of drawing
and editing tasks because it enforces a nice, rectilinear orderliness on your
drawing. Chapter 5 describes how to use ortho mode to draw orthogonal

lines.
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Chapter 8
A Zoom with a View

In This Chapter

Zooming and panning

Naming and restoring views

Zooming and panning in paper space layouts
Regenerating the display

One of the advantages of CAD over manual drawing is its capability of
giving you different ways to view your drawing. You can zoom in close,
zoom out to a great distance, and pan around. In fact, not only can you zoom
and pan in your drawing, but in most kinds of drawings, you must do it fre-
quently to be able to draw, edit, and view effectively.

Technical drawings are jam-packed with lines, text, and dimensions. Zooming
and panning frequently enables you to see the details better, draw more con-
fidently (because you can see what you're doing), and edit more quickly
(because object selection is easier when there aren’t a zillion objects on the
screen). This chapter covers AutoCAD’s most useful display control features.

Zoom and Pan with Glass and Hand

Moving your viewpoint in to get a closer view of your drawing data is called
zooming in; moving your viewpoint back to get a more expansive view is
called zooming out.

Zooming in and out of your drawing is one of the big advantages that
AutoCAD offers over manual drawing. You can do detailed work on tiny
objects and then zoom out and move around rooms, houses, or neighbor-
hoods from an Olympian perspective.

Panning is closely related to zooming. If you zoom in enough that some of
your drawing no longer shows up on-screen, you're going to want to pan
around — move left, right, up, and down in your drawing — without zooming
in and out. AutoCAD makes panning easy with scroll bars and real-time pan-
ning. And in case you're wondering what real-time panning might be (as
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Figure 8-1:
The
Zoom/Pan
Realtime
right-click
menu.
|

opposed to pretend-time panning, maybe?), it simply means you can see the
objects moving around the screen as you drag the mouse up and down or
back and forth. (Of course, it’s your viewpoint that’s moving, not the
objects!)

Both panning and zooming change what is known as the view. The view is the
current location and magnification of the AutoCAD depiction of your drawing.
Each time you zoom or pan, you establish a new view. You can give a name to
a specific view to make returning to that view easy, as we demonstrate later
in this chapter.

You'll get a better sense of panning and zooming around a drawing if you
actually have a drawing to look at. Draw some objects on the screen or open
one of AutoCAD’s sample drawings located in the C: \Program Files\
AutoCAD 2007\Sample folder. (If you're using AutoCAD LT, the sample
drawings are located in the C: \Program Files\AutoCAD LT 2007\
Sample folder.)

Fortunately, zooming and panning in AutoCAD is as simple as it is necessary.
The following steps describe how to use AutoCAD’s Zoom and Pan Realtime
feature, which is easy to operate and provides a lot of flexibility:

1. Click the Zoom Realtime button (the one that looks like a magnifying
glass with a plus/minus sign next to it) on the Standard toolbar.

The Realtime option of the ZOOM (Z) command starts. The crosshairs
change to a magnifying glass, and AutoCAD prompts you at the com-
mand line.

Press ESC or ENTER to exit, or right-click to display
shortcut menu.

2. Move the crosshairs near the middle of the screen, press and hold
down the left mouse button, and drag the crosshairs up and down
until the objects you want to see almost fill the screen.

Dragging up increases the zoom magnification and dragging down
decreases it.

3. Right-click in the drawing area and choose Pan from the menu that
appears (shown in Figure 8-1).

The magnifying glass cursor changes to a hand.

Exit
Pan R"

v Zoom
3D Orbit

Zoom Window
Zoom Original
Zoom Extents
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4. Click and drag to pan the drawing in any direction.

\P
) You can use the right-click menu to toggle between Zoom and Pan as

many times as you like. If you get lost, choose Zoom Original or Zoom
Extents to return to a recognizable view.

5. Right-click in the drawing area and choose Exit.

The Zoom or Pan Realtime cursor returns to the normal AutoCAD
crosshairs.

& In the preceding example, you started with zooming and ended with panning.

Wa You also have the option of doing the reverse: Click the Pan Realtime button
(the one showing a hand and crosshairs), and after you've panned, use the
right-click menu to switch to zooming. However you start it, the important
thing to realize is that Zoom and Pan Realtime is a single AutoCAD function.
At any time, you can switch between panning and zooming (or switch to a
related function, such as Zoom Window) by using the right-click menu.

\\J

You also can pan and zoom by using your mouse’s scroll wheel (if it has one)
or the middle button of a three-button mouse.

v To zoom in and out, roll the scroll wheel forward or backward.

v To zoom to the extents of your drawing, double-click the scroll wheel or
the middle button.

v To pan, hold down the scroll wheel or the middle button as you move
the mouse.

The scroll wheel or middle mouse button zoom and pan operations
described in the preceding list depend on an obscure AutoCAD system vari-
able named MBUTTONPAN. (See Chapter 2 for a description of what system
variables are and how to change them.) When MBUTTONPAN is set to 1 —
the default value — you can use the middle button to pan and zoom, as we
describe in the preceding list. If you change MBUTTONPAN to 0, clicking the
middle mouse button displays an object snap menu at the crosshairs, as it
did in older AutoCAD versions. If you're not able to zoom or pan with your
middle mouse button, set MBUTTONPAN back to 1. (With MBUTTONPAN set
to 1, you use Shift+right-click to display the object snap menu at the
crosshairs.)

Realtime zooming and panning is the easiest, most interactive way to get
around in your drawings. In some situations, though, this method is less effi-
cient or precise than the old-fashioned methods, the most important of
which are described in the next section.
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Out of the frying pan . . .

Another way to pan in AutoCAD should be familiar from other Windows pro-
grams — the scroll bars in the drawing area. Scrolling is the same in AutoCAD
as in any other Windows program; click the arrows in the right and bottom
borders of the drawing window to scroll, or pan, a step at a time; or click and
drag the little square thumbs in those borders to pan as little or as much as
you want to.

By default, scroll bars are turned off in the AutoCAD Classic workspace. To
turn them on, choose Tools=>Options to display the Options dialog box. On
the Display tab, check the box next to Display Scroll Bars In Drawing Window.

Time to zoom

Because zooming is such a frequent necessity in AutoCAD, it’s worth knowing
some alternative ways of doing it.

Of the following options, Zoom Realtime and Zoom Previous have full-time
tool buttons on the Standard toolbar. The middle of the three magnifying-
glass buttons is a flyout button. Press down on it, and buttons for the other
Zoom options fly out. Since, theoretically, you may want to use whichever
option that is again soon, the most recently used flyout button floats to the
top of the pile.

The ZOOM command has different options, the most important of which are
the following:

v~ All and Extents: Zoom Extents (the button with the four-headed arrow)
zooms out just far enough to show all the objects in the current drawing.
Zoom All (the button showing the sheet with the folded-over corner)
does the same thing, unless the drawing’s limits are larger than the
extents, in which case Zoom All zooms to show the entire rectangular
area defined by the limits. If you've defined your limits properly (see
Chapter 4), Zoom All is a good way to see your whole drawing area.
These two options are especially useful when you zoom in too small or
pan off into empty space and want to see your entire drawing again.

It’s a good idea to Zoom All or Zoom Extents and then save the drawing
before you close it. By performing these steps, you ensure the following:

¢ The next person who opens the drawing — whether it’s you or
someone else — can see the full drawing from the very beginning.

¢ [f you've accidentally copied some objects way beyond where they
should be, Zoom All or Extents will make them show up so you can
delete them.
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e The drawing preview that displays in the Select File dialog box dis-
plays the full drawing, instead of just a tiny, unidentifiable corner
of it.

v Window: This option is great for zooming in quickly and precisely. It
zooms to a section of your drawing that you specify by clicking two
points. The two points define the diagonal of a window around the area
you want to look at. (Note that the ZOOM command’s Window option is
not a click-and-drag operation — unlike in some other Windows pro-
grams and, confusingly, unlike in the Zoom/Pan Realtime Zoom Window
option. With the ZOOM command’s Window option, you click one
corner, release the mouse button and then click the other corner.)

v Scale (X/XP): The X option zooms by a percentage of the current dis-
play; values less than 1 cause you to zoom in, values greater than 1
cause you to zoom out. You can also think of the value as a scaling
factor: 0.5X causes the screen image to shrink to half its apparent size,
and 2X causes the screen image to double its apparent size. (The XP
option after a number is for zooming model space objects in a viewport
relative to paper space; see Chapter 4 for information about paper
space.)

1 Realtime: Realtime zooming, the technique described previously,
enables you to zoom in and out by starting a realtime zoom and then
moving the crosshairs up (to zoom in) or down (to zoom out).

v Previous: This option undoes the last zoom and/or pan sequence. It’s
like going back in time but without the funny costumes!

1 Object: This option zooms in close enough to show selected objects as
large as they can be displayed on-screen. Think of zoom object as
AutoCAD’s microscope.

AutoCAD provides smooth view transitions whenever you use the non-real-
time pan and zoom commands. The thinking is that, sometimes you can get
lost if you do a zoom all from a small, highly magnified area. It’s not a good
idea to leave a trail of breadcrumbs across your screen, so these slow-motion
pans and zooms may be a good idea, at least until you do know your way out
of the forest . . . or your drawing. If, like us, you find that this feature gets old
fast, luckily there’s a View Transitions dialog box (type VTOPTIONS to open
it) in which you can turn it off. Just uncheck the Enable Animation for Pan &
Zoom option.

Some of the zoom options take some getting used to. We recommend that
you use realtime zoom and pan for most of your zooming and panning.
Supplement it with Zoom Window to move quickly into a precise area, Zoom
Previous to back up in zoom/pan time, and Zoom All or Zoom Extents to view
your whole drawing.
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A View by Any Other Name . . .
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If you find yourself repeatedly zooming and panning to the same area, you
can probably get there faster with a named view. A named view is a name that
you assign to a particular region of your drawing. After you create a named
view, you can return to that region quickly by restoring the view. You use the
VIEW (V) command, which displays the View Manager dialog box, to create
and restore named views.

With a view to its new 3D abilities, AutoCAD 2007 has considerably revamped
the old View dialog box and replaced it with an enhanced View Manager
dialog. You still create 2D views in the standard way we describe in the fol-
lowing steps, but you can also use the View Manager to set up preset 3D
views.

Follow these steps to create a named view:

1. Zoom and pan until you find the view that you want to assign a
name to.

2. Choose Viewr>Named Views.
The View Manager dialog box appears.

3. Click the New button.
The New View dialog box appears, as shown in Figure 8-2.

4. Type a name in the View Name text box.

5. (Optional) Type a new category in the View Category box, or select an
existing one from the drop-down list.

You use View Categories to organize views and certain display charac-
teristics of views in sheet sets. Until you use the sheet sets feature, you
can leave this box blank.

6. Select the Current Display radio button, if it’s not selected already.

If you want to name a region other than the currently displayed view,
select the Define Window radio button instead, click the Define View
Window button to the right of it, and pick two corners of the region’s
rectangle (as though you were zooming windows).

7. Confirm or change the choices in the Settings area.

If you turn on the Save Layer Snapshot with View option, when you later
restore the view, AutoCAD also will restore the layer visibility settings
(on/off and freeze/thaw) that were in effect when you created the view.
(Chapter 5 describes the layer visibility settings.) The two UCS-related
settings are primarily for 3D drawings. If you're creating 2D drawings,
you can ignore the UCS settings.
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8. Click OK.

The New View dialog box disappears, and you see your new named view
in the list in the View Manager dialog box.

9. Click OK.

The View Manager dialog box disappears.

To restore a named view, choose View>Named Views or enter VIEW at the
command line to display the View Manager dialog box. In the Views list,
expand either Model Views or Layout Views (depending where you saved
your view). Click the name of the view that you want to restore, click the Set
Current button, and then click OK to close the dialog box.

You also can plot the area defined by a named view. See Chapter 13 for
instructions on plotting views.

Looking around in Layout Land

All the zoom, pan, and view operations we describe in this chapter apply to
paper space layouts as well as to model space. (Chapter 4 describes the dif-
ference between model space and paper space and how to navigate between
the two.) One little complication exists, though: In a paper space layout —
that is, any drawing area tab except for the Model tab — it’s possible for the
crosshairs to be in either paper space or in model space inside a viewport.
Zooming and panning have a different effect depending on which space your
crosshairs are in at the moment. Experiment with the different effects by fol-
lowing these steps:
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|
Figure 8-3:
The full
layout.
|

1. Open a drawing that contains at least one paper space layout with a
title block and one or more viewports.

If you don’t have any such drawings handy, try using the AutoCAD
sample drawing located at C: \Program Files\AutoCAD 2007\
Sample\Welding Fixture-1.dwg. (If you're using AutoCad LT, start
with C:\Program Files\AutoCAD LT 2007\Sample\Home Floor
Plan.dwg.)

2. Click one of the layout tabs — that is, any tab other than the Model tab.

AutoCAD displays the paper space layout for that tab, including any title
block and viewports.

3. Click the PAPER/MODEL button on the status bar until it says PAPER.

Alternatively, you can double-click in the gray part of the drawing area
outside of the layout.

The crosshairs are now in paper space, so zooming and panning changes
the display of all the objects in the layout, including the title block.

4. Choose View=>Zoom=All.

AutoCAD displays the entire layout, as shown in Figure 8-3.
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|
Figure 8-4:
Zooming in
paper
space.
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5. Zoom and pan by using any of the techniques described in this chapter.

Zooming and panning change the appearance of the title block, as
shown in Figure 8-4. The effect is similar to moving a plotted sheet in
and out and all around in front of your face.

6. Choose View>Zoom=All.
AutoCAD displays the entire layout again.

7. Click the PAPER/MODEL button on the status bar until it says MODEL.
Alternatively, you can double-click with the crosshairs over a viewport.

The crosshairs are now in model space, inside the viewport, so zooming
and panning change only the display of the objects that are visible in the
viewport. The display of the title block doesn’t change.

8. Zoom and pan by using any of the techniques described in this chapter.

Zooming and panning don’t change the appearance of the title block, as
shown in Figure 8-5. The result looks as if you’re moving a picture of the
model space geometry in and out and all around behind a frame.
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10.

In real drawings, you usually shouldn’t zoom and pan inside viewports
after they’ve been set up (see Chapter 4). Doing so changes the scale of
the viewport, which messes up plotting. We're asking you to do it here
to illustrate the difference between zooming in paper space and zooming
in a model space viewport.

If the title block is changing when you zoom and pan, someone has
locked the viewport to prevent the kind of mischief that we warn against
in the previous paragraph. (You also see the command prompt
Viewport is view-locked. Switching to Paper space.) See
“viewports, floating, locking” in the AutoCAD online help system if you
need to lock — or unlock — viewports.

. Choose View=>Zoom=Previous one or more times until you’ve

restored the original view.
Click the PAPER/MODEL button on the status bar until is says PAPER.

Always leave the crosshairs in paper space when you're ready to call a
drawing finished.
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11. Choose File=>Close and click the No button to close the drawing with-
out saving changes.

In this example, we have you close the drawing without saving changes,
just in case you did mess up the viewport zoom scale.

In most cases, you set up a paper space layout once, as described in Chapter
4, and then just return to it to plot. You shouldn’t be spending a lot of time
zooming and panning in paper space layouts. You zoom and pan to get a
better view of what you're drawing and editing, and that’s what the Model tab
is for. But if you do want to zoom in paper space — to get a better look at
part of your title block, for example — make sure that you're doing it with the
PAPER/MODEL button set to PAPER.

The VPMAX and VPMIN commands allow you to maximize and minimize a
viewport in the current layout. These commands provide an alternative to
switching between the Model and Layout tabs without the potential problems
of zooming inside of paper space viewports. The easiest way to run VPMAX
or VPMIN is to click the Maximize Viewport/Minimize Viewport button
located on the status bar, just to the right of the PAPER button.

Degenerating and Regenerating

As you zoom and pan around your drawing, you may wonder how the image
that you see on-screen is related to the DWG file that AutoCAD saves on the
hard disk. Well, maybe you don’t wonder about that, but we’re going to tell

you anyway!

When you draw and edit objects, AutoCAD stores all their geometrical prop-
erties (that is, location and size) in a highly precise form — technically,
double floating-point precision. The program always maintains that precision
when you save the DWG file. For computer performance reasons, however,
AutoCAD does not use that high-precision form of the data to display your
drawing on-screen. Instead, AutoCAD converts the highly precise numbers in
the DWG file into slightly less precise integers in order to create the view that
you see on-screen.

The happy consequence of this conversion is that zooming, panning, and
other display changes are a lot faster than they would be otherwise. The
unhappy consequence is that the conversion, which is called a regeneration
(or regen for short), occasionally leaves you with some artifacts to deal with.

In most cases, AutoCAD performs regenerations automatically when it needs
to. You will sometimes see command line messages like Regenerating
model or Regenerating layout, which indicate that AutoCAD is taking
care of regens for you.
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If, on the other hand, you see the command line message Regen queued,
then AutoCAD is warning you that it’s not performing a regeneration, even
though one might be advisable now. In addition, you might see a warning
dialog box with the message "About to regen -- proceed?" These mes-
sages are AutoCAD’s way of saying, “What your drawing looks like on the
screen at the moment may not exactly match the real version of the drawing
database that gets stored when you save the drawing. I'll update the display
version at the next regeneration.”

The REGENAUTO command controls whether or not AutoCAD performs most
regenerations automatically by setting the system variable REGENMODE.
(See Chapter 2 if you're unfamiliar with system variables or how to change
them.)

v The default REGENAUTO mode in new drawings, On, tells AutoCAD to
regenerate your drawing automatically if it’s required to synchronize the
screen display with the drawing database.

v The other REGENAUTO mode, Off, tells AutoCAD not to regenerate auto-
matically but instead to display Regen queued on the command line
and let you force a regeneration with the REGEN (RE) command if you
want to.

The REGENAUTO off option is for the most part a holdover from much slower
computers and older versions of AutoCAD. You probably don’t need to sub-
ject yourself to the mental contortion of trying to avoid regens unless you
work on huge drawings and/or use a painfully slow computer.

Don’t confuse the REGEN command with the REDRAW (R) command. REGEN
(View>Regen) forces the synchronization process described in this section.
Redraw (View=>Redraw) simply refreshes the screen, without attempting to
synchronize the screen with the drawing database. The REDRAW command
was useful in the days of very slow computers and older versions of AutoCAD,
which didn’t handle the display as effectively, but it’s essentially a useless
command now.

The REGENALL (REA) command (Viewr>Regen All) regenerates all viewports

in a paper space layout. If you run the REGENALL command in model space,
it has the same effect as the ordinary REGEN command.
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On a 3D Spree

In This Chapter

Getting used to the 3D interface
Using the Dashboard
Using visual styles

Navigating in three dimensions

Where to go for more

NN

We’re sticking our little New In AutoCAD 2007 icon at the very beginning
of this chapter, and you won'’t see it again because nearly everything
we discuss in this chapter is new to AutoCAD 2007.

Autodesk has devoted perhaps 90 percent of the new features in AutoCAD
2007 to 3D. The feature set is divided into three broad topics (and a market-
ing slogan): Visualize, Make, Navigate.

Unfortunately, we simply don’t have the space to cover every aspect of 3D in
AutoCAD 2007, so we're going to focus here on visualization and navigation,
two facets you’ll need to know before you can go far in 3D object creation. We
start off by showing you how to navigate in AutoCAD 2007’s 3D environment.
Then, we show you how to change the appearance of your models on-screen.

A book like this one can only begin to cover some of the specialist areas
involved in working in 3D in AutoCAD. Among the areas we pass over are

v 3D object creation

v Camera functions

v Animations and walkthroughs

v Advanced solid and surface modeling

v Lighting

1 Materials

v Rendering
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For these and other facets of working in AutoCAD 2007’s powerful — and
complex — 3D environment, have a look at AutoCAD and AutoCAD LT All-in-
One Desk Reference For Dummies from Wiley Publishing.

AutoCAD LT users, you're going to have to sit out most of this chapter. One of
the major areas where LT differs from regular AutoCAD is in its extremely lim-
ited 3D functionality.

The new 3D visualization and rendering abilities of AutoCAD 2007 have upped
the system requirements substantially. The full version of AutoCAD will run
in 512MB, but if you want to work in 3D, Autodesk recommends 2GB of RAM
and a video card with at least 128MB of its own memory. If you're thinking of
buying a new system, check Autodesk’s Web site (www.autodesk. com) for a
list of supported video cards.

Which Way Is Up?

\NG/
s

Two new features in AutoCAD 2007 help you get your 3D feet wet:

v The 3D Modeling workspace
v The Dashboard

Before you start making stuff, or even looking at already-made stuff, it’s
important to get a firm grasp on these two features. A workspace is a named
collection of toolbars and tool palettes that you use for specific processes.
The new 3D Modeling workspace loads the Dashboard and adjusts some of
the other tool palettes.

Rather confusingly, selecting the 3D Modeling workspace (or the AutoCAD
Classic workspace, for that matter) does not visually change the drawing
area. You need to start a new file and choose the appropriate drawing tem-
plate file.

Entering the Third Dimension

\\J

When you start AutoCAD, by default you see a Workspaces dialog box that
asks whether you want to work in the old 2D environment (AutoCAD Classic)
or in 3D (3D Modeling).

You may have checked the Don’t Show Me This Again option in the Workspaces
dialog box that displays when you start AutoCAD. To restore the dialog box,
choose Tools=>Options=>System, and in the General Options area, check the
box beside Show All Warning Messages.
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If you don’t see the dialog box — probably because you checked Don’t Show
Me This Again — you can switch between the 2D and 3D environments by
switching workspaces. The following steps explain how to switch from 2D

to 3D:

1. Choose Tools=>Workspaces=>3D Modeling.

Toolbars and palettes flash on and off, and eventually AutoCAD settles
down and displays the Dashboard and the Modeling tool palette.

You now have a 3D Modeling workspace, but you're still in a 2D drawing.

2. Choose Filer>New.
The Select Template dialog box appears.

3. Choose acad3d.dwt if you're working in imperial units, or
acadiso3d.dwt if you’re working in metric. Click OK.

A 3D modeling space appears (see Figure 9-1).
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To switch from 3D to 2D, follow these steps:

1. Choose Tools~>Workspaces>AutoCAD Classic.

After more flashing toolbars and palettes, AutoCAD settles down and
displays (by default) the Sheet Set Manager and Tool Palettes. Again,
you need to start a new drawing to complete the process.

2. Choose File>New.
The Select Template dialog box appears.
3. Choose an appropriate template file and click OK.

If you want to work in imperial units, choose acad. dwt for color-depen-
dent plotting, or acad -Named Plot Styles.dwt for named plot
styles. For metric, choose acadiso.dwt or acadISO -Named Plot
Styles.dwt.

Go Dashboarding!

If you’ve gotten this far, you can’t help but notice that large, palette-like area
over at the right side of the screen. It’s called the Dashboard, and it contains a
number of panels that give access to different aspects of working in 3D (see
Figure 9-2).
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Each section of the Dashboard contains an additional hidden set of tool but-
tons and controls. To access them, move your mouse pointer over the verti-
cal border area at the left side of the panel. When a downward-pointing
double arrow appears, click to expand the panel (see Figure 9-3). The vertical
bar in the expanded panel turns orange; to collapse the panel, click the
upward-pointing double arrow (see Figure 9-4).

The Dashboard is divided into seven control panels as follows:

v~ 2D Draw control panel: Contains tool buttons for basic 2D drawing and
editing commands. This panel is not displayed by default; to turn it on,
right-click anywhere in the dashboard and choose Control Panels=>2D
Draw control panel.

v 3D Make control panel: Contains tool buttons for creating 3D primitive
solids (for example, cubes, spheres, cones, and so on), freeform solids
and surfaces (that is, lofts and sweeps), and Boolean and other 3D
object modification tools. The expanded control panel contains addi-
tional 3D editing tools.

v~ 3D Navigate control panel: Contains tool buttons for standard display
commands like PAN (P) and ZOOM (Z) as well as camera creation and
modification, animation walkthrough setup, and perspective/parallel
toggles. The expanded panel contains sliders and additional controls for
varying camera focal length and setting up and recording animations.

v~ Visual Style control panel: Contains tool buttons for configuring display
type (for example, x-ray mode, shadows on or off, and so on) and a drop-
down list for selecting preconfigured visual styles. See the “Get Some
(visual) style” coming up.

v~ Light control panel: Contains tool buttons for enabling or disabling
default ambient light or sunlight. Sliders control time of year and hour of
day for shadow generation. The expanded panel contains tools for
adding new point, spot, and distant lights, changing global location
(unless you live in San Francisco, in which case you're already home!). If
you really want to play master of the universe, click the Edit The Sun
button.

v~ Materials control panel: Select materials from a dialog box and apply
them to the surfaces of your 3D model.

+ Render control panel: You've got your lights, you’ve got your camera,
and you’ve got your action — now create your final renderings here.
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The bottom half of the Dashboard, including lights, materials, and rendering
tools, is beyond the scope of this book. For more information, check out the
online help system or our companion title, AutoCAD and AutoCAD LT All-in-

One Desk Reference For Dummies.

The Dashboard can be set up to display in three different configurations. By
default, when you apply the 3D Modeling workspace, the Dashboard is
docked at the right side of the screen. You can also anchor the Dashboard so
that it appears as a vertical title bar; when you move your mouse pointer
over the title bar, the Dashboard expands. Finally, the Dashboard can float in

the drawing area, just like any other palette.

Unless you’ve got way more screen space than we do, we suggest you anchor
your Dashboard. To anchor a docked Dashboard, press down on the “han-
dles” (the two raised horizontal bars) at the top of the Dashboard and drag it
into the drawing area. Then right-click the title bar and choose Anchor Right
or Anchor Left to reduce the Dashboard palette to a vertical title bar. Fig-

ure 9-5 shows both Dashboard and Tool Palettes anchored at the right side of
the display. Pausing the mouse over the title bar opens the Dashboard to its

full size.
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If you've accidentally closed the Dashboard, you can reopen it by choosing
Tools=>Palettess>Dashboard.

Working out with the Dashboard

The following steps show you some of the functions built into the Dashboard
(and, once again, we refer you to our sister volume AutoCAD and AutoCAD LT
All-in-One Desk Reference For Dummies for more information on working in 3D
in AutoCAD 2007).

1. Open a drawing containing some 3D objects. If you don’t have such a
thing, open one of AutoCAD 2007’s sample drawings — for example,
C:\Program Files\AutoCAD 2007\Sample\3D House.

A 3D model of a single-story house opens, displayed from a south-east
isometric point of view (that is, “south-east” relative to the x- and y-axes).

2. If the Dashboard is not already open, open it.

For this exercise, it might be worth turning off Autohide or un-anchoring
the Dashboard so you don’t have to keep mousing over the title bar to
open it.
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|
Figure 9-6:
A new
perspective
on things.
|

3. Move the mouse pointer over the gray bar at the left side of the 3D
Navigate control panel and click the double downward-pointing
arrows.

The 3D Navigate control panel expands, displaying additional tool but-
tons and controls for moving about in 3D.

4. In the Dashboard’s 3D Navigate control panel, click Perspective.

The two buttons at the right end of the 3D Navigate toolbar switch
between Perspective and Parallel Projection. One or the other of these
buttons is always orange to show you which mode you’re in — not that
there’s any doubt when you’re in perspective mode! (See Figure 9-6.)

5. Drag the Lens Length/Field Of View slider bar to the left to reduce the
focal length of the camera lens.

The farther to the left you drag the slider, the wider the apparent focal
length. Stop when you’ve had enough distortion!

6. Click Parallel on the 3D Navigate control panel’s toolbar.

The view of the model returns to Parallel Projection mode.
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7. Move the mouse pointer over the gray bar at the left side of the Visual
Styles control panel and click the double downward-pointing arrows.

The expanded 3D Navigate panel rolls up, and the Visual Styles control
panel expands to show a number of additional buttons and controls.

8. Click the arrow in the Visual Styles drop-down list.

A schematic representation of five preconfigured visual styles appears
(see Figure 9-7). We discuss visual styles in the next section.

Realistic

|
Figure 9-7:
Some new
styles to

try on. |

Get some (Visual) style

Visual styles are collections of settings that build on the SHADEMODE set-
tings found in earlier versions of AutoCAD. There are five default visual styles
in AutoCAD 2007.

v 2D Wireframe: Old Faithful! AutoCAD’s classic 3D viewing mode, full
wireframe, dot-based grid, the 2D UCS icon, and no steenkin’ perspective.

v 3D Hidden: You can still run the old HIDE command from the command
line and get a hidden-line-removed (HLR) view in the 2D Wireframe
visual style, but selecting 3D Hidden switches you to a gray background
and linear grid.

v 3D Wireframe: AutoCAD uses two different display systems, one for 2D
and one for 3D. You can actually view 3D objects in the 2D system (are
you confused yet?) but you don’t get gray backgrounds, linear grids, and
a flashy 3D UCS icon; for that, you need to call upon the 3D display
system. And functionally, kids, that’s the only difference between 2D
Wireframe and 3D Wireframe.
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v Conceptual: This is the more artistic of the two shaded visual styles in
AutoCAD 2007. The objects tend to look a little chunkier and more
sketch-like than in the Realistic mode.

v~ Realistic: Choosing the Realistic visual style displays the model in fully
shaded (but not rendered) mode.

AutoCAD’s 2D display system is a cleaner-looking environment, and display
changes do seem to go faster than in the 3D display system. However, you
can’t view in perspective mode using the 2D display system.

AutoCAD 2007’s five preconfigured visual styles are only the beginning. You
can modify any of the styles or create new ones in the Visual Styles Manager
(VSM) palette (see Figure 9-8).

To display the Visual Styles Manager, click the Visual Styles Manager button

on the Visual Styles control panel toolbar. To modify an existing visual style,
change the values in the Visual Styles Manager’s Properties area.

Properties of selected Visual Style

@ Available visual Styles in Drawing
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The following steps explain how to create a new visual style:

1. In the Visual Style Manager, click Create New Visual Style.
The Create New Visual Style dialog box opens.

2. Enter a name and optional description for the new visual style, and
then click OK to return to the Visual Style Manager.

3. Enter new values in the appropriate fields of the Properties area.

For example, to create a sketchy appearance to your model, do the
following:

4. In the Edge Settings section of the Visual Style Manager, turn on
Overhanging Edges and Jitter Edges by clicking the two buttons on
the Edge Modifiers title bar.

Overhanging Edges extends edges so they extend beyond the objects
they meet; Jitter Edges applies a hand-drawn effect to object edges. You
can increase the overhang amount by changing the numeric value. You
can increase the jitter effect by selecting High — or drinking more coffee.
See Figure 9-9 for a rather extreme example of overhanging jitters.
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Navigating in Three Dimensions

|
Figure 9-10:
The 3D
Views
submenu.
|

If you're brand new to 3D AutoCAD, you may be wondering how to look at the
back of the house — or whatever it is your modeling from whatever angle
you desire.

The easiest way to change viewpoints is to use the View>3D Views submenu
(shown in Figure 9-10) to switch to one of the standard orthographic 3D
views or an isometric view.

v The six standard orthographic (straight-on) views are Top, Bottom, Left,
Right, Front, Back.

v The four standard isometric views are SW (left-front), SE (right-front), NE
(right-back), and NW (left-back). (An isometric view is one in which you
see the object from above — or below, but AutoCAD’s standard views
don’t do below.)

These 10 views are called standard because they’re often used in manual
drafting and rendering work. They work well for showing 3D models of
common objects such as mechanical components and buildings. (You can
also change to plan view, which is a top-down view of either the world coordi-
nate system or a user coordinate system.)
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You can specify nonstandard viewpoints by choosing View=3D Viewss>
Viewpoint Presets. In the Viewpoint Presets dialog box that appears, specify
the following settings:

v A viewing angle in the XY plane (imagine your camera circling around an
object, while keeping the camera at the same elevation)

v An angle from the XY plane (imagine using a boom to swoop the camera
up to a different height so that you're looking at the object from increas-
ingly steep angles)

AutoCAD LT includes limited 3D viewing capabilities. The same preset views
are in LT as well as in AutoCAD, and there’s also a Viewpoint Presets dialog
box in which you set a viewing position by specifying an angle in the XY
plane, and another angle from the XY plane. Finally, there’s the really ugly
VIEWPOINT command (View=>3D Views=Viewpoint). Refer to the online help
for directions on . . . er, viewing directions.

Going into Orbit

Standard views and the Viewpoint Presets dialog box are fine for many 3D
construction tasks, but if you really want to have fun with a model, 3DOrbit is
your ticket to it. There are two orbiter modes: Constrained and Free. The
Constrained mode is pretty much like the Free mode with training wheels.

Free Orbit displays an arcball on the screen — a circle representing a sphere

around your object (refer to Figure 9-10). You click various places inside, out-
side, and on the arcball and then drag to change the 3D view. The idea is that
you’re spinning an imaginary sphere containing your model. As you drag the

cursor, AutoCAD updates the screen dynamically.

In case you're wedded to the command line, there are two different command
names you need before you can enter orbit: 3DORBIT (3DO) starts
Constrained orbiting (no arcball), and 3DFORBIT runs the arcball-enhanced
Free orbiting mode.

3DOrbit provides many other options through its right-click shortcut menu.
You can change the shading mode and projection type, and you can turn on
several visual aids that help you understand where you are in 3D space.
Additional shortcut menu options enable you to pan, zoom, and restore stan-
dard or named views.
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The following steps show some of the things that you can do with 3DOrbit:

1. Open or continue in a drawing file containing some 3D objects.

C:\Program Files\AutoCAD 2007\Sample\3D House is a good
example.

. Choose View>Orbit=>Free Orbit.

The 3DOrbit arcball appears, as shown in Figure 9-11.

. Move the cursor inside the arcball.

The 3DOrbit full orbit cursor appears (two oval arrows circling a sphere).

. Click and drag, keeping the cursor inside the arcball.

You can rotate the model in all directions. Imagine that the cursor is
your finger pushing on a globe that rotates freely in all directions.

\\3 . . .
Pay attention to the shaded UCS (user coordinate system) icon at the
lower-left corner of the drawing area as you change the view. The UCS
icon helps you visualize how each orbiting operation works.
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10.

11.

. Release the mouse button and move the cursor outside the arcball.

The 3DOrbit roll cursor appears (a circular arrow circling a tiny sphere).

. Click and drag, keeping the cursor outside the arcball.

You can rotate the model around an axis at the center of the circle,
coming out of the screen. Imagine that you're turning the steering wheel
on a car, with the steering column pointing into the screen.

. Release the mouse button and move the cursor over one of the small

circles at the quadrant points (that is, 12 o’clock, 3 o’clock, 6 o’clock,
and 9 o’clock) of the arcball.

The 3DOrbit horizontal or vertical rotation cursor appears (an elliptical
arrow circling a sphere).

. Click and drag away from the small circle.

You can rotate the model around a horizontal axis (if you clicked the
circle at 3 o’clock or 9 o’clock) or a vertical axis (if you clicked the circle
at 12 o’clock or 6 o’clock) passing through the little circle. Imagine that
you're turning a piece of meat on a spit (vegetarians, imagine it’s an egg-
plant), with the spit located horizontally or vertically in the plane of the
screen.

. Release the mouse button and right-click in the drawing area.

The 3DOrbit shortcut menu, shown in Figure 9-10, appears.
Experiment with different Projection modes.

¢ Parallel projection is the default AutoCAD projection — lines that
are parallel in the 3D object remain parallel in the projected view
on the screen.

¢ Perspective projection makes objects look more realistic (for
example, train tracks appear to converge in the distance), but lines
that are parallel in the model don’t remain parallel in perspective
projection.

If you manage to 3DOrbit out of control so that you no longer see your
model, right-click to display the 3DOrbit shortcut menu and choose
Zoom Extents. The Zoom, Pan, and Preset Views options offer other
ways of getting your model back in your sights.

When you’re finished orbiting, right-click in the drawing area and
choose Exit.

When you start orbiting with no objects selected, AutoCAD tries to update
the display of everything in your model, and this can take some time. To
speed things up or to simply regain your bearings, try selecting some objects
before you start orbiting. Then, AutoCAD updates the display of the selected
models only. When you exit orbit mode, the entire model redisplays based on
the new viewpoint.
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Hungry for More?

AutoCAD 2007’s shiny new 3D features are logical, intuitive, and (relatively)
easy to use. And, unfortunately, more than we can cover in a 400-page book.
To learn about solid and surface modeling, AutoCAD 2007 includes a number
of options:

v New Features Workshop: Choose Help=>New Features Workshop. The
Create, Produce, and Present headings cover new 3D features. The New
Features Workshop includes animations and tutorials to help get you up
to speed quickly.

v Online help system: Choose Helpr>Help, or press the F1 key. In the left
pane of the Help window, expand User’s Guide, and then click Work With
3D Models. Figure 9-12 shows a help section on lofts and sweeps. (We
know, once upon a time this would have been in a printed manual!)

v~ Building Your World: This PDF file comes on the AutoCAD 2007 CD and
covers object creating, 3D navigation, and visualization, including light-
ing and rendering. (Is this a case of “Print your own darned manual?”)
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In this part . . .

Text, dimensions, and hatching have long been impor-
tant clarifying elements in drafting. In AutoCAD, these
elements are flexible almost to a fault, and you can edit
and update them quickly as you change the geometry
beneath them. The text, dimension, and hatching annota-
tions that you add “speak” about the geometry so that
others can understand exactly what, how big, and how far.

After you've made some drawings that talk, you’ll proba-
bly send the message around by printing — or as CAD
users call it, plofting — them. Chapter 13 is your passport
to navigating the plot process, understanding how the
legacy of AutoCAD plotting influences current practice,
and most of all getting a good-looking, properly scaled
plot onto paper.
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Text with Character

In This Chapter

Using text styles to control text appearance

Creating single-line and multiline text

Using fields and background masks with text

Making numbered and bulleted lists

Editing text contents and properties

Creating tables

Checking spelling

A\\S

A Ithough it’s often true that “A picture is worth a thousand words,” it’s
also true that adding a few words to your drawing can save you from
having to draw a thousand lines and arcs. It’s a lot easier to write Simpson
A35 framing clip nextto a simple, schematic representation of a clip
than to draw one in photorealistic detail and hope that the contractor can
figure out what it is!

Most CAD drawings include some text in the form of explanatory notes,
object labels, and titles. This chapter demonstrates how to add text to draw-
ings and shows you how to take advantage of AutoCAD text styles and the
spelling checker. Chapter 11 covers text that’s connected with dimensions
and leaders.

In most cases, adding text, dimensions, and other descriptive symbols is
something that you should do later in the drafting process, after you've drawn
at least some of the geometry. In CAD drawings, text and other annotations
are usually intended to complement the geometry, not to stand alone. Thus,
you generally need to have the geometry in place before you annotate it. Many
drafters find that it’s most efficient to draw as much geometry as possible
first, and then add text annotations and dimensions to all the geometry at the
same time. In this way, you develop a rhythm with the text and dimensioning
commands, instead of bouncing back and forth between drawing geometry
and adding annotations. (It helps if you hum, “I've got rhythm . . . .” while slid-
ing the mouse back and forth in time.)
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Getting Ready to Write

In AutoCAD, adding text to a drawing is only slightly more complicated than
adding it to a word processing document. Here are the steps:

1. Create a new AutoCAD text style, or select an existing style, that
includes the font and other text characteristics you want to use.
2. Make an appropriate text layer current.
3. Run one of these commands to draw text:
e MTEXT draws paragraph (also called multiline) text.
e TEXT draws single-line text.
4. Specify the text alignment points, justification, and height.
5. Type the text.
You’re probably familiar with most of these steps already — especially if
you've ever used a word processor. In the next few sections of this chapter,

we review the particularities of AutoCAD text styles, the two kinds of
AutoCAD text, and ways of controlling height and justification.

Simply stylish text

AutoCAD assigns text properties to individual lines or paragraphs of text
based on fext styles. These text styles are similar to the paragraph styles in a
word processor; they contain font and other settings that determine the look
and feel of text. An AutoCAD text style includes

v The font.

v A font height, which you can set or leave at 0 for later flexibility.

v Special effects such as italic.

v Really special effects such as vertical and upside down, which almost

nobody uses.

Before you add text to a drawing, use the Text Style dialog box — choose
Format=Text Style to open it — to select an existing style or create a new one
with settings that are appropriate to your purpose. Your AutoCAD notes may
generate strange responses (or no response at all) if they appear in Old
Persian Cuneiform or the Cyrillic alphabet.
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Most drawings require very few text styles. You can create one style for all
notes, object labels, and annotations and another text style for special titles.
A title block may require one or two additional fonts, especially if you want to
mimic the font used in a company logo or project logo.

As with layers, your office may have its own text style standards. If so, you’ll
make everyone happy by following those standards. One of the best ways to
make your use of text styles efficient and consistent is to create them in a
template drawing that you use to start new drawings. (If your office is well
organized, it may already have a template drawing with the company-
approved styles defined in it.) See Chapter 4 for information about creating
and using templates. Another handy technique is to copy existing text styles
from one drawing to another by using the DesignCenter palette. See Chapter
5 for instructions.

Font follies

When you create a text style in AutoCAD, you have a choice of a huge
number of fonts. AutoCAD can use two different kinds of fonts: native
AutoCAD SHX (compiled SHape) fonts and Windows TTF (TrueType) fonts:

v SHX: In the Text Style dialog box, SHX font names appear with a drafting
compass to the left of the name. SHX fonts usually provide better perfor-
mance because they’re optimized for AutoCAD’s use.

v TTF: In the Text Style dialog box, TrueType font names appear with a TT
symbol to the left of name. TTF fonts give you more and fancier font
options, but they slow down AutoCAD when you zoom, pan, and select
and snap to objects. TrueType fonts also can cause greater complica-
tions when you exchange drawings with other AutoCAD users. Chapter
15 describes the special procedure that you need to use in order to
install custom TrueType fonts.

It’s okay to use a TrueType font sparingly for something like a title block logo,
but in general, you should stick with standard AutoCAD SHX fonts whenever
possible.

The most popular AutoCAD font is Romans.shx (Roman Simplex). (You may
also run into Simplex.shx, an older version of Roman Simplex.) Romans.shx is
a good, general-purpose font for drafting in AutoCAD. Avoid complicated,
thick fonts. They can slow down AutoCAD, and they’re usually more difficult
to read than the simpler fonts. Remember, you're doing CAD here — not
fancy graphic design or reproduction of medieval manuscripts!
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Figure 10-1:
Text with
style.

Whenever possible, avoid custom fonts, which are font files that don’t come
with AutoCAD or AutoCAD LT (both programs come with the same fonts).
AutoCAD installs its standard SHX fonts in the C: \Program Files\
AutoCAD 2007\Fonts folder (AutoCAD LT fonts are installed in C: \
Program Files\AutoCAD LT 2007\Fonts)— as long as you haven’t
added any custom fonts to that folder, you can refer to it for a list of standard
fonts. AutoCAD does not embed font files in drawings; instead, it must refer
to the font files installed locally under either AutoCAD (for SHX fonts) or
Windows (for TrueType fonts). If you use a custom font, exchanging your
drawings with other people will be more complicated. If you’re compelled to
use a custom font, make a note of it and remember either to send it whenever
you send the DWG file (assuming that the font isn’t copyrighted, which many
custom fonts are) or to warn the recipients that the text will appear different
on their systems. It’s far less hassle to eschew custom fonts altogether. See
Chapter 15 for additional information about how to deal with fonts when you
send and receive drawings.

Get in style

The following steps describe how to select an existing text style or create a
new one before you enter text into a drawing. (If you want to experiment with
an existing drawing that contains a variety of text styles, you can use
C:\Program Files\AutoCAD 2007\Sample\Blocks and Tables-
Imperial.dwg or Blocks and Tables-Metric.dwg; LT users can check
out C:\Program Files\AutoCad 2007\Sample\Tallship.dwg.)

1. Choose Format->Text Style.
The Text Style dialog box appears, as shown in Figure 10-1.

W Text Style
Style Name
S-Tent v New... ] [ Rename.. ] [ Delete |
Fant
Fort Name: Fontt Style: Height:
B romans. shx v 0.0000
[] Use Big Fortt
Effects Preview
[ Upside down Width Factor: 1.0000
[[] Backwards Oblique Angle: 0 | AaBbCecD |
D vetcal AaBbCcD | [ Previen ]

2. In the Style Name drop-down list, select each style in turn to see what
text styles have been created in this drawing.

Note the font name and look at the Preview panel to get a feel for what
the different fonts look like.
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3. If you find a suitable text style, select it in the Style Name drop-down

list and then skip to Step 8.

What constitutes a suitable text style depends on industry practices,
office standards, and personal preferences about how the text should
look. The information in preceding sections may help you decide. If not,
ask an experienced drafter in your office or look at some printed draw-
ings and try to match the text on those.

The selected text style name becomes the current style.

. If you don’t find a suitable text style, or if you prefer to create your

own text style, click New.

The New Text Style dialog box appears, with a text box for you to type
aname.

. Type a name for your new text style and then click OK.

Your new text style is added to the Style Name list and becomes the cur-
rent style.

. Choose a font from the Font Name list.

Romans.shx is the best all-purpose font for most drafting work. If you’d
like to use a different font, review the font suggestions and warnings in
the previous section.

The font that you choose becomes the font that’s assigned to your new
text style.

. Set the remaining text style settings as shown in Figure 10-1:

Height = 0. 0, Width Factor = 1. 0, Oblique Angle = 0, and all four
check boxes unchecked.

A text style height of 0.0 makes the style variable height, which means
that you can specify the height separately for each text object. Assigning
a fixed (that is, nonzero) height to a text style forces all text using the
style to be the same height. Variable height styles are more flexible, but
fixed height styles usually make it easier to draw text of consistent
height. The decision to use variable height versus fixed height styles is
another aspect of text that depends on office practice, so if you work
with other AutoCAD users, ask around.

Dimensions use text styles to format the appearance of the dimension text.
When you create a text style that you think you might use for your dimen-
sions, you must set a height of 0. Otherwise, the setting that controls the
dimension text will not work, and your dimension text is likely to be either
enormous or microscopic. This one should be a double warning because
it’s one of the most common mistakes made by new AutoCAD drafters.

8. Click Apply.
9. Click Close.

The Text Style dialog box closes, and the text style that you selected or
created is now the current style for new text objects.
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Attack of the giant text strings

“Why do | need to know the drawing scale
factor in order to draw text?” you may ask,
especially if you've spent time on the boards, as
we grizzled old-timers like to call manual draft-
ing. You need to know the drawing scale factor
because you handle scaling of objects and text
in CAD opposite from the way you do in manual
drafting.

In manual drafting, you squeeze real-world
objects (the building, widget, or whatever) down
by a specific scale factor, like 10 or 48, so that
they fit nicely on a sheet of paper. Naturally, you
always draw text the size that you want it to
appear on the paper (for example, /% inch or
3 mm high), regardless of the scale of the
drawing.

In CAD drafting, you draw objects as if they were
at their actual size. Then, when you plot, you
shrink — or, if you make drawings of tiny things
such as microprocessor circuitry, expand —
the entire drawing by that same scale factor (for
example, 10 or 48) to fit on the paper. When you
shrink the whole drawing to fit on the paper, text
shrinks, too. To avoid indecipherably small text,

or incredibly large text, you must create text at
a size that's scaled appropriately by the draw-
ing scale factor. (If you're an architect, imagine
that your text is neon lettering on the side of the
building. If you're a mechanical designer, think
of a brand name stamped on the side of a
screw.)

For example, assume that someone has drawn
a widget at a scale of 1:20 (corresponding to a
drawing scale factor of 20), and you want your
notes to appear 3 mm high when the drawing is
plotted to scale. You need to create text that's
20 times 3 mm, or 60 mm, high. In a building plan
drawn at a scale of /" = 1'-0" (drawing scale
factor equals 48), text that will appear % inch
when plotted needs to be % inch times 48, or
6inches, high.

This tiny text/enormous text approach seems
peculiar atfirst, especially if you were schooled
in manual drafting. But it's a consequence of
AutoCAD’s ability to let you draw and measure
full-size geometry. After all, the geometry of
what you're representing, not the ancillary
notes, is usually the main point of the drawing.

R,

S{,N\BEH

Taking your text to new heights

In Chapter 4, we describe the importance of choosing an appropriate drawing

scale when you set up a drawing. We warn you that you need to know the
drawing scale factor for tasks described in other chapters of this book. This
is one of those chapters, and we’re about to explain one of those tasks!

Drawing scale is the traditional way of describing a scale with an equal sign

or colon — for example " = 1'-0", 1:20, or 2:1. The drawing scale factor repre-
sents the same relationship with a single number such as 48, 20, or 0.5. The
drawing scale factor is the multiplier that converts the first number in the
drawing scale into the second number.

One of the things that distinguishes knowledgeable CAD users is that they
always know the drawing scale factor of any drawing they’re working on.
Make it a point to determine the drawing scale factor of a drawing before you

add text to it.
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Plotted text height

Most industries have plotted text height standards. A plotted text height of 4
inch or 3 mm is common for notes. Some companies use slightly smaller
heights (for example, % inch or 2.5 mm) to squeeze more text into small
spaces.

Calculating AutoCAD text height

To calculate AutoCAD text height, you need to know the drawing scale factor,
the desired plotted text height, and the location of the multiplication button
on your calculator. Use the following steps to figure out text height:

1. Determine the drawing’s drawing scale factor.

If you set up the drawing, you should know its drawing scale, as
described in Chapter 4. If someone else set up the drawing, try the sug-
gestions in the nearby sidebar, “Figuring out a drawing’s scale factor.”

2. Determine the height that your notes should appear when you plot
the drawing to scale.

See the preceding “Plotted text height” section for suggestions.

3. Multiply the numbers that you figured out in Steps 1 and 2.

Table 10-1 lists some common drawing scales and text heights for drawings in
imperial and metric units. You should know how to calculate the drawing
scale factors and text heights, but you're allowed to use the table to check
your work. (Hint: Multiply the number in the second column by the number
in the third column to get the number in the fourth column!) The Cheat Sheet
tables include some additional drawing scales and text heights.

Table 10-1 Common Drawing Scales and Text Heights
Drawing Scale Drawing Scale Plotted Text AutoCAD Text
Factor Height Height

%'=1-0" 96 %" 12"
%=1-0" 48 %" 6"
%'=1-0" 16 %" 2'
1"=1-0" 12 %" 17"

1:100 mm 100 3mm 300 mm

1:50 mm 50 3mm 150 mm

1:20 mm 20 3mm 60 mm

1:10 mm 10 3mm 30 mm
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After you know the AutoCAD text height, you can use it to define the height of
a text style or of an individual text object. If you assign a nonzero height to a
text style (Step 7 in the “Get in style” section, earlier in this chapter), all
single-line text strings that you create with that style will use the fixed height.
If you leave the text style’s height set to 0, AutoCAD asks you for the text
height when you draw each single-line text object.

P This discussion of text height assumes that you're adding text in model
space, which is the most common practice. You may want to add text to a
paper space layout — for example, when you draw text in a title block or add
a set of sheet notes that doesn’t directly relate to the model space geometry.
When you create text in paper space, you specify the actual, plotted height,
instead of the scaled-up height.

One line or two?

For historical reasons (namely, because the AutoCAD text capabilities used
to be much more primitive than they are now), AutoCAD offers two different
kinds of text objects and two corresponding text-drawing commands.

Table 10-2 explains the two options.

Table 10-2 The Two Kinds of AutoCAD Text
Text Object Command Comments
Paragraphtext =~ MTEXT Designed for multiple lines, with word-wrapping.

AutoCAD keeps the multiple lines together as a
single object. Other special formatting, such as
numbered and bulleted lists, is possible.

Single-linetext ~ DTEXT Designed for creating single lines. Although you
can press Enter to create more than one line of
text, each line becomes a separate text object.

Although you may be inclined to ignore the older single-line text option, it’s
worth knowing how to use both kinds of text. The DTEXT (DT) command is a
bit simpler than the MTEXT (T) command, so it’s still useful for entering
short, single-line pieces of text such as object labels and one-line notes. And
it’s the command of choice for CAD comedians who want to document their
one-liners!
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Figuring out a drawing's scale factor

If you're adding text to a drawing that someone
else created, you may notimmediately know its
drawing scale factor. In some cases, making the
determination is trivial, whereas in other cases
it's tricky indeed. Here are some methods you
can use:

v Ask the creator of the drawing.

v Look for text or a scale bar on the drawing
that indicates the scale.

v Use an architectural or engineering scale to
measure distances on the plotted drawing,
if you have one.

v Check the value of the DIMSCALE (the
system variable that controls dimension
scale), as described in Chapter 11.

None of these methods is infallible by itself, but
by comparing the evidence, you usually can

Chapter 10: Text with Character 2 3 7

figure out the drawing scale factor with rea-
sonable certainty.

Vour text will be justified

Both the DTEXT and MTEXT commands offer a bewildering array of text
Justification options — in other words, which way the text flows from the jus-
tification point or points that you pick in the drawing. For most purposes, the
default Left justification for single-line text or Top Left justification for para-
graph text works fine. Occasionally, you may want to use a different justifica-
tion, such as Center for labels or titles. Both commands provide options for
changing text justification. We point out these options when we demonstrate
the commands later in this chapter.

Using the Same Old Line

N\\3

Despite its limitations, the DTEXT command is useful for labels and other
short notes for which MTEXT would be overkill. The following procedure
shows you how to enter text by using the AutoCAD DTEXT command.

You can use DTEXT for multiple lines of text: Just keep pressing Enter after
you type each line of text, and DTEXT puts the new line below the previous
one. The problem with this approach is that DTEXT creates each line of text
as a separate object. If you later want to add or remove words in the multiple
lines, AutoCAD can’t do any word-wrapping for you; you have to edit each
line separately, cutting words from one line and adding them to the adja-
cent line.
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The DTEXT command does not use a dialog box or a fancy formatting toolbar
like the MTEXT command’s In-Place Text Editor. You set options by typing
them into the command line or the dynamic cursor.

Here’s how you enter text with the DTEXT command:

1. Set an appropriate layer current, as described in Chapter 5.

2. Set an appropriate text style current, as described in the section
“Simply stylish text,” earlier in this chapter.

3. Use the OSNAP button on the status bar to turn off running object
snap mode.

You usually don’t want to snap text to existing objects.
4. Choose Draw~>Text>Single Line Text to start the DTEXT command.

The Text button on the Draw toolbar starts the multiline text command,
MTEXT, which we cover in the next section.

AutoCAD tells you the current text style and height settings and prompts
you to select a starting point for the text or to choose an option for
changing the text justification or current text style first:

Current text style: "Standard" Text height: 0.2000
Specify start point of text or [Justify/Style]:

5. If you want to change justification from the default (lower left), type J,
press Enter, and choose one of the other justification options.

Look up “single-line text, aligning” in the online help system index if you
need help with the justification options.

6. Specify the insertion point for the first text character.

You can enter the point’s coordinates from the keyboard, use the mouse
to click a point on-screen, or press Enter to locate new text immediately
below the most recent single-line text object that you created.

AutoCAD prompts you for the text height:
Specify height <0.2000>:
7. Specify the height for the text.

This prompt doesn’t appear if you're using a text style with a fixed (that
is, nonzero) height. See the “Simply stylish text” section, earlier in this
chapter, for information about fixed versus variable text heights.

AutoCAD prompts you for the text rotation angle:

Specify rotation angle of text <0>:
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8. Specify the text rotation angle by typing the rotation angle and press-
ing Enter or by rotating the line on-screen with the mouse.

AutoCAD prompts you to type the text:
Enter text:
9. Type the first line of text and press Enter.
10. Type additional lines of text, pressing Enter at the end of each line.
Figure 10-2 shows text appearing on-screen as you type it.
11. To complete the command, press Enter at the start of a blank line.
AutoCAD adds the new single-line text object — or objects, if you typed

more than one line — to the drawing.

To align lines of text exactly, make sure that you type all the lines in one invo-
cation of the DTEXT command, pressing Enter after each line to make the
next line appear just after it. Otherwise, aligning different lines of text pre-
cisely is harder to do (unless you set your snap just right or use a compli-
cated combination of object snaps and point filters).
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The system variable DTEXTED has a new value: When it is set to 2, you can
click anywhere on-screen to create a new single-line text object within the
same DTEXT command sequence. (This new value actually restores the pre-
AutoCAD 2006 behavior of the DTEXT command.)

To edit single-line text after you’'ve created it, select the text, right-click, and
choose Edit to open the In-Place Text Editor. Here, you edit text at its exact
size and location in the drawing. We tell you more about in-place text editing
later in this chapter.

An in-place editing box highlights the selected text object, enabling you to
edit the contents of the text string. If you want to edit other text properties,
such as text height, select the text, right-click, and choose Properties to dis-
play the Properties palette. Use the Properties palette to change parameters
as needed.

Saying More in Multiline Text

WNG/

When you just can’t shoehorn your creative genius into one or more one-line

pieces of text, the AutoCAD multiline text object gives you room to go on and
on and on. The following procedure shows you how to create text paragraphs
with the MTEXT (multiline Text) command.

Making it with Mtext

The first part of the MTEXT command prompts you for various points and

options. The order is a bit confusing, so read these steps and the prompts
carefully.

Here’s how you use the MTEXT command:

1. Set an appropriate layer and text style current and turn off running
object snaps, as in Steps 1 through 3 in the previous section.

2. Click the Multiline Text button on the Draw toolbar.

The command line displays the current text style and height settings
and prompts you to select the first corner of an imaginary rectangle that
will determine the word-wrapping width for the text object:

Current text style: "S-NOTES" Text height: 0.2000
Specify first corner:
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3. Pick a point in the drawing.

The command line prompts you for the opposite corner of the text rec-
tangle that will determine the word-wrapping width and gives you the
option of changing settings first:

Specify opposite corner or [Height/Justify/Line
spacing/Rotation/Style/Width] :

4. Type H and press Enter to change the default text height.
The command line prompts you for a new default text height:
Specify height <0.2000>:
5. Type an appropriate text height.

See the “Taking your text to new heights” section, earlier in this chapter,
for information. If you're adding text in model space, remember to use
the scaled AutoCAD text height, not the plotted text height.

The prompt for the opposite corner of the Mtext rectangle reappears.
The command line shows:

Specify opposite corner or [Height/Justify/Line
spacing/Rotation/Style/Width] :

6. If you want to change justification from the default (top left), type J,
press Enter, and choose one of the other justification options.

Look up “multiline text, aligning, Justify Multiline Text” in the index of
the online help system if you want an explanation of the other justifica-
tion options.

7. Pick another point in the drawing.

Don’t worry about the height of the rectangle that you create by choos-
ing the second point; the width of the rectangle is all that matters.
AutoCAD adjusts the height of the text rectangle to accommodate the
number of lines of word-wrapped text. Don’t worry too much about the
width, either; you can adjust it later.

The In-Place Text Editor frameless window appears with the tab and
indent ruler above it and the Text Formatting toolbar above that, as
shown in Figure 10-3.

8. Verify the text font and height.

The text font and height should be right if you correctly performed
Steps 1, 4, and 5. If not, you can change these settings in the Font drop-
down list and the Text Height text box in the Text Formatting toolbar.
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|
Figure 10-3:
Adding
multiline
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|
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9. Type text into the text area of the dialog box.

AutoCAD word-wraps multiline text automatically. If you want to force a
line break at a particular location, press Enter.

By convention in most industries, text in drawings is always uppercase.
How many times have you forgotten to press the Caps Lock key before
entering drawing text? How many times have you forgotten to turn Caps
Lock off again when it’s time to type your e-mail? To save yourself some
agony, right-click in the text editor window and choose AutoCAPS from
the menu.

10. If you want other formatting, select text, right-click, and choose the
appropriate option from the menu (as shown in Figure 10-4).

11. Click OK in the Text Formatting toolbar (or press Ctrl+Enter).

The In-Place Text Editor window closes, and AutoCAD adds your text to
the drawing.
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Figure 10-4:
More
multiline
text
formatting
options in
the right-
click menu.
|
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Character Set L2

Help F1

Cancel

As you can tell by looking at the Text Formatting toolbar and multiline text
right-click menu, the MTEXT command gives you plenty of other options. You
can show or hide the toolbar, the ruler, or the Options buttons, and you can
give the in-place editor an opaque background. Right-clicking gives you
access to numbered and bulleted lists and a shortcut to the New Features
Workshop entry on multiline text (choose “Learn about MTEXT”).

Between them, the Text Formatting toolbar and the right-click menu also
include a Stack/Unstack button for fractions, access to the Indents And Tabs
feature, a Find And Replace utility, tools for changing between lowercase and
uppercase, options for applying background masks and inserting fields, a
special Symbol submenu, and an Import Text option for importing text from a
TXT (ASCII text) file or RTF (Rich Text Format) file.

We discuss background masks and fields in the next section. If you think you

may have a use for any of these other features, choose Contents=>Command
References>Commands=>M Commands=>MTEXT in AutoCAD’s online help.
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It slices, it dices . . .

Two more useful options on the multiline text right-click menu are Insert
Field and Background Mask.

Mtext dons a mask

When you turn on background masking, AutoCAD hides the portions of any
objects that lie underneath the multiline text. Use these steps to turn on and
control this feature:

1. Right-click in the In-Place Text Editor window and choose Background
Mask from the menu.

The Background Mask dialog box appears.

2. Click the Use Background Mask check box so that this option is
turned on.

3. Either click Use Drawing Background Color (to make the mask the
same color as the drawing area’s background color) or choose a color
from the drop-down list (to make the text appear in a solid rectangle
of the specified color).

4. Click OK to return to the In-Place Text Editor window.

If you've turned on background masking but it isn’t having the desired effect,
use the DRAWORDER (DR) or TEXTTOFRONT command to move text on top
of other objects.

Mtext plays the field

The Insert Field option (not in AutoCAD LT) creates a text field that updates
automatically every time you open, save, plot, or regenerate the drawing.
These fields can contain data such as the date, filename, or author. Fields
draw information from the operating system settings, Drawing Properties
dialog box, sheet sets feature, and AutoCAD system variables. (For more
information about system variables, see Chapter 2.) Use the following proce-
dure to add a field while you’re creating multiline text:

1. Right-click in the In-Place Text Editor window and choose Insert Field
from the menu.
The Field dialog box appears.

2. Choose a Field Name in the left column.

3. Choose a Format in the right column, or for date fields, type a format
in the Date Format box.

4. Click OK.
AutoCAD adds the field to the Mtext object that you're creating or editing.
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If you see four dashes instead of a valid field value, you probably need to do
one of the following things:

v Regenerate the drawing (see Chapter 8).
1 Save the drawing.

v~ Fill in Drawing Properties dialog box values (see Chapter 4) and then
regenerate the drawing.

v Configure sheet sets (see Chapter 13).

Figure 10-5 shows fields and background masking in action.

Doing a number on your Mtext lists

Another advantage of Mtext is that it supports bulleted and numbered lists.
This feature is especially useful for creating general drawing notes, as shown
in Figure 10-6. AutoCAD automates the process of creating numbered lists
almost completely. Here’s how:

1. Follow Steps 1 through 8 in the previous section, “Making it with
Mtext.”

2. Type a title — for example, DESIGN CRITERIA.

If you’d like to have your title underlined, click Underline on the Text
Formatting toolbar before you type the title, and then click Underline
again to turn it off. Press Enter to go to the next line and Enter again to
leave a little more space.

3. Right-click inside the text editing window and choose Bullets And
Lists from the menu; then re-open the menu and enable Allow Bullets
And Lists, Allow Auto-List, Use Tab Delimiter Only and Numbered.

The number 1 followed by a period appears on the current line, and the
cursor jumps to the tab stop visible in the ruler at the top of the In-Place
Text Editor’s frameless window.

Numbered places numerals followed by periods in front of items in a list.
(Bulleted places bullet characters in front of items in a list.) Auto-list
enables automatic numbering — each time you press Enter to move to a
new line, its number increments.

4. Type the text corresponding to the current number or bullet.

As AutoCAD wraps the text, the second and subsequent lines align with
the tab stop — that is, the text is automatically indented.

5. Press Enter at the end of the paragraph to move to the next line.

Just like creating numbered lists in your favorite word processor,
AutoCAD automatically inserts the next number at the beginning of the
new paragraph, with everything perfectly aligned, as shown in Figure 10-6.
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6. Type the text corresponding to the next number or bullet, and then

press Enter at the end of the paragraph to move to the next line.

7. Repeat Steps 4 through 6 for each subsequent numbered or bulleted

item.

For legibility, you sometimes want to add spaces between the notes. If
you press Enter twice to give yourself a blank line, AutoCAD — like
every good word processor — thinks you're finished with your list and
turns numbering off. AutoCAD is smart, so you need to be smarter. If you
put the cursor at the end of the first note and press Enter, you get a
blank line. The problem is, the blank line is now numbered, and your
intended Note 2 is now Note 3. Just press the Backspace key. The
number on the blank line disappears, and Note 2 is back to being Note 2
again. When you delete a numbered item, the remaining numbers auto-
matically adjust.

If you don’t like the horizontal spacing of the numbers or the alignment
of subsequent lines, you can adjust them easily by manipulating the tab
and indent markers in the In-Place Text Editor’s ruler, as described in the
next step.
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8. In the ruler, drag the upper slider (the triangle pointing down) to the
right a short distance. Drag the lower slider (the triangle pointing up)
to the right a slightly greater distance.

The upper slider controls the indentation of the first line in each para-
graph. The lower slider controls the indentation of the second and sub-
sequent lines. An indent of one to two of the short, vertical tick marks
usually works well for the first line. An indent of two to four tick marks
works well for the second and subsequent lines.

9. Click in the ruler just above the lower slider.

A small triangle (pointing right) appears above the lower slider. This tri-
angle shows the tab stop.

Make sure that the corner of the tab stop (right-pointing) triangle aligns
horizontally with the point of the lower slider triangle. If not, click and
drag the tab stop until it aligns.

You can bump a nested text item up a level by selecting a numbered or bul-
leted item in the In-Place Text Editor and press Shift+Tab.
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If you prefer to type tab and indent distances, not adjust them with the
cursor, use the Indents and Tabs choice on the Mtext right-click menu.
Whichever way you do it, if you select text first, the tab and indent changes
apply to the selected text. If you don’t select text first, the changes apply to
new text from that point in the multiline text object forward.

AutoCAD’s multiline text feature has come a long, long way since its introduc-
tion over a decade ago. Even so, remember the old adage about using the
right tool for the right job. It’s possible to make a drawing in your favorite
word processor, but AutoCAD is probably a better tool. Likewise, if you're
contemplating adding pages of text or fancy text formatting to a drawing,
consider putting the text in a separate word processing document instead. If
you absolutely must place the text from a long document on a drawing (on a
general notes sheet, for example), you’ll have to break it up into several
columns, each of which is a separate Mtext object. Get the text right in a
word processor first and then copy and paste it into AutoCAD.

If you're tempted to circumvent our warning by pasting a word processing
document directly into an AutoCAD drawing, please read Chapter 16 first.

An alternative to pasting parts or all of a word processor document is to save
the word processed text in RTF format and then import it into the In-Place
Text Editor. See Chapter 17 for more information on this technique.

Modifying Mtext

After you create a multiline text object, you edit it like a single-line text
object: Select the object, right-click, and choose Mtext Edit or Properties.

v The Mtext Edit option opens the In-Place Text Editor window so that you
can change the text contents and formatting.

v The Properties option opens the Properties palette, where you can
change overall properties for the text object.

The easiest way to change the word-wrapping width of a paragraph text
object is to grip edit it. Select the text object, click one of the corner grips,
release the mouse button, move the cursor, and click again. Chapter 7
describes grip editing in detail.

Double-clicking a multiline text object to open the In-Place Text Editor was
fine as far as it went, but in the last version of AutoCAD, you may have had to
zoom in closer to see the text you were editing. In AutoCAD 2007, the system
variable MTEXTFIXED has a new default value of 2; with this setting, Mtext
now automatically zooms to the text when it’s too large, too small, rotated, or
off the screen.
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AutoCAD includes two text modification commands that may be useful to you
when you become an AutoCAD textpert. SCALETEXT scales a group of text
objects, similar to the SCALE (SC) command. The difference is that SCALE-
TEXT scales each text object around its own base point, whereas SCALE uses
a single base point for scaling all objects. SCALETEXT is especially useful
when you have to change the scale of a drawing. JUSTIFYTEXT changes the
justification of one or more text strings without causing the text to move.
Both of these commands are available on the Modify=>Object>Text submenu.

Gather Round the Tables

You don’t know the meaning of the word tedious unless you’ve tried to create
a column-and-row data table in older versions of AutoCAD with the Line and
DTEXT commands. AutoCAD'’s table object and the TABLESTYLE (TS) and
TABLE (TB) commands for creating it make the job almost fun.

Tables have style, too

You control the appearance of tables — both the text and the gridlines —
with table styles (just as you control the appearance of standalone text with
text styles). Use the TABLESTYLE command to create and modify table
styles. Follow these steps to create a table:
1. Choose Format~>Table Style.
The Table Style dialog box appears.

2. In the Styles list, select the existing table style whose settings you
want to use as the starting point for the settings of your new style.

For example, select the default table style named Standard.

3. Click the New button to create a new table style that’s a copy of the
existing style.

The Create New Table Style dialog box appears.
4. Enter a New Style Name and click Continue.
The New Table Style dialog box appears, as shown in Figure 10-7.

5. On the Data tab, specify settings for the data text and gridlines (that
is, for all cells except the column heads and the table title).

The settings you are likely to want to change are Text Style, Text Height,
and perhaps either Text Color or Grid Color. (If you leave colors set to
ByBlock, then the text and grid lines will inherit the color that’s current
when you create the table. That color will be the current layer’s color, if
you follow our advice in Chapter 5.)
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6. Repeat Step 5 for the Column Heads tab and the Title tab.
7. Click OK to close the New Table Style dialog box.
The Table Style dialog box reappears.

8. (Optional) Select your new table style from the Styles list, and then
click Set Current.

Your new table style becomes the current table style that AutoCAD uses
for future tables in this drawing.

9. Click Close.

The Table Style dialog box closes. Now you're ready to create a table, as
described in the next section.

In AutoCAD 2007, you can access the Table Cell Format dialog box directly
from the Title, Column Head, or Data tabs of the New Table Style dialog box.
The Table Cell Format dialog provides a number of additional options for for-
matting cells by data type.

AutoCAD stores table styles in the DWG file, so a style that you create in one
drawing isn’t immediately available in others. You can copy a table style from
one drawing to another with DesignCenter. (Use the “Borrowing existing
dimension styles” procedure in Chapter 11, but substitute Table Styles for
DimStyles.)
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Creating and editing tables

After you create a suitable table style, adding a table to your drawing is easy
with the TABLE command. Here’s how:

1. Set an appropriate layer current.

Assuming that you leave the current color, linetype, and lineweight set
to ByLayer, as we recommend in Chapter 5, the current layer’s proper-
ties will control the properties of any parts of the table that you left set
to ByBlock when you defined the table style. (See Step 5 in the preceding
section, “Tables have style, t00.”)

2. Choose Drawr>Table.

The Insert Table dialog box appears.
3. Choose a table style from the Table Style Name drop-down list.
4. Choose an Insertion Behavior.

Specify Insertion Point is the easiest method and means that you'll pick
the location of the table’s upper-left corner (or lower-left corner if you
set Table Direction to Up in the table style). With this method, you spec-
ify the default column width and number of rows in the Insert Table
dialog box.

Specify Window means that you'll pick the upper-left corner and then the
lower-right corner. With this method, AutoCAD automatically scales the
column widths and determines how many rows to include.

5. Specify Column & Row Settings.

If you chose Specify Window in Step 4, AutoCAD sets the Column Width
and number of Data Rows to Auto, which means that AutoCAD will figure
them out based on the overall size of the table that you specify in Steps 7
and 8.

6. Click OK.
AutoCAD prompts you to specify the insertion point of the table.
7. Click a point or type coordinates.

If you chose Specify Insertion Point in Step 4, AutoCAD draws the table
grid lines, places the cursor in the title cell, and displays the Text
Formatting toolbar.

8. If you chose Specify Window in Step 4, specify the diagonally opposite
corner of the table.

AutoCAD draws the table. Based on the table size that you indicated,
AutoCAD chooses the column width and number of rows.
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9. Type a title for the table.

10. Press the arrow keys or Tab key to move among cells, and type values
in each cell.

The cell right-click menu offers many other options, including copying
contents from one cell to another, merging cells, inserting rows and
columns, changing formatting, and inserting a block (that is, a graphical
symbol — see Chapter 14 for information about blocks).

The fields feature described earlier in this chapter works for table text,
too — you can insert a field into a table cell. For example, you might use
this feature to create part of a title block, with fields serving as the
“date” and “drawn by” data.

11. Click OK on the Text Formatting toolbar.

Figure 10-8 shows a completed table, along with the Insert Table
dialog box.

You can edit cell values later simply by double-clicking in a cell. To change
column width or row height, click on the table grid and then click and move
the blue grips. (To change the width of one column without altering the over-
all width of the table, hold down the Ctrl key while you move the grip.) If you
want to change other aspects of a table or individual cells in it, select the
table or cell and use the Properties palette to make changes.
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You can import tables from Microsoft Excel instead of using the Insert Table
dialog box. To import Excel data, in Excel, select the desired cells and choose
Edit2>Copy. Then in AutoCAD, choose Edit=>Paste Special and choose
AutoCAD Entities in the Paste Special dialog box. AutoCAD attempts to copy
the Excel spreadsheet’s formatting along with the cell data, but you’ll proba-
bly have to adjust column widths and perform other cleanup on the imported
table.

You can go the other direction — from AutoCAD to Excel or another program —
via a CSV (Comma Separated Value) file. Look up “TABLEEXPORT command”
in AutoCAD’s online help index.

You can extract attribute data to tables. See Chapter 14 for information about
blocks and attributes. You can also perform simple calculations in tables,
using predefined functions or your own arithmetical expressions. Look up
“Use Formulas in Table Cells” in AutoCAD’s online help Search page.

Checking Out Your Spelling

AutoCAD, like almost every other computer program on this planet — and
possibly on other planets and moons in our solar system — has a spelling
checker.

Unlike Microsoft Word, AutoCAD’s spelling checker doesn’t make those little
red squiggles under your errors, but it does let you search for spelling errors
in most of the text objects in your drawing. This feature checks single-line
text, paragraph text, attribute text (described in Chapter 14), and tables, but
not dimension text (described in Chapter 11). The following procedure
demonstrates how to use the spell checker:

1. Press the Esc key to deselect any selected objects.
2. Choose Tools=Spelling to start the SPELL (SP) command.
The command line prompts you to select objects.

3. Select the objects you want to check.

You can use any of the standard AutoCAD object selection methods to
select text to check. (See Chapter 7 if you're unfamiliar with object selec-
tion.) Type ALL and press Enter if you want to check the spelling of all
text in the drawing. Don’t worry if you select objects other than text; the
spelling checker ignores any objects that aren’t text. When you're fin-
ished selecting objects, press Enter to start the spelling check.

If a misspelling is found, the Check Spelling dialog box appears with the
first misspelled or unrecognized word. Figure 10-9 shows an example.
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4. Click the dialog box buttons to tell AutoCAD how to handle a
misspelling.

You probably know which buttons to click from having used other
spelling checkers. If not, use the dialog box help to find out: Click the
question mark on the Check Spelling dialog box’s title bar, and then click
the button that you want to know more about.

AutoCAD continues with spell checking until it has checked all the
selected text objects. When it finds no further misspellings, the dialog
box disappears, and the Spelling check complete alert appears.

Every industry has its own abbreviations and specialized vocabulary. At first,
AutoCAD complains about perfectly good words (from a drafter’s point of
view) such as thru and S.A.D. (which stands for See Architectural Drawing).
Be prepared to click the Add button frequently during the first few weeks to
tell AutoCAD which words and abbreviations are acceptable in your industry
and office. If you're patient with it, AutoCAD, like an errant puppy, will gradu-
ally become more obedient. Then you’ll be thru feeling S.A.D.
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Chapter 11
Entering New Dimensions

In This Chapter

Understanding dimension parts and types

Using dimension styles from other drawings
Creating and modifying your own dimension styles
Drawing dimensions

Editing dimensions

Drawing leaders

n drafting — either CAD or manual drafting — dimensions are special text

labels with attached lines that together indicate unambiguously the size of
something. Although it’s theoretically possible to draw all the pieces of each
dimension by using AutoCAD commands such as LINE (L) and MTEXT (T),
dimensioning is so common a drafting task that AutoCAD provides special
commands for doing the job more efficiently. These dimensioning commands
group the parts of each dimension into a convenient, easy-to-edit package.
Even better, as you edit an object — by stretching it for example — AutoCAD
automatically updates the measurement displayed in the dimension text label
to indicate the object’s new size, as shown in Figure 11-1.

AutoCAD controls the look of dimensions by means of dimension styles, just
as it controls the look of text with text styles. (AutoCAD also uses text styles
to control the appearance of the text in dimensions.) But dimension styles
are much more complicated than text styles because dimensions have so
many more pieces that you need to control. After you find or create an appro-
priate dimension style, you use one of several dimensioning commands to
draw dimensions that point to the important points on an object (the two
endpoints of a line, for example).
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Dimension updates when you change the object

AutoCAD dimensioning is a big, complicated subject. (It’s so complicated, in
fact, that Autodesk has an especially wise person in charge of dimensioning
in AutoCAD — this person is called the dimwit.) Every industry has its own
dimensioning conventions, habits, and quirks. As usual, AutoCAD tries to
support them all and, in so doing, makes things a bit convoluted for every-
one. This chapter covers the essential concepts and commands that you
need to know to start drawing dimensions. Be prepared to spend some addi-
tional time studying how to create any specialized types of dimensions that
your industry uses.

You may be able to avoid getting too deeply into the details of dimensioning
just by copying dimension styles from existing drawings in your office. (We
show you how later in this chapter.) This may also be a good time to get
some advice and coaching from the AutoCAD geek in the cubicle across from
yours.

You add dimensions to a drawing after you've drawn at least some of the
geometry; otherwise, you won’t have much to dimension! Your dimensioning
and overall drafting efficiency improve if you add dimensions in batches,
rather than draw a line, draw a dimension, draw another line, draw another
dimension. . . .
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Why dimensions in CAD?

You may think that CAD would have rendered
text dimensions obsolete. After all, you comply
with all our suggestions about using AutoCAD
precision techniques when you draw and edit,
and you're careful to draw each object at its
true size, right? The contractor or machinist can
just use AutoCAD to query distances and angles
in the CAD DWG file, right? Sorry, but no (to the
last question, anyway). Here are a few reasons
why the traditional dimensioning that CAD draft-
ing has inherited from manual drafting is likely
to be around for a while:

1~ Some people need to or want to use paper
drawings when they build something.
We're still some time away from the day
when contractors haul computers around
on their tool belts (never mind mousing
around a drawing while hanging from
scaffolding).

v In many industries, paper drawings still
rule legally. Your company may supply both
plotted drawings and DWG files to clients,
but your contracts probably specify that the
plotted drawings govern in the case of any
discrepancy. The contracts probably also
warn against relying on any distances that

the recipient of the drawings measures —
using measuring commands in the CAD
DWG file or a scale on the plotted drawing.
The text dimensions are supposed to supply
all the dimensional information that's
needed to construct the object.

v Dimensions sometimes carry additional
information besides the basic length or
angle. For example, dimension text can indi-
cate the allowable construction tolerances
or show that a particular distance is typical
of similar situations elsewhere on the
drawing.

v~ Even conscientious CAD drafters rarely
draw every object its true size. Drafters
sometimes exaggerate distances for graph-
ical clarity. For example, they might draw a
small object larger than its true size so that
it shows up clearly on a scaled plot. In addi-
tion, drafters sometimes settle for approxi-
mate distances because time pressures
(especially late in a project) make it difficult
to be completely accurate.

So remember the old rule of drafting prowess:
“It's not the size of the drawn object that mat-
ters, but the dimensions that are on it.”

Discovering New Dimensions

Before digging into the techniques that you use to create dimension styles
and dimensions, we review some AutoCAD dimensioning terminology. If
you’re already familiar with CAD dimensioning lingo, just skim this section
and look at the figures in it. Otherwise, read on.
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Anatomy of a dimension

AutoCAD uses the names shown in Figure 11-2 and described in the following
list to refer to the parts of each dimension:

v Dimension text: Dimension text usually is the number that indicates the
actual distance or angle. Dimension text can also include other text
information in addition to or instead of the number. For example, you
can add a suffix such as TYP. to indicate that a dimension is typical of
several similar configurations, or you can insert a description such as
See Detail 3/A2.

v Dimension lines: In dimensions that indicate length or distance, the
dimension lines go from the dimension text outward, either horizontally,
vertically, or parallel to the object being measured, to indicate the
extent of the dimensioned distance. (For other dimension types — for
example, the ones shown in Figure 11-3 — the dimension line simply
points at the object being dimensioned.) AutoCAD’s default dimension
style settings center the dimension text vertically and horizontally on
the dimension lines (see Figure 11-2), but you can change those settings
to cause the text to appear in a different location — riding above an
unbroken dimension line as shown in Figure 11-1, for example. See the
section “Adjusting style settings,” later in this chapter, for instructions.

v Dimension arrowheads: The dimension arrowheads appear at the ends
of the dimension lines and clarify the extent of the dimensioned length.
AutoCAD’s default arrowhead style is the closed, filled type shown in
Figure 11-2, but you can choose other symbols, such as tick marks, to
indicate the ends of the dimension lines. (Don’t get ticked off, but
AutoCAD calls the line ending an arrowhead even when, as in the case of
a tick mark, it doesn’t look like an arrow.)

1 Extension lines: The extension lines extend outward from the extension
line origin points that you select (usually by snapping to points on an
object) to the dimension lines. By drafting convention, a small gap usu-
ally exists between the extension line origin points and the beginning of
the extension lines. You can also make a set of dimensions look tidier by
assigning fixed lengths for the extension lines. And if you need to dimen-
sion to circles or centerlines, you can assign dash-dot linetypes to either
or both extension lines. The extension lines usually extend just beyond
where they meet the dimension lines.
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A field guide to dimensions

AutoCAD provides several types of dimensions and commands for drawing
them. Figure 11-3 shows the most common types, and the following list
describes them:

v Linear dimensions: A /inear dimension measures the linear extent of an
object or the linear distance between objects. Most linear dimensions
are either horizontal or vertical, but you can draw dimensions that are
rotated to other angles, too.

v Aligned dimensions: An aligned dimension is similar to a linear dimen-
sion, but the dimension line tilts to the same angle as a line drawn
through the origin points of its extension lines.

v Radial dimensions: A radius dimension calls out the radius of a circle or
arc, and a diameter dimension calls out the diameter of a circle or arc.
You can position the dimension text inside or outside the curve, as
shown in Figure 11-3. If you position the text outside the curve, AutoCAD
(by default) draws a little cross at the center of the circle or arc.
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v Angular dimensions: An angular dimension calls out the angular mea-
surement between two lines, the two endpoints of an arc, or two points
on a circle. The dimension line appears as an arc that indicates the
sweep of the measured angle.

Vertical linear

dimension Aligned dimension Radius dimension
RC.7S
|
Figure 11-3: B
Common
types of —@1.50
dimensions.
|
Angular Horizontal Diameter
dimension linear dimension dimension

Other types of AutoCAD dimensions include arc length, ordinate, tolerance,
center mark, and leader dimensions. See the “Pointy-Headed Leaders” section
at the end of this chapter for instructions on how to draw leaders. Look up
“dimensions, creating” on the Index tab in the AutoCAD online help system
for more information about other kinds of dimensions.

Dimension associativity

By default, AutoCAD groups all the parts of each dimension — the extension
lines, dimension lines, arrowheads, and text — into a special associative
dimension object. Associative means two things:

v The different parts of the dimension function as a single object. When
you click any part of the dimension, AutoCAD selects all of its parts.

v The dimension is connected with the points on the object that you spec-
ified when you drew the dimension. If you change the size of the object
(for example, stretch a line), the dimension updates appropriately — the
lines and arrows move, and the text changes to reflect the line’s new
size.
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The associative dimensions we’re talking about here first appeared in
AutoCAD 2002. Before that, AutoCAD had a more primitive kind of dimension-
ing. Dimensions were single objects, and they did update if you stretched an
object while being very careful to include the dimension itself in the crossing
selection for the STRETCH (S) command. Here’s where things can get a bit
confusing: AutoCAD used to call these old-style, single-object dimensions
associative, but now calls them non-associative. It doesn’t stop there, either;
what used to be called non-associative dimensions before AutoCAD 2002 are
now called exploded dimensions. For more information about how to deter-
mine which kind of dimension AutoCAD draws, see the “Controlling and edit-
ing dimension associativity” section, later in this chapter.

Pulling out your dimension tools

The AutoCAD Dimension menu provides access to dimensioning commands.
If you find yourself adding dimensions in batches, the Dimension toolbar is
more efficient because it makes the dimensioning commands more accessi-
ble. You toggle the Dimension toolbar off and on by right-clicking any
AutoCAD toolbar icon and choosing Dimension from the menu. As with other
toolbars, you can move the Dimension toolbar to a different location on the
screen or dock it on any margin of the drawing area.

All dimensioning commands have long command names (such as DIMARC,
DIMLINEAR, and DIMRADIUS) and corresponding shortened abbreviations
(such as DAR, DLI, and DRA) that you can type at the command prompt. If
you do lots of dimensioning and don’t want to toggle the Dimension toolbar
on and off repeatedly, memorize the abbreviated forms of the dimension com-
mands that you use frequently. You'll find a list of the long command names
on the Contents tab in the AutoCAD online help system. Choose Command
References>Commands=D Commands. The short names are usually the first,
fourth, and fifth letters of the long names (for example, DimLInear = DLI).

Doing Dimensions with Style (s)

Creating a usable dimension style that gives you the dimension look you want
is the biggest challenge in using AutoCAD’s dimensioning features. Each
drawing contains its own dimension styles, so changes you make to a dimen-
sion style in one drawing affect only that drawing. However, after you get the
dimension styles right in a drawing, you can use it as a template or starting
point for later drawings.
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A dimension style is a collection of drawing settings called dimension vari-
ables, which are a special class of the system variables that we introduce in
Chapter 2.

If you want to see a list of the dimension variable names and look up what
each variable controls, see Contents=>Command Reference=>System
Variables=D System Variables in the AutoCAD online help system. All the
system variables that begin with DIM- are dimension variables.

AutoCAD users, like all computer nerds, like to shorten names. You may hear
them refer to dimstyles and dimvars instead of dimension styles and dimen-
sion variables. You can tell them that doing so makes you think of them as
dimwits — which is actually an honorable title at Autodesk, as we mention
earlier in this chapter.

Borrowing existing dimension styles

If you're lucky enough to work in an office where someone has set up dimen-
sion styles that are appropriate for your industry and project, you can skip
the pain and strain of creating your own dimension styles. If the ready-made
dimension style that you need lives in another drawing, you can use the
DesignCenter palette to copy it into your drawing, as described in the follow-
ing steps:

1. Open the drawing that contains the dimension style you want to copy
(the source drawing).

2. Open the drawing to which you want to copy the dimension style (the
destination drawing).

If you already had both drawings open, make sure that you can see the
destination drawing. If you can’t, open the Window menu and choose
the destination drawing in order to bring it to the foreground.

3. Click the DesignCenter button on the Standard toolbar.

The DesignCenter palette appears. (Chapter 5 describes this palette in
detail.)

4. In the DesignCenter palette, click the Open Drawings tab.

DesignCenter’s navigation pane displays a list of drawings that you cur-
rently have open in AutoCAD.

5. In the left pane of the DesignCenter palette, click the plus sign (+) next
to the name of the drawing that you opened in Step 1.

A list of copyable objects, including Dimstyles, appears.

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 11: Entering New Dimensions 2 63

WING/
&

\\J

Figure 11-4:
Copying a
dimension
style from

one drawing
to another.
|

6. Click and drag the desired dimension style from the right pane of the
DesignCenter palette into the window containing the drawing that you
opened in Step 2, as shown in Figure 11-4.

If the name of the dimension style that you copy duplicates the name of
an existing dimension style in the destination drawing, AutoCAD refuses
to overwrite the existing dimension style. In that case, you must first
rename the existing dimension style in the destination drawing by using
the information in the following section, “Creating and managing dimen-
sion styles.”

7. Change the Use Overall Scale Of factor on the Fit tab of the Modify
Dimension Style dialog box so that it matches the drawing scale factor
of the current drawing.

See Chapter 4 for detailed instructions on calculating and setting the
scale factor.

If you want a dimension style to be available in new drawings, copy the style
to a template drawing and use that template to create your new drawings.
See Chapter 4 for more information about template drawings.
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Creating and managing dimension styles

If you do need to create your own dimension styles, or you want to tweak
ones that you copied from another drawing, you use the Dimension Style
Manager dialog box, shown in Figure 11-5.

14’ Dimension Style Manag 2]>]
Current Dimatyls: 5-DIMS
Styfes Preview of: 5-DIMS
S-DIMS 7agg Sat Cument
S-DIMS-AROW 1;
STANDARD T New...

P ==
[Lovence.. ]

| & / Overide.
2 4 Compare...
K
@ /

List: Description

Al styles |

Close Help

Every drawing comes with a default dimension style named Standard (for
imperial [feet and inches] drawings) or ISO-25 (for metric drawings).
Although you can use and modify the Standard or ISO-25 style, we suggest
that you leave them as is and create your own dimension style(s) for the set-
tings that are appropriate to your work. This approach ensures that you can
use the default style as a reference. More important, it avoids a potential
naming conflict that can change the way your dimensions look if the current
drawing gets inserted into another drawing. (Chapter 14 describes this
potential conflict.)

The following steps describe how to create your own dimension style(s):
1. Choose Format>Dimension Style, or click the Dimension Style
Manager button on the Styles toolbar.
The Dimension Style Manager dialog box appears.

2. In the Styles list, select the existing dimension style whose settings
you want to use as the starting point for the settings of your new style.

For example, select the default dimension style named Standard or
ISO-25.
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3. Click the New button to create a new dimension style that’s a copy of
the existing style.

The Create New Dimension Style dialog box appears.
4. Enter a New Style Name and click Continue.

The New Dimension Style dialog box appears. (This dialog box is
virtually identical to the Modify Dimension Style dialog box shown in
Figure 11-6 in the following section.)

5. Modify dimension settings on any of the seven tabs in the New
Dimension Style dialog box.

See the descriptions of these settings in the next section of this chapter.
In particular, be sure to set the Use Overall Scale Of factor on the Fit tab
to set the drawing scale factor.

6. Click OK to close the New Dimension Style dialog box.
The Dimension Style Manager dialog box reappears.

7. Select your new dimension style from the Styles list and click Set
Current.

Your new dimension style becomes the current dimension style that
AutoCAD uses for future dimensions in this drawing.

8. Click Close.
The Dimension Style Manager dialog box closes.

9. Draw some dimensions to test your new dimension style.

Avoid changing existing dimension styles that you didn’t create, unless you
know for sure what they’re used for. When you change a dimension style set-
ting, all dimensions that use that style change to reflect the revised setting.
Thus, one small dimension variable setting change can affect a large number
of existing dimensions! When in doubt, ask the dimension style’s creator
what the dimension style is for and what the consequences of changing it are.
If that’s not possible, instead of modifying an existing dimension style, create
a new style by copying the existing one and modifying the new one.

A further variation on the already convoluted dimension style picture is
that you can create dimension secondary styles (also called substyles or style
families) — variations of a main style that affect only a particular type of
dimension, such as radial or angular. You probably want to avoid this addi-
tional complication if you can, but if you open the Dimension Style Manager
dialog box and see names of dimension types indented beneath the main
dimension style names, be aware that you're dealing with secondary styles.
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Adjusting style settings

After you click New or Modify in the Dimension Style Manager dialog box,
AutoCAD displays a tabbed New/Modify Dimension Style subdialog box with
a mind-boggling — and potentially drawing-boggling, if you're not careful —
array of settings. Figure 11-6 shows the settings on the Lines tab, which
we’ve modified from the AutoCAD defaults to conform to one office’s drafting
standards.
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Fortunately, the dimension preview that appears on all tabs — as well as on
the main Dimension Style Manager dialog box — immediately shows the
results of most setting changes. With the dimension preview and some trial-
and-error changing of settings, you usually can home in on an acceptable
group of settings. For more information, use the dialog box help feature: Click
the question mark button on the title bar and then click the setting that you
want to know more about.

Before you start messing with dimension style settings, it’s important to
know what you want your dimensions to look like when they’re plotted. If
you’re not sure how it’s done in your industry, ask others in your office or
profession or look at a plotted drawing that someone in the know represents
as being a good example.

The following sections introduce you to the more important New/Modify
Dimension Style tabs and highlight useful settings. Note that whenever you
specify a distance or length setting, you should enter the desired plotted size.
AutoCAD scales all these numbers by the overall scale factor that you enter
on the Fit tab.
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Following lines and arrow's

The settings on the Lines and the Symbols And Arrows tabs control the basic
look and feel of all parts of your dimensions except text. Use these tabs to
change the type and size of arrowheads or the display characteristics of the
dimension and extension lines.

Tabbing to text

Use the Text tab to control how your dimension text looks — the text style
and height to use (see Chapter 10) and where to place the text with respect
to the dimension and extension lines. You'll probably want to change the Text
Style setting to something that uses a more pleasing font than the dorky
default Txt.shx font, such as the Romans.shx font. The default Text Height is
too large for most situations — set it to %", 3mm, or another height that
makes sense. Figure 11-7 shows one company’s standard text settings.
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You must define the text style that you specify for a dimension style with a
height of 0 in the Text Style dialog box. (See Chapter 10 for more information
about variable height and fixed height text styles.) If you specify a fixed
height text style for a dimension style, the text style’s height will override the
Text Height setting in the New/Modify Dimension Style subdialog box. Use a
zero-height style to avoid the problem.

Enter the desired plotted text height. Don’t multiply it by the drawing scale
factor, as you do for ordinary text.
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Industry or company standards usually dictate the size of dimension text.
(For example, /4 inch is common in the architectural industry.) In any case,
make sure you pick a height that’s not too small to read on your smallest
check plot.

Getting fit

The Fit tab includes a bunch of confusing options that control when and
where AutoCAD shoves the dimension text if it doesn’t quite fit between the
dimension lines. The default settings leave AutoCAD in “maximum attempt at
being helpful mode” — that is, AutoCAD moves the text, dimension lines, and
arrows around automatically so that things don’t overlap. If these guesses
seem less than satisfactory to you, try the modified settings shown in Fig-
ure 11-8: Select the Over Dimension Line, Without Leader radio button under
Text Placement and the Draw Dim Line Between Ext Lines check box under
Fine Tuning. (You can always move the text yourself by grip editing it, as we
describe later in this chapter.)

Even at its most helpful, AutoCAD sometimes makes a bad first guess about
how you want your dimension text and arrows arranged. If you think they’ll
look better that way, you can flip your dimension arrows to the other side of
the extension lines. If you're having problems getting the look you want, don’t
flip your wig — flip your arrows by selecting the dimension, right-clicking,
and choosing Flip Arrow from the shortcut menu.

Most important, the Fit tab includes the Use Overall Scale Of setting, as
shown in Figure 11-8. This setting acts as a global scaling factor for all the
other length-related dimension settings.
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If your drawing includes areas of different scales, you can create multiple
dimension styles, one for each scale. Alternatively, you can select the Scale
Dimensions To Layout radio button and draw dimensions in a paper space
layout, rather than in model space. See the “Trans-spatial dimensioning” sec-
tion, later in this chapter, for more information.

The Use Overall Scale Of setting corresponds to the DIMSCALE system vari-
able, and you’ll hear AutoCAD drafters refer to it as such. AutoCAD accepts 0
as a special DIMSCALE setting for dimensioning in paper space layouts. Look
up the DIMSCALE system variable in the AutoCAD online help system for
more information about additional dimension scale options.

Using primary units

The Primary Units tab gives you incredibly detailed — or maybe overly
detailed — control over how AutoCAD formats the characters in the dimen-
sion text string. You usually want to set the Unit format and Precision and
maybe specify a suffix for unitless numbers, if it’s not clear from your draw-
ing what units you’re using. You may also change the Zero Suppression set-
tings, depending on whether you want dimension text to read 0.5000,
.5000, or 0.5. (“Zero Suppression!” also makes a great rallying cry for orga-
nizing your fellow AutoCAD drafters.)

Other style settings

If your work requires that you show dimensions in two different units (such
as inches and millimeters), use the Alternate Units tab to turn on and control
alternate units. If your work requires listing construction tolerances (for
example, 3.5 +/-0.01), use the Tolerances tab to configure the tolerance
format that you want.

The New/Modify Dimension Style dialog box Tolerances tab settings are for
adding manufacturing tolerances (for example, +0.2 or -0.1) to the text of
ordinary dimensions — the kind of dimensions we cover in this chapter.
AutoCAD also includes a separate TOLERANCE (TOL) command that draws
special symbols called geometric tolerances. If you need these symbols, you
probably know it; if you've never heard of them, just ignore them. Look up
“Geometric Tolerance dialog box” on the Index tab in the AutoCAD online
help system for more information.

Drawing Dimensions

After you've copied or created a suitable dimension style, you're ready to
dimension. Fortunately, adding dimensions to a drawing with existing dimen-
sion styles is usually pretty straightforward.
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When you want to dimension something in AutoCAD, you can either select
the object, such as a line or polyline segment, or select points on that object,
such as the endpoints of the line or polyline segment. If you select an object,
AutoCAD finds the most obvious points on it to dimension, such as the end-
points of a line. If you choose to select individual points instead, use object
snaps (see Chapter 5). The points that you pick — or that AutoCAD finds for
you — are called the origins of the dimension’s extension lines. When you
change the size of the object (for example, by stretching it), AutoCAD auto-
matically moves the dimension’s origin points and updates the dimension
text to show the new length.

If you don’t use object snaps or another AutoCAD precision technique to
choose dimension points, the dimension text probably won't reflect the pre-
cise measurement of the object. This lack of precision can cause serious
problems. When in doubt, OSNAP to it!

When you set up a new drawing, make sure that you change the Use Overall
Scale Of setting on the Fit tab in the New/Modify Dimension Style dialog box
(refer to Figure 11-8) so that it matches the drawing scale factor. Before you
draw any dimensions in a drawing that you didn’t set up, check this setting to
make sure it’s correct.

The AutoCAD dimensioning commands prompt you with useful information
at the command line. Read the command line prompts during every step of
the command, especially when you’re trying a dimensioning command for
the first time.

Lining up some linear dimensions

Linear dimensions are the most common type of dimensions, and horizontal
and vertical are the most common of those. The following example demon-
strates all the important techniques for creating horizontal and vertical
linear dimensions, as well as aligned dimensions (which are similar to linear
dimensions):

1. Use the LINE command to draw a nonorthogonal line —, that is, a line
segment that’s not horizontal or vertical.
An angle of about 30 degrees works well for this example.

If you want to apply dimensioning to an object other than a line, use
these steps as a general guideline, filling in the appropriate commands
and data as applicable to your drawing.

2. Set a layer that’s appropriate for dimensions as current.

See Chapter 5 for details on setting a layer as current.
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3. Set a dimension style that’s appropriate for your needs as current.

Choose an existing dimension style from the Dim Style Control drop-
down list on the Styles toolbar or create a new style by using the proce-
dure in the section “Creating and managing dimension styles,” earlier in
this chapter.

. Choose Dimension=Linear or click the Linear button on the

Dimension toolbar.
AutoCAD prompts you:

Specify first extension line origin or <select
object>:

. To specify the origin of the first extension line, snap to the lower-left

endpoint of the line by using endpoint object snap.

If you don’t have endpoint as one of your current running object snaps,
specify a single endpoint object snap by holding down the Shift key,
right-clicking, and choosing Endpoint from the menu. (See Chapter 5 for
more about object snaps.)

AutoCAD prompts you:

Specify second extension line origin:

. To specify the origin of the second extension line, snap to the other

endpoint of the line by using endpoint object snap again.

AutoCAD draws a horizontal dimension — the length of the displace-
ment in the left-to-right direction — if you move the crosshairs above or
below the line. It draws a vertical dimension — the length of the dis-
placement in the up-and-down direction — if you move the crosshairs to
the left or right of the line.

AutoCAD prompts you:

Specify dimension line location or
[Mtext/Text/Angle/Horizontal /Vertical /Rotated] :

. Move the mouse to generate the type of dimension you want, horizon-

tal or vertical, and then click wherever you want to place the dimen-
sion line.

When you're specifying the dimension line location, you usually don’t
want to object snap to existing objects — you want the dimension line
and text to sit in a relatively empty part of the drawing rather than bump
into existing objects. If necessary, temporarily turn off running object
snap (for example, click the OSNAP button on the status bar) in order to
avoid snapping the dimension line to an existing object.

AutoCAD draws the dimension.
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If you want to be able to align subsequent dimension lines easily, turn on
snap and set a suitable snap spacing — more easily done than said! —
before you pick the point that determines the location of the dimension
line. See Chapter 4 for more information about snap.

. Repeat Steps 4 through 7 to create another linear dimension of the

opposite orientation (vertical or horizontal).

. Choose Dimension=>Aligned or click the Aligned button on the

Dimension toolbar.

The prompt includes an option to select an object instead of picking
two points (you can use this technique with the Linear Dimension com-
mand, too):

Specify first extension line origin or <select
object>:

Press Enter to choose the Select Object option.
AutoCAD prompts you:
Select object to dimension:
Select the line or other object that you want to dimension.

AutoCAD automatically finds the endpoints of the line and uses them as
the extension line origin points, as shown in Figure 11-9.

AutoCAD uses endpoints as dimension origin points
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AutoCAD prompts you:

Specify dimension line location or
[Mtext/Text/Angle] :

12. Click wherever you want to place the dimension line.

AutoCAD draws the dimension.

Drawing other kinds of dimensions

After you have the hang of ordinary linear dimensions, you should be able to
master other common dimension types quickly. Draw some lines, arcs, and
circles, and try the other dimension commands on the Dimension toolbar

or menu.

To draw a series of side-by-side dimensions whose dimension lines are per-
fectly aligned, use the DIMCONTINUE (DCO) command. To draw an overall
dimension above one or more smaller dimensions, use DIMBASELINE (DBA).
If you use these commands often in your work, you may find that the QDIM
(Quick DIMension) command provides a quick way to draw lots of dimen-
sions in one fell swoop. (And wouldn’t you know it — QDIM is not included in
AutoCAD LT))

Figure 11-10 shows some results of using the more common additional dimen-
sioning commands.
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Arc dimensions created with the DIMARC (DAR) command measure the
length along the circumference of the arc, not the radius. Make sure your
industry or office standards agree with this type of dimensioning — the stan-
dard way of dimensioning arcs is with a radius dimension like the one in
Figure 11-3.

Trans-spatial dimensioning

Trans-spatial dimensioning may sound like the latest New Age fad — after all,
most of Autodesk’s programmers do work in California — but actually, it’s
just a relatively new (circa AutoCAD 2002) dimensioning feature. There’s an
age-old argument about whether to draw dimensions in model space, where
the geometry that you’re dimensioning usually resides, or paper space. (See
Chapter 4 for information about model space and paper space.) Many people
have settled on dimensioning in model space, but sometimes dimensioning in
paper space offers advantages — for example, when you want to dimension
different parts of the same geometry in different paper space viewports.

Since AutoCAD 2002, the program works much better for dimensioning in
paper space layouts — when you set the DIMSCALE system variable to 1.0
and then draw dimensions in paper space, AutoCAD can associate them with
objects in model space.

Get comfortable with dimensioning in model space first. If you later want to
try dimensioning in paper space, look up “dimensioning, methods” in the
AutoCAD online help system.

Editing Dimensions

After you draw dimensions, you can edit the position of the various parts of
each dimension and change the contents of the dimension text. AutoCAD
groups all the parts of a dimension into a single object.

Editing dimension geometry

The easiest way to change the location of dimension parts is to use grip edit-
ing, which we describe in Chapter 7. Just click a dimension, click one of its
grips, and maneuver away. You'll discover that certain grips control certain
directions of movement. Experiment a few minutes to see how they work.
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If you want to change the look of a dimension part (for example, substitute a
different arrowhead or suppress an extension line), use the Properties
palette. (See Chapter 7 for more on the Properties palette.) All the dimension
settings in the New/Modify Dimension Style dialog box (see “Adjusting style
settings,” earlier in this chapter) are available in the Properties palette when
you select one or more dimensions.

If you select one or more dimensions and right-click, the menu displays a
number of useful options for overriding dimension settings or assigning a dif-
ferent style.

When you change a setting in the Properties palette, you're overriding the
default style setting for that dimension. If you need to make the same change to
a bunch of dimensions, it’s better to create a new dimension style and assign
that style to them. You can use the Properties palette or the right-click menu to
change the dimension style that’s assigned to one or more dimensions.

You can use the Properties palette to turn on AutoCAD’s background mask
feature, described in Chapter 10, for the text of individual dimensions: Select
the dimensions, display the Text area in the Properties palette, and choose
either Background or a specific color from the Fill Color drop-down list. (To
ensure that dimension text lies on top of other objects, use the DRaworder or
TEXTTOFRONT command — see Chapter 10 for more information.) Note that
turning on background mask in the In-Place Text Editor window, as Chapter
10 tells you to do for regular (nondimension) text, does not work for dimen-
sion text. You must use the Fill Color setting on either the Text tab of the
New/Modify Dimension Style dialog box (as described earlier in this chapter)
or the Properties palette.

The AutoCAD EXPLODE (X) command on the Modify toolbar will blow a dimen-
sion apart into a bunch of line and multiline text objects. Don’t do it! Exploding
a dimension makes it much harder to edit cleanly and eliminates AutoCAD’s
capability of updating the dimension text measurement automatically.

Editing dimension text

In most cases, you shouldn’t have to edit dimension text. Assuming that you
drew your geometry accurately and picked the dimension points precisely,
AutoCAD displays the right measurement. If you change the size of the asso-
ciated object, AutoCAD updates the dimension and its measurement.
However, you occasionally may need to override the dimension text (that is,
replace it with a different measurement) or add a prefix or a suffix to the true
measurement.
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AutoCAD creates dimension text as a multiline text (Mtext) object, so dimen-
sion text has the same editing options as ordinary text. Unfortunately, the
right-click menu for dimension objects doesn’t include a Text Edit option. You
can use the Text Override field in the Properties palette, or type ED (the key-
board shortcut for the DDEDIT command), to edit dimension text in the In-
Place Text Editor window.

The default text is <> (that is, the left- and right- angled bracket characters),
which acts as a placeholder for the true length. In other words, AutoCAD dis-
plays the true dimension length as text in the actual dimension (and keeps
the text up to date if you change the distance between the dimension’s origin
points). You can override the true length by typing a specific length or other
text string. You can preserve the true length but add a prefix or suffix by
typing it before or after the left- and right-angled bracket characters. In other
words, if you enter <> Max., and the actual distance is 12.00, AutoCAD dis-
plays 12.00 Max. for the dimension text. If you later stretch the object so
that the actual distance changes to 14.50, AutoCAD automatically changes
the dimension text to read 14.50 Max. Now you can appreciate the impor-
tance of drawing and editing geometry precisely!

Avoid the temptation to override the default dimension text by replacing the
angled brackets with a numeric value. Doing so eliminates AutoCAD’s capabil-
ity of keeping dimension measurements current, but even worse, you get no
visual cue that the default distance has been overridden (unless you edit the
dimension text). If you're overriding dimension text a lot, it’s probably a sign
that the creator of the drawing didn’t pay enough attention to using precision
techniques when drawing and editing. We're not going to point any fingers,
but you probably know whom to talk to.

Controlling and editing dimension
associativity

When you add dimensions by selecting objects or picking points on the
objects by using object snap modes, AutoCAD normally creates associative
dimensions, which are connected to the objects and move with them. This is
the case in new drawings that were originally created in any version of
AutoCAD starting with 2002.

AutoCAD automatically creates associative dimensions only in AutoCAD 2002
and later drawings. (See the “Dimension associativity” section, earlier in this
chapter, for more information.) If you have to edit drawings created in
AutoCAD 2000 or even earlier versions of AutoCAD, you must set the DIMAS-
SOC system variable to 2 before AutoCAD 2007 will create the new-style
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associative dimensions. An easy way to make this change for the current
drawing is to open the Options dialog box (choose Tools®>Options), click the
User Preferences tab, and turn on the Make New Dimensions Associative set-
ting. Be aware that this setting affects only new dimensions that you draw
from now on. Thus, you’ll end up with associative new dimensions and non-
associative existing dimensions in your old drawing. Look up “DIMASSOC
system variable” in the AutoCAD online help system for more information.

You aren’t likely to need any of these three commands very often, but if you
do, look up the command name in the online help system:

v DIMREASSOCIATE: If you have dimensions that aren’t currently associa-
tive (probably because they were created in older versions of AutoCAD)
or are associated with the wrong objects, you can use the DIMREASSOCI-
ATE command (Dimension=>Reassociate Dimensions) to associate them
with points on the objects of your choice.

v DIMDISASSOCIATE: You can use the DIMDISASSOCIATE command to
sever the connection between a dimension and its associated object.

v DIMREGEN: In a few special circumstances, AutoCAD doesn’t automati-
cally update geometry-driven associative dimensions (maybe Autodesk
should call them “usually fully awake but occasionally asleep at the
wheel associative dimensions”). In those cases, the DIMREGEN com-
mand will fix things.

Pointy-Headed Leaders

\NG/
S

No, we’re not talking about your boss (or about you, if you happen to be the
boss). We're talking about arrows that point from your comment to the object
or area about which you’re commenting. AutoCAD treats leaders as a special
kind of dimension object (no jokes about dimwitted leaders, now). You can
draw leaders and text at the same time easily by using the QLEADER (LE)
[Quick Leader] command, as described in the following steps.

If you've become attached to typing commands, or if you've been away from
AutoCAD for a number of versions, you may be inclined to type LEADER to
create those pointy-headed thingies. If you do, be aware that what you're
asking AutoCAD is “Take me to your old leader.” For the new and much
improved version, use the menu or toolbar, or type the LE command alias. To
learn more about the old command, look up LEADER command in the online
help index.
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QLEADER is another one of those annoying AutoCAD commands that prompts
you for some information on the command line and some in a dialog box. Pay
close attention to the command line prompts throughout this example:

1. Set a layer — one that’s appropriate for dimensions — current.

See Chapter 5 for the details on setting a layer as current.

. Set a dimension style — one that’s appropriate for your needs —

current.

Choose an existing dimension style from the drop-down list on the Styles
toolbar, or create a new style by using the procedure in the section,
“Creating and managing dimension styles,” earlier in this chapter.

. Choose Dimension->Leader or click the Quick Leader button on the

Dimension toolbar.

The command line prompts you to select the first leader point — that is,
the arrowhead point — and gives you the option of changing leader set-
tings first.

Specify first leader point, or [Settings] <Settings>:

If you want to draw curved rather than straight leader lines or choose a
different leader arrowhead style, press Enter now to open the Leader
Settings dialog box.

. Pick a point that you want to point to.

If you use an object snap mode, such as Nearest or Midpoint, to pick a
point on an object, AutoCAD associates the leader with the object. If you
later move the object, AutoCAD updates the leader so that it points to
the new location.

The command line prompts you for the next point — AutoCAD draws a
shaft from the arrowhead to this point:

Specify next point:

. Pick a second point.

If you pick a second point that’s too close to the arrowhead point,
AutoCAD doesn’t have enough room to draw the arrowhead, and thus
omits it.

AutoCAD repeats the next point prompt so that you can draw a multiseg-
ment shaft if you want to.

Specify next point:
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6. Pick one more point if you want to, or press Enter if you want a leader
with a single shaft.

Pressing Enter tells the QLEADER command that you’re finished select-
ing the points that define the leader shaft. By default, the QLEADER com-
mand lets you pick up to three points (the arrowhead point and two
more points). You can change this behavior in the Leader Settings dialog
box (refer to Step 3).

The command line prompts you to specify the width for word-wrapping
the text that you’ll attach to the leader:

Specify text width <0.0000>:

The default text width, 0.0000, turns off word-wrapping and displays
your text on a single line. You can type a width or point and click with
the mouse.

Turning off word-wrapping works fine for short notes that fit on one line.
If you think your note may be longer, specify a width instead of accept-
ing the default value of 0.0000.

You can also specify a width for your note by picking points on-screen.
This is often a more sensible approach than trying to guess a numeric
width.

7. Press Enter to suppress word-wrapping, or move the crosshairs to the
right or left to specify a width for word-wrapping; then click.

The command line prompts you to type a short note directly at the com-
mand line, or you can press Enter to type your note in the In-Place Text
Editor window:

Enter first line of annotation text <Mtext>:
8. Press Enter to open the In-Place Text Editor window.
9. Enter your comment.
10. Click OK.
The In-Place Text Editor window closes and adds your comment to the
drawing, next to the leader.

Figure 11-11 shows several different leaders with notes.

If both the leader arrowhead and the text are the wrong size or appear to be
missing entirely, the dimension scale isn’t set correctly in the drawing. (As we
warn you earlier, AutoCAD treats leaders as a special kind of dimension
object.) See Chapter 4 for detailed instructions on how to set the dimension
scale. After you set the dimension scale properly, erase and re-create the
leader and text.
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If you add a comment to a drawing and later decide that the comment merits
a leader, you can use the QLEADER command to draw the leader so that the
end of the shaft ends up in the vicinity of the existing text object. Then, when
the In-Place Text Editor window appears (Step 8 in the previous steps), click

OK without entering any new text.

Aleader and the text that you draw with it are partially associated with each
other. When you move the text, the leader’s shaft follows. Unfortunately, the
converse isn’'t true — moving the leader or one of its vertices doesn’t cause

the text to follow.
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Adding hatching to your drawings

Copying existing hatches

Using predefined and user-defined hatch patterns

Making solid and gradient fills

Scaling hatches properly

Choosing hatching boundaries
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If you were hoping to hatch a plot (or plot a hatch), see Chapter 13 instead.
If you want to hatch an egg, buy our companion book, Raising Chickens
For Dummies. If you need to fill in closed areas of your drawings with special
patterns of lines or solid fills, this is your chapter.

Drafters often use hatching to represent the type of material that makes up
an object, such as insulation, metal, concrete, and so on. In other cases,
hatching helps emphasize or clarify the extent of a particular element in the
drawing — for example, showing the location of walls in a building plan, or
highlighting a swampy area on a map so you know where to avoid building a
road. Figure 12-1 shows an example of hatching in a structural detail.

An AutoCAD hatch is a separate object that fills a space, that has an appear-
ance dictated by the hatch pattern assigned to it, and that is associated with
the objects that bound the space, such as lines, polylines, or arcs. If you
move or stretch the boundaries, AutoCAD normally updates the hatching to
fill the resized area.

Don’t go overboard with hatching. The purpose of hatching is to clarify, not
overwhelm, the other geometry in the drawing. If your plots look like a patch-
work quilt of hatch patterns, it’s time to simplify.

Hatching is another kind of annotation of your geometry, similar in purpose
to text and dimensions. As we describe at the beginning of Chapter 10, you'll
usually be more efficient if you save annotation for later in the drafting
process. Draw as much geometry as possible first, and then hatch the parts
that require it. In other words, batch your hatch.
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This section outlines the steps you use to add hatching to a drawing with the
Hatch And Gradient dialog box, shown in Figure 12-2. (AutoCAD LT doesn’t do
gradients, so the dialog box is simply labeled Hatch.)You can use this infor-
mation to get started quickly with hatching. When you need more informa-
tion about any part of the process, jump to the relevant sections of “Pushing
the Boundary (of) Hatch,” later in this chapter.
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To see the additional hatch options at the right side of the dialog box in
Figure 12-2, click the More Options arrow beside the Help button.

The following steps show you how to hatch an enclosed area by using the
“pick points” method of selecting the hatch area:

1. Open a drawing containing geometry that forms fully closed bound-
aries, or draw some boundaries by using the drawing commands we
describe in Chapter 6.

The areas you want to hatch should be completely enclosed. The
CIRCLE (C), POLYGON (POL), and RECTANG (REC) commands, and the
LINE (L) and PLINE (PL) commands with the Close option, make great
hatch boundaries (see Chapter 6 for details).

It’s possible to set an obscure system variable named HPGAPTOL so
that you can hatch an area whose boundaries are not perfectly closed.
We strongly recommend that you ignore this option until you are so pro-
ficient with AutoCAD that you’ll never need it anyway.

2. Set an appropriate layer current, as described in Chapter 5.
It’s usually best to put hatching on its own layer.

3. Start the HATCH (H) command by clicking the Hatch button on the
Draw toolbar.

\\J

The Hatch And Gradient dialog box appears.

4. Choose Predefined, User Defined, or Custom from the Type drop-
down list.

Predefined or User Defined works best for most purposes. See the next
section for details.

5. If you chose Predefined or Custom in the previous step, select any
predefined or custom hatch pattern from the Pattern drop-down list
or the Pattern button just to the right of it. If you chose User Defined,
you don’t need to choose a pattern.

6. Specify an Angle and Scale for the hatch pattern. (Or, if you chose
User Defined in Step 4, specify Angle and Spacing.)

See the section, “Getting it right: Hatch angle and scale,” later in this
chapter, for more information.

7. Click the Add: Pick Points button.

The Hatch And Gradient dialog box (temporarily) disappears, and your
drawing reappears with the following prompt at the command line:

Select internal point or [Select objects/remove
Boundaries] :
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8.

10.

11.

12.

13.

Select a point inside the boundary within which you want to hatch by
clicking it with the mouse.

AutoCAD analyzes the drawing and decides which boundaries to use. In
a complex drawing, this analysis can take several seconds. AutoCAD
highlights the boundary that it finds.

If AutoCAD highlights the wrong boundary, right-click, choose Clear All
from the menu, and try again.

. Right-click anywhere in the drawing area and choose Enter from the

menu to indicate that you're finished selecting points.
The Hatch And Gradient dialog box reappears.
Click the Preview button to preview the hatch.

The Hatch And Gradient dialog box (temporarily) disappears again, and
AutoCAD shows you what the hatch will look like.

Pick or press Esc to return to dialog or <Right-click
to accept hatch>:

Click anywhere in the drawing area to return to the Hatch And
Gradient dialog box.

Adjust any settings and preview again until you're satisfied with the
hatch.

Click OK.

AutoCAD hatches the area inside the boundary. If you modify the bound-
ary, the hatch automatically resizes to fill the resized area.

Occasionally, AutoCAD gets confused and doesn’t resize a hatch after you
resize the boundary. If that happens, erase and then re-create the hatch in
the resized area.

Pushing the Boundary (of) Hatch

The remainder of this chapter shows you how to refine the techniques pre-
sented in the preceding section. We describe how to copy existing hatching,
take advantage of the various options in the Hatch And Gradient dialog box,
and choose more complicated hatching boundaries.

Hatch from scratch

You can use predefined, user-defined, or custom hatch patterns. Most of the
time, you'll choose either predefined or user-defined hatch patterns, unless
some generous soul gives you a custom pattern.
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Catch a hatch: Copying hatch properties

One slick way to hatch is by using the Inherit
Properties button in the Hatch And Gradient
dialog box to copy hatch properties from an
existing hatch object. Think of it as point and
shoot hatching. If someone — such as you —
added some hatching in the past that's just like
what you want to use now, click the Inherit
Properties button and pick the existing hatching.

Inherit Properties updates the hatch pattern
settings in the Hatch And Gradient dialog box to
make them the same as the existing hatch pat-
tern object that you picked. You can use the

cloned hatch pattern specifications as is or
modify them by making changes in the Hatch
And Gradient dialog box.

Consistency is a good thing in drafting, espe-
cially in computer-aided drafting, in which some
or all of your drawing may be used for a long
time. Thus, it's good to use the same hatch pat-
terns, scales, and angles for the same purposes
in all your drawings. Find out whether your pro-
ject, office, company, or profession has hatch-
ing standards that apply to your work.

Pick a pattern, any pattern: Predefined hatch patterns

To use AutoCAD’s predefined hatch patterns, select Predefined from the Type
drop-down list at the top of the Hatch tab in the Hatch And Gradient dialog
box. This selection sets the stage for choosing the hatch pattern.

You specify a predefined hatch pattern in one of two ways:

v If you know the name of the hatch pattern, select it from the Pattern
drop-down list. The list is alphabetical, except that SOLID (that is, a
solid fill) is at the very beginning.

Chapter 12: Down the Hatch 285

v If you don’t know the pattern’s name, or you prefer the visual approach,
click the Pattern button (the tiny button with the ellipsis [three dots] to
the right of the Pattern drop-down list and pattern name) to display the
Hatch Pattern Palette with pattern previews and names.

AutoCAD has about 80 predefined hatch patterns from which to choose.
The list includes ANSI (American National Standards Institute) and ISO
(International Standards Organization) standard hatch patterns. Figure 12-3
shows the some of the Other Predefined hatch patterns, which cover every-
thing from Earth to Escher to Stars. Hatch patterns whose names begin with
AR- are intended for architectural and related industries.

After you've selected a pattern, specify angle and scale, as we describe in the
section, “Getting it right: Hatch angle and scale,” later in this chapter.
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Make it solid, man

Although you may not guess it, AutoCAD treats use the PLINE command’s Width option.
filling an area with a solid color as a type of (Chapter 6 discusses the DONUT and PLINE
hatching. Simply choose SOLID from the top of commands.)

it Paiaitn el (s v If you want a pattern that starts out solid but

Like any other object, a solid hatch takes on then fades away (or transitions to a differ-
the current object color— or the current layer’s ent color) in one or more directions, use the
color if you leave color set to Bylayer. Gradient tab on the Hatch And Gradient
Therefore, check whether the current object dialog box (not included in AutoCAD LT).
layer and color are set appropriately before you This option creates a gradient fill. You can
use the Solid hatching option (see Chapter 5 for control the color(s), direction(s), and angle
details). of the gradient.

You can create the effect of a solid fill in  Solid and gradient fills are a good way to mimic
AutoCAD in several other ways: poché — an old, hand-drafting technique in
which you shade areas with a lighter colored
pencil (usually red) to make those areas appear
lightly shaded on blueline prints. The following
figure shows some examples of solid and gra-
v If you want one or more line segments dientfills.
with either uniform or tapered widths,

v~ If you want a filled-in circle or donut, use
the DONUT (DO) command and specify an
inside diameter of 0.
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It’s up to you: User-defined hatches

A user-defined hatch pattern makes a hatch pattern out of parallel lines. Use
this option to create a simple pattern and specify the space between the lines
in drawing units. For example, you can hatch a wall in a building plan with a
user-defined pattern and specify that the hatch lines be three inches apart.

After you choose User Defined from the Type drop-down list in the Hatch And
Gradient dialog box, you specify the angle and spacing of the lines. You can
select the Double check box to achieve a crosshatching effect (two perpen-
dicular sets of hatching lines).

Getting it vight: Hatch angle and scale

Predefined and custom hatch patterns require that you enter the angle and
scale for AutoCAD to generate the hatching. You usually won’t have any trou-
ble deciding on an appropriate angle, but a suitable scale can be tricky.

The hatch scale usually should be a pattern-specific multiplier times the
drawing scale factor, as described in Chapter 4. For example, the EARTH
pattern (in the Other Predefined tab of the Hatch Pattern Palette; refer to
Figure 12-3) looks pretty good in a full-scale (1 = 1) drawing with a hatch scale
of 0.75. If you're adding EARTH pattern hatching to a 1" = 1'-0" detail (drawing
scale factor equals 12), try using a hatch scale of 0.75 x 12, or 9.0. This pat-
tern-specific multiplier and drawing-scale-factor approach ensures that
hatching looks consistent (that the spaces between the lines are the same) at
all scales when you plot.
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Assuming that you know your drawing’s scale factor, the only complication is
figuring out what the pattern-specific multiplier should be for a particular
hatch pattern. In a more rational world, the pattern-specific multiplier would
always be something sensible, like 1.0. Unfortunately, that’s not the case for all
hatch pattern definitions. Even worse, there’s no way to predict before you
use a hatch pattern for the first time what an appropriate pattern-specific mul-
tiplier might be. (Autodesk created the hatch patterns whose names begin
with AR- [that is, the ones intended for architectural drawings] with a final
hatch scale of 1.0 in mind, but in some cases, you'll have to adjust up or down
in order to achieve a suitable scale.) You have to use trial and error the first
time and then make a note of the hatch pattern and multiplier for future use.

The first time you use a hatch pattern definition, try 1.0 as the multiplier.
Don’t forget to multiply by the drawing scale factor. Preview the hatch and
then adjust the hatch scale in steps; preview after each change. After you
settle upon a scale for the current drawing, calculate the corresponding mul-
tiplier (for future use); divide the hatch scale by the current drawing’s scale
factor.

User-defined patterns require that you enter an angle and spacing, not angle
and scale. Spacing is expressed in the current drawing units.

Do fence me in: Defining hatch boundaries

After you specify the hatch pattern, angle, and scale you want to use, you
define the boundary (or boundaries) into which you want to pour that hatch
pattern in one of two ways:

v Picking points within the area(s) you want hatched

v Selecting objects that surround those areas

The actual operation involved in using either of these options is confusing to
most people. You'll probably need a little practice before you get used to it.

The idea behind either definition option is simple when applied to simple
areas — that is, closed areas with no additional objects inside them. To
define the hatch boundary for a simple area, do one of these two things:

v Click the Add: Pick Points button in the Hatch And Gradient dialog box
and then click a point inside the boundary.

v Click the Add: Select Objects button and select one or more objects that
form a fully closed boundary.
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This simple hatching gets more complicated if you have one closed object
inside another, as in Figure 12-4. The AutoCAD hatch preview and a bit of
experimentation will clarify all these potentially puzzling permutations.

As we warn earlier in this chapter, boundaries should be completely closed
before AutoCAD will hatch them. That’s one of the reasons you should employ
the precision techniques from this book whenever you draw or edit objects. If
the lines surrounding your boundary don’t either meet exactly or cross,
AutoCAD scolds you with avalid boundary not found error message.

The valid boundary not found error message means that you need to
repair lines or other objects so they are a fully closed boundary. Sometimes
you can use the FILLET (F) command with a zero fillet radius to force two lines
to meet exactly. Another possibility is to use grip editing to align one endpoint
precisely with another. Chapter 7 discusses these two editing techniques.

Hatching that knows its place

AutoCAD’s Hatch And Gradient dialog box includes a Draw Order drop-down
list that controls where AutoCAD places the hatching with respect to the
boundary. (Refer to Figure 12-2.) The default setting, Send Behind Boundary,
puts the hatching underneath its boundary for object selection purposes,
and that’s usually exactly what you want.

Pick inside a Pick one point Pick points
simple area. between two areas. inside both areas.

Select a single Select one boundary Select both
boundary object. object with another boundary objects.
nested inside.
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Have palette, will hatch

With Tool Palettes, described in Chapter 2, you can create click-and-drag
hatch palettes. With a hatch palette, you click a tool (a swatch) and drag into
an enclosed boundary to hatch the area. If your hatching needs are simple,
you can create a Tool Palette for the patterns and scales you often use.

See “hatches, adding to tool palettes” in AutoCAD’s online help for more
information.

Editing Hatch Objects

\\J

Editing an existing hatch pattern is simple after you're familiar with the Hatch
And Gradient dialog box. Follow these steps:

1. Select the hatch object.

2. Right-click anywhere in the drawing area and choose Hatch Edit from
the menu.

AutoCAD opens the Hatch Edit dialog box and displays the hatch
object’s current settings.

3. Make any desired changes, use the Preview button to look them over,
and click OK to keep the changes.

Alternatively, you can use the Properties palette (described in Chapter 7) to
make most existing hatch pattern changes. The Properties palette is espe-
cially good for changing several hatches at once.

To make one hatch look like another, use the Match Properties button on the
Standard toolbar.

The multitude of options in the Hatch And Gradient and Hatch Edit dialog
boxes let you tweak your hatch patterns in all sorts of useful and semi-useful
ways. You can easily set a new origin point for hatch objects, you can hatch
areas that are not fully visible on-screen, and you can optionally hatch multi-
ple boundaries at one go and have the hatches treated as individual objects.

You can find the area of any hatch object by simply selecting the hatch object

and then opening the Properties palette. The area is listed in the Geometry
section, near the bottom of the palette.

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 13
The Plot Thickens

In This Chapter

Configuring printers and plotters
Plotting model space

Plotting to scale

Plotting paper space layouts
Plotting lineweights and colors
Controlling plotting with plot styles
Using page setups

Troubleshooting plotting

Despite the increasing number of offices with a computer (or two) on
every desk, many people still need to or want to work with printed draw-
ings. Perhaps you thought that using AutoCAD means you don’t have to rely
on hard-copy versions of drawings, but you can view them on-screen instead.
Even if that’s true, you may need to give hard-copy prints to your less savvy
colleagues who don’t have AutoCAD. You may want to make some quick prints
to pore over during your bus ride home. You may find that checking drawings
the old-fashioned way — with a hard-copy print and a red pencil — turns up
errors that managed to remain hidden on the computer screen.

Whatever the reason, you’ll want to print drawings at some point — probably
sooner rather than later. Depending on where you are in a project, plotting is
the pop quiz, midterm, or final exam of your drawing-making semester. This
chapter helps you ace the test.

Vou Say Printing, 1 Say Plotting

Plotting originally meant creating hard-copy output on a device that was capa-
ble of printing on larger sheets, such as D size or E size, that measure several
feet on a side. (See Chapter 4 for information about drafting paper sizes.)
These plotters often used pens to draw, robot-fashion, on large sheets of
vellum or drafting film. The sheets could then be run through diazo blueline
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machines — copying machines that create blueline prints — in order to
create less-expensive copies. Printing meant creating hard-copy output on
ordinary printers that used ordinary-sized paper, such as A size (letter size,
8% x 11 inches) or B size (tabloid or ledger size, 11 x 17 inches).

Nowadays, AutoCAD and most CAD users make no distinction between plot-
ting and printing. AutoCAD veterans usually say “plotting,” so if you want to
be hip, you can do so, too.

Whatever you call it, plotting an AutoCAD drawing is considerably more com-
plicated than printing a word processing document or a spreadsheet. CAD
has a larger range of different plotters and printers, drawing types, and
output procedures than other computer applications. AutoCAD tries to help
you tame the vast jungle of plotting permutations, but you’ll probably find
that you have to take some time to get the lay of the land and clear a path to
your desired hard-copy output.

Get with the system

One of the complications you face in your attempts to create a hard copy is
that AutoCAD has two distinct ways of communicating with your plotters and
printers. Operating systems, and the programs that run in them, use a special
piece of software called a printer driver to format data for printing and then
send it to the printer or plotter. When you configure Windows to recognize a
new printer connected to your computer or your network, you're actually
installing the printer’s driver. (“Bring the Rolls around front, James. And bring
me a gin and tonic and a D-size plot while you're at it.”) AutoCAD, like other
Windows programs, works with the printers you've configured in Windows.
AutoCAD calls these system printers because they’re part of the Windows
system.

But AutoCAD, unlike other Windows programs, can’t leave well enough alone.
Some output devices, especially some larger plotters, aren’t controlled very
efficiently by Windows system printer drivers. For that reason, AutoCAD
comes with specialized nonsystem drivers (that is, drivers that are not
installed as part of the Windows system) for plotters from companies such as
Hewlett-Packard, Xerox, and Océ. These drivers are kind of like nonunion
workers. They ignore the tidy rules for communicating with Windows print-
ers in order to get things done a bit more quickly and flexibly.

Using already-configured Windows system printer drivers usually is easiest,
and they work well with many devices — especially devices such as laser and
inkjet printers that print on smaller paper. However, if you have a large plotter,
you may be able to get faster plotting, better plot quality, or more plot fea-
tures by installing a nonsystem driver. To find out more, choose Contents=>
Driver and Peripheral Guider>Use Plotters and Printers in the AutoCAD online
help system.
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Configure it out

For now, you simply should make sure that AutoCAD recognizes the devices
that you want to use for plotting. The following steps show you how:

1. Launch AutoCAD and open an existing drawing or start a new, blank
drawing.

2. Choose Tools=>Options to open the Options dialog box, and click the
Plot and Publish tab.

3. Click the drop-down arrow to view the list just below the Use As
Default Output Device option, as shown in Figure 13-1.

The list includes two kinds of device configurations, designated by two
tiny, difficult-to-distinguish icons to the left of the device names:

¢ Alittle laser printer icon, with a sheet of white paper coming out
the top, indicates a Windows system printer configuration.

e A little plotter icon, with a piece of paper coming out the front,
indicates a nonsystem (that is, AutoCAD-specific) configuration.

The nonsystem configuration names always end in .pc3 because they're

« : : A ; . :
stored in special AutoCAD Plotter Configuration version 3 files. So, if you
can'’t tell the difference between the icons, look for the .pc3 at the end
of the name.

System printers List of devices
3 Options [B2]=]
Cumert profie: Wiey & Cument drawing: Drawing3.dwg
Fies | Display | Open and Save | Plot and Publith | System | Liser Prefesences | Drafting | 30 Modeling | Selection | Profiles
Defauit plot settings for new drawings General plot options
@ UE? as default output device : When changing the plot device:
LI 4050 Loca! —_—— = (%) Keep the lzyout paper size § possile
— - () Use the plot device paper size
gﬁmﬁ i S System printer spool alert:
W g::.;ETenﬁgéﬁ‘la Aways lert {and log emors) v|
Default location for plat to file cperations: DEF iy e
s Automaticaly ssect v |
C\Documents and Settings\Dave My Documents J =
“% [] Lse OLE application when plotting OLE
objects
I Background processing options
F. 13 1 . Enable background plot when: [C] 4o aystem itz
tgure 13-1: [ Petting 4] Putishing Speciy plot offset relative to
SySte ma nd Plot and publish log fie (&) Pretable area ) Edge of paper
no nsystem [#] faromatically save piot and publish log -
p rinter g: :::: ::: io;ntpr:::.: plot log Plot Stamp Settings.. |
Config- : ! Plat Style Table Settings... ]
urations.
| QK Cancel Help
|

Nonsystem printers
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4. Verify that the list includes the printers and plotters that you want to
have available in AutoCAD.

If not, choose Start>Printers and Faxes (in Windows XP), click the Add a
Printer link under Printer Tasks on the left side of the window or
Start=>Settings~Printers (in Windows 2000), launch the Add Printer
Wizard, and follow the instructions. If your printer isn’t in the default
Windows list, cancel the wizard and hunt down a driver disk that came
with your printer, or better yet, download the current driver from the
printer manufacturer’s Web site.

5. Choose the output device that you want to make the default for new
drawings.

6. Click OK to close the dialog box and retain any changes that you
made in the previous step.

You use the AutoCAD Plotter Manager Add-A-Plotter Wizard to create nonsys-
tem driver configurations. (Choose File>Plotter Manager to display a window
containing a shortcut to the wizard.) This wizard is similar to the Windows
Add Printer Wizard; if you can handle adding an ordinary printer in Windows,
you probably can handle adding a nonsystem plotter configuration to
AutoCAD. When you complete the wizard steps, AutoCAD saves the informa-
tion in a PC3 (Plotter Configuration version 3) file. If you add an HP Designjet
plotter, you may be advised by the Add-A-Plotter Wizard to install a custom
driver (see the online help for more information). Many people find that the
standard drivers work fine, but as we mention later in this chapter, custom
drivers may include additional paper sizes as well as other handy settings.

A Simple Plot

Okay, so you believe us. You know that you're not going to master AutoCAD
plotting in five minutes. That doesn’t change the fact that your boss,
employee, wife, husband, construction foreman, or 11-year-old son wants a
quick check plot of your drawing.

Plotting success in 16 steps

Here’s the quick, cut-to-the-chase procedure for plotting a simple drawing —
a mere 16 steps! This procedure assumes that you plot in model space — that
is, that the Model tab at the bottom of the drawing area shows the drawing in
a way that you want to plot. (We cover plotting paper space layout tabs in
the section, “Plotting the Layout of the Land,” later in this chapter.) This pro-
cedure doesn’t deal with controlling plotted lineweights. (See the “Plotting
Lineweights and Colors” section later in this chapter for those details.) It
should, however, result in a piece of paper that bears some resemblance to
what AutoCAD displays on your computer monitor.
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Follow these steps to make a simple, not-to-scale, monochrome plot of a

drawing:

1. Open the drawing in AutoCAD.

2. Click the Model tab at the bottom of the drawing area to ensure that
you're plotting the model space contents.

We explain model space and paper space in Chapter 4, and we explain
how to plot paper space layouts later in this chapter.

. Zoom to the drawing’s current extents (choose Viewr>Zoom=>Extents)

so you can verify the area you’re going to plot.

The extents of a drawing consist of a rectangular area just large enough
to include all the objects in the drawing.

toolbar.

. To display the Plot dialog box, click the Plot button on the Standard

The Plot dialog box appears, as shown in Figure 13-2.

8.50 x 11.00 inches

Printable area: 8.00 x 10.67 inches

5. In the Printer/Plotter area, select a device from the Name drop-down
list.
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6. In the Paper Size area, select a paper size that’s loaded in your printer
or plotter.

Of course, you must make sure that the paper size is large enough to fit
the drawing at the scale you want to plot it at. For example, if you want
to plot a D-size drawing, but you have only a B-size printer, you're out of
luck — unless you resort to multiple pieces of paper and lots of tape.

7. In the Plot Area area (sponsored by the Department of Redundancy
Department), choose Extents from the What To Plot drop-down list.

If you set limits properly, as we suggest in Chapter 4, you can choose
Limits instead to plot the drawing area that you defined. The Window
option — that is, plot a window whose corners you pick — is useful
when you want to plot just a portion of your drawing.

8. In the Plot Offset (Origin Set to Printable Area) area, select the Center
The Plot check box.

Alternatively, you can specify offsets of zero or other amounts in order
to position the plot at a specific location on the paper.

9. In the Plot Scale area, either select the Fit To Paper check box, or
uncheck Fit To Paper and specify a scale (by choosing from the drop-
down list or typing into the two text boxes).

For most real plotting, you’ll plot to a specific scale, but feel free to
select the Fit To Paper check box for now. If you do want to plot to a spe-
cific scale, see the “Instead of fit, scale it” section later in this chapter
for guidance.

10. Click the More Options button (at the bottom-right corner of the
dialog box, next to the Help button).

The Plot dialog box reveals additional settings, as shown in Figure 13-3.
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11.

12.

13.

14.

15.

16.

In the Plot Style Table (Pen Assignments) area, choose
monochrome.ctb or monochrome.stb from the drop-down list.

AutoCAD may ask you whether to “Assign this plot style table to all
layouts?” Answer Yes to make monochrome.ctb (or monochrome.stb)
the default plot style table for the paper space layout tabs as well as
the Model tab, or answer No to make the change apply only to the cur-
rent tab.

The “Plotting with style” section, later in this chapter, describes plot
style tables.

In the Plot Options area, make sure that the Plot With Plot Styles
check box is selected and that the Save Changes To Layout check box
is deselected, as shown in Figure 13-3.

Leaving the Save Changes To Layout check box deselected tells
AutoCAD to use any plot settings changes that you make only for this
plot — AutoCAD will revert to the original plot settings the next time
you plot the drawing.

After you become confident with plotting, you may want to select this
check box so that AutoCAD does save your plotting settings changes as
the default. Alternatively, click the Apply To Layout button to make the
current plot settings the default for future plotting of this tab (that is,
the Model tab) in this drawing.

In the Drawing Orientation area, choose Portrait or Landscape.

The postage stamp-sized preview in the middle of the Plot dialog box
should help you decide on the right orientation. If not, the full preview in
the next step will tell you for sure.

Click the Preview button and check that the drawing displays on the
paper at the correct orientation and size, as shown in Figure 13-4;
then right-click and choose Exit to return to the Plot dialog box.

If you found any problems in the preview, adjust the plot settings
(for example, Plot Area, Plot Scale, or Drawing Orientation) and
repeat the preview until the plot looks right.

Click OK to create the plot.

When AutoCAD finishes generating and sending the plot, it displays a
Plot and Publish Job Complete balloon notification from the status bar. If
you decide that you don’t want to see these notifications, right-click the
Plot/Publish Details Report Available icon near the right end of the
status bar and deselect Enable Balloon Notification.

There — 16 steps, as promised. If for some reason your plot didn’t work, well,
we warned you that AutoCAD plotting was complicated and temperamental!
Read the rest of this chapter for all the details about the numerous other
plotting options that can cause plotting to go awry. If you're in a big hurry,
turn directly to the troubleshooting section, “Troubles with Plotting,” at the
end of the chapter.
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One of the keys to efficient plotting is liberal use of AutoCAD’s preview fea-
ture. (To maintain political fairness, we recommend conservative use of some
other AutoCAD options elsewhere in the book.)

The postage stamp-sized partial preview in the middle of the Plot dialog box
is a quick reality check to make sure your plot fits on the paper and is turned
in the right direction. If the plot area at the current scale is too large for the
paper, AutoCAD displays thick red warning lines along the side(s) of the
sheet where the drawing will be truncated.

Click the Preview button to see a full preview in a separate window. You see
exactly how your drawing lays out on the paper and how the various
lineweights, colors, and other object plot properties will appear. You can
zoom and pan around the preview by using the right-click menu. (Any zoom-
ing or panning that you do does not affect what area of the drawing gets
plotted — zooming and panning is just a way to get a better look at different
areas of the plot preview.)
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Instead of fit, scale it

In most real plotting situations, you want to plot to a specific scale rather
than let AutoCAD choose an oddball scale that just happens to maximize the
drawing on the paper. And if you're going to plot the Model tab of a drawing
to scale, you need to know its drawing scale factor. Chapter 4 describes setup
concepts, and Chapter 10 provides some tips for determining the scale factor
of a drawing that someone else created.

If your drawing was created at a standard scale, such as 1:50 or %4"=1'-0", then
you simply choose the scale from the handy Scale drop-down list in the Plot
dialog box. If your scale is not in the list, type the ratio between plotted dis-
tance and AutoCAD drawing distance into the two text boxes below the Scale
drop-down list, as shown in Figure 13-5. The easiest way to express the ratio
usually is to type 1 (one) in the upper box and the drawing scale factor in the
lower box. (See Chapter 4 for more information.)

Your CAD manager may have added uncommon scales or removed scales
from the Scale drop-down list that your company never uses. If you're design-
ing espresso machines in Milano, for example, you’ll probably never need to
plot your drawings at "=1'-0".
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Creating half-size plots for some purposes is common in some industries. To
plot model space half-size, double the drawing scale factor. For example, a
%"=1'-0" drawing has a drawing scale factor of 96, which is equivalent to a
plot scale of 1=96. To make a half-size model space plot of it, specify a plot
scale of 1=192 (or choose /"=1'-0" from the Scale drop-down list).

Even if you work with drawings that are created to be plotted at a specific
scale, plotting with a Fit To Paper scale may be the most efficient way to
make a reduced-size check plot. For example, drafters in your office might
create drawings that get plotted on D-size sheets (24 x 36 inches), whereas
you have access to a laser printer with a B-size (11 x 17 inches) paper tray. By
plotting the D-size drawings scaled to fit on B-size paper, you end up with
check plots that are slightly smaller than half size (4 size, to be exact). You
won’t be able to measure distances on the check plots with a scale, but you
probably will be able to check them visually for overall correctness.

Plotting the Layout of the Land

WNG/

In the previous section, we show you how to plot the model space represen-
tation of your drawing by making sure that the Model tab is active when you
open the Plot dialog box. However, paper space gives you many additional
options for controlling the look of your output, without having to modify the
underlying geometry. So in some drawings, you may want to plot a paper
space layout instead.

About paper space layouts and plotting

As Chapter 4 describes, you can use AutoCAD’s paper space feature to com-
pose one or more layouts for plotting your drawing in particular ways. Each
layout lives on a separate tab, which you click at the bottom of the drawing
area. In addition, AutoCAD saves plot settings (plot device, paper size, plot
scale, and so on) separately for each of the tabs — that is, for each of the
layout tabs as well as the Model tab.

Whether to plot model space or a paper space layout in a drawing depends
entirely on how the drawing was set up. If you or someone else went through
a layout setup procedure similar to the one in Chapter 4, then you probably
should plot the paper space layout. If not, then plot the Model tab.

Don’t confuse the Model tab at the bottom of the drawing area with the
MODEL/PAPER button on the status bar. The tabs control which view of the
drawing (model space or a paper space layout) fills the drawing area. When a
paper space layout fills the drawing area, the status bar button controls
whether drawing and editing take place in paper space or in model space
inside a viewport. When you plot a layout, it doesn’t matter whether the
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MODEL/PAPER button says MODEL or PAPER — AutoCAD always plots the
paper space layout (not just the contents of model space in the viewport).

The presence of a Layout1 tab next to the Model tab at the bottom of the
drawing area doesn’t necessarily mean that the drawing contains an already
set up paper space layout. AutoCAD always displays a Layoutl tab when you
open a drawing created in AutoCAD Release 14 or earlier, and it displays a
Layoutl and Layout2 tab when you open a drawing created in AutoCAD 2000
or later. Layoutl and Layout2 are simply AutoCAD’s default names; the cre-
ator of the drawing may have renamed them something more descriptive.

If you don’t have any paper space drawings handy, you can use one of the
AutoCAD sample drawings, such as the mechanical drawing stored in
C:\Program Files\AutoCAD 2007\Sample\Blocks and Tables -
Imperial.dwg or Blocks and Tables - Metric.dwg. LT users, have
alook at C:\Program Files\AutoCad 2007\Sample\Home Floor
Plan.dwg.

The path to paper space layout
plotting success

Plotting a paper space layout is pretty much like plotting model space,
except that you need to find the appropriate layout first and make sure that
its tab is selected before you open the Plot dialog box.

1. Click the layout tabs at the bottom of the drawing area until you find a
suitably set-up layout.

If no one has set up the layout yet, AutoCAD creates a default layout.

(If the Show Page Setup Manager For New Layouts setting on the Display
tab of the Options dialog box is turned on, you'll see the Page Setup
Manager dialog box first — just click the Close button.) The default
layout probably won’t be useful for real projects, but you can use it to
find out about the layout plotting procedure. Refer to Chapter 4 for
instructions on creating a real layout.

2. Click the Plot button on the Standard toolbar.
The Plot dialog box appears.
. Specify a Printer/Plotter Name and a Paper Size.
. In the What To Plot drop-down list, choose Layout.
. Specify the Plot Offset (such as 0 in both the X and Y directions).

. In the Plot Scale area, select 1:1 from the Scale drop-down list.

S U1 e W

One of the big advantages of layouts is that you don’t need to know any-
thing about drawing scale in order to plot the drawing — hence the name
paper space. Figure 13-6 shows the proper settings for plotting a layout.
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Figure 13-6:
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To create a half-size plot of a layout, select 1:2 from the Scale drop-down
list. In addition, select the Scale Lineweights check box in order to
reduce lineweights proportionally. (We cover plotting lineweights later
in this chapter.)

If you find that the layout is too big for your plotter’s largest paper size
at a plot scale of 1:1, you can select Extents from the What To Plot drop-
down list and then select the Fit To Paper check box in the Plot Scale
area. Alternatively, you can close the Plot dialog box and fix the problem
if you want to have a paper space layout that permanently reflects a new
paper size. Use the Page Setup dialog box to modify the layout settings,
or copy the layout and modify the new layout.

7. Click the More Options button and change any additional plot options
that you want to.

Refer to Steps 11 through 13 in the section, “Plotting success in 16
steps.”

8. Click the Preview button, ensure that the drawing displays on the
paper at the correct orientation and size, and then right-click and
choose Exit to return to the Plot dialog box.

If you found any problems in the preview, change your plot settings and
preview again until it looks right.

9. Click OK to create the plot.
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Plotting Lineweights and Colors

In previous sections of this chapter, we help you gain some plotting confi-
dence. Those sections show you how to create scaled, monochrome plots
with uniform lineweights in model space or paper space. Those skills may be
all you need, but if you care about controlling plotted lineweights and colors,
or adding special effects such as screening (plotting shades of gray), read on.

Figure 13-7:
Editing a
color-
dependent
plot style
table.

Plotting with style

Plot styles provide a way to override object properties with alternative plot
properties. (See Chapter 5 for information about object properties.) The
properties include plotted lineweight, plotted color, and screening (plotting
shades of gray). Figure 13-7 shows the full range of options. Plot styles come
in two exciting flavors:

v Color-dependent plot styles

v Named plot styles

Color-dependent plot styles are based on the standard way of plotting in ear-
lier versions of AutoCAD (before AutoCAD 2000), whereas named plot styles
provide a newer way.
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It’s remotely possible that you won’t need to bother with plot styles. If the
drawings you want to plot have layer and object properties (especially
lineweight) that reflect how you want objects to plot, you can dispense with
plot styles. But most people and most drawings use plot styles, so you
should at least be familiar with them.

A couple of common reasons for using plot styles are to

v Map screen colors to plotted lineweights. If this idea seems completely
loony to you, try to suspend judgment until you’ve read the “Plotting
through thick and thin” section, a bit later in this chapter.

v Create screened lines on monochrome plots. Lines that are screened
display in various shades of gray, not black. Drafters sometimes use
screened lines to de-emphasize secondary objects that otherwise would
overwhelm the main objects in the drawing. Screening is expressed as a
percentage, with 100 percent being completely black and 0 percent
being invisible.

Using plot styles

If you want objects in your drawing to plot with properties that differ from
their display properties, you need plot styles. For example, you can plot with
different lineweights or colors from the ones you’re using for display pur-
poses. Or, as we mention in the preceding section, you may need to map dis-
play colors to plotted lineweights. AutoCAD groups plot styles into plot style
tables, each of which is stored in a separate file.

Color-dependent plot style tables live in Color TaBle (CTB) files and they map
the 255 AutoCAD display colors to 255 plot styles. AutoCAD automatically
attaches the color-dependent plot styles to every object, based on — you
guessed it — the object’s color. (Are those AutoCAD programmers brilliant, or
what?) Color-dependent plot style tables are especially handy for mimicking
the old color-mapped-to-lineweight plotting approach of AutoCAD R14 and
earlier releases; this remains the most common method in most companies.

Named plot style tables live in Style TaBle (STB) files. After you've created a
named plot style table, you create one or more plot styles and give them any
names you like. Then you can assign the named plot styles to layers or to
individual objects. (See Chapter 5 for more information about object and
layer properties.)

Named refers to the plot styles, not to the tables. Both color-dependent plot
style tables and named plot style tables have names because both are stored
in files and files have to have names. But color-dependent plot styles don’t
have names, and named plot styles do have names.
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To use a plot style table and its included plot styles (whether they’re color-
dependent or named), you must attach it to model space or a paper space
layout. The plot style table then affects plotting only for that tab. This
approach lets you plot the same drawing in different ways by attaching differ-
ent plot styles to different tabs.

You can attach a plot style to model space or a paper space layout by select-
ing its tab at the bottom of the drawing area, opening the Plot dialog box or
Page Setup Manager dialog box, and choosing the plot style table name in the
Plot Style Table (Pen Assignments) area of the expanded Plot dialog box. See
the section, “Controlling plotted lineweights with screen colors,” later in this
chapter, for an example.

When you start a new drawing in the usual way — that is, by using a template
drawing (see Chapter 4), the template drawing’s plot style behavior deter-
mines whether you can choose CTB or STB files. (That’s why most of
AutoCAD’s stock template drawings come in Color Dependent Plot Styles and
Named Plot Styles versions.) If you want to change from color-dependent plot
styles to named plot styles (or vice versa) in a particular drawing, use the
CONVERTPSTYLES command.

Creating plot styles

If you're really lucky, you won’t need to use plot styles. If you're somewhat
lucky, you'll need to use plot styles, but someone will provide the plot style
table files for you. If that’s the case, you must put the CTB or STB files in your
Plot Styles folder in order for AutoCAD to recognize them. (To find the loca-
tion of your Plot Styles folder, open the Options dialog box, choose the Files
tab, and look for the Printer Support File Pathc>Plot Style Table Search Path
setting.)

If you're not lucky at all, then you’ll need to be smart — that is, you’ll want to
know how to create your own plot style table files. Here’s how:
1. Choose Filec>Plot Style Manager.
The Plot Styles folder opens in a separate window.
2. Double-click the Add-A-Plot Style Table Wizard program shortcut.
3. Read the opening screen and then click Next.

4. Choose the Start from Scratch option or one of the other three options
if you want to start with settings from another file. Then click Next.

The remaining steps in this procedure assume that you chose Start from
Scratch. If you chose another option, simply follow the wizard’s prompts.

If the creator of a drawing provides you with an AutoCAD R14/AutoCAD
LT 98 PC2 (version 2) or AutoCAD R12/AutoCAD LT 95 PCP (version 1)
file, choose the Use A PCP Or PC2 File option. With this option, the
wizard imports color-to-plotted-lineweight settings automatically.
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5. Choose whether you want to create a color-dependent plot style table
(CTB file) or a named plot style table (STB file). Then click Next.

Choose Color-Dependent Plot Style Table in order to map screen colors
to plotted lineweights. Choose Named Plot Style Table in order to leave
screen colors alone (so that the colors plot as you see them on-screen)
and to create named plot styles that you can apply to layers or objects.

6. Type a name for the new CTB or STB file and then click Next.
7. Click the Plot Style Table Editor button.
The Plot Style Table Editor dialog box opens (refer to Figure 13-7).

8. If you created a color-dependent plot style table, assign Lineweight,
Screening, or other plot properties to each color that’s used in the
drawing. If you created a named plot style table, click the Add Style
button and then assign plot properties to each of the named styles
that you create.

To determine which colors are used in a drawing, switch to the AutoCAD
window and open the Layer Properties Manager dialog box by clicking
the Layers button located on the Layers toolbar.

To change a setting for all colors or named styles, select all of them first
by clicking the first color or named style, holding down the Shift key,
scrolling to the end of the list, and then clicking the last color or named
style. Any subsequent changes you make get applied to all the selected
colors or named styles.

9. Click the Save & Close button to close the Plot Style Table Editor
dialog box. Then click Finish to complete the steps for the wizard.

The Plot Styles folder now displays your new CTB or STB file.
10. Close the Plot Styles folder by clicking the X in its title bar.

Creating your first plot style table can be a harrowing experience because
you have so many options. Just remember that your most likely reason for
creating one is to map screen colors to plotted lineweights (as we describe in
greater detail in the next section). Also remember that you may be able to
minimize your effort by getting a CTB file from the person who created the
drawing that you want to plot.

In Chapter 5, we recommend that you limit yourself to the first 9 Standard
AutoCAD Colors when defining layers, and not a patchwork of the 255 colors
that AutoCAD makes available. If you follow our advice, your work to create a
color-dependent plot style table will be much reduced because you’ll have to
assign plot properties for only 9 colors, rather than worrying about 255 of
them.
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You can use the file found in C: \Program Files\AutoCAD 2007\Sample\
Plot Screening and Fill Patterns.dwg for systematic testing of your
CTB files. This drawing shows an array of color swatches for all 255 AutoCAD
colors. Some of the other tabs (such as Grayscale and Screening 25%) also
demonstrate how different CTB files attached to the same layout produce
radically different results.

Named plot styles hold a lot of promise, but there’s at least one place —
dimensions — where they don’t work as well as traditional color-based plot-
ting. Dimension properties allow you to assign different colors to dimension
lines, extension lines, and text. The purpose for this is to allow different parts
of a dimension object to print with different lineweights; for example, you can
have your dimension text print with a medium lineweight, the same as your
annotation text, while keeping extension and dimension lines to a fine
lineweight. But since named plot styles are based on objects or layers, you
don’t have that lineweight control over individual dimension components.

If you really get carried away and decide to take advantage of the 16 million-
odd colors in AutoCAD'’s true color capability, you're not going to be control-
ling lineweights with color-dependent plot styles. CTB plot styles affect the
lineweights only of objects that use the traditional 255 colors of the AutoCAD
Color Index palette. If you want true color, use object lineweights or named
plot styles to control plotted lineweight.

Your life is simpler if you use AutoCAD LT. Only the full version of AutoCAD
supports True Color mode.

Plotting through thick and thin

Long ago, manual drafters developed the practice of drawing lines of different
thicknesses, or lineweights, in order to distinguish different kinds of objects.
Manual drafters did it with different technical ink pen nib diameters or with
different hardnesses of pencil lead and varying degrees of pressure on the
pencil. Because a computer mouse usually doesn’t come with different diam-
eters of mouse balls or a pressure-sensitive button, the AutoCAD developers
had to figure out how to let users indicate lineweights on-screen and on a
plot. They came up with two different ways to indicate lineweight:

v Mapping on-screen colors to plotted lineweights. We describe this
common approach in Chapter 5.

v Displaying lineweights on-screen to match what the user can expect to
see on the plot. This approach first appeared in AutoCAD 2000.
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Plotting with plodders

Color-as-color and lineweight-as-lineweight
seem like greatideas, but Autodesk knew when
it added object lineweights back in 1999 that
longtime users of AutoCAD weren't going to
abandon the old colors-mapped-to-lineweights
approach overnight. Thus, you can still control
plotted lineweight by display color in AutoCAD.

AutoCAD veterans, by and large, have chosen
to stick with the Old Way for now. They've done
so for a variety of reasons, including inertia,
plotting procedures and drawings built around
the Old Way, third-party applications that don't
fully support the newer methods, and the need
to exchange drawings with clients and subcon-
tractors who haven't upgraded. In summary, the

ripple effect of those who need to or want to
continue using colors-mapped-to-lineweights is
lasting a long time. Don't be surprised if you find
yourself going with the flow for a while.

The default setting in AutoCAD 2007 is to plot
object lineweights, so that's the easiest method
if you don't have to consider the historical prac-
tices or predilections of other people with
whom you exchange drawings. Mapping
screen colors to lineweights requires some ini-
tial work on your part, but after you've set up
the mapping scheme, the additional effort is
minimal.

\\J

Controlling plotted lineweights with object lineweights

Plotting object lineweights is trivial, assuming that the person who created
the drawing took the trouble to assign lineweights to layers or objects (see
Chapter 5 for details). Just make sure that the Plot Object Lineweights check
box in the expanded Plot dialog box is checked. You may also want to dese-
lect the Plot With Plot Styles check box because plot styles can override the
object lineweights with different plotted lineweights. (You can also make
these settings in the Page Setup dialog box for the appropriate layout or
Model tab. To access Page Setup, right-click the Model tab or any layout tab
and choose Page Setup Manager.)

As long as you check the Plot Object Lineweights check box, you'll find that
(those who hate cheap puns, read no further!) the plot thickens! It also thins,
but that’s not as punny.

If you don’t want to plot the lineweights assigned to objects, you must
uncheck both the Plot Object Lineweights and Plot With Plot Styles check
boxes in the Plot Options area of the Plot or Page Setup dialog box. Checking
Plot With Plot Styles checks Plot Object Lineweights as well.

Controlling plotted lineweights with screen colors

To map screen colors to plotted lineweights, you need a color-dependent plot
style table (CTB file), as we describe in the section “Plotting with style,” ear-
lier in this chapter. If you're plotting a drawing created by someone else, that
someone else may be able to supply you with the appropriate CTB file or, at
least, with a PCP or PC2 file from which you can create the CTB file quickly.
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Figure 13-8:
Selecting a
plot style
table that
maps
screen
colors to
plotted
lineweights.
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At the very least, the creator of the drawing should be able to give you a
printed chart showing which plotted lineweight to assign to each AutoCAD
screen color. Use the instructions in the “Plotting with style” section to copy
or create the required CTB file.

Unfortunately, no industry-wide standards exist for mapping screen colors to
plotted lineweights. Different offices do it differently. That’s why it’s so useful
to receive a CTB, PCP, or PC2 file with drawings that someone sends you.

After you have the appropriate CTB file stored in your Plot Styles folder,
follow these steps to use it:

1. Click the tab that you want to plot — the Model tab or the desired
paper space layout tab.

2. Click the Plot button on the Standard toolbar.

3. In the Plot Style Table (Pen Assignments) area on the expanded Plot
dialog box, select the CTB file from the drop-down list, as shown in
Figure 13-8.

This action attaches the plot style table (CTB file) to the tab that you
clicked in Step 1.
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4. Click the Apply To Layout button.

AutoCAD records the plot setting change with the current tab’s configu-
ration information. Assuming that you save the drawing, AutoCAD uses
the CTB that you selected as the default plot style when you (or other
people) plot that tab in the future.

5. Continue with the plotting procedures described earlier in this chapter.
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If your drawing uses a named plot style table instead of a color-dependent
plot style table, you follow the same procedure, except that you select an
STB file instead of a CTB file in Step 3.

You can tell whether the current drawing was set up to use color-dependent
plot styles or named plot styles by looking at the Properties toolbar. If the
last drop-down list (Plot Style Control) is grayed out, the drawing uses color-
dependent plot styles. If this list is not grayed out, the drawing uses named
plot styles.

Plotting in color

Plotting the colors that you see on-screen requires no special tricks. In the
absence of a plot style table (that is, if you selected None from the drop-down
list in the Plot Style Table (Pen Assignments) area in the Plot or Page Setup
dialog box), AutoCAD sends color information as it appears on-screen to the
plotter. As long as your output device can plot in color, what you see should
be what you get.

If you attach a plot style table to the tab that you're plotting (as described in
the previous section), you can — if you really want to — map screen colors
to different plotted colors. In most cases, you don’t want that kind of confu-
sion. Instead, leave the Color property in the plot style table set to Use
Object Color.

If your goal is not to plot color, make sure that you set the Color property for
all plot styles to Black. If you try to plot colors on a monochrome device, you
may find that objects appear in various shades of gray, like in a black and
white newspaper photograph, with lighter colors mapped to lighter shades of
gray and darker colors to darker shades of gray. This process of mapping
colors to shades of gray is called monochrome dithering, and it usually is not
what you want in a CAD drawing. To override it, use the Plot Style Table
Editor, as described in the section “Creating plot styles,” earlier in this chap-
ter, to set the Color option for all colors to Black (the default setting is Use
Object Color). If you don’t already have a plot style table that you want to
use, choose monochrome.ctb (for color-based plot styles) or monochrome.
stb (for named plot styles) from the drop-down list in the Plot Style Table
(Pen Assignments) area of the Plot dialog box, both of which come with
AutoCAD.

To see the full range of AutoCAD colors available on your plotter, or to see
how a particular plot style table affects plotting, open and then plot the file
C:\Program Files\AutoCAD 2007\Sample\Plot Screening and
Fill Patterns.dwg. The Screening 100% layout in this drawing contains
color swatches for all 255 AutoCAD colors.

www.it-ebooks.info


http://www.it-ebooks.info/

When in doubt, send it out

Whether you plot to scale or not, with different
lineweights or not, in color or not, consider
using a service bureau for some of your plotting.
In-house plotting on your office’s output devices
is great for small check plots on faster laser or
inkjet printers. Large-format plotting, on the
other hand, can be slow and time consuming. If
you need to plot lots of drawings, you may find
yourself spending an afternoon loading paper,
replenishing ink cartridges, and trimming
sheets.

Good plotting service bureaus have big, fast,
expensive plotters that you can only dream
about owning. Also, they're responsible for
babysitting those fancy devices, feeding them,
and fixing them. As a bonus, service bureaus
can make blueline prints from your plots if you
need to distribute hard-copy sets to other
people.

The only downside is that you need to coordi-
nate with a service bureau to make sure it gets
what it needs from you and can deliver the kinds
of plots you need. Some service bureaus plot

directly from your DWG files, while others ask
you to make PLT (plot) files. Some service
bureaus specialize in color plotting, while
others are more comfortable with monochrome
plotting and making blueline copies.

When you're choosing a service bureau, look
for one that traditionally has served drafters,
architects, and engineers. These service
bureaus tend to be more knowledgeable about
AutoCAD, and they should have more plotting
expertise than the desktop publishing, printing,
and copying shops.

Whomever you choose, do some test plots well
before the day when that important set of draw-
ings is due. Talk to the plotting people and get a
copy of their plotting instructions. Have the ser-
vice bureau create some plots of a couple of
your typical drawings and make sure they look
the way you want them to.

If you do lots of plotting with a service bureau,
look into whether you can charge it to your
clients as an expense (just like bluelines or

copying).

It's a (Page) Setup!

Page setups specify the plotter, paper size, and other plot settings that you
use to plot a particular tab of a particular drawing. AutoCAD maintains sepa-

rate page setups for model space and for each paper space layout (that is, for

each tab you see in the drawing area). When you click the Apply To Layout
button in the Plot dialog box (or select the Save Changes To Layout check
box and then click OK to plot), AutoCAD stores the current plot settings as

Chapter 13: The Plot Thickens 3 ’ 1

the page setup for the current tab.

You also can give page setups names and save them. The advantage of doing
so is that you can switch quickly between different plot settings and copy plot
settings from one drawing tab to another. Named page setups are stored with
each drawing, but you can copy them from another drawing into the current
one with the Page Setup Manager dialog box (described later in this section).
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Figure 13-9:
The Page
Setup
Manager
dialog box.

If you want to get fancier, you can create named page setups in order to plot
the same layout (or the Model tab) in different ways, or to copy plot settings
from one tab to another or one drawing to another. Click the Add button in
the Plot dialog box to create a named page setup from the current plot set-
tings. After you create a named page setup, you can restore its plot settings
by choosing it from the Page Setup Name drop-down list.

For even greater control, choose Filec>Page Setup Manager to create, change,
and copy page setups. In the Page Setup Manager dialog box, shown in Figure
13-9, you can create new page setups and modify existing ones. Click the
Modify button to open the Page Setup dialog box, which is almost identical to
the Plot dialog box. The primary difference is that you're changing plot set-
tings rather than actually plotting. The Set Current button copies the page
setup that you've selected on the Page Setups list to the current layout tab.
With the Import button, you can copy a layout from another drawing or draw-
ing template (DWT) file.

B! Page Setup Manager 2=
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e Current layout: D755 - 36x24 Page Setup mansasr

Page setups
Current page setup: <hone>
"x11x8.5LEFT™
IGHT*
| g i
ANSI D tile block - no output device
Madify...
Import.
Selected page setup details
Device name: HP DesignJet 755CM(C3138A)by HP (to fil)
Plotter: HP Designlet 755CM{C31%8A)by HP
Plot size: 35.00 x 23.99 inches (Landscape)
Where: File
Description:
[] Display when creating & new layout | Help

Continuing the Plot Dialog

In previous sections of this chapter, we cover most of the important options
in the Plot dialog box. This section reveals a few more fine points that will
make your plotting life easier. We don’t cover every minute, obscure, useful-
only-at-cocktail party-discussions detail. (And if this sounds like your kind of
cocktail party, remind us that we’re busy that night.) We do point out some
occasionally useful options that will increase your vocabulary when you’re
communicating with the Plot dialog box.
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Sheet sets without regrets

A typical AutoCAD project could include dozens
of drawings, scores of sheets, lots of layouts,
copious cross-drawing references, and more
than a few people working on those compo-
nents at once. How do you create, manage,
update, plot, and generally keep a handle on all
that stuff without going crazy? The sheet sets
feature is AutoCAD’s response to this challenge.

Sheet sets were introduced in AutoCAD 2005,
and it's probably fair to say the feature hasn't
caught on like wildfire just yet. It's a whole new
paradigm for creating and outputting drawing
sets, and many individuals and companies
apparently haven't felt the need to make the
switch. (Maybe they're still trying to get their
heads around named plot styles!)

Sheet sets rely on several relatively sophisti-
cated AutoCAD features, so make sure you
have at least a nodding acquaintance with
these items before you start to grapple with
sheet sets:

v~ Paper space layouts (covered in Chapter 4)
v+ Named views (Chapter 8)

v~ Tables and text fields (Chapter 10)

v~ Blocks and attributes (Chapter 14)

v~ External references (Chapter 14)

Understanding external references and layouts
is especially important because these features
are central to the way that the Sheet Set
Manager creates and organizes sheets. You
can create a sheet list automatically, and labels
and callouts also automatically update as you
add and remove sheets from the sheet set.

An AutoCAD sheet set is treated as a single unit
for ease in publishing drawings to paper or the
Web, for electronically transmitting complete
sets of drawing sheets, and for archiving pro-
jects at milestones or on completion.

For more information on sheet sets, look at the
User’s Guide in AutoCAD's online help system —
select Choose A Work Process Before You
Begin, then Work With Sheets In A Sheet Set.
Or open the Sheet Set Manager palette from the
Standard toolbar and click Learn About Sheet
Sets to open a presentation in the New Features
Workshop.

Sheet sets are a feature of full AutoCAD only —
they're notincluded in AutoCAD LT.
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Use the Plot dialog box’s quick help to find out more about any part of the
dialog box:

1. Click the question mark next to the Close button in the dialog box’s
title bar.

2. Point the arrow at the part of the dialog box that confuses you and
click.

3. Click the Help button at the bottom of the dialog box if the pop-up
help isn’t enough.

\3
P Quickstart and New Features Workshop help provide information on proce-
dures and concepts for selected topics in AutoCAD. In the Plot dialog box,
click Learn About Plotting for additional information.

v Printer/Plotter: As we describe in the section “Configure it out,” earlier
in this chapter, you use the Name drop-down list to select the Windows
system printer or nonsystem driver configuration that you want to use
for plotting.

Clicking the Properties button opens the Plotter Configuration Editor
dialog box, with which you can change media (type of paper) and other
properties that are unique to the currently selected plotter or printer. In
particular, you can define custom paper sizes.

@“\NG! As if AutoCAD’s Plot dialog box settings weren’t overwhelming enough,
S depending on your plot device, you may also have to deal with the

Plotter Configuration Editor dialog box. Some plotter drivers hide impor-
tant settings in this dialog box. To access them, you typically click the
Custom Properties button near the bottom of the Plotter Configuration
Editor dialog box. (For example, if you're using the enhanced Windows
system driver for HP plotters, available at www.designjet.hp.com,
you can click the Custom Properties button and then the More Sizes
button to specify which paper sizes are available to you on the Paper
Size drop-down list of the main Plot dialog box.)

To make matters even more confusing, if you make any changes in the
Plotter Configuration Editor dialog box, AutoCAD prompts you to save
the changes to a separate PC3 file. You should choose Save Changes To
The Following File (that is, create a new AutoCAD-specific configuration
that includes the revised settings) and type a configuration name that
you’ll recognize later. When you want to plot with custom settings,
remember to choose the AutoCAD-specific PC3 configuration near the
end of the Printer/Plotter Name drop-down list, and not the original
Windows system printer configuration near the beginning of the list.

v~ Plot To File: If you need to plot to a file rather than directly to your plot-
ter or network printer queue, select the Plot To File option. When you
click OK to plot, AutoCAD asks you for a plot file name and location.
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This option is especially useful when you want to use the ePlot feature
to publish a DWF file on a Web site. You also may need to use this option
to create files to send to a plotting service bureau.

Plotting to the new DWG to PDF.pc3 file creates versions of your draw-
ing files that can be opened and viewed in the free and widely available
Adobe Reader software.

+~ Plot Stamp On: Use this option to turn on and off and configure the con-

tents of a text string that AutoCAD adds automatically to the corner of
each plot. The plot stamp can include useful information such as the
drawing filename and plot date and time.

v~ Plot Area: Specify the area of the drawing to plot. Your choices include

Display, Extents, and Window, regardless of whether you're plotting a
paper space layout or the model space tab. If you defined named views
in the drawing, AutoCAD adds a View option. The additional choice is
Layout for a paper space layout tab or Limits for the model space tab.

¢ Display means the drawing as it’s currently displayed in the draw-
ing window (including any white space — or black space — around
the drawing objects).

e FExtents means the rectangular area containing all the objects in the
drawing.

e Limits means the model space area that you specified (or should
have specified) when you set up the drawing (see Chapter 4 for
details).

e Window means a rectangular area that you specify.

¢ View means a named view, which you select from the drop-down
list. (Chapter 8 describes named views and how to create them.)

Usually, you’ll choose to plot Layout in paper space. For model space,
the choice depends on whether the drawing was set up properly and
what you want to plot. If you set limits properly, as we suggest in
Chapter 4, then plot Limits in order to get the whole drawing area. If
you're trying to plot a drawing in which the limits weren’t set properly,
try Extents instead. Use Window or View if you want to plot just a por-
tion of model space.

v~ Plot Offset: A plot offset of X=0 and Y=0 positions the plot at the lower-

left corner of the plottable area. If you want to move the plot from this
default position on the paper, enter nonzero numbers or select the
Center The Plot check box. (The Center The Plot check box is available
only when you haven’t selected Layout from the What To Plot drop-
down list.)

v Shaded Viewport Options: If your drawing includes viewports showing

shaded or rendered 3D models, use this area to control the plotted
appearance.
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+ Plot Options: The Plot Object Lineweights and the Plot With Plot Styles
check boxes control whether AutoCAD uses the features described in
the “Plotting with style” and “Plotting through thick and thin” sections,
earlier in this chapter.

The Hide Paperspace Objects check box controls whether AutoCAD
hides objects that are behind other objects when a 3D model is dis-
played in a viewport. If your drawing is entirely 2D, then this option
doesn’t matter. If your drawing includes 3D objects, then selecting this
setting is like applying the 3DORBIT (3DO) command’s Hidden option to
the plot. Look up “3DORBIT command” on the Index tab in the AutoCAD
online help system for more information.

v Plot Upside-Down: Select this check box if you want to rotate the plot
180 degrees on the paper (a handy option for plotting in the southern
hemisphere or for avoiding having to cock your head at an uncomfort-
able angle as you watch plots come out of the plotter).

AutoCAD normally generates plots in the foreground — that is, the plotting
process takes over the program for the entire time that the program is creat-
ing the plot. AutoCAD 2007 includes a background plotting feature that
returns control of the program to you more quickly. If you have a reasonably
fast computer with adequate memory, turn on this feature in the Options
dialog box: Choose Tools=>Options, click the Plot And Publish tab, and select
Plotting In The Background Processing Options area.

If you want to automate plotting for a batch of drawings, check out
AutoCAD’s sheet sets feature. One of the tasks that sheet sets are designed to
accomplish is the publishing of a set of drawing sheets at one fell swoop. See
the “Sheet sets without regrets” sidebar for a brief overview.

Troubles with Plotting

No matter how many times you read this chapter or how carefully you study
the AutoCAD documentation, you’ll occasionally run into plotting problems.
You're especially likely to encounter problems when trying to plot other
people’s drawings because you don’t always know what plotting conventions
they had in mind. (Plotting conventions aren’t where spies meet; they're a
standardized approach to plotting issues.) Table 13-1 describes some of the
more common plotting problems and solutions.
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Table 13-1 Plotting Problems and Solutions

Problem Possible Solution

Nothing comes out of the plotter Check whether you can print to the device
(system printer driver). from other Windows applications. If not, it's

not an AutoCAD problem. Try the Windows
Print Troubleshooter (Start=>Help=>
Contentse>Troubleshooting and
Maintenance).

Nothing comes out of the plotter Choose Filec>Plotter Manager, double-click

(nonsystem printer driver). the plotter configuration, and check the
settings.

Objects don't plot the way they Check for a plot style table with weird set-

appear on-screen. tings or try plotting without a plot style table.

Objects appear ghosted or with In the plot style table, set Color to Black for

washed-out colors. all colors.

Scaled To Fit doesn’t work right in Change the What To Plot drop-down list
paper space. from Layout to Extents.

The HP enhanced Windows system  In the Plot dialog box's Printer/Plotter area,
driver that you downloaded from HP’s click the Properties button to display the
Web site doesn't have the right paper Plotter Configuration Editor dialog box,
sizes (for example, no architectural click the Custom Properties button (near

paper sizes). the bottom), and then click the More Sizes
button to specify the standard and custom
paper sizes.

Something else is wrong. Check the plot log: Click the Plot/Publish

Details Report Available icon near the right
end of the status bar and look for error
messages.
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In this part . . .

A fter you get the lines and text right, you may be justi-
fied in thinking that your work in AutoCAD is done.

But AutoCAD enables you to do so much more! Blocks and
external references help you manage data within drawings,
between drawings, and across a network. If you plan to
share drawings, the Internet is the biggest ongoing swap
meet in human history, and AutoCAD offers some unique
trading possibilities — and potential pitfalls — via e-mail
and the Web. With the information in this part, you'll be
teaching AutoCAD how to give and receive in no time.
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Chapter 14
Playing Blocks and Rasteroids

In This Chapter

Introducing blocks, external references (xrefs), and raster images
Creating block definitions

Inserting blocks

Using attributes in blocks

Authoring dynamic blocks

Attaching and managing xrefs and DWFs

Controlling xref paths

Attaching and managing raster image files

C hapter 7 shows you how to copy objects within a drawing or even

to another drawing. That’s one way to use CAD to improve drafting
efficiency. You can copy a DWG file and then modify it to create a similar
drawing — an even better productivity-booster, as long as you're in the habit
of making similar drawings. But all those are baby steps compared to the
techniques that we cover in this chapter: treating drawings, parts of draw-
ings, drawings saved in Web format (DWF), and raster images as reusable and
updateable modules. If you want to make drafting production more efficient
with CAD, you want to know how to use blocks, xrefs, DWFs, and raster files.

A block is a collection of objects grouped together to form a single object.
You can insert this collection more than once in the same drawing, and when
you do, all instances of the block remain identical, even after you change the
block definition. Although a block lives within a specific drawing, you can
transfer copies of it into other drawings. You can add fill-in-the-blank text
fields called attributes to blocks.

Blocks don’t have to be static creations. Instead of having a half-dozen regular
blocks for a half-dozen different door sizes, you can create a single dynamic
block that includes all those sizes. Unlike a regular block, in which every
instance of a particular block is geometrically identical, each instance of a
dynamic block can display geometric variations. For example, you can insert
one furniture block three times and have one instance display as a sofa, one as
aloveseat, and one as an armchair. We look more closely at block authoring —
the process for creating and editing dynamic blocks — in this chapter.
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An external reference, or xref, is like an industrial-strength block. An external
reference is a pointer to a separate drawing outside the drawing you're work-
ing on. When you attach a reference drawing, it appears on-screen and on
plots as part of your drawing, but it continues to live as a separate document
on your hard disk. If you edit the externally referenced drawing, the appear-
ance of the drawing changes in all drawings that reference it.

A raster file (also called a bitmap file) stores a graphical image as a series of
dots. Raster files are good for storing photographs, logos, and other images,
whereas CAD vector files are good for storing geometrical objects such as
lines and arcs, along with text and other annotations for describing the geom-
etry. Sometimes it’s handy to combine raster images with CAD vector files by
attaching them to your drawing files, and AutoCAD’s External References
palette makes the process straightforward.

In AutoCAD 2007 you can use the new External References palette to attach a
third type of external file as a DWF underlay. A DWF (Design Web Format) file
is a lightweight version of a DWG file; we discuss DWFs (you can call them
dwiffs if you don’t mind being thought of as a dweeb) in Chapter 15.

Blocks, external references, DWF underlays, and raster images enable you to
reuse your work and the work of others, giving you the potential to save
tremendous amounts of time — or to cause tremendous problems if you
change a file on which other peoples’ drawings depend. Use these features
when you can to save time, but do so in an organized and careful way so as to
avoid problems.

The way you use blocks and especially xrefs depends a lot on the profession
and office in which you work. Some disciplines and companies use these
drawing organization features heavily and in a highly organized way, while
others don’t. Ask your colleagues what the local customs are and follow them.

Rocking with Blocks

First, a little more block theory and then you can rock right into those blocks.

To use a block in a drawing, you need two things: a block definition and one
or more block inserts. AutoCAD doesn’t always make the distinction between
these two things very clear, but you need to understand the difference to
avoid terminal confusion about blocks. (Maybe this syndrome should be
called blockheadedness?)

A block definition lives in an invisible area of your drawing file called the
block table. (It’s one of those symbol tables that we describe in Chapter 5.)
The block table is like a book of graphical recipes for making different kinds
of blocks. Each block definition is like a recipe for making one kind of block.
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When you insert a block, as described later in this chapter, AutoCAD creates
a special object called a block insert. The insert points to the recipe and tells
AutoCAD, “Hey, draw me according to the instructions in this recipe!”

Although a block may look like a collection of objects stored together and
given a name, it’s really a graphical recipe (the block definition) plus one or
more pointers to that recipe (one or more block inserts). Each time you
insert a particular block, you create another pointer to the same recipe.

The advantages of blocks include

v Grouping objects together when they belong together logically. You
can draw a screw using lines and arcs and then make a block definition
out of all these objects. When you insert the screw block, AutoCAD
treats it as a single object for purposes of copying, moving, and so on.

v~ Saving time and reducing errors. Inserting a block is, of course, much
quicker than redrawing the same geometry again. And the less geometry
you draw from scratch, the less opportunity there is to make a mistake.

v~ Efficiency of storage when you reuse the same block repeatedly. If you
insert the same screw block 15 times in a drawing, AutoCAD stores the
detailed block definition only once. The 15 block inserts that point to
the block definition take up much less disk space than 15 copies of all
the lines, polylines, and arcs.

v~ The ability to edit all instances of a symbol in a drawing simply by
modifying a single block definition. This one is a biggie. If you decide
that your design requires a different kind of screw, you simply redefine
the screw’s block definition. With this new recipe, AutoCAD then
replaces all 15 screws automatically. That’s a heck of a lot faster than
erasing and recopying 15 screws!

v Varying the appearance of block inserts using dynamic blocks. This
one is an even bigger biggie. If your design requires a different kind of
screw, you simply change the view of the screw to the other kind
(assuming, of course, you've defined your screw as a dynamic block).
Every instance of the screw in the drawing could show a different kind of
screw. And that’s a heck of a lot more efficient than creating 15 different
block definitions!

Blocks aren’t as great for drawing elements used in multiple drawings, how-
ever, especially in a situation where several people are working on and shar-
ing parts of drawings with one another. That’s because blocks, after they get
into multiple drawings, stay in each drawing; a later modification to a block
definition in one drawing does not automatically modify all the other draw-
ings that use that block. If you use a block with your company’s logo in a
number of drawings and then you decide to change the logo, you must make
the change within each drawing that uses the block.
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If all you need to do is make some objects into a group so that you can more
easily select them for copying, moving, and so on, use the AutoCAD group fea-
ture. Type Group and press Enter to open the Object Grouping Dialog box in
AutoCAD or the Group Manager dialog box in AutoCAD LT. Then select some
objects, click the New button in AutoCAD or the Create Group button in
AutoCAD LT, and type a name for the group. When you’re editing drawings
containing groups, press Ctrl+H to toggle “group-ness” on or off. If you’ve tog-
gled “group-ness” on, picking any object in a group selects all objects in the
group. If you've toggled it off, picking an object selects only that object, even
if it happens to be a member of a group.

Creating block definitions

To create a block definition from objects in the current drawing, use the
Block Definition dialog box. (The other way to create a block definition is by
inserting another drawing file into your current drawing as a block, which we
explain in the next section.) The following steps show you how to create a
block definition using the Block Definition dialog box:

1. Click the Make Block button on the Draw toolbar.
The Block Definition dialog box appears (see Figure 14-1).

Layers matter when you create the objects that make up a block. Block
geometry created on most layers retains the characteristics, such as
color and linetype, of those layers. But if you create a block using geom-
etry on Layer 0, that geometry has no characteristics, such as color and
linetype, of its own; chameleonlike, it takes on the features of the layer
into which it’s inserted.

2. Type the block definition’s name in the Name text box.

If you type the name of an existing block definition, AutoCAD replaces
that block definition with the new objects you select. This process is
called block redefinition.

To see a list of the names of all the current blocks in your drawing, pull
down the Name list.

3. Specify the base point (also known as the insertion point) of the block,
using either of the following methods:

¢ Enter the coordinates of the insertion point in the X, Y, and Z text
boxes.

e Click the Pick Point button and then select a point on the screen.
(In this case, use an object snap or other precision technique, as
described in Chapter 5, to grab a specific point on one of the
block’s objects.)

The base point is the point on the block by which you insert it later, as
we describe in the next section.
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want as part of the block.

AutoCAD uses the selected objects to create a block definition and dis-

plays an icon showing those objects next to the block name. Figure 14-2
shows the base point and group of selected objects during the process

of creating a new block definition.

N

)

Base point

5. Select a radio button to tell AutoCAD what to do with the objects used
to define the block: Retain them in place, convert them into a block
instance, or delete them.

The default choice, Convert To Block, is usually the best. See Step 9 for a
description of what happens with each choice.
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6. Specify the Insert units to which the block will be scaled in the Block

Unit drop-down list.

When you or someone else drags the block from one drawing into
another via the DesignCenter palette (see Chapter 5) or Tool Palette
(described later in this chapter), the units you specify here and the units
of the drawing you’re dragging into will control the default insertion
scale factor.

Two additional features in AutoCAD’s Block Definition dialog box give
you even more control over what happens to your blocks as they're
inserted. If the Scale Uniformly check box is selected, blocks can’t be
inserted with differing x, y, or z scale factors. If the Allow Exploding
check box is deselected, blocks can’t be exploded during or after their
insertion in a drawing.

. Enter a description for the block in the Description text area.

You don’t have to enter a description to create a block, but it’s not a bad
idea. Think like a database manager and enter a useful description that
will identify the block to yourself and others.

. Make sure that the Open In Block Editor check box is unchecked.

You don’t need to use the Edit Block Definition dialog box if you're not
going to add dynamic features to the block. We look at defining dynamic
blocks later in the chapter.

. Click OK to complete the block definition process.

If you typed the name of an existing block definition in Step 2, AutoCAD
warns you that you'll redefine that block definition. Click Yes to redefine,
which will update all instances of the block in the current drawing to
match the changed block definition.

AutoCAD stores the block definition in the current drawing’s block table.
If you selected the Convert To Block radio button (the default) in Step 5,
AutoCAD also creates a block insert pointing to the new block definition —
the objects look the same on-screen, but now they’re an instance of the
block rather than existing as separate objects. If you selected the Retain
radio button, the objects remain in place but aren’t converted into a
block insert — they stay individual objects with no connection to the
new block definition. If you selected the Delete radio button, the objects
disappear (but the block definition still gets created).

You can include in a block definition a special kind of variable text object
called an attribute definition. When you insert a block that contains one or
more attribute definitions, AutoCAD prompts you to fill in values for the text
fields. Attributes are useful for variable title block information (sheet number,
sheet title, and so on) and symbols that contain different codes or call-outs.
We describe how to create and use attribute definitions later in this chapter.
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Figure 14-3:
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Keep your common symbol drawings in one or more specific folders that you
set aside just for that purpose. You may want to use one of the following tech-
niques to develop a block library of symbols that you use frequently:

1 Create a separate DWG file for each symbol (using Wblock, or simply by

drawing each one in a new drawing).

v Store a bunch of symbols as block definitions in one drawing and use

DesignCenter to import block definitions from this drawing when you
need them.

Inserting blocks

AutoCAD provides a number of ways to insert a block, but the most com-
monly used and most flexible is the Insert dialog box. Here’s the procedure
for inserting a block:

1.

Set an appropriate layer current, as described in Chapter 5.

It’s a good idea to insert each block on a layer that has something to do
with its geometry or purpose:

e If all the objects in the block definition reside on one layer, then it’s
usually best to insert the block on that layer.

e [f the block geometry spans several layers, choose one of them to
insert the block on.

If any of the block definition’s geometry was created on Layer 0, that
geometry will inherit the color, linetype, and other object properties of
the layer that you insert the block on. It’s like the chameleon changing
color to match its surroundings or a politician changing his position to
match the day’s opinion polls.

. Click the Insert Block button on the Draw toolbar.

The Insert dialog box appears, as shown in Figure 14-3.
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3. Enter the block definition name or external filename by using one of
the following methods:

e Use the Name drop-down list to select from a list of block defini-
tions in the current drawing.

¢ Click the Browse button to select an external DWG file and have
AutoCAD create a block definition from it.

You can use an external drawing to replace a block definition in your
current drawing. If you click Browse and choose a file whose name
matches the name of a block definition that’s already in your drawing,
AutoCAD warns you and then updates the block definition in your draw-
ing with the current contents of the external file. This process is called
block redefinition, and as described in Steps 2 and 9 in the “Creating
block definitions” section, AutoCAD automatically updates all the block
inserts that point to the block definition.

4. Enter the insertion point, scale, and rotation angle of the block.

You can either select the Specify On-screen check box in each area to
specify the parameters on-screen at the command prompt, or type the
values you want in the Insertion Point, Scale, and Rotation text boxes.

Check the Uniform Scale check box to constrain the X, Y, and Z scaling
parameters to the same value (which in almost all cases you want).

5. If you want AutoCAD to create a copy of the individual objects in the
block instead of a block insert that points to the block definition,
select the Explode check box.

6. Click OK.

7. If you checked the Specify On-screen check box for the insertion
point, scale, or rotation angle, answer the prompts on the command
line to specify these parameters.

After you insert a block, all the objects displayed in the block insert behave
as a single object. When you select any object in the block insert, AutoCAD
highlights all the objects in it.

Another way to insert a block is to drag a DWG file from Windows Explorer
and drop it anywhere in the current drawing window. AutoCAD then prompts
you to choose an insertion point and optionally change the default scale
factor and rotation angle. Similarly, you can drag a block definition from the
Blocks section of the DesignCenter palette and drop it into the current draw-
ing window. (Chapter 5 describes DesignCenter.)

AutoCAD provides one additional way of inserting blocks: the Tool Palettes
window, which is described in Chapter 2. As is true of using a tool palette
for hatching (Chapter 12), you first must create and configure appropriate
tools — that is, swatches. The easiest method is right-clicking a drawing in

www.it-ebooks.info


http://www.it-ebooks.info/

Chapter 14: Playing Blocks and Rasteroids 32 9

\NG/
V?\“

\\J

DesignCenter and choosing Create Tool Palette. A new tabbed page is added
to the Tool Palettes window containing all the block definitions from the
drawing that you right-clicked. Simply click and drag a tool to insert its corre-
sponding block into a drawing. As with hatching, you don’t get the chance to
specify a different insertion scale. You also can’t use all AutoCAD’s precision
tools to specify the insertion point precisely, so you may need to move the
block into place after inserting it. We recommend that you first master the
other block insertion methods described in this chapter — especially the
Insert dialog box and DesignCenter palette. Then if you find yourself inserting
the same blocks frequently, consider creating a tool palette containing them.
See “tool palettes, adding drawings from” in the AutoCAD online help system
for more information.

Be careful when inserting one drawing into another. If the host (or parent)
drawing and the inserted (or child) drawing have different definitions for
layers that share the same name, the objects in the child drawing take on the
layer characteristics of the parent drawing. For example, if you insert a draw-
ing with lines on a layer called Walls that’s blue and dashed into a drawing
with a layer called Walls that’s red and continuous, the inserted lines on the
wall layer will turn red and continuous after they’re inserted. The same rules
apply to linetypes, text styles, dimension styles, and block definitions that
are nested inside the drawing you’re inserting.

If you need to modify a block definition after you’ve inserted one or more
instances of it, use the REFEDIT command (Tools=>Xref and Block In-place
Editing=>Edit Reference In-Place). Look up “REFEDIT” in the AutoCAD online
help system. (AutoCAD LT does not include the REFEDIT command.)

Attributes: Fill-in-the-blank blocks

You may think of attributes as the good (or bad) qualities of your significant
other, but in AutoCAD, attributes are fill-in-the-blank text fields that you can
add to your blocks. When you create a block definition and then insert it sev-
eral times in a drawing, all the ordinary geometry (lines, circles, regular text
strings, and so on) in all the instances are exactly identical. Attributes pro-
vide a little more flexibility in the form of text strings that can be different in
each block insert.

For example, suppose that you frequently designate parts in your drawings
by labeling them with a distinct number or letter in a circle for each part. If
you want to create a block for this symbol, you can’t simply draw the number
or letter as regular text using the MTEXT (T) or DTEXT (DT) command. If you
create a block definition with a regular text object (for example, the letter A),
the text string will be the same in every instance of the block (always the
letter A). That’s not much help in distinguishing the parts!
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Instead, you create an attribute definition, which acts as a placeholder for a
text string that can vary each time you insert the block. You include the
attribute definition when you create the block definition (as we demonstrate
in the “Creating block definitions” section, earlier in this chapter). Then each
time you insert the block, AutoCAD prompts you to fill in an attribute value
for each attribute definition.

The AutoCAD documentation and dialog boxes often use the term attribute to
refer indiscriminately to an attribute definition or an attribute value. We
attribute a lot of the confusion about attributes to this sloppiness. Just
remember that an attribute definition is the text field or placeholder in the
block definition, while an attribute value is the specific text string that you
type when you insert the block.

If you've worked with databases, the correspondences in Table 14-1 between
AutoCAD objects (blocks and attributes) and database terminology may help
you understand the concept.

Table 14-1 Attribute and Database Comparison
AutoCAD Database

Block definition Database table structure

Block insert One record in the table

Attribute definition Field name

Attribute value Value of the field in one record

Attribute definitions

You use the Attribute Definition dialog box to create attribute definitions
(clever, huh?). The procedure is similar to creating a text string, except that
you must supply a little more information. Create attribute definitions with
the following steps:

1. Change to the layer on which you want to create the attribute
definition.

2. Choose Drawr>Block=>Define Attributes to run the ATTDEF (ATT)
command.

The Attribute Definition dialog box appears, as shown in Figure 14-4.

You rarely need to use any of the Mode settings (Invisible, Constant,
Verify, or Preset). Just leave them unchecked. If you're curious about
what the modes do, use the dialog box help to find out more.
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3. In the Attribute area, type the Tag (database field name), Prompt (user
V?‘“‘NG 1 prompt), and Value (default value).
S The name you type into the Tag text box can’t contain any spaces. The
Prompt and Value text boxes may contain spaces.
Attribute values can include automatically updating fields, such as date,
filename, or system variable setting. Click the Insert Field button to the
right of the Value text box to insert a field. See the “Mtext plays the field”
section in Chapter 10 for more information.
4. In the Text Options area, specify the Justification, Text Style, Height,
and Rotation.
The text properties for attribute definitions are the same as those for
single-line text objects — see Chapter 10.
5. Select Specify On-screen to choose an insertion point for the attribute
definition.
An attribute definition’s insertion point is like a text string’s base point.
Remember to use snap, object snap, or another precision tool if you
want the eventual attribute values to be located at a precise point.
6. Click OK to create the attribute definition.
7. Repeat Steps 1 through 6 for any additional attribute definitions.
P If you need to create a series of attribute definitions in neat rows, create

the first one using Steps 1 through 6 and then select the Align Below
Previous Attribute Definition check box for the subsequent definitions.
To make a series of non-adjacent attributes, create the first one using
Steps 1 through 6 and then copy the first attribute definition and edit the
copy with the Properties palette. You can prevent your attributes from
being dragged around the block by selecting the Lock Position in Block
check box in the Attribute Definition dialog box.
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|
Figure 14-5:
The Edit
Attributes
dialog box.

Block definition containing attribute definitions

After you create one or more attribute definitions — and any other geometry
that you want to include in the block — you’re ready to create a block defini-
tion that contains them. Follow the steps in the section “Creating block defin-
itions,” earlier in this chapter.

At Step 4 in the section “Creating block definitions,” you can select any
attribute definitions before or after you select the other geometry. However,
you should select each attribute definition one-by-one (clicking on each
attribute definition rather than selecting multiple attributes with a selection
window), in the order that you want the attribute value prompts to appear in
the Edit Attributes dialog box (see Figure 14-5). If you don’t select the attrib-
utes one by one, your block and attributes will still work, but the order of the
attribute prompts in the Edit Attributes dialog box may not be what you
want.

You can use the Block Attribute Manager (choose Modify=>Object=>Attributer>
Block Attribute Manager — not included in AutoCAD LT) to reorder the
attribute definitions in a block definition. You also can use this dialog box to
edit other attribute definition settings, such as the prompt, text style, or layer.

Insert a block containing attribute definitions

After you create a block definition that contains attribute definitions, you
insert it just like any other block. Follow the steps in the section “Inserting
blocks,” earlier in this chapter. At the end of the steps, AutoCAD should dis-
play the Edit Attributes dialog box, shown in Figure 14-5. The dialog box con-
tains one row for each of the attribute definitions and has any default values
filled in. You simply edit the values and then click OK.

[ 31'Edit Attributes It

Block mame: Widget

Part number Al

Cuantity

) Lo
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P The ATTDIA (AT Tribute DIAlog box) system variable controls whether
AutoCAD prompts for attribute values in a dialog box (ATTDIA=1) or at the
command line (ATTDIA=0). If you insert a block and see command line
prompts for each attribute value, type a value and press Enter for each
attribute value. When you return to the Command prompt, type ATTDIA,
press Enter, type 1, and press Enter again. When you insert blocks with
attributes in this drawing in the future, AutoCAD displays the Edit Attributes
dialog box instead of prompting you at the command line.

Edit attribute values

After you insert a block that contains attributes, you can edit the individual
attributes in that block insert with the EATTEDIT command (Enhanced
ATTtribute EDIT — once again, not included in AutoCAD LT). Choose
Modify=>Object>Attributer>Single and click on any object in the block insert.
AutoCAD displays the Enhanced Attribute Editor dialog box with the current
attribute values, as shown in Figure 14-6. The most common attribute editing
operation is to edit the text value — that is, the text string that appears in the
block insert. You also can change properties of the attributes, such as layer
and text style.

3! Enhanced Attribute Editor 2E
Block: Widget 5 ]
Tag: PART_NUM siect bock &
I
Atbute | Text Options || Properties
Figure 14-6: s E— Vo
The PART_NUM  Pat rumber Al
arY Quantt 1
Enhanced o
Attribute
. . Value: |A1
Editor dialog
box.
[ OK | [ Cancal | L Help ]
a—— |

Many people use attributes in the way we’ve described so far — as fill-in-the-
blank text fields in blocks. But attributes also can serve as data extraction
tools. For example, you can export attribute values, such as part numbers
and quantities, to a table object in AutoCAD, a text, spreadsheet, or data-
base file for analysis or reporting. The Attribute Extraction wizard (Tools=>
Attribute Extraction) makes the process fairly straightforward. If you're
hungry to find out more, look up “EATTEXT (Enhanced AT Tribute EXTtract)
command” in the AutoCAD online help system. AutoCAD LT users, we hope
you’re not getting a complex, but you don’t have this command either.
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Purging unused block definitions

Each block definition slightly increases the size
of your DWG file, as do other named objects
such as layers, text styles, and dimension styles.
If you delete (or explode) all the block inserts
that point to a particular block definition,
then that block definition no longer serves any

You should run the PURGE (PU) command peri-
odically in each drawing and purge unused
block definitions and other named objects.
Choose Filec>Drawing Utilities=>Purge to dis-
play the Purge dialog box, as shown in the fol-
lowing figure. Click the Purge All button in order

purpose.

to purge all unused named objects in the cur-
rent drawing.

W Purge
(%) View items you can purge

(C View items you cannot purge

Eems not used in drawing:
= Al items ~

I Fiot styies
Te Shapes
BB Table styles
= Bs Text stvles [

[#] Confimm ezch ftem to be purged

[ Purge nested tems

[ Puge | [ Pugeal | [ owse | [ w0 |

Exploding blocks

In regular block definitions (that is, excluding dynamic blocks), the objects in
each block insert act like a well-honed marching squadron: If you move or
otherwise edit one object in the block insert, all objects move or change in
the same way. Usually this cohesion is an advantage, but occasionally you
need to break up the squadron in order to modify one object without affect-
ing the others.

To explode a block insert into individual objects, click Explode (the fire-
cracker button) on the Modify toolbar and then select the block insert. When
you explode a block insert, AutoCAD replaces it with all the objects — lines,
polylines, arcs, and so on — specified in the block definition. You then can
edit the objects or perhaps use them to make more block definitions.
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If you explode a block that contains attributes, the attribute values change
back to attribute definitions. This usually isn’t the sort of change that you
want. If you really need to explode the block insert, you’ll probably want to
erase the attribute definitions and draw regular text strings in their place. If
you’ve installed the AutoCAD Express Tools (not in AutoCAD LT), you can
perform this task automatically with the BURST command (Express=>Blocks=
Explode Attributes to Text).

Theme and variations: Dynamic blocks

You can add variety to your blocks by making them dynamic. The two most
useful applications for dynamic blocks are multiple presentations of similar
objects and manipulation of components within individual block inserts.

There’s no question that AutoCAD’s dynamic blocks feature gives a great deal
of flexibility to block creation and insertion. But it’s also a very complicated
system, with its own set of commands and system variables. We recommend
that you make yourself very familiar with the regular block creation and
insertion techniques we describe in the previous sections before you tackle
dynamic blocks.

Spend some time planning your dynamic blocks. Sketch out the geometry for
each variation in appearance (or visibility state) and decide where the
common base point should be. Unless you're a lot smarter than we are, you’ll
probably find that creating dynamic blocks is complex enough without trying
to design your blocks as you go.

Now you see it . . .

If your drawing shows six different kinds of windows, one approach is to
create six different standard blocks to represent them all. Alternatively, you
can create a single dynamic block, and define visibility states to cover all six
different types. The following steps show you how to make your blocks do
double (or sextuple?) duty using the Edit Block Definition dialog box:

1. Open a drawing that contains some blocks definitions you’d like to
combine, or draw some simple geometry to make some similar types
of object.

You can create dynamic blocks from scratch, or you can work with exist-
ing standard (that is, non-dynamic) block definitions. Figure 14-7 shows
a drawing with three non-dynamic blocks.

2. Choose Tools=>Block Editor to open the Edit Block Definition
dialog box.
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3. Specify a new block name or click Current Drawing, and then click

OK to display the Block Editor window.

The Block Editor is a special authoring environment with its own set of
palettes, a toolbar, and a passel of command-line commands. You also
have access to the rest of AutoCAD’s toolbars, so you can draw and edit
just like you're in the regular drawing window.

If you enter a new block name, AutoCAD displays an empty block-
authoring environment where you draw geometry or insert existing
blocks. If you instead select Current Drawing, AutoCAD places all draw-
ing objects inside the block-authoring environment.

. Create some geometry for the first visibility state, or choose Insert=>

Block and select an existing block definition to serve as the first visi-
bility state.

When creating geometry from scratch, pay attention to where the
common base point should be. Although you use different blocks to
assemble a multiple view block, they should all have the same base
point (0,0 is a good one for blocks). You don’t want your chairs jumping
around between different insertion points!

. If you inserted an existing block in Step 4, uncheck all three Specify

On-screen check boxes, make sure that the Explode check box is not
checked, and then click OK.

. Repeat Steps 4 and 5, drawing or inserting all the necessary geometry.

At this point, your drawing screen may look pretty strange (see Fig-
ure 14-8). Don’t worry; you're going to fix it up in the next steps.
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7. Click the Parameters tab of the Block Authoring palettes, and then

click Visibility Parameter.

If the Block Authoring palettes are not open, click the Authoring Palettes
button on the Block Authoring toolbar.

AutoCAD prompts you to specify the parameter location.

. Click to place the parameter marker somewhere other than the base

point location you chose in Step 4.

The parameter location you specify will be the spot on the block where
the dynamic block option grip will be displayed. It’s not crucial where
you locate this point, but try to pick a sensible location on the object.
If you specify the same point for the parameter location as the base
point for the block, you may have a hard time selecting the dynamic
option grip.

. AutoCAD places a parameter marker at the selected point and returns

to the command line.

As shown in Figure 14-8, the label Visibility appears next to the visibility
parameter marker, and a yellow Alert symbol indicates that no action
has been assigned to the parameter yet. The Visibility States controls at
the right end of the Block Authoring toolbar become active.
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10.

11.

12.

13.

14.

Click Manage Visibility States on the Block Authoring toolbar. Click
Rename and change VisibilityState( to something more descriptive.
Click OK.

As is the case with other named objects in AutoCAD, it’s good procedure
to assign useful names rather than accept the default generic labels.

On the Block Authoring toolbar, click Make Invisible. At the Select
objects prompt, select the geometry or block inserts that are not asso-
ciated with the current visibility state, and then press Enter.

By default, the invisible objects disappear from the screen. You can view
them in a faded appearance by clicking Visibility Mode on the Block
Authoring toolbar.

Click Manage Visibility States again and then click New to create a
new visibility state. In the New Visibility State dialog box, enter a
descriptive name. Select the Show All Existing Objects in New State
radio button, and then click OK.

All of your geometry should reappear.

Repeat Steps 11 and 12 to create additional visibility states associated
with the remaining geometry or blocks.

The geometry or block insert associated with the last-created visibility
state should be visible on-screen.

From the Block Authoring toolbar, click Close Block Editor. Save the
changes to your new block or Current Drawing.

AutoCAD closes the block authoring environment and returns to the
standard drawing editor window.

Lights! Parameters!! Actions!!!

You can modify the appearance of individual instances of the same block by
defining parameters and actions to move, rotate, flip, or align parts of them.
You can adjust the block’s appearance as you insert it or at any time after-
wards. The following steps show you how to use the Block Editor to add

some action to a block definition:

1.

3.

Open a drawing that contains some block definitions whose appear-
ance you’d like to spice up a little, or draw some simple geometry that
might make a suitably dynamic block.

Action parameters are most effective in block definitions that contain
groups of related objects — for example, an office desk and chair, or a
furniture arrangement.

. Choose Tools>Block Editor or enter the BEDIT (BE) command to open

the Block Editor.

Specify a new block name or click Current Drawing, and then click OK.
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10.

11.

. Create some geometry or insert some blocks. When inserting blocks,

remember to make sure that the Explode check box is not checked,
and then click OK.

Draw the geometry or insert the blocks in a group such that you can
insert the finished arrangement into your drawings — for example,
Figure 14-9 shows the creation of a dynamic block for a coffee shop or
cafeteria.

. Repeat Step 4 until you’ve drawn all the needed geometry or inserted

all the necessary blocks.

. Click the Parameters tab of the Block Authoring palettes, and then

click Rotation Parameter.

If the Block Authoring palettes are not open, click the Authoring Palettes
button on the Block Authoring toolbar.

AutoCAD prompts you to specify the parameter location.

. Click to place the parameter marker somewhere on the object geome-

try other than the base point location.

If you specify the same point for the parameter location as the base point
for the block, you may have a hard time selecting the dynamic option grip.

. AutoCAD places a parameter marker at the selected point and returns

to the command line.

The parameter marker’s label appears next to the rotation parameter
marker.

. Click the Actions tab of the Block Authoring palettes. Click Rotate

Action. Select the Rotate Parameter, select the objects that should be
modified when the grip is used, and specify a point for the action’s label.

AutoCAD returns to the command prompt. At this point, it’s fine to go
with default values and on-screen pick points.

Repeat Steps 6 through 9, trying different parameters and actions. For
example, choose a Point Parameter and a Move Action.

Figure 14-9 shows a set of block components, several of which have
action parameters assigned to them. After the block is inserted, you can
manipulate the components to which you’ve added parameters to vary
the appearance of the blocks. We explain how a little later in this chapter.

From the Block Authoring toolbar, click Close Block Editor. Save the
changes to your new block or Current Drawing.

AutoCAD closes the block-authoring environment and returns to the
standard drawing editor window.
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Manipulating dynamic blocks

After a dynamic block has been inserted in a drawing, you can select it and
modify its display through a special set of custom grips. (That’s what
AutoCAD is calling them, so we’re following suit.)

When you select a standard (that is, non-dynamic) block, you see a single
grip at the insertion point. When you select a dynamic block, you see at least
two — and maybe more — custom grips, as well as the insertion point grip.
The custom grips usually look different from the regular object grips, but not
always, so take care when clicking grips. The following steps show you how
to make your dynamic blocks do the things you just spent all this time teach-
ing them to do:

1. Insert a few blocks that contain some dynamic parameters such as vis-
ibility or action parameters.

If your block inserts don’t have any action parameters, go to Step 4.
2. Select a block that includes some action parameters.

The block insert displays a number of grips (see Figure 14-10). If the
insert displays only one grip, it is not a dynamic block.
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3. Click one of the custom grips — for example, clicking a round grip
opens the rotation parameter of the object. Rotate the component as
required.

4. Select a block that includes a visibility parameter and then click the
visibility grip. Choose the desired visibility state from the shortcut
menu.

For additional information on manipulating actions and visibility states,
refer to the online help system.

Dynamic blocks, as we’ve suggested more than once, are a powerful — and
complicated — feature. The Block Authoring Palettes contain ten selectable
parameters, eight actions, and twenty parameter sets. We're thinking of writ-
ing a new book called Block Authoring For Dummies. Until we do, AutoCAD’s
online help system is your best resource for more information on all the pos-
sibilities of dynamic blocks. The quickest and most direct way to AutoCAD’s
own help is to click the Learn About Dynamic Blocks button while you're
working in the Block Editor environment.

Going External

In AutoCAD, an xref, or external reference, is a reference to another, external
drawing file — one outside the current drawing — that you can make act as

though it’s part of your drawing. Technically, a reference is simply a pointer
from one file to another. The xref is the actual pointer, but many people call

the combination of the pointer and the external file the xref.
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Somewhat confusingly, AutoCAD 2007 replaces the old Xref Manager and
Image Manager dialog boxes with a new palette called, simply, External
References. You use this new palette to attach externally referenced drawings
(xrefs) and images, as well as a third file type: DWF. It’s really worth getting
past the confusion — it’s very useful to be able to see externally referenced
drawing files, attached images, and DWF underlays all in the same window.

Drawings that you include as xrefs in other drawings are called child draw-
ings. Drawings that contain pointers to the child drawings are called parent
drawings. This family terminology gets a little weird when you realize that a
child drawing can have lots of parent drawings that refer to it — apparently
it’s the commune version of family relations. If you find such relationships
odd, you can, like the AutoCAD online help system, refer to the parent draw-
ing as the host drawing. We prefer the terms parent and child, in part because
they’re easily extendable to describing more complex hierarchies, such as a
parent drawing, which xrefs a child drawing, which in turn xrefs a grandchild
drawing.

Xrefs have a big advantage over blocks: If you change a child drawing,
AutoCAD automatically loads the change into all the parent drawings
that reference the child drawing.

AutoCAD loads all xrefs into the parent drawing each time the parent drawing
is opened. If the child drawing has been changed, AutoCAD automatically
incorporates those changes into the parent drawing.

When you open a drawing containing xrefs, AutoCAD displays a little symbol
(which looks like papers with a binder clip) on the right end of the status
bar. This symbol alerts you to the fact that some of the things you see in the
drawing are actually parts of other, xrefed drawings. If an xref changes while
you have the parent drawing open (because you or someone else opens and
saves the child drawing), the status bar xref symbol displays an External
Reference Files Have Changed balloon notification. (If you want to
change whether the notifications appear and how often AutoCAD checks for
changes, look up “XREFNOTIFY” and “XNOTIFYTIME” in the online help.)
You can use the Reload option on the External References palette to show
the updated xrefs. See the “Managing xrefs” section, later in this chapter,

for details.

Another advantage of xrefs over blocks is that their contents aren’t stored

in your drawing even once. The disk storage space taken up by the original
drawing (that is, the xref) isn’t duplicated, no matter how many parent draw-
ings reference it. This characteristic makes xrefs much more efficient than
blocks for larger drawings that are reused several times.
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You can always buy a larger hard drive, however, so the storage issue isn’t
crucial. The key benefit of xrefs is that they enable you to organize your
drawings in a modular way so that changes you make to a single drawing file
automatically “ripple through” all the parent drawings to which it’s xrefed.
This benefit is even greater on larger projects involving multiple drafters,
each of whose work may be incorporated in part or in whole in the work of
others.

@\\\NG-’ The automatic update feature of xrefs is a big advantage only if you're orga-

S nized about how you use xrefs. Suppose that an architect creates a plan
drawing showing a building’s walls and other major features that are common
to the architectural, structural, plumbing, and electrical plan drawings. The
architect then tells the structural, plumbing, and electrical drafters to xref
this background plan into their drawings, so that everyone is working from
a consistent and reusable set of common plan elements. If the architect
decides to revise the wall locations and updates the xrefed drawing, every-
one will see the current wall configuration and be able to change their draw-
ings. But if the architect absentmindedly adds architecture-specific objects,
such as toilets and furniture, to the xrefed drawing, or shifts all the objects
with respect to 0,0, everyone else will have problems. If different people in
your office share xrefs, create a protocol for who is allowed to modify which
file when, and what communication needs to take place after a shared xref is
modified.

Becoming attached to your xrefs

Attaching an external reference drawing is similar to inserting a block, and
almost as easy. Just use the following steps:

1. Set an appropriate layer current, as described in Chapter 5.

We recommend that you insert xrefs on a separate layer from all other
objects. Note that if you freeze the layer an xref is inserted on, the entire
xref disappears. (This behavior can be either a handy trick or a nasty
surprise.)

2. If the External References palette is not already open, choose Tools~>
Palettes>External References to open it.

The toolbar at the top of the palette lets you attach a drawing as an xref,
a raster image file, or a DWF underlay. We cover attaching images and
DWFs later in this chapter.

3. Click Attach DWG (see Figure 14-11) and locate the drawing file you
want to attach.

The Select Reference File dialog box appears.
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4. Browse to find the file you want to attach, select it, and then click

Open.
The External Reference dialog box appears.
. Specify the parameters for the xref in the dialog box.

Parameters include the insertion point, scaling factors, and rotation
angle. You can set these parameters in the dialog box or specify them
on-screen, just as you can do when inserting a block, as described ear-
lier in this chapter.

You can select the Attachment or Overlay radio button to tell AutoCAD
how to handle the xref. The choice matters only if you create a drawing
that uses xrefs, and then your drawing is, in turn, used as an xref.
Attachment is the default choice, and it means that the xrefed file will
always be included with your drawing when someone else uses your
drawing as an xref. Overlay, the other choice, means that you see the
xrefed drawing, but someone who xrefs your drawing won'’t see the over-
laid file. By choosing Overlay, you can xref in a map, for example, to your
drawing of a house, but not have the map show up when someone else
xrefs your house drawing. (That person can xref the map, if need be.) We
recommend that you use the default Attachment reference type unless
you have a specific reason to do otherwise.
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The Path Type drop-down list provides more flexibility in how the xref’s
path gets stored. See the “Forging an xref path” section later in this
chapter for more information. For now, we recommend that you choose
Relative Path instead of the default Full Path.

6. Click OK.

The externally referenced file appears in your drawing.

Layer-palooza

When you attach or overlay an xref, AutoCAD adds new layers to your cur-
rent drawing that correspond to the layers in the xrefed DWG file. The new
layers are assigned names that combine the drawing name and layer name;
for example, if you xref the drawing MYSCREW . DWG, which has the layer
names GEOMETRY, TEXT, and so on, the xrefed layers will be named
MYSCREW | GEOMETRY, MYSCREW I TEXT, and so on. By creating separate
layers corresponding to each layer in the xrefed file, AutoCAD eliminates the
potential problem we warned you about with blocks when layers have the
same name but different color or linetype in the two drawings.

AutoCAD also creates new linetypes, text styles, dimension styles, and block
definitions for each of these items in the xrefed file — for example, MYSCREW
IDASHED, MYSCREW INOTES, MYSCREW | A-DIMS, and MYSCREW |LOGO.

Creating and editing an
external reference file

To create a file that you can use as an external reference, just create a draw-
ing and save it (or use the WBLOCK command to create a new DWG from
geometry in the current drawing). That’s it. You then can create or open
another drawing and create an external reference to the previous one. The
xrefed drawing appears in your parent drawing as a single object, like a block
insert. In other words, if you click any object in the xref, AutoCAD selects the
entire xref. You can measure or object snap to the xrefed geometry, but you
can’t modify or delete individual objects in the xref — you open the xref
drawing in order to edit its geometry.

AutoCAD’s XOPEN command (not in AutoCAD LT) provides a quick way to
open an xrefed drawing for editing. You just start the command and pick on
any object in the xref. Alternatively, you can select the xref in the External
References palette, then right-click, and choose Open from the shortcut
menu to open one or more xrefs for editing. See the “Managing xrefs” section,
later in this chapter, for more information.
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Figure 14-12:
Chart your
path when
you attach

an xref.

An alternative to opening the xrefed file when you need to edit it is to use the
REFEDIT command (not in AutoCAD LT). Look up “REFEDIT” in the AutoCAD
online help system.

Forging an xref path

When you attach an xref, AutoCAD, by default, stores the xref’s full path —
that is, the drive letter and sequence of folders and subfolders in which the
DWHG file resides — along with the filename. This default behavior corre-
sponds to the Full Path setting in the Path Type drop-down list. (Figure 14-12
shows the three xref path options.) Full Path works fine as long as you never
move files on your hard disk or network and never send your DWG files to
anyone else — which is to say, it almost never works fine!

3! External Reference 2]
Name: | Xsteplan il
Found in: D:\Wark'\X-siteplan.dwg
Saved path: Di\Work'\X-steplan.dwg
Reference Type Path type
(%) Attachment (O Oveday Full path v
Insertion poirk Scale
Specify On-screen [ Specify On-screen
X100
T |10 Block Unit
Unit:
Z o Unileas
Factor
[] Uriform Scale actor:1.0000
[ ok |[ canca || Heb

At the other end of the path spectrum, the No Path option causes AutoCAD
not to store any path with the xref attachment — only the filename is stored.
This is the easiest and best option if the parent and child drawings reside in
the same folder.

If you prefer to organize the DWG files for a particular project in more than
one folder, then you’ll appreciate AutoCAD’s Relative Path option, shown in
Figure 14-12. This option permits xrefing across more complex, hierarchical
folder structures but avoids many of the problems that the Full Path option
can cause. For example, you may have a parent drawing H: \Project-X\
Plans\First floor.dwg that xrefs H: \Project-X\Common\Column
grid.dwg. If you choose Relative path, AutoCAD will store the xref path

as ..\ Common\Column grid.dwg instead of H: \Project-X\Common\
Column grid.dwg. Now if you decide to move the \Project-X folder
and its subfolders to a different drive (or send them to someone else who
doesn’t have an H: drive), AutoCAD will still be able to find the xrefs.
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When you use Relative Path, you’ll see xref paths that include the special
codes . and . . (single and double period). The single period means “this
parent drawing’s folder” and the double period means “the folder above
this parent drawing’s folder” (in other words, the folder of which the parent
drawing’s folder is a subfolder).

You can report on and change xref paths for a set of drawings with the AutoCAD
Reference Manager (not in AutoCAD LT). See Chapter 15 for more information.

If all these path options and periods have got you feeling punchy, you can
keep your life simple by always keeping parent and child drawings in the
same folder and using the No Path option when you attach xrefs.

Managing xrefs

The External References palette includes many more options for managing
xrefs after you attach them, many of which are hiding in shortcut menus.
Important options include:

v~ List of external references: You can change between a List and a Tree
view of your drawing’s external references just by clicking the appropri-
ate button at the top of the palette (see Figure 14-11). You also can resize
the columns by dragging the column dividers or re-sort the list by click-
ing the column header names, just as in other Windows dialog boxes.

v Detach: Right-click on an xref in the External References palette and
choose Detach to completely remove the selected reference to the exter-
nal file from your drawing.

v Reload: Right-click on an xref and choose Reload to force AutoCAD to
reread the selected xrefed DWG file from the disk and update your draw-
ing with its latest contents. This feature is handy when you share xrefs
on a network and someone has just made changes to a drawing that
you've xrefed.

v Unload: Right-click on an xref and choose Unload to make the selected
xref disappear from the on-screen display of your drawing and from any
plots you do of it, but retain the pointer and attachment information.
Right-click again and choose Reload to redisplay an unloaded xref.

+~ Bind: Right-click on an xref and choose Bind to bring the selected xref
into your drawing and make it a block. You might use this function, for
example, to roll up a complex set of xrefs into a single archive drawing.

In many offices, binding xrefs without an acceptable reason for doing so
is a crime as heinous as exploding blocks indiscriminately. In both cases,
you'’re eliminating an important data management link. Find out what
the policies are in your company. When in doubt, keep yourself out of a
bind. And even when you do have a good reason to bind, you generally
should do it on a copy of the parent drawing.
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v Open: Right-click on an xref and choose Open to open one or more
xref drawings in separate drawing windows. After you edit and save
an xref drawing, return to the parent drawing and use the Reload
option in the External References palette to show the changes.

None of these options (other than opening and editing the xref) affects the
xrefed drawing itself; it continues to exist as a separate DWG file. If you need to
delete or move the DWG file that the xref refers to, do it in Windows Explorer.

Q‘&N\BER The fact that the xrefed drawing is a separate file is a potential source of

> problems when you send your drawing to someone else; that someone else
needs all the files that your drawing depends on, or it will be useless to the
receiving party. Make sure to include xrefed files in the package with your
drawing. See Chapter 15 for a procedure.

AutoCAD (but not AutoCAD LT) includes an additional xref feature called xref
clipping. You can use the XCLIP command to clip an externally referenced file
so only part of it appears in the parent drawing. AutoCAD LT doesn’t include
the XCLIP command, but if you open a drawing containing an xref that was
clipped in AutoCAD, the clipped view will be preserved.

Blocks, Xrefs, and Drawing Organization

Blocks and xrefs are useful for organizing sets of drawings to use and update
repeated elements. It’s not always clear, though, when to use blocks and
when to use xrefs. Applications for xrefs include

v The parts of a title block that are the same on all sheets in a project.

1~ Reference elements that need to appear in multiple drawings (for exam-
ple, wall outlines, site topography, column grids).

1 Assemblies that are repeated in one or more drawings, especially if the
assemblies are likely to change together (for example, repeated framing
assemblies, bathroom layouts, modular furniture layouts).

v Pasting up several drawings (for example, details or a couple of plans)
onto one plot sheet.

v Temporarily attaching a background drawing for reference or tracing.

On the other hand, blocks remain useful in simpler circumstances. Situations
in which you might stick with a block are

v Components that aren’t likely to change.

»* Small components.
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v A simple assembly that’s used repeatedly but in only one drawing. (You
can easily update a block in one drawing with the REDEFIT command.)

v When you want to include attributes (variable text fields) that you can fill
in each time you insert a block. Blocks let you include attribute defini-
tions; xrefs don’t.

Everyone in a company or workgroup should aim for consistency as to when
and how they use blocks and xrefs. Check whether guidelines exist for using
blocks and xrefs in your office. If so, follow them; if not, it would be a good
idea to develop some guidelines.

Mastering the Raster

AutoCAD includes two more xref-like features: the ability to attach raster
images and DWF files to drawings. We look at the latter option in the next
section. The image feature is useful for adding a raster logo to a drawing
title block or placing a photographed map or scene behind a drawing. A
raster, or bitmapped, image is one that’s stored as a field of tiny points.

Most AutoCAD drawings are vector images. A vector image is an image defined
by storing geometrical definitions of a bunch of objects. Typical objects
include a line, defined by its two endpoints, and a circle, defined by its center
point and radius. Vector-based images are typically smaller (in terms of the
disk space they occupy) and more flexible than raster images but also are less
capable of displaying visually rich images such as photographs.

Raster images often come from digital cameras or from other programs, such
as Photoshop. Raster images also can come into the computer from some
kind of scanner that imports a blueline print, photograph, or other image.

Whether you're doing your scanning yourself or having a service bureau do
it for you, you need to know that AutoCAD — but not AutoCAD LT — handles
most of the popular image file formats including the Windows BMP format,
the popular Web graphics formats GIF and JPEG, the popular PCX and TIFF
formats, as well as DIB, FLC, FLI, GP4, MIL, PNG, RLE, RST, and TGA.

Here are three scenarios to incorporate raster images in your drawing:

v Small stuff: You can add logos, special symbols, and other small images
that you have in raster files.

+~ Photographs and maps: You can add photographs (such as a future
building site) and maps (for example, showing the project location).
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|
Figure 14-13:
The Select
Image File
dialog box.
|

v Vectorization: To convert a raster image into a vector drawing by tracing
lines in the raster image, you can attach the raster image in your drawing,
trace the needed lines by using AutoCAD commands, and then detach the
raster image. (This procedure is okay for a simple raster image; add-on
software is available, from Autodesk and others, to support automatic or
semiautomatic vectorization of more complex images.)

Using raster images is much like using external references. The raster image
isn’t stored with your drawing file; a reference to the raster image file is
established from within your drawing, like an xref. You can clip the image and
control its size, brightness, contrast, fade, and transparency. These controls
fine-tune the appearance of the raster image on-screen and on a plot.

When you attach raster images, you have to make sure that you send the
raster files along when you send your drawing to someone else.

AutoCAD LT can open, view, and plot drawings containing attached raster
images, but LT can’t do the attaching. Raster masters require full AutoCAD.

Attaching an image
Follow these steps to bring a raster image into AutoCAD:
1. If the External References palette is not already open, choose Tools™>
Palettes>External References to open it.

Use the drop-down list on the first toolbar button to attach a drawing, an
image, or a DWF file.

2. Click Attach Image and locate the image file you want to attach.

The Select Image File dialog box appears, as shown in Figure 14-13.

2Jed
L'.II.;| Hide preview

Select Image File

«| D F =

Look in: | (53 Drawings
) _Old Files O

LAme 3
[)DWG possibilities -'J\uaﬂ'n_og:u.t
[J5A-3.5

)55 foobar

255 Minnow

Q|'ev=

Fraview

File name: mylego bmp Open

Fles of type: | 4l image files | Cancel
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3. Browse to find the file you want to attach, select it, and then click
Open.

The Image dialog box appears.

Click the Details button in the Image dialog box to see more information
about the resolution and image size of the image you're attaching.

4. Specify the parameters for the attached image in the dialog box.

Parameters include the insertion point, scale factor, and rotation angle.
You can set these parameters in the dialog box or specify them on-
screen, similar to what you can do with blocks and external references,
as described earlier in this chapter. Use the quick dialog box help (click
the question mark in the dialog box’s title bar and then click the area in
the dialog box for which you want help) or click the dialog box’s Help
button to find out more about specific options.

The IMAGE (IM) command includes the same Full Path, Relative Path,
and No Path options as those for attaching xrefs. (See the “Forging an
xref path” section, earlier in this chapter.)

5. Click OK.
The image appears in your drawing.

6. If you need to ensure that the raster image floats behind other objects
in the drawing, select the raster image, right-click, choose Draw
Order, and then choose Send to Back.

The DRAWORDER (DR) command provides additional options for which
objects appear on top of which other objects. If you need this kind of
flexibility, look up “DRAWORDER command” in the AutoCAD online help
system.

Managing your image

You manage the images in your drawing with the External References palette.
You can view a list of image files that appear in the current drawing, detach
(remove) image references, and unload and reload images when needed. You
can’t bind an image to your drawing; it always remains an external file.

You can clip images so that only part of the image is displayed in your draw-
ing. Choose Modify=>Clip>Image and follow the prompts to clip the image.
You can have multiple overlapping or distinct pieces of any number of images
in your drawing, and only the parts you need are loaded into memory when
you have your drawing open.
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Raster image files often are larger than DWG files of corresponding complex-
ity; raster file size can affect performance within AutoCAD because the raster
file loads into memory when you are working on your drawing. Some
workarounds speed up operations:

v Attach raster images late in the production process.

1~ Create a lower-resolution version of the raster file, just large enough to
create the desired effect in your drawing.

v Right-click over an image in the External References palette and choose
Unload to temporarily disable an image without losing the attachment
information.

In addition, raster files can increase the time that AutoCAD takes to generate
plots (and the plot file sizes) dramatically. Before you settle on using large
raster files in your AutoCAD drawing, do some testing on zooming, editing,
and plotting.

A DWF s Just a DWF

N

DWEF stands for Design Web Format. You could think of a DWF as DWG-light
because it looks just like a drawing file and contains some of the actual draw-
ing file data. (Some people call DWF files dwiffs, but we’re going to hold off on
that one until we start hearing DWG files called dwiggs.)

You create DWFs from within AutoCAD in one of two ways. Choose either Plot
and select the DWF option in the Printer/Plotter name list, or Publish, and
select DWF in the Publish To area of the Publish dialog box. DWFs are com-
pact and secure: You can’t edit a DWF in AutoCAD. The DWF format is ideal
for two purposes: You can post DWFs on the Web, and you can send your
drawings to consultants and clients in a form that they can’t mess up.

AutoCAD 2007 introduces another benefit: You can attach DWFs to your draw-
ing files in pretty much the same way you now attach drawings as external ref-
erences. DWFs attached to drawing files are referred to as DWF underlays.

The previous sections show how to attach a DWG and a raster image. Follow
these steps to attach a DWF file as an underlay.

1. If the External References palette is not already open, choose Tools=>
Palettes=>External References to open it.

The toolbar at the top of the palette lets you attach a drawing as an xref,
a raster image file, or a DWF underlay. We cover attaching xrefs and
images earlier in this chapter.
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2. Click Attach DWF and locate the file you want to attach.
The Select DWF File dialog box appears.

3. Browse to find the file you want to attach, select it, and then click
Open.

The Attach DWF Underlay dialog box appears.
4. Specify the parameters for the DWF in the dialog box.

The layout may be different, but the content is mostly the same.
Parameters include specifying a sheet, the insertion point, scaling fac-
tors, rotation angle, and path type (see Figure 14-14). You can set these
parameters in the dialog box or specify them on-screen, just as you can
do when inserting a block, attaching an xref, or attaching as image, as
described earlier in this chapter.

4 Attach DWF Underlay B3]}
Name: | 1267 Map-Model i Browss..
Foundin: D:\Drawings'1257 Map-Model dwf

Savedpath:  D\Drawings' 1267 Map-Model dwf
Select a sheet from the DWF file:
Mode!

Fath Type Scale

Full path v Specify on-screen

Ful path |
||Relative path
No path

Rotation

[[] Speciy on-screen

ngle:

0K | [ Cancel | [ Hel

5. Click OK.

The externally referenced file appears in your drawing.
DWEF files are not as precise as DWGs — that’s why they’re a lot smaller.
When using object snap to locate points in DWFs, you may see the word

approximate on the object snap tooltip. If this is a problem, you can increase
the precision of your DWF file when you create it.
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Chapter 15
Drawing on the Internet

In This Chapter
Understanding AutoCAD Internet features
Exchanging drawing files via e-mail and FTP
Using the Reference Manager to view and fix file dependencies
Using the Design Web Format and ePlot
Making multiple Web and paper plots with PUBLISH

Protecting drawings with passwords and digital signatures

u nless you've been living under a rock for the past ten years, you know
that the Internet is causing major changes in the way that people work.
(And even if you have been living under a rock, someone probably is offering
broadband service to it by now!) Because of the Net, most of us communicate
differently, exchange files more rapidly, and fill out express delivery forms
less frequently.

AutoCAD users were among the online pioneers, well before the Internet burst
onto the public scene. Despite this early adoption, the CAD world has been
relatively slow to take the full-iimmersion Internet plunge. Exchanging draw-
ings via e-mail and using the World Wide Web for CAD software research and
support are pretty common nowadays. But it’s still uncommon to find draw-
ings incorporated into Web pages or Web-centric CAD applications. That’s
partly because CAD drafters have traditionally been somewhat insulated from
the general computing community — they spend most of their time cranking
out drawings and leave all that new-fangled Web design stuff to people who
don’t have real work to get done, thank you very much! Even the more forward-
thinking CAD users tend to display a healthy, and often reasonable, skepticism
about whether any particular innovation will help with the pressing job of get-
ting drawings finished on deadline.

Many of the features described in this chapter have undergone frequent tin-

kering, revision, and refocusing in recent AutoCAD versions. For example,
AutoCAD 2005 added ETRANSMIT and PUBLISH capabilities to keep up with
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AutoCAD 2005’s sheet sets feature. The Standard toolbar includes a Markup
Set Manager for those who receive drawing markups from users of Autodesk
DWF Composer. (DWF Composer is Autodesk’s newest effort to draw more
people into using the DWF format. The idea is that architects, engineers, and
others who don’t themselves use AutoCAD can mark up drawings by using
DWF Composer and then transmit those markups to an AutoCAD drafter, who
incorporates the changes into the DWG files.) Autodesk is aiming DWF
Composer squarely at Adobe’s Acrobat Professional and its familiar PDF file
format. We discuss PDF in Chapter 17.

DWFs are not just for the Web any more. In AutoCAD 2007, you can attach

a DWF as a reference “underlay” in the same way you attach regular DWGs
as external references. See the “Design Web Format — Not Just for the Web”
section later in this chapter for more information.

This chapter shows you how and when to use AutoCAD’s Internet features.
We also cover how the Internet features can connect with traditional CAD
tasks, such as plotting. The emphasis of this chapter is on useful, no-nonsense
ways of taking advantage of the Internet in your CAD work.

Your ticket to most of the features described in this chapter is an account
with an Internet service provider (ISP). You probably already have Internet
access through work or a private ISP account — or both; but if not, now is
the time to come out from under that rock and get connected. Other CAD
users will expect to be able to send drawings to you and receive them from
you via e-mail. Software companies, including Autodesk, expect you to have
Web access in order to download software updates and support information.
Dial-up modem access to the Internet is acceptable (barely), but if you're
doing much drawing exchange or want to be able to download software
updates without waiting all day, consider springing for broadband access,
such as DSL (Digital Subscriber Line) or cable modem.

The Internet and AutoCAD: An Overview

As with all things Internet-y, the Internet features in AutoCAD are a hodge-
podge of the genuinely useful, the interesting but still somewhat immature
or difficult to use, and the downright foolish. We steer you toward features
and techniques that are reliable and widely used today. We warn you about
“stupid pet trick” features that may impress a 12-year-old computer geek
but leave your project leader wondering what planet you come from. On
the other hand, a few of today’s questionable features are likely to become
the reliable, commonplace ones of tomorrow. We give you enough context
to see how everything works and where it may lead. Table 16-1 summarizes
AutoCAD’s Internet features and tells you where in this book to find more
information.
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Table 16-1 AutoCAD 2007 Internet Features
Feature Description Comments Where You Can
Find More Info
ETRANSMIT  Package DWG files for ~ Useful to most The “Send it with
command sending via e-mail or people eTransmit” section
FTP or posting on the in this chapter
Web
Reference Report on and modify ~ Useful for people “Help from the
Manager paths of referenced who send drawings Reference
files and use complex,  Manager” in this
multifolder xref chapter
schemes
File navigation Cansavetoand open  Potentially useful ~ Chapter2
dialog box from Web and FTP for people who
sites routinely work
with files on Web
or FTP sites
DWEF files A “lightweight” The recipient must  “Design Web
drawing file format have Autodesk DWF Format — Not Just
for posting drawings Viewer installed; for the Web” in this
on the Web or sharing  potentially useful for chapter
them with people who  sharing drawings
dont have AutoCAD with people who
don’t have AutoCAD
PUBLISH Create DWFfiles, plot ~ Can help automate  “Making DWFs
command (PLT) files, or paper the traditional (or plots) with

plots in batches

PUBLISH" in this
chapter

plotting procedure;

if DWF files ever
catch on, will stream-
line their creation

Publish to Web

A wizard that builds
and publishes a Web
page containing
drawings

Like most wizards, “PUBLISHTOWEB
fairly easytouse, command” in the
but limited; possibly AutoCAD online
useful as a quick-  help system
and-dirty Web

publishing approach

Insert
hyperlink

Add hyperlinks to
objects in drawings

Of questionable use, “Hand-y objects”
exceptin special-  inthis chapter
ized applications

(continued)
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Table 16-1 (continued)

Feature Description Comments Where You Can
Find More Info

Password Requires a password Useful for limiting ~ “The Drawing

protection in order to open access to sensitive Protection Racket”
a drawing DWG or DWFfiles  in this chapter

Digital Provide electronic con- Requires an account “The Drawing

signatures firmation that someone  with a digital Protection Racket”
has approved a certificate provider; in this chapter
particular version new technology, so

of a particular drawing  look before you
leap — and talk to
your attorney first

Sending Strategies

E-mail and FTP (File Transfer Protocol) have largely replaced blueline prints,
overnight delivery, floppies, and higher-capacity disks as the standard means
of exchanging drawings. Some companies even use specially designed Web-
based services, such as Autodesk’s Buzzsaw, as a repository for project draw-
ings from all the companies working on a particular project. Whether you're
exchanging drawings in order to reuse CAD objects or simply to make hard-
copy plots of someone else’s drawings, you need to be comfortable sending
and receiving drawings electronically.

Sending and receiving DWG files do not differ much from sending and receiv-
ing other kinds of files, except for the following:

v DWG files tend to be bigger than word processing documents and
spreadsheets. Consequently, you may need to invest in a faster Internet
connection. For instance, if you have dial-up modem access to the
Internet, you may want to consider upgrading to broadband access,
such as DSL or cable.

+ You can easily forget to include all the dependent files. We tell you
in the next section how to make sure that you send all the necessary
files — and how to pester the people who don’t send you all their
necessary files.
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v It’s often not completely obvious how to plot what you receive. Read
Chapter 13 and the “Bad reception?” section later in this chapter to
solve plotting puzzles.

Whenever you send DWG files together, follow the Golden Exchange Rule:
“Send files unto others as you would have them sent unto you.” That means
sending all the dependent files along with the main DWG files, sending plot-
ting support files (CTB or STB files — see Chapter 13), and including a
description of what you're sending. And ask the recipient to try opening the
drawings you sent right away, so you both have more time to respond if
there’s any problem.

\\J

Send it with ETRANSMIT

Many people naively assume that an AutoCAD drawing is always contained in
a single DWG file, but that’s often not the case. Each drawing file created in
AutoCAD can contain references to other kinds of files, the most important of
which are described in Table 16-2. Thus, before you start exchanging draw-
ings via e-mail or FTP, you need a procedure for assembling the drawings
with all their dependent files.

Table 16-2 Other Kinds of Files that DWG
Files Commonly Reference
Description File Types Consequences Where the Use of
if Missing These File Types
Is Explained
Custom font files SHX, TTF AutoCAD substitutes Chapter 10
another font
Other drawings DWG, DWF Stuff in the main Chapter 14
(xrefs) drawing disappears
Raster graphics JPG, PCX, TIF,  Stuff in the drawing Chapter 14
files and so on disappears
Plot style tables CTB, STB Lineweights and other ~ Chapter 13
plotted effects won't
look right

As you can see from the table, the consequences of not including a custom
font aren’t that dire: The recipient still will see your text, but the font will be
different. Of course, the new font may look odd or cause text spacing prob-
lems within the drawing. If, on the other hand, you forget to send xrefs or
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Figure 15-1:
Rapid
eTransmit.

raster graphics that are attached to your main drawing, the objects con-
tained on those attached files simply will be gone when the recipient opens
your drawing. Not good!

Table 16-2 doesn’t exhaust the types of files that your DWG files might refer
to. Custom plotter settings (such as custom paper sizes) may reside in PC3 or
PMP files. If you use sheet sets (see Chapter 13), a DST file contains informa-
tion about the sheet structure. An FMP file controls some aspects of font
mapping. (Like so much else in AutoCAD, the tools and rules for mapping
missing fonts are flexible but somewhat complicated. Look up the “FONTALT”
and “FONTMAP” system variables in the AutoCAD online help system for
detailed information.)

Rapid eTransmit

Fortunately, the AutoCAD ETRANSMIT command pulls together all the files
that your main DWG file depends on. Follow these steps to assemble a draw-
ing with all its dependent files with ETRANSMIT.

1. Open the drawing that you want to run ETRANSMIT on.

If the drawing is already open, save it. ETRANSMIT requires that any
changes to the drawing be saved before you proceed.

2. Choose File~>eTransmit.

The Create Transmittal dialog box appears, as shown in Figure 15-1.

Y Create Tr ittal B
'é Cument Drawingls): & Curent user: Dave
Fles Tree | Fies Table Select a fransmittal setup
=-F8 Cument Drawing Standard

=+ /B [ Throop Ste Plan dwg
S AutoCAD Fort Map
W acad fmp

=4 Bimap mage

a_"] ¥ Hsiteplan dwg
™ ¥ ¥-Thlock.dwg

chuded 5fiels). 146KE [Add File.. || | Trnsmitisl Setupa..
Entter notes to include with this transmittal package:
[ vewRepr | [__ok |

Help
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3. On the Files Tree or Files Table tab, remove the check mark next to
any file that you want ETRANMSIT not to copy with the main drawing.

a\\J

Unless you have assigned custom font mapping, you can omit the
Acad. fmp file.

4. Select a transmittal setup from the list.

Transmittal setups contain settings that control how ETRANSMIT
processes the drawings and creates the transmittal package. Click the
Transmittal Setups button to create new or modify existing setups. The
default Standard transmittal setup works fine for many purposes, except
that you probably want to turn on the Include Fonts setting, as described
in the next paragraph. In any case, you should view the settings (click
the Modify button) just to see what options you can change if you need

to later.
Vg‘\\\NG! If you want AutoCAD to include SHX and TTF font files, including any
S custom fonts that you're using, you must turn on the Include Fonts set-

ting in the transmittal setup. (Click Transmittal Setups, click Modify, and
check the Include Fonts check box.) Note, however, that many SHX and
TTF files are custom fonts, which work like licensed software. Sending
them to others is just like sharing your AutoCAD program CD with
others. No, we don’t mean that it’s easy and fun; we mean that it’s illegal
and unethical. Before you send a custom font file to someone else, find
out what the licensing restrictions are on the font and be prepared to
work within them.

5. Click the View Report button.

You see a report listing the files that ETRANSMIT will copy, along with
warnings about any files that it can’t locate.

6. Review the report and make sure that ETRANSMIT was able to find all
the files.

7. Click OK.

ETRANMSIT displays a file dialog box so that you can specify the name
and location of the transmittal package.

8. Click Save.

ETRANSMIT creates the transmittal package (which is a ZIP file by
default).

P Although recent versions of AutoCAD automatically compressed DWG files,
AutoCAD 2007 started packing some weight back on. Zipping AutoCAD 2007
files manages to compress them by up to 50 percent, in our experience. More
importantly, zipping creates a single, tidy package of all your DWG, raster
image, plot style table, and font files. No one likes to receive an e-mail mes-
sage carrying an endless cargo of attached files. Do everyone a favor: Be hip
and zip.
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Figure 15-2:
eTransmit
faster with
sheet sets.

The only downside to zipping is that creating a zipped file and extracting files
from it require a separate zip/unzip program. Several good shareware utilities
are available, including WinZip (www.winzip.com).

Transmitting multiple drawings

In many cases, you’ll want to send more than one drawing to a recipient. In
this situation, you can open each drawing and run ETRANSMIT on each in
turn. (In the transmittal setup, set Transmittal Package Type to Folder (set
of files), specify the Transmittal File Folder to copy the files to, and use
Transmittal Options to control whether the files are copied to one or more
than one folder.) When you've processed all the drawings, use a program like
WinZip to package the files into a single zipped file before sending it.

AutoCAD provides a slicker way of transmitting multiple drawings, as long as
you're using the sheet sets feature. In the Sheet Set Manager palette, just right-
click the sheet set name and choose eTransmit. The Create Transmittal dialog
box then will include an additional Sheets tab, as shown in Figure 15-2. This
tab lists all drawings in the sheet set and includes them in the transmittal by
default. Sheet sets are a specialized output process and are beyond the scope
of this book. For more information, check out the online help’s User’s Guide,
Choose a Work Process before You Begin, Work with Sheets in a Sheet Set.

! Create Tr ittal B[]

ey
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=HE) Notes
Kl W 5101 General Notes
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Help

FTP for you and me

FTP, or File Transfer Protocol, is a simple but robust protocol for copying files
over the Internet. A computer that’s connected to the Internet can act as
an FTP server, which means that part of its hard disk is accessible over the
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Internet. The person who configures the FTP server can place restrictions so
that only people who enter a particular logon name and password can see
and download files. FTP overcomes the file size limitations that often occur
with e-mail.

Because of all these FTP benefits, it’s increasingly common for people at
larger companies to place drawing files on their company’s FTP site and tell
you to go get them. This approach relieves them of having to e-mail you the
files, and relieves you of waiting for that 10MB e-mail download when you
least expected it.

In most cases, the person making the files available to you via FTP will send
you a Uniform Resource Locator (URL) that looks like a Web page address,
except that it starts with ftp:// instead of http://. If you open your Web
browser and enter the FTP URL into the address field, the browser should
connect to the FTP site, ask you for a location and name to use for the file
when it gets copied to your system, and begin downloading the file. If the FTP
site uses password protection, you’ll have to enter a logon name and pass-
word first.

If you want fancier FTP download options, you can use an FTP utility program
such as WS_FTP (www. ipswitch.com).

Even if you work for a small company, you may be able to post files on your
ISP’s FTP server in order to make them available to others. Check with your
ISP to find out whether you can do it and, if so, what the procedures are.

FTP transfers are more prone to user confusion problems than are e-mail file
attachments, especially if the recipient hasn’t used FTP before. For example,
it’s common for the person posting the files to forget to tell the recipient the
logon name and password, or for the recipient not to have an FTP program —
or to not know how to use it. Check with your recipient the first couple of
times you use FTP to transfer files to make sure he or she got the files suc-
cessfully — and don’t be surprised if the recipient asks you to use e-mail or
overnight delivery instead.

Bad reception?

Other sections in this chapter focus on sending files to others. What happens
when you’re on the receiving end? Not everyone will be as conscientious as
you are about following the Golden Exchange Rule. You'll receive drawings
with missing dependent files and no information or support files for plotting.

When you receive an e-mail message or FTP download containing drawings

(zipped, we hope!), copy the file to a new folder on your hard disk or a net-
work disk and unzip the files.
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Check at least a few of the drawings in the package to make sure that all the
xrefs, fonts, and raster image files were included. You can perform this check
by opening each main drawing in that folder. After you open each file, press
the F2 key to view the command line window and look for missing font and
xref error messages of the following sort:

Substituting [simplex.shx] for [helv.shx].
Resolve Xref "GRID": C:\Here\There\Nowhere\grid.dwg
Can't find C:\Here\There\Nowhere\grid.dwg

A Substituting . . . message indicates AutoCAD couldn’t find a font
and is substituting a different font for it. ACan't find . . . message indi-
cates that AutoCAD couldn’t locate an xref. Any missing raster files appear

as rectangular boxes with the names of the image files inside the rectangles.
Alternatively, you can open the External References palette, which reveals
any missing xref or raster image files. (See Chapter 14 for details.)

Write down each missing file and then tell the sender to get on the ball and
send you the missing pieces. While you’re at it, tell that person to buy this
book and read this chapter!

Press the F2 key after opening any drawing that you didn’t create so that you
know right away if any fonts and xrefs are missing.

If you receive drawings with custom TrueType font files (files whose exten-
sions are TTF), you must install those files before Windows and AutoCAD will
recognize them. In Windows XP, choose Startc>Control Panel, and then click
the Switch To Classic View link in order to see the Fonts applet. (In Windows
2000, choose Starte>Settingse>Control Panel.) Double-click the Fonts icon to
open the Fonts window and then choose Filew>Install New Font.

Help from the Reference Manager

In Chapter 14, we warn you about the complications of xref paths and the
potential perils of AutoCAD not being able to locate xrefs if you move project
folders around or transfer drawings to or from someone else. A similar danger
exists for raster image files (Chapter 14) and font files (Chapter 10). The
ETRANSMIT command, described earlier in this chapter, does a good job of
gathering together dependent xrefs, raster files, and font files, but it can’t
gather what AutoCAD can’t locate.

AutoCAD’s Reference Manager (not available to LT users) utility is a real
lifesaver if you find yourself suffering from xref, raster image, or font path
perils — whether they occur in your own company or when sending files
to or receiving them from others.
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Reference Manager is a separate utility program, not a command inside
AutoCAD. Follow these steps to launch the utility:

1. Choose Start=>All Programs=>Autodesk=>AutoCAD 2007->Reference
Manager.
The Reference Manager program opens, as shown in Figure 15-3.

2. Click the Add Drawings button to add one or more DWG files to the
drawings pane on the left.

3. Click the Export Report button to create a text report listing all the
dependent files and their paths, or click the Edit Selected Paths
button to modify paths.

Click the Help button in Reference Manager to find out more about the
utility’s capabilities.

\J . o .

) If you always keep parent and child DWG files in the same folder — the sim-
plest approach to dealing with xref paths — then you probably won’t need to
use the Reference Manager.
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Design Web Format —
Not Just for the Web

Earlier in this chapter, we explain how you can exchange drawings via e-mail
and FTP. That’s all the Internet connectivity that many AutoCAD users need,
but if you're curious about connecting drawings to the Web or sharing draw-
ings with people who don’t have AutoCAD, this section is for you.

The AutoCAD Web features are built on three pieces of technology:

v A special “lightweight” drawing format called DWF that Autodesk origi-
nally developed especially for putting drawings on the Web.

www.it-ebooks.info


http://www.it-ebooks.info/

366 Part IV: Share and Share Alike

v A free program from Autodesk called Autodesk DWF Viewer that enables
anyone to view and print DWF files without having AutoCAD.

v A not-free program from Autodesk called Autodesk DWF Composer, for
marking up and reviewing DWF and DWG files.

All about DWF

The AutoCAD DWG format works well for storing drawing information on
local and network disks, but the high precision and large number of object
properties that AutoCAD uses make for comparatively large files.

To overcome this size problem and encourage people to publish drawings

on the Web, Autodesk developed an alternative lightweight vector format for
representing AutoCAD drawings: DWF (Design Web Format). A DWF file is a
more compact representation of a DWG file. DWF uses less space — and less
transfer time over the Web and e-mail — because it’s less precise and doesn’t
have all the information that’s in the DWG file.

You can create DWF files from your drawings and send the DWFs to people
who don’t have AutoCAD. Your recipients can view and plot the DWF files
after they download the free Autodesk DWF Viewer program, which is avail-
able on Autodesk’s Web site, www.autodesk. com.

In AutoCAD 2007, DWFs can be used just like external references. Here’s
one more file type — and one more reason — to use Reference Manager or
ETRANSMIT to package up your drawings before you send them out. For
more on DWF underlays, see Chapter 14.

ePlot, not replot

A DWF file captures a single, plotted view of your drawing, so, unlike a DWG
file, it can provide a relatively unambiguous snapshot of what you want to
see on paper. With a DWG file, on the other hand, you have to provide lots of
information to other people — drawing view, scale, plot style settings, and so
on — in order for them to get the same plotting results that you did.

Potential ePlotting scenarios include

v Architects and other consultants on a building project periodically
upload DWF files to the project Web site. Architects and engineers with
some minimal CAD knowledge can review the drawings on-screen and
create their own hard-copy plots, if necessary. Principals and clients
who don’t want anything to do with CAD, or even with computers, can
have their employees create hard-copy plots for them to examine.
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v When Internet-savvy people need hard-copy prints of your drawings,
you e-mail a zipped file containing DWF files, along with the URL for
Autodesk DWF Viewer and simple instructions for creating plots from
the DWF files. (Be ready to walk them through the process by phone
the first time or two to reduce anxiety on everyone’s part.)

v A CAD plotting service bureau encourages its customers to send DWF
files instead of DWG files for plotting. The DWF files are much smaller
and require less intervention on the part of the service bureau’s
employees.

The ePlot concept debuted way back in AutoCAD 2000 and hasn’t yet caught
on in a big way. Autodesk hopes to establish ePlot and the DWF format as a
standard for CAD documents similar to what Adobe’s PDF has become for
word processing documents. It remains to be seen whether ePlotting will
become a popular way to generate hard-copy output. In particular, many
people outside of CAD-using companies don’t have access to large-format
plotters. They're limited to 8/4-x-11-inch — or, at best, 11-x-17-inch —
reduced-size check plots. Consequently, many people won’t be able to plot
your DWF files to scale and may not even be able to plot them large enough
to read everything.

Don’t be afraid to try ePlotting with colleagues inside or outside your com-
pany, but don’t become too dependent on it until you see whether the rest
of the CAD world shares your enthusiasm. Otherwise, you risk becoming
the only one who’s willing to use your DWF files for plotting — in which
case the next version of the feature will be called mePlot.

AutoCAD 2007 uses version 6 of the DWF format, which Autodesk introduced
with AutoCAD 2004. (The DWF format changes at least as often as the DWG
format because Autodesk adds new features to AutoCAD and new Design Web
Format capabilities.) The most important new feature in DWF 6 is multiple
sheets in a single DWF file, as shown in Figure 15-4. It’s like stapling together
a set of drawings, except that you never have to worry about your stapler
being empty.

Making DWFs with ePlot

As we describe in the previous section, AutoCAD treats DWF files like elec-
tronic plots, or ePlots. You create a DWF file from the current drawing just

as if you were plotting it to a piece of paper, as we describe in Chapter 13.
The only difference is that, in the Plot dialog box’s Printer/Plotter area, you
choose the plotter configuration named DWF6 ePlot.pc3, as shown in
Figure 15-5. When you do so, AutoCAD automatically turns on the Plot To File
setting. Then when you click OK to generate the ePlot, AutoCAD displays a
file dialog box in which you specify a filename and location for the DWF file
that gets created. The location can be a folder on a hard disk or a Web server.
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Figure 15-4:
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Figure 15-5:
“Look ma,
no paper!”
Plotting to a
DWEF file.
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When you make DWFs with ePlot, pay particular attention to the Scale

setting in the Plot Scale area. If you're creating a DWF simply for viewing in a
browser, you can turn on the Fit To Paper setting rather than worry about a
specific plot scale. If you want to enable others to plot your DWF file to scale,
as described earlier in this chapter, you need to choose the desired plot scale
factor. Chapter 13 describes how to choose an appropriate plot scale factor.
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Figure 15-6:
Hot off the
presses:
AutoCAD
Publish
dialog box.

Making DWFs (or plots) with PUBLISH

The ePlot method of creating DWF files described in the previous section
works fine for single drawings. But if you want to create DWF files for a lot of
drawings or plot a bunch of drawings the good ol’ fashioned way (on paper,
that is), you can use the Publish dialog box, shown in Figure 15-6, to speed
the process.
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Although the Publish dialog box is wired to support DWF as well as regular
(paper) plotting, for now, more people are likely to use it for paper plotting.
(An alternative use is creating plot files to send to a plotting service bureau.)
But if you do decide to go into large-scale DWF publishing, including multi-
sheet DWF files, use the Publish Drawing Sheets dialog box, as in the
following steps:

1. Choose Filec>Publish.

The Publish dialog box appears (refer to Figure 15-6). The dialog box
lists all tabs (model and paper space layouts) of the current drawing for
plotting. The Publish dialog box refers to each tab as a sheet.

2. Click the buttons below the sheet list to preview any sheet, add sheets
from other drawings, remove sheets from the to-be-plotted list, or
rearrange the plotting order.

With the additional buttons, you can save and recall lists of sheets. See
Step 4 for more information.

3. After you specify the sheets that you want to plot, specify whether you
want to plot them to an actual plotter or plot (PLY) file or to a DWF
file.

You can select a specific plotter configuration for each sheet by choos-
ing a Page Setup in the sheet list. See Chapter 13 for more information
about page setups.
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4. Click the Publish Options button to display a dialog box containing
additional settings.

Most of these options are of concern only if you're creating DWF files.
The one exception is Default Output Directory, which also applies to cre-
ating plot (PLT) files.

5. Click the Save Sheet List button to save the current drawings and set-
tings list, if you anticipate having to publish the same group of draw-
ings again.

6. Click the Publish button to start the process.

Don’t confuse the PUBLISH command (File>Publish) with the PUBLISH-
TOWEB command (File=>Publish to Web). The PUBLISH command creates
sets of DWF files, plot files, or actual plots. The PUBLISHTOWEB Wizard cre-
ates a Web page containing images of your drawings. The results of this
wizard won'’t put any Web designers or programmers out of work, but you
can use it to create primitive Web page paste-ups of your drawings. See
“PUBLISHTOWEB command” in the AutoCAD online help system if you’d
like to give it a whirl.

Hand-y objects

No Web file format would be complete without hyperlinks, and DWF has those,
too. You can attach a hyperlink to any drawing object in AutoCAD, not just

to a text string. As you pass the cursor over an object with a hyperlink, the
cursor changes from the ordinary pointer to a globe and two links of a chain
(as in “World Wide Web” and “link,” not “world-wide chain gang”). Right-click
the object and select the Hyperlink option from the menu, which opens your
browser and navigates to the URL that’s attached to the object. If you create a
DWEF file that includes objects with hyperlinks, Autodesk DWF Viewer embeds
the links in the DWF file so that you can click to navigate to them.

Hyperlinks on objects are a clever trick, but they’re of limited practical value
in most DWG and DWF files:

v The drawing images are so small that it’s difficult to distinguish the
hyperlink on one object from the hyperlink on another object.

v Most people aren’t used to associating hyperlinks with individual lines
and other objects. The interface is likely to leave them perplexed.

If you'd like to experiment with hyperlinks in objects, look up “HYPERLINK
command, about” in the online help system.
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Autodesk DWF Viewer

After you create DWF files, whether with ePlot or PUBLISH, you or the recipi-
ent of your DWF files can use Autodesk DWF Viewer to view and print them.
Autodesk DWF Viewer, shown in Figure 154 earlier in this chapter, is a free
viewer from Autodesk. You can download the current version from Autodesk’s
Web page, www.autodesk.com.

When you install AutoCAD 2007, the setup program, by default, installs
Autodesk DWF Viewer as well. Choose Start=>All Programs=>Autodesk=>
Autodesk DWF Viewer or simply double-click on a DWF file in Windows
Explorer to launch it.

The Drawing Protection Racket

Whether you're sending DWG or DWF files, you may be concerned about
their misuse (that is, by the wrong people or for the wrong purposes),
abuse (for example, modification without your consent), or reuse (on
other projects or by other people without due compensation to you).

AutoCAD has two features for securing your drawings when you send them to
others:

v~ Password protection enables you to lock a DWG or DWF file so that only
those who type the password that you've specified can open, insert, or
xref it.

Add password protection to drawings only when you really need it:

e If you forget the password, then you no longer will be able to open
the drawing. Neither AutoCAD nor Autodesk has any magical way
to extract the password or unlock the drawing.

¢ After you password-protect a drawing, others can’t insert the
drawing as a block or attach it as an xref.

If you're using a password, you probably should do it on a copy of the
drawing that you send, and keep an unprotected version for yourself.

v~ Digital signature is a high-tech way to add an electronic marker to a
DWG file that verifies that someone approved the drawing. You must
first get an account with a digital certificate provider, who serves to
authenticate you and your computer. Of course, for this feature to be
useful, you need to send drawings to someone who wants to receive dig-
itally authenticated drawings from you (or vice versa) and who has the
technological savvy to deal with digital certificates. For more informa-
tion, see “digital signatures, learning more about” in the AutoCAD online
help system.
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Figure 15-7:
Password,
please.
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To activate either of these options for the current drawing, choose Filew>
Save As to display the Save Drawing As dialog box and then choose Toolsw>
Security Options to display the Security Options dialog box before you save
the file. If you want to add a digital signature and you have a digital ID from
a certificate provider, enter your information on the Digital Signature tab

of the Security Options dialog box. If you want to add a password to the cur-
rent drawing, just type it in the text field on the Password tab of the Security
Options dialog box.

After you password-protect and save a DWG file, anyone who tries to open,
insert, or xref it will see a dialog box similar to the one shown in Figure 15-7.

Password %]

Enter password to open drawing:
G M\Drawings*.Top secret baby.dwg

To password-protect a DWF file, use the PUBLISH command and click the
Publish Options button in the Publish dialog box.

Although electronic security features such as the ones described in this sec-
tion can be useful as part of a strategy to protect your work from misuse,
they’re not a substitute for communicating clearly, preferably in the form of
written contracts, what constitutes appropriate use of drawings that you
send to or receive from others.
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The Part of Tens

The 5th Wave By Rich Tennant
CRAATENNANT—

Tt started out as a
wrap-around porch,
and then Stuart
started learning
AutoCad.
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In this part . . .

Tens sounds a lot like tense, and tense is how AutoCAD
may make you feel sometimes. It also may remind
you of the metric system, and that may also make you
feel tense. But never fear — help is on the way! Checklists
are always a big help in getting things right and fixing
things that are wrong. And a Top Ten list is a good way

to quickly spot the best — or the worst — of almost
anything, AutoCAD included. This Part of Tens features
lists that help you keep your drawings healthy and trade
drawings with other people and programs.
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Chapter 16
Ten Ways to Do No Harm

procrates of Greece is famous for many things, not least of which is
the Hippocratic oath sworn by doctors. It begins, “First, do no harm.”
This is not a bad approach to take when editing existing drawings with
AutoCAD, whether you or someone else originally created the drawings. You
can accidentally undo, in minutes, days or weeks of work done by yourself
and others. (Of course, you also can purposefully undo, in minutes, days or
weeks of work done by yourself and others, but we can’t give much advice to
stop you if you want to do that!)

Follow these guidelines to avoid doing harm to the hard work of others and
to your own productive potential.

Be Precise

Throughout this book, we remind you that using precision techniques such
as snap, object snaps, and typed coordinates is a fundamental part of good
CAD practice. Don’t try to use AutoCAD like an illustration program, in which
you eyeball locations and distances. Use one of the many AutoCAD precision
techniques every time you specify a point or distance.

Control Properties by Layer

As we describe in Chapter 5, AutoCAD gives you two different ways of con-
trolling object properties such as color, linetype, and lineweight: by layer
and by object. Unless you have a really good reason to assign properties by
object — such as instructions from your company’s CAD manager or the
client for whom you're creating the drawing — use the by-layer method:
Assign colors, linetypes, and lineweights to layers, and let objects inherit
their properties from the layer on which they reside. Don’t assign explicit
color, linetype, or lineweight to objects.
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Know Vour Drawing Scale Factor

Chapter 4 describes the importance of choosing an appropriate drawing
scale factor when you set up a drawing. Knowing the drawing scale factor
of any drawing you're working on is equally important whether you set it up
or not. You need this number in order to calculate lots of scale-dependent
objects, such as text, dimensions, and hatching. Chapter 10 includes tips
for figuring out the drawing scale factor of an existing drawing.

Know Your Space

Understand the difference between model space and paper space (described
in Chapter 2), and know which space the different parts of the drawing you're
looking at on-screen reside in. Above all, make sure that you draw objects in
the appropriate space. When you're viewing a paper space layout, keep an
eye on the status bar’s MODEL/PAPER button so that you know which space
the crosshairs are currently in. (Chapter 4 describes how to keep your model
and paper space bearings.) When you plot, ensure that you've selected the
right tab — either the Model tab or one of the paper space layout tabs.

Explode with Care

The EXPLODE (X) command makes it easy to explode polylines (Chapter 6),
dimensions (Chapter 11), hatches (Chapter 12), and block inserts (Chapter
14) into their constituent objects. The only problem is that someone proba-
bly grouped those objects together for a reason. So until you understand
that reason and know why it no longer applies, leave the dynamite alone.

Don’t Cram Vour Geometry

It’s okay to cram for a geometry test, but don’t cram geometry, dimensions,
text, or anything (and everything) else into your drawings. You might be
tempted to put a lot of stuff into every square inch of your drawing, using
AutoCAD’s flexible panning and zooming capabilities to really work over all
the available space. If you succumb to this temptation, however, you’ll dis-
cover that editing is more difficult and adding more information may be
impossible! In addition, the result probably will be harder to read. Instead of
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cramming stuff onto the sheet, use white (empty) space to surround areas
of dense geometry. Put details on separate sheets. Attach a page of notes
instead of putting a ton of text onto your drawing. Managing a reasonable
number of drawings with less on each one is easier than having two or three
densely packed sheets crammed with every bit of geometry and annotation
needed for the project.

Freeze Instead of Erase

It’'s common to start with an existing drawing from another discipline when
you want to add, say, an electrical system to a floor plan. But if you remove
the landscaping around a building because you don’t need it for the wiring,
you may cause a great deal of rework when the landscaping information is
needed again. And what if the person who did the landscaping work has, in
the meantime, decided to leaf? (Sorry . .. .) Unless you know that objects
are no longer needed, use the AutoCAD Freeze or Off layer setting to make
objects on those layers invisible without obliterating them. These settings
are in the Layer Properties Manager dialog box, as described in Chapter 5.

Use CAD Standards

Become knowledgeable about CAD standards in your industry and company,
and take advantage of any standardized resources and approaches that are
available to you. By following standards consistently, you can apply your cre-
ativity, expertise, and energy to the interesting parts of the job at hand, not to
arguing about which hatching patterns to use. And if you find that things are
a mess in your company because no one else pays much attention to indus-
try standards, well, knowing those standards makes you very employable as
well.

Save Drawings Frequently

As with all computer documents that you work on, get in the habit of saving
your current AutoCAD drawing frequently. Instead of figuring out an appropri-
ate time interval (“Does saving every 20 minutes include my coffee break?”),
ask yourself the simple question: “How much work am I prepared to lose?”
Hitting the Save button at the end of every significant procedure makes much
more sense to us than waiting for the clock to tell you when to save.
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Each time you save, AutoCAD writes the current state of the drawing to

the drawingname.DWG file, after renaming the previously saved version
drawingname.BAK. Thus, you can always recover the next-to-last saved ver-
sion of your drawing by renaming drawingname.BAK to somethingelse.DWG
and opening it in AutoCAD.

AutoCAD also includes an automatic drawing save feature. It’s useful as a sec-
ondary backup save, but you shouldn’t rely on it exclusively. AutoCAD creates
automatic save files with inscrutable names like Drawingl_1_1_1478.SV$
and puts them in the folder specified by the Automatic Save File Location set-
ting on the File tab of the Options dialog box. Save your drawing and save
yourself the pain of lost work and the hassle of trying to locate the right auto-
matic save file. If you find yourself in the unfortunate position of needing an
automatic save file, move the SV$ files from the automatic save folder to
another folder. Rename the files from SV$ to DWG, open them in AutoCAD, and
look for the one that corresponds to the drawing you're trying to recover.
Note that AutoCAD deletes the SV$ file after you close the drawing, so it’s usu-
ally useful only after a software or computer crash.

Back Up Drawings Regularly

\NG/
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Backing up your data is prudent advice for any important work that you

do on a computer, but it’s doubly prudent for CAD drawings. A set of CAD
drawings is a lot harder and more time consuming to re-create than most
other computer documents (unless you’ve just written the sequel to War
and Peace, that is). Unless you’re willing to lose more than a day’s worth of
work, develop a plan of daily backups onto DVD, CD, an external hard drive,
or another high-capacity medium.

Don’t be lulled into complacency by the increasing reliability of hard disks.
Although hard disk failure is increasingly rare, it still happens, and if it hap-
pens to you sans backup, you’ll quickly understand the full force of the
phrase catastrophic failure. Also, backups aren’t just protection against disk
failure. Most of the time, backups help you recover from pilot error — acci-
dentally erasing a file, messing up a drawing with ill-advised editing, and so
on. Even if you're conscientious and never make mistakes, there’s a good
chance that someone else in your office who has access to your DWG files
hasn’t quite achieved your exalted level of perfection. Protect your work and
minimize recriminations with regular backups.
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Chapter 17

Ten Ways to Swap Drawing Data
with Other People and Programs

A t various times, you probably need to transfer information from one
kind of document to another. You may even have taken the CAD plunge
because you want to import AutoCAD drawing data into your word process-
ing or other documents. If so, this chapter is for you. It covers exchanging
AutoCAD drawing data with other programs — what works, what doesn’t,
and how to do it. We also tell you when to give up and reach for the scissors
\‘&N\BEI} and glue.
&

This chapter frequently mentions vector and raster graphics file formats:

v A vector format stores graphics as collections of geometrical objects
(such as lines, polygons, and text). Vector graphics are good for high
geometrical precision and for stretching or squeezing images to different
sizes. These two characteristics make vector formats good for CAD.

v A raster format stores graphics as a series of dots, or pixels. Raster
graphics are good for depicting photographic detail and lots of colors.
However, you can’t squeeze or stretch raster images like you can vector
images — if you shrink them too much, you lose pixels, and if you
expand them too much, you stop seeing objects and start seeing gigan-
tic pixels — even if you're not pixellated.

v?‘“\NG! Exchanging AutoCAD drawing data with other programs sometimes works
great the first time you try it. Sometimes, you have to try a bunch of tech-
niques or exchange formats to get all the data to transfer in an acceptable
way. Occasionally, no practical exchange method exists for preserving for-
matting or other properties that are important to you. Where your exchange
efforts fall in this range of possibilities depends on the kind of drawings you
make, the other programs you work with, and the output devices or formats
that you use. We provide recommendations in this chapter but be prepared
to experiment.

Table 18-1 lists exchange formats between common programs and AutoCAD.
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Table 18-1 Swapping between AutoCAD and Other Programs

Swap Recommended Formats
AutoCAD to AutoCAD LT DWG

AutoCAD 2007 to AutoCAD R14 DWG

AutoCAD 2007 to AutoCAD R12 R12/LT2 DXF

AutoCAD to another CAD program  DXF or DWG

AutoCAD to humans who PDF or DWF

don't have AutoCAD

AutoCAD to Word WMF

Word to AutoCAD RTF or TXT

AutoCAD to paint program BMP

Paint program to AutoCAD

BMP or other raster format (use the AutoCAD
IMAGE command; in AutoCAD LT use
Windows Clipbhoard)

AutoCAD to draw program DXF or DWG or WMF
Draw program to AutoCAD DXF or DWG or WMF
AutoCAD to the Web DWF

Excel to AutoCAD

Windows clipboard, using Paste Special (see
Chapter 10)

AutoCAD to Excel

CSV, using AutoCAD TABLEEXPORT com-
mand (see Chapter 10)

The remainder of this chapter gives you specific procedures for making most
of the exchanges recommended in this table, as well as others.

DWG

DWG, AutoCAD'’s native file format, is the best format for exchanging draw-
ings with other AutoCAD or AutoCAD LT users. Use the SAVE and SAVEAS
commands to create DWG files and the OPEN command to open them.

AutoCAD LT can’t create every kind of object that AutoCAD can — raster
attachments and most 3D objects, for example — but it can successfully read
and save DWG files that contain these objects.
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Round-trip DWG fare

The most demanding — and elusive — kind of
data exchange is called round-trip transfer.
Round-trip means that you create and save a
file in one program, edit and save it in another
program, and then edit and save it in the first
program again. A perfect round trip is one in
which all the data survives and the users of both
programs can happily edit whatever they want
to. Unfortunately, the perfect round trip, like the
perfect visit to your in-laws, rarely happens.

In CAD, round-trip transfer becomes an issue
when two people want to work on the same
drawings with different CAD programs. AutoCAD
and AutoCAD LT have excellent round-trip com-
patibility, as we explain in Chapter 1. Expect a
bumpier road if you're exchanging drawings with
users of other CAD programs. Perform some test
transfers before you assume that your drawings
can get from here to there and back again
unscathed.

AutoCAD 2007 can save DWG files that can be opened in versions all the way
back to Release 14 — that’s a version that was released way back in 1997. If
you need to go farther back than R14 (Does your co-worker wear a mullet and
bell-bottoms?), there’s still the R12 DXF format. (See the “DXF” section in this
chapter for instructions.)

Wiy
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Autodesk does not document the native AutoCAD DWG file format and rec-
ommends that all file exchanges between AutoCAD and other CAD programs
take place via DXF files (see the next section). But several companies have
reverse-engineered the DWG format, and it’s now common for other CAD pro-
grams to read and sometimes write DWG files directly, with greater or lesser
accuracy. Because the DWG format is complicated, isn’'t documented, and
gets changed every couple of years, no one ever figures it out perfectly. Thus,
exchanging DWG files with non-Autodesk programs always involves some
compatibility risks. This is going to be a particular issue with AutoCAD 2007,
as the DWG format has changed for the first time since AutoCAD 2004, and
there are many new features, particularly in the 3D realm.

When you send DWG files to other people — whether they use AutoCAD or a
different CAD program — you need to make sure that their software can read
the DWG file version that you're sending. See Chapter 1 for information about
AutoCAD DWG file versions.

When you send DWG files to other people, remember to use the ETRANSMIT

command to ensure that you send all the dependent files (fonts, xrefs, and
raster images). See Chapter 15 for details.
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DXF

DWF

PDF

DXF (Drawing eXchange Format) is the Autodesk-approved format for exchang-
ing drawing data between different CAD programs. (Some other vector graph-
ics applications, such as drawing and illustration programs, read and write DXF
files, too.) DXF is a documented version of the undocumented DWG format.
Because DXF more-or-less exactly mimics the DWG file’s contents, it’s (usually)
a faithful representation of AutoCAD drawings.

How well DXF works for exchanging data depends largely on the other pro-
gram that you're exchanging with. Some CAD and vector graphics programs
do a good job of reading and writing DXF files, while others don’t. In practice,
geometry usually comes through well, but properties, formatting, and other
nongeometrical information can be tricky. Test before you commit to a large-
scale exchange and always check the results.

To create DXF files, use the SAVEAS command (Filew>Save As) and choose one
of the four DXF versions in the Files Of Type drop-down list. To open a DXF
file, use the OPEN command (File=>Open) and choose DXF from the Files Of
Type drop-down list.

As Chapter 15 describes, DWF is Autodesk’s special “lightweight” drawing
format for posting drawings on the Web or sharing them with people who
don’t have AutoCAD. Those people can use Autodesk’s free DWF Viewer pro-
gram to view and print DWF files. Chapter 15 describes how to create and use
DWEF files.

Adobe’s PDF (Portable Document Format) is the most popular format for
exchanging formatted text documents among users of different computers
and operating systems. PDF also does graphics, as you probably know from
having viewed PDF brochures on Web sites.

Autodesk has worked hard to make DWF the PDF for CAD drawing exchange,
but DWF hasn’t caught on in a big way quite yet. When AutoCAD users need

to send drawings to people who don’t have AutoCAD, many prefer to convert
the drawings to PDF files. Most potential recipients are familiar with PDF and
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already have the free Adobe Reader installed on their computers which they
can use to view almost any document type. To view DWFs, they would need
to visit Autodesk’s Web site and download and install the Autodesk DWF
Viewer, an additional piece of viewing software that’s only good for viewing
DWEF files.

Each format has its strengths and weaknesses. PDF files tend to be much
larger than DWFs, while DWFs tend to include more of the drawing’s intelli-
gence. Current versions of both formats support layering information,
markup, and measuring tools. Both formats are competent and efficient
means of sharing drawing data, but there’s no question that PDF is more
prevalent.

If you're reading this book, you probably already have the software for creat-
ing DWF files — AutoCAD or AutoCAD LT. The free Adobe Reader views and
prints PDF files but won’t create them.

AutoCAD 2007 (and AutoCAD LT 2007 — for once you’re not left out!) have
the ability to create PDF files. And it’s easy. In the Plot dialog box, from the
list of plotters choose DWG to PDF.pc3. When you click Plot, the output will
be a PDF file.

WMF

a\\J

There are lots of different vector and raster graphics file formats, but Microsoft
has been pretty successful at making its WMF and BMP formats the standard
for exchanging graphical information in Windows.

WMF (Windows MetaFile) is a vector format, so it does a decent job of repre-
senting AutoCAD objects such as lines, arcs, and text.

To create a WMF file showing some or all the objects in a drawing, use the
EXPORT command (File>Export) and choose Metafile (* .wmf) in the Files Of
Type drop-down list. After you create a WMF file in AutoCAD, use the other
program’s file insertion command to place the image in a document.

AutoCAD puts objects in the WMF file with the colors and display lineweights
that you see on the AutoCAD screen. To create a WMF file that looks like a
monochrome plot — that is, with varying lineweights and all objects black —
you need to set layer and object properties in AutoCAD so the objects look
that way on-screen before you create the WMF file.
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You can go the other direction, from a WMF file into AutoCAD, by using the
WMFIN command (Insert=>Windows Metafile). The entire WMF comes in as a
block which can then be exploded and edited (see Chapter 14 for more on
blocks).

BMP, JPEG, TIFF, and
Other Raster Formats

Q‘“\NG!

BMP (BitMaP) is the standard Windows raster format. AutoCAD can create
BMP files from drawing objects (via the EXPORT command) and place BMP
files in drawings (via the IMAGE command, or the Windows clipboard if
you're using AutoCAD LT). When you export AutoCAD drawing objects to a
BMP file, all the objects get converted to dots. Turning a line into a bunch of
dots isn’t a swell idea if you want to change the line again. But it is useful if
you need to copy a drawing into a company brochure.

One problem with BMP files is their big file size. Unlike some other raster for-
mats, BMP doesn’t offer compression. Because CAD drawings usually are
fairly large in area, they can turn into monstrously large BMP files.

Creating a BMP file showing some or all the objects in a drawing is just like
creating a WMF file: Use the EXPORT command (File=>Export) but choose
Bitmap (*.bmp) in the Files Of Type drop-down list. (AutoCAD LT users must
use the BMPOUT command.) After you create a BMP file in AutoCAD, you use
the other program’s Filem>Open to open it or use the graphics file insertion
command to place it in an existing document.

If you want to go the other direction and bring a BMP file into an AutoCAD
drawing, use the IMAGE (IM) command (not in AutoCAD LT), as described in
Chapter 14.

Although BMP is a standard Windows format for exchanging raster data, it’s
certainly not the preferred format of many programs. Other common raster
formats include PNG, PCX, JPEG, and TIFF (the latter two appear as JPG and
TIF in Windows). Among their other advantages, these formats offer image
compression, which can reduce the size of raster files dramatically.

If the program that you're trying to work with works best with other formats
or you want to avoid huge BMP files, you have a couple of options:

v Create an AutoCAD-friendly format (such as WMF or BMP) and translate

it to another graphics format with a translation program such as HiJaak
(www.imsisoft.com) or VuePrint (www.hamrick.com).
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AutoCAD includes JPGOUT, PNGOUT, and TIFOUT commands for creat-
ing JPG, PNG, and TIF files in the same way that you export WMF and
BMP files. Type the command name, press Enter, specify a raster file-
name, and select the objects to be included in the image file. Unlike
WMFOUT, these commands use the current drawing area background
color as the background color for the image. If you want your image
background to be white, make sure that the AutoCAD drawing area color
is white when you run the command. (Choose Tools~>Options~Display~
Colors to change display colors.)

v If you need to convert drawings to a raster format other than BMP or
TIF, the second option is to use the AutoCAD Raster File Format plotter
driver. This driver enables you to plot to a file with one of nine raster
formats, including PCX, JPEG, and TIFF. Before you can use the Raster
File Format driver, you must create a new plotter configuration: Choose
Filec>Plotter Manager and then run the Add-A-Plotter Wizard. After you
create the Raster File Format driver configuration, you use the Plot
dialog box as described in Chapter 13 to generate plots to raster files.

To go the other direction, raster image file into an AutoCAD drawing, use the
IMAGE command (not in LT), as described in Chapter 14.

Windows Clipboard

WNG/
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If you need to transfer lots of WMF or BMP figures, you can do it a bit more
quickly with the Windows Clipboard, which bypasses the creation of WMF
and BMP files on disk. Instead, Windows uses your computer’s memory to
transfer the data. Choose Edit=>Copy in the program from which you want to
copy the data, and then choose Edit=>Paste Special in the program into which
you want to paste it. In the Paste Special dialog box, choose Picture to paste
the image in WMF format or Bitmap to paste it in BMP format.

AutoCAD (but not AutoCAD LT) has a set of image manipulation commands.
You can clip images, turn their borders off and on, and generally treat them
like regular AutoCAD objects. However, these image commands work only if
you use the IMAGE command to load the raster image. If you paste from the
Windows Clipboard, the image comes into AutoCAD as an OLE object (see
the next section), not as an image object, and the additional image com-
mands do not work on OLE objects.
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OLE

Microsoft Windows includes a data transfer feature, Object Linking and
Embedding, or OLE. (In case you're wondering, that’s oh-LAY pronounced like
the Spanish cheer, not like the Cockney way of saying hole.) Microsoft touts
OLE as an all-purpose solution to the challenge of exchanging formatted data
between any two Windows programs.

If you want to share data between two OLE-aware programs (and most
Windows applications are OLE-aware), creating an embedded or linked
document shouldn’t be much more complicated than cut and paste.

That’s the theory.

Here’s how it works. In OLE lingo, the program that you’re taking the data
from is the source. The program that receives the data is called the container.
For example, if you want to place some word processing text from Microsoft
Word into an AutoCAD drawing, Word is the source, and AutoCAD is the

container.

Should you shout, “OLE!"?

Unfortunately, OLE is afflicted with several prac-
tical problems:

v* Compound OLE documents can slow per-
formance — a lot. If you plan to use OLE,
you should have a fast computer with lots
of memory — or lots of time on your hands.

v Supporting OLE well is a difficult program-
ming job, and many applications, including
AutoCAD, suffer from OLE design limitations
and bugs. (For example, when you link or
embed a word processing document, only
the first page appears in AutoCAD.)

v In versions of AutoCAD prior to AutoCAD
2005, plotted OLE output often underwent
creative but undesirable transformations. If
you exchange drawings with users of ear-
lier versions, what they see on the screen
and plot may not match what you created.

AutoCAD 2005 and later versions include a bevy
of OLE improvements, which address some of
the limitations:

v+ You can control text size more easily, via
the MSOLESCALE system variable and OLE
SCALE command.

v~ Editing of OLE objects with commands such
as MOVE (M) and COPY(CP) is more consis-
tent with editing of native AutoCAD objects.

+* You can control the quality of plotted OLE
objects with a setting on the Plot and Publish
tab of the Options dialog box.

Even with the recent OLE improvements, you
should consider carefully and test extensively
before embedding or linking documents into
drawings. If you want to play it safe, use the
alternative methods described in this chapter,
and save OLE for your next trip to Spain.
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In Word, you select the text that you want to put in the AutoCAD drawing and
choose Edit=>Copy to copy it to the Windows Clipboard. Then, you switch to
AutoCAD and choose Edit=>Paste Special. The Paste Special choice displays
a dialog box containing the choices Paste and Paste Link. The Paste option
creates a copy of the object from the source document and embeds the
copied object into the container document. The Paste Link option links the
new object in the container document to its source document so any changes
to the source document are automatically reflected in the container docu-
ment. In other words, if you link word processing text to an AutoCAD draw-
ing, changes that you make later in the Word document get updated in the
AutoCAD drawing automatically. If you embed the same text object in an
AutoCAD drawing, changes that you later make to the text in Word aren’t
reflected in the AutoCAD drawing.

That’s how it’s supposed to work. In practice, the container application some-
times doesn’t display or print all the linked or embedded data correctly. See
the “Should you shout, ‘OLE!'?” sidebar for details.

Screen Capture

If your goal is to show the entire AutoCAD program window, not just the
drawing contained in it, create a screen capture. Most of the figures in this
book are screen captures. You might use similar figures to put together a
training manual or to show your mom all the cool software you use.

Windows includes a no-frills screen capture capability that is okay for an
occasional screen capture. It works like this:
1. Capture the whole screen or active window with one of these steps:

¢ Press the Print Screen key to capture the entire Windows screen,
including the desktop and taskbar.

¢ Hold down the Alt key and press the Print Screen key to capture
just the active program window (for example, AutoCAD).

It looks like nothing happened, but Windows copied a bitmap image of
the active window or the entire screen to the Windows Clipboard.

2. Paste the bitmap image into another program. You have two options:

¢ Paste into a paint program (such as the Paint program in Windows).
Use that program to save a raster image as a BMP file format.

¢ Paste the bitmap image directly into a document (such as a Word
document or an AutoCAD drawing) without creating another file.
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If you do lots of captures, a screen capture utility program makes the job
faster and gives you more options. You can control the area of the screen
that gets captured, save to different raster file formats with different mono-
chrome, grayscale, and color options, and print screen captures. Two good
screen capture utility programs are FullShot by Inbit, Inc. (www. inbit.com)
and Snaglt by TechSmith Corp. (www. techsmith. com).

When you create screen captures, pay attention to resolution and colors:

v High screen resolutions (for example, above 1280 x 1024) can make your
captures unreadable when they get compressed onto an 8%-x-11-inch
sheet of paper and printed on a low-resolution printer.

v Some colors don’t print in monochrome, and a black AutoCAD drawing
area is overwhelmingly dark. For most of the screen captures in this
book, we used 1024 x 768 resolution, a white AutoCAD drawing area,
and dark colors — mostly black — for all the objects in the drawing.

TXT and RTF
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TXT (Text, also called ASCII for American Standard Code for Information
Interchange) is the simplest format for storing letters and numbers. TXT files
store only basic text, without such formatting as boldface or special para-
graph characteristics. RTF (Rich Text Format) is a format developed by
Microsoft for exchanging word processing documents (text plus formatting).

Pasting text from a word processor brings it into your drawing in exactly the
form it appeared in the word processor document. So far, so good. However,
what you’ve just pasted is another one of those troublesome OLE objects —
you can’t edit it in AutoCAD’s Multiline Text Editor because it’s not AutoCAD
text. The solution is to save the word-processed text in Rich Text Format
(RTF). Then start AutoCAD’s MTEXT (T) command, right-click inside the
Multiline Text Editor window, and choose Import Text. Find the RTF file and
click OK. The word-processed text is now AutoCAD text. When you import an
RTF file, AutoCAD even brings along most of the text formatting and align-
ment. Chapter 10 covers the Multiline Text Editor window.

Because no rational person would use AutoCAD as a word processor, Auto-
CAD doesn’t provide any special tools for exporting text. You can select
AutoCAD text, copy it to the Windows Clipboard, and then paste it into
another program.
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character, 76 o A o
- (dash) foot/inch separator character,
125-126 abbreviation, industry-specific, 254
= (equal sign) drawing scale separator About to regen-proceed? message, 210
character, 76 acad.dwt file, 22, 49
? (question mark) Acad. fmp file, 361
help command, 165, 166 acadiso.dwt file, 22
system variable command, 43 acadiso.lin file, 114
“ (quotation mark) measurement unit acadiso3d.adwt file, 22, 213
suffix, 126 acad.lin file, 114
third-party software, 15, 17, 30 acadlt.dwt file, 49, 85
3D acad3d.dwt file, 22, 213
archall, 223, 224 acadltiso.dwt file, 85
AutoCAD LT support, 16 ACADVER system variable, 44
camera, 215, 218, 223 ACI (AutoCAD Color Index), 113
Dashboard, 214-218 Add Printer Wizard, 294
edge effect, 221 Add-A-Plot Style Table Wizard, 305
engine, 20 Add-A-Plotter Wizard, 294
light, ambient, 215 add-on software, 15, 16
measurement system, specifying, 213 American National Standards Institute
Modeling workspace, 19, 21, 212, 213 (ANSD)
navigation, 215, 218-219, 222-223 hatch pattern, 285
orbit, 223-225, 316 paper size, 78
panning, 215, 225 angle
perspective, 218, 225 arc, of, 149
plotting, 315-316 constraining crosshair to, 28-29
projection, 218, 225 dimension, 260, 273
rendering, 215 hatch, 283, 287, 288
rotation, 224, 225 precision, 131-132
solid, freeform, 215 rotation angle, 179

solid, primitive, 215
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ANSI. See American National Standards
Institute
apostrophe () measurement unit suffix,
86, 125
arc
angle, 149
chord, 149
circular, 141, 142-143, 147, 148-151
corner, creating curved using, 187-188
dimension, 273, 274
elliptical, 151-152
joining two arcs into one, 188
offsetting, 182
polyline, converting arc segment to, 183
revision cloud arc length, 156
splitting in two, 186
ARC command, 135
arcball, 3D, 223, 224
Architectural Desktop software, 15
architectural drawing
coordinate entry, 125-126
measurement system, 74, 85-86
paper size, 78
scale, 76-77
ARRAY command, 61-62, 169, 180-181
Array dialog box, 181
arrowhead, 92, 258, 267, 268, 278. See also
dimension
ARX (AutoCAD Runtime eXtension), 17
at sign (@) relative coordinate prefix, 54
Attach DWF Underlay dialog box, 353
ATTDEF command, 330
ATTDIA system variable, 333
Attribute Definition dialog box, 330-331
Attribute Extraction wizard, 333
AUNITS system variable, 82
AUPREC system variable, 82
AutoCAD and AutoCAD LT All-In-One Desk
Reference For Dummies (Wiley
Publishing), 212
AutoCAD Color Index (ACI), 113
AutoCAD Runtime eXtension (ARX), 17
AutoCAPS feature, 242
Autodesk
software, 15
Web site, 46, 366
AutoLISP software, 17

ol e

Background Mask dialog box, 244
backup, 55, 378
.bak files, 55
BEDIT command, 338
bitmap image, 322
block. See also title block
action parameter, 338-340
advantages/disadvantages, 323
attribute, 326, 329-334, 335
authoring, 321
base point, 324, 335, 336
color, 113
database analogy, 330
definition, 321, 324-327, 332, 334
description, entering, 326
dragging, creating using, 328
dynamic, 321, 323, 335-341
exploding, 326, 328, 334-335, 376
grip editing, 337, 340-341
inserting, 321, 322, 323, 327-329, 332
instance, 323, 326
layer, 324, 327
library, 327
multiple drawings, using in, 323, 329
naming, 324, 336, 338
purging unused, 334
redefinition, 324, 328, 329
rotating, 328, 339, 341
scale, 326, 328, 329
symbol group, creating using,
323, 326, 327
table, 252, 322, 326
visibility state, 335, 336, 337-338
xref, relation to, 322, 345
xref versus, 342, 348-349
Block Attribute Manager dialog box, 332
Block Authoring palettes, 337, 339, 341
Block Authoring toolbar, 337, 338
Block Definition dialog box, 324-325
Block Editor feature, 335, 338
Block In-place Editing = Edit Reference
In-Place, 329
Blocks and Tables-Imperial.dwg file,
232, 301
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Blocks and Tables-Metric.dwg file,
232, 301
BMP files, 380, 384
brackets, angled (< >)
command option delimiters, 37
dimension text placeholder, 276
brackets, square ([ ]) command option
delimiters, 36
BREAK command, 169, 186-187
Building Your World feature, 226
bullet, text, 245-246
BURST command, 335
button display when feature
activated/deactivated, 31, 124

oo

camera, 3D, 215, 218, 223
Can't find message, 364
Cartesian coordinate, 124
cartoon, 80
case sensitivity, 113
CELTSCALE system variable, 82
CHAMFER command, 169, 187
channel, Communication Center, 30
Check Spelling dialog box, 253-254
chord, arc, 149
CHSPACE Express tool, 197
circle
arc, circular, 141, 142-143, 147, 148-151
center point, 56, 147, 148
circumference, 147
diameter, 56, 259, 260, 273
dimension, 259, 260, 273
donut, 135, 147, 154, 155
filling, 154, 155
object tangent to, defining, 147
polygon, imaginary circle enclosing,
145-146
radius, 56, 147-148, 259, 260, 273
snap, using when drawing, 148
Classic workspace, 21, 202
Clipboard, Windows, 174-175, 380, 385
cloud, revision, 135, 137, 154-156
colon () drawing scale separator
character, 76

color
ACI, 113
block, 113
configuration, changing default, 20
dimension, 275, 307
drawing area background, 20, 244, 385
fill, solid, 154, 155, 285, 286
grip color, 190
HSL, 113
layer, 52-53, 56, 111-112, 113
line, 137
LWT mapping, 110, 306, 307-310
name, assigned, 114
number, assigned, 114
object property, 109
PANTONE, 113
plotting, 113-114, 303, 304, 306-307, 310
RAL, 113
RGB, 113
standard, industry-specific, 110
text, 249
True Color mode, 307
Color TaBle (CTB) files, 304, 305, 306-307,
308-309, 359
command. See also specific command
action, accepting default, 36, 37
canceling, 35, 36
cycling through recent commands, 37
drawing area, using with, 40
dynamic input versus, 34, 135
editing, command-first, 160, 161, 166, 189
entering, 33, 36-37, 125
keyboard shortcut, 25, 33
line, 19, 32, 37
message display, 35, 48
option entry, 33, 34, 35, 37
prompt, importance of reading, 170
space, adding to, 125
Spacebar, using to enter, 37
text area, 35
window, 32-33, 35, 36, 37
COMMANDLINE command, 166
commenting drawing using leader, 277-280
Communication Center, 30
compiled SHape (SHX) font, 231, 361
compressing object using STRETCH
command, 176, 195
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construction tolerance, indicating in
dimension, 257, 269
Contentsc>Command Referencem>System
Variables=D System Variables, 262
Contents=>Customization Guide>
Custom Linetypes, 117
Contentst>Driver and Peripheral Guider>
Use Plotters and Printers, 292
coordinate
absolute, 124, 125
Cartesian, 124
display, 27-28, 31, 53-54, 86, 124
DUCS, 29
entering, 34, 53, 123, 124-126
polar, 124, 125
precision, 123, 124-126
relative, 54, 124, 125
UCS, 204, 219, 224
COPY command, 171-172, 174, 175
COPYBASE command, 175
COPYCLIP command, 174, 175
copying
base point, 171, 175
cutting/pasting object, 174, 175
dimension to/from another drawing,
256, 262-263
displacement, 171-172
exchanging data with other software via,
174-175, 380, 385, 387-388
grip editing, 194
hatch property, 285
layout to another drawing, 120, 312
rotating copy of object, 179
SCALE command copy option, 180
undoing copy operation, 174
Windows Clipboard, using, 174-175,
380, 385
corner, rounding, 54-55, 187
cramming drawing, 376-377
Create Layout Wizard, 95-97
Create New Dimension Style dialog
box, 265
Create New Table Style dialog box, 249
Create Transmittal dialog box, 360, 362
crosshair cursor
angle, constraining using polar tracking,
28-29
coordinate display, 27-28, 124

input, dynamic, 31, 166
movement, constraining using ortho
tracking, 28, 58
crosshatching. See hatching
crossing object selection, 63-64, 163-165,
166, 167, 175-176
CTB (Color TaBle) files, 304, 305, 306-307,
308-309, 359
cursor. See specific cursor
curve
arc, circular, 141, 142-143, 147, 148-151
arc, elliptical, 151-152
corner, rounding, 54-55, 187
drawing, 136, 139
free-form, 153
NURBS, 152
spline object, 152
Customize User Interface dialog box, 26
CUTCLIP command, 175
cutting/pasting object, 174, 175

o) e

dash (-) foot/inch separator character,
125-126
Dashboard feature, 214-218
dash-dot linetype, 75, 92, 186
DDE (direct distance entry), 123, 131, 174
DDPTYPE command, 157
Decimal measurement system, 74, 86
Descartes, Rene (Discourse on Method), 124
Design Web Format (DWF)
creating DWF file, 367-370
described, 357, 365
exchanging data with other software
using, 380, 382
exchanging data with other user
using, 357
file size, 366
hyperlink, embedding, 370
insertion point, 353
password-protecting, 358, 371-372
plotting, 366-367, 369
precision, 353
rotating, 353
scale, 353, 368
snapping, 353
underlay, 322, 353

www.it-ebooks.info


http://www.it-ebooks.info/

393

Index

Web, publishing to, 369
xref, 352-353
DesignCenter palette, 41, 118-122, 262, 329
Designjet Web site, 314
dialog box, modal/modeless, 40, 41
diazo blueline machine, 291-292
digital signature, 358, 371-372
DIMANGULAR command, 273
DIMARC command, 273, 274
DIMASSOC system variable, 277
DIMBASELINE command, 273
DIMCONTINUE command, 273
DIMDIAMETER command, 273
DIMDISASSOCIATE command, 277
dimension
aligned, 259, 260, 272
angular, 260, 273
arc, 273, 274
arrowhead, 92, 258, 267, 268, 278
associativity, 260-261, 275-276
batching entry, 256, 261
change to object, automatic update upon,
256, 260, 270
circle, 259, 260, 273
color, 275, 307
construction tolerance, indicating in,
257, 269
copying to/from another drawing,
256, 262-263
described, 255
diameter, 259, 260, 273
drafting, inheritance from manual, 257
editing, 265, 274-277
exploding, 275, 376
geometry, 274-275
horizontal, 271
leader, 277-280
line, 258-259, 267, 268
line, extension, 258-259, 267, 270, 271, 272
linear, 259, 260, 270-273
model space, working in, 274
paper space, working in, 274
plotting, 266, 267, 307
point, origin, 270, 272
precision, 269
previewing, 266
quick entry feature, 273
radius, 259, 260, 273

scale, 82, 92, 237, 263, 268-269
selecting, 260
side-by-side dimensions, entering, 273
snapping, using when entering, 270,
271-272, 275, 278
standard, industry-specific, 256
stretch operation, behavior during, 261
style, 93, 233, 261-269, 275, 345
text, 233, 258, 259, 267-268, 275-276
tick mark, 258
trans-spatial, 274
unit format, 269
vertical, 271
zero suppression, 269
Dimensionc>Leader, 278
Dimensiont>Linear, 271
Dimension Style Manager dialog box,
82,93, 264
Dimension toolbar, 261, 271, 272, 278
dimension variable (dimvar), 262
DIMLINEAR command, 273
DIMRADIUS command, 273
DIMREASSOCIATE command, 277
DIMREGEN command, 277
DIMSCALE system variable, 82, 92, 237, 269
DIMSTYLE system variable, 93
dimvar (dimension variable), 262
direct distance entry (DDE), 123, 131, 174
direct manipulation editing, 160
Discourse on Method (Descartes), 124
displacement editing method, 171-172,
173, 195
dithering, monochrome, 310
DLINE command, 144
DONUT command, 135, 147, 154, 155
double floating-point precision, 209
drafting, pin-bar, 108
Drafting Settings dialog box
Object Snap tab, 129-130
Snap And Grid tab, 50, 82, 89-91, 132
Tracking tab, 131
dragging
block, 328
grip, 190, 191
object, 173, 177
zoom maghnification, controlling using,
200
Drawc>Blocke>Define Attributes, 330
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Draw menu, 134-135
Draw Order toolbar, 26
Draw=>Table, 251
Draw=Text>Single Line Text, 238
Draw toolbar
Arc button, 135
Circle button, 135
Construction line button, 134
Ellipse button, 135
Hatch button, 66
introduced, 26
Line button, 134
Make Block button, 324
Multiline Text button, 240
Point button, 135
Polygon button, 134
Polyline button, 134
Rectangle button, 134
Revision Cloud button, 135
Spline button, 135
Text button, 238
drawing area
background color, 20, 244, 385
clicking in, 40
command window, using with, 40
configuration, restoring default, 38
finding object lost on, 202-203
Layout tabs, 29, 38-40
maximizing/minimizing, 24
Model tab, 29, 38-40, 300
option menu, 40
orientation, 40
paper size, matching to, 79
Drawing eXchange Format (DXF),
380, 381, 382
drawing limits
grid, 82, 87, 90-91
model space, 49-50, 68, 88
plotting, 68, 87, 296, 315
setting, 88-89
zooming to, 87
Drawing Properties dialog box, 94
drawing scale, 76, 234
drawing scale factor, 76, 180, 234-235,
237, 376
Drawing Units dialog box, 74, 82, 85
DRAWORDER command, 26, 244, 275, 351
DST files, 360

DTEXT command, 236, 237-238, 240
DTEXTED system variable, 240
DUCS (Dynamic User Coordinate
System), 29
Duplicate definitions will be
ignored message, 121
DWF Composer software, 366
DWEF. See Design Web Format
DWEF Viewer software, 366, 370, 371
DWF6 ePlot.pc3 file, 367
DWG files
compatibility, backward, 13-14, 17, 18
compression, 361
DWF precision compared, 353
exchanging data with other software,
using when, 380-381
extension display, 51
hyperlink, embedding, 370
panning, involvement in, 209-210
password-protecting, 358, 371-372
path, 346-347
sending to another user, 358-360, 365
size, 358
xref, 343, 345, 346
zooming, involvement in, 209-210
DWT files, 83
DXF (Drawing eXchange Format),
380, 381, 382
dynamic input. See input, dynamic
Dynamic User Coordinate System
(DUCS), 29

oF o

EATTEDIT command, 333
EATTEXT command, 333
Edit Attributes dialog box, 332
Edit Block Definition dialog box, 326,
335-336
Edit=>Copy, 253
Edit>Paste Special, 253
Edit Scales List dialog box, 77
ELLIPSE command, 135, 147, 151-152
emailing drawing, 357, 358, 361, 363
engineering
coordinate entry, 125-126
measurement system, 74, 85-86
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Enhanced Attribute Editor dialog box, 333
ePlot feature, 366-368
equal sign (=) drawing scale separator
character, 76
erasing, 167-168, 169, 377
ETRANSMIT command, 357, 359-362,
366, 381
exchanging data with other software
block attribute, 333
BMP format, using, 380, 384
copying data, via, 174-175, 380, 385,
387-388
DWF format, using, 380, 382
DWG format, using, 380-381
DXF format, using, 380, 381
Excel, 253, 380
image, 349, 384-385
LT2 format, using, 380
OLE, via, 386
paint program, 379-380
PDF format, using, 380, 382-383
PNG format, using, 385
RTF format, using, 243, 248, 380, 388
text, 243, 248, 253
TIFF format, using, 384
transfer, round-trip, 381
TXT format, using, 243, 380, 388
Windows Clipboard, using, 174-175,
380, 385
WMF format, using, 380, 383-384
Word, 380
exploding
block, 326, 328, 334-335, 376
dimension, 275, 376
polyline, 140, 376
EXPORT command, 384. See also
exchanging data with other software
ExpresscBlocksvExplode Attributes to
Text, 335
Express Tools feature, 18, 117, 118
EXTEND command, 169, 184-185
external reference. See xref
External Reference Files Have
Changed message, 342
External References palette, 41, 322, 342,
343, 350

ofFe

File>Close, 209
File>Drawing Properties, 94
Filew>Drawing Utilities = Purge, 334
Filec>eTransmit, 360
Filec>Install New Font, 364
File navigation dialog box, 357
Filec>New, 22
Filec>Page Setup Manager, 312
File=>Plot Style Manager, 305
Filec>Plotter Manager, 294
Filec>Publish, 369
FilecvSave As, 17
File Transfer Protocol (FTP), 362-363
fill, solid

donut, 154, 155

hatch, 285, 286
FILLET command, 54-55, 170, 187-188, 289
Find And Replace utility, 243
finding object lost on drawing area,

202-203

FMP file, 360
font. See also text

custom, 232, 359

In-Place Text Editor, display in, 241

installing, 364

previewing, 232

Roman Simplex, 231

sending drawing to another user,

including when, 359, 360, 361, 364

SHX, 231, 361

specifying, 230, 233

title block, 231

TTF, 231, 361, 364
FONTALT system variable, 360
FONTMAP system variable, 360
Fonts applet, Windows, 364
Format=>Dimension Style, 93, 264
Format=>Drawing Limits, 49
Format=Linetype, 93
Format=Lineweight, 115
Format=>Point Style, 157
Format=>Scale List, 77
Format>Table Style, 249
Format=>Text Style, 230
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Format=>Units, 85
Fractional measurement system, 74

FTP (File Transfer Protocol), 362-363

FullShot software, 388

oG o

geometry

annotating, 229

cramming, 376-377

dimension geometry, 274-275

drawing, 123, 133

precision, 123

tolerance, geometric, 269
globe and chain cursor, 370
Golden Exchange Rule, 359
grab point, 126
grid

Adaptive Grid option, 90

described, 28, 89

drawing limits, 82, 87, 90-91

plotting grid bubble, 80

snapping to, 50

spacing, 50, 82, 90, 91

turning on/off, 90, 92

zooming, behavior when, 82, 90
Grid too small to display

message, 82

GRIDDISPLAY system variable, 82
GRIDMAJOR system variable, 82
GRIDMODE system variable, 82
GRIDUNIT system variable, 82
grip editing

block grip, 337, 340-341

color of grip, 190

command-first editing versus, 189

copy operation, using in, 194

described, 160

displaying grip, 190

dragging grip, 190, 191

hot grip, 190, 196

menu, 191, 192

mirror operation, using in, 190

move operation, using in, 190, 193-194

options, cycling through, 191
pull of other object, 192
removing grip, 192

rotation operation, using in, 190
scale operation, using in, 190
snap, using in, 192
STRETCH command grip-editing
operation, 191-192, 195-196

text, 248
tooltip, dynamic input, 191
vertex point, 140

Group Manager dialog box, 324

o o

hand cursor, 60, 200
Hatch And Gradient dialog box, 66, 282-283,
285, 289, 290
HATCH command, 283
Hatch Edit dialog box, 290
hatching
angle, 283, 287, 288
annotation to drawing, as, 281
ANSI-standard, 285
batching application, 281
boundary, 284, 288-289
copying hatch property, 285
editing hatch object, 290
fill, solid, 285, 286
ISO-standard, 285
layer, 66, 283
measurement system, 75
pick point, 283, 288, 289
poché effect, 286
predefined, 285, 287
previewing, 66, 284, 290
scale, 66, 180, 283, 287-288
spacing, 288
usage, appropriate, 281
user-defined, 283, 287, 288
help, accessing, 45-46, 165, 166, 314
HIDE command, 219
highlighting, rollover, 166
HiJaak software, 384
HP (Hewlett-Packard) Designjet Web
site, 314
HPGAPTOL system variable, 283
HSL (Hue Saturation Luminance), 113
hyperlink, embedding, 357, 370
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image
bitmap, 322
clipping, 351
importing, 349
insertion point, 351
raster, 322, 349-352, 359-360, 379, 384
scale, 351
vector, 322, 349, 350, 379
IMAGE command, 351, 384
Image dialog box, 351
Image Manager dialog box, 342
imperial measurement system, 22, 49, 74,
86, 114
implied windowing, 163
importing data. See exchanging data with
other software
IMSI HiJaak software, 384
Inbit FullShot software, 388
Info Palette, 41, 46
In-Place Text Editor, 238, 241, 242,
245-246, 248
input, dynamic
command prompt, importance of reading,
170
command window input versus, 34, 135
coordinate display, 28, 31
crosshair, 31, 166
displaying previous input, 170
DYN status bar button, 32
introduced, 18
toggling on/off, 31-32
tooltip, 29, 31, 36, 37, 191
Insert dialog box, 327-328
Insert Table dialog box, 251, 253
Insert->Windows Metafile, 384
Internet feature overview, 357-358
Internet service provider (ISP), 356
Ipswitch WS_FTP software, 363
ISO (International Standard Organization)
dimension style, 264
hatch pattern, 285
paper size, 78, 79
isometric view, 222
ISP (Internet service provider), 356

° ] °
JOIN command, 169, 188-189
JPEG files, 384-385

JPGOUT command, 385
JUSTIFYTEXT command, 249

oK o

keyboard shortcut, 25, 33
keyword, option, 35

o/ o

lassoing object, 168
layer

assigning property by object versus,
110-111, 375

block, 324, 327

color, 52-53, 56, 111-112, 113

copying to another drawing, 120-122

creating, 52, 57, 112-117

current, 53, 54, 107-109, 116

description, adding, 115

drawing on, 53

filtering, 116-117

freezing, 116, 377

grouping objects using, 107, 110

hatch, 66, 283

hiding/displaying, 116

introduced, 52

isolating, 117

line, 111-112, 114-115, 137

listing all layers, 118

locking, 116

LWT, 111-112, 115

moving object to another, 109

naming, 52, 57, 113, 121

object, as named, 118-119

object property, as, 106

overriding object property inherited
from, 110-111

pin-bar drafting analogy, 108

plot style, 111-112, 115

revision cloud, 155
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layer (continued)
selecting all objects on, 166
standard, industry-specific, 109
table, 118
turning on/off, 116, 117
view, saving layer snapshot with, 204
xref, 343, 345
LAYER command, 52
Layer Properties Manager dialog box
accessing, 52
Description column, 115
Name list, 114
New Group Filter button, 117
New Layer button, 112
New Property Filter button, 117
Layers toolbar
introduced, 25
Layer drop-down list, 53, 107, 109
Layer Properties Manager button, 52
layout
area printable, 98
copying to another drawing, 120, 312
creating, 95-98
described, 94
dimension, scaling to, 269
displaying, 29
naming, 96
number of layouts, determining
optimal, 99
object, as named, 119
orientation, 96
paper size, specifying, 96
paper space, relation to, 38
plotting, 69, 297, 300-302, 309, 311
regeneration, 209-210
sheet set, changing to, 99
title block, 38, 96-97
viewport, 29, 97, 99
LAYOUT command, 98
LAYOUTWIZARD command, 95
LEADER command, 277
Leader Settings dialog box, 278, 279
LENGTHEN command, 169, 186
light, 3D ambient, 215
LIMITS command, 88
limits, drawing, 49-50, 68, 82, 88-89

LIMMAX system variable, 82
LIMMIN system variable, 82
line. See also lineweight
adding segment, 128, 129, 137-138
arc segment, converting to polyline, 183
circle, defining line tangent to, 147
color, 137
command line, drawing using, 34-35
connecting segments into polyline,
137, 139
construction line, 136
converting segment to polyline, 183
coordinate, entering, 34
copying linetype to another drawing, 120
corner between two lines, creating, 54-55,
187-188
curved segment, polyline, 136, 142-143
dash-dot linetype, 75, 92, 186
definition, linetype, 114, 117
dimension extension line, 258-259, 267,
270-272
dimension line, 258-259, 267, 268
double line, drawing, 144
endpoint, defining, 35, 128, 138, 141, 143
exploding polyline, 140, 376
filleting using polyline, 54-55
infinite, 136
joining two lines into one, 188-189
layer, 111-112, 114-115, 137
lengthening polyline, 186
loading linetype, 114, 117
measurement system, 75, 114
multiline, 144
nonorthogonal, 270
object, linetype as named, 119
object property, linetype, 109
offsetting, 55, 182, 183
parallel, 144, 182-183
plotting, 70, 110, 137
polygon, polyline, 136
ray, 134, 136
rectangle, polyline, 136
removing segment, 137
scale, linetype, 82, 92-93
selection area, polyline, 166
snapping, using when drawing,
126-128, 137
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splitting polyline, 186
start point, defining, 34, 137-138, 141
straight segment, polyline, 136, 140,
141, 143
stretching, 176, 195-196
template, adding linetype to, 117
undoing change made to, 34
vertex point, 140
xref linetype, 345
LINE command
closing, 137, 138
Draw menu option, 134
Draw toolbar button, 34
PLINE command compared, 139-140
prompt, 34
Specify first point prompt, 34, 137
Specify next point or
[Close/Undo] prompt, 34
Specify next point or [Undo]
prompt, 34, 138
Undo option, 137
Linetype Manager dialog box, 82, 93, 117
lineweight (LWT)
color mapping, 110, 306-310
default, 115
described, 29
displaying, 110
layer, 111-112, 115
object property, 109
plotting, 70, 110, 305, 307-310
polyline, 140
standard, industry-specific, 110
status bar, display in, 29
Lineweight dialog box, 115
Lineweight Settings dialog box, 115
list, text, 245-248
lost object on drawing area, finding,
202-203
LSP software, 17
LTSCALE system variable, 82, 92-93
LT2 files, 380
LUNITS system variable, 82
LUPREC system variable, 82
LWEIGHT command, 115
LWT. See lineweight

o/l o

magnifying glass cursor, 200
manipulation of object, direct, 160
Markup Set Manager, 41, 356
masking, text, 244, 246
MBUTTONPAN system variable, 201
measurement system

Architectural, 74, 85-86

Decimal, 74, 86

default, 82

Engineering, 74, 85-86

Fractional, 74

hatch, 75

imperial, 22, 49, 74, 86, 114

line drawing, 75, 114

metric, 22, 49, 75, 76, 114

model space, 85-87

paper size, 79

precision, 74

removing unused, 77

scale, 76

Scientific, 74

SI, 75

specifying, 22, 49, 82-83

template, 85, 101

3D Modeling workspace, 213

unit, linear, 82, 85

unitless, 74
MEASUREMENT system variable, 75
Mechanical Desktop software, 15
menu bar, 23, 25
metric measurement system, 22, 49, 75,

76, 114
midpoint of object, finding when
snapping, 128

Migrate Settings dialog box, 23
MIRROR command, 169, 190
MLINE command, 144
model space

described, 38

dimensioning in, 274

drawing limits, 49-50, 68, 88

importance of understanding, 376

measurement system, 85-87
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model space (continued)
panning behavior in, 205, 207-209
paper space, switching to/from, 29-30, 40,
99-100, 197
plotting, 68-70, 295, 299-300
selecting all objects in, 166
text, adding in, 236
viewport, 29-30, 38
zooming behavior in, 205, 207-209
Modeling tool palette, 213
Modify=>Clip=>Image, 351
ModifyDimension Style dialog box, 93
Modify=>Object=>Attribute Block Attribute
Manager, 332
Modify=>Object=>Attributew>Single, 333
Modify toolbar
Array button, 61
Break At Point button, 187
Break button, 186
Erase button, 167
Explode button, 275
Extend button, 184
Fillet button, 54
introduced, 26
Join button, 188
Move button, 172
Offset button, 55
Rotate button, 179
Scale button, 179
Stretch button, 63
Trim button, 184
monochrome. ctb file, 69, 297
moving object
dragging, using, 173, 177
grip, using, 190, 193-194
MOVE command, using, 169, 171-174, 190
MSOLESCALE system variable, 386
MSPACE command, 99
MTEXT command
described, 236
Draw toolbar, accessing from, 240
DTEXT command versus, 236, 237
Edit option, 248
In-Place Text Editor, 238, 241, 242,
245-246, 248
Insert Field option, 244
justification options, 237, 238, 241

list options, 245

New Features Workshop resources, 243

Specify height option, 241

text rectangle options, 241
MTEXTFIXED system variable, 248

o\ o

National Institute of Standards and
Technology (NIST) Special Publication
814,75

NEW command, 84

New Features Workshop, 46, 226, 243, 314

New Table Style dialog box, 249

New Text Style dialog box, 233

New View dialog box, 204

New Visibility State dialog box, 338

New/Modify Dimension Style dialog box,
266-269, 270

NIST (National Institute of Standards
and Technology) Special Publication
814, 75

noun-verb editing, 160

NURBS (NonUniform Rational B-Spline)
curve, 152

o () o

Object does not intersect an edge
message, 184
Object Grouping dialog box, 324
object snap (OSNAP), 29, 57, 123,
126-130, 132
Object Snap toolbar, 127
Object Snap Tracking (OTRACK), 29
OFFSET command, 169, 182-183
OLE (Object Linking and Embedding), 386
one-by-one selection, 162-163
OOPS command, 168
opening
AutoCAD, 49
drawing, 22, 120, 345, 348
option keyword, 35
Options dialog box
Display tab, 20, 202, 301
Drawing Template Settings area, 84
Files tab, 305
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Plot and Publish tab, 293, 316
Profiles tab, 20
Selection tab, 161-162, 163, 166
Startup dialog box, accessing from, 85
system variable storage, setting in, 44
Systems tab, 22
User Preferences tab, 277
orientation
drawing area, 40
layout, 96
plot, 297
ortho mode
crosshair cursor, constraining using,
28, 58
overriding, 132
polar tracking mutually exclusive with, 29
polygon drawing, using in, 58, 146
revision cloud drawing, using in, 156
stretch operation, using in, 65, 176, 178,
195, 197
turning on/off, 58
orthographic view, 222
OSNAP (object snap), 29, 57, 123,
126-130, 132
OTRACK (Object Snap Tracking), 29

oo

Page Setup dialog box, 302
Page Setup Manager dialog box,
301, 305, 312
palette. See also specific palette
position, locking, 30
toggling on/off, 41
Palettes>External References, 343
panning
described, 59
DWG file involvement, 209-210
model space, behavior in, 205, 207-209
mouse, controlling using, 60, 201
real-time, 59-60, 199-201
regeneration, 209-210
3D, 215, 225
title block display, effect on, 206, 207
view, 200, 203, 204-205
viewport, inside, 208

zooming compared, 199-200
zooming, toggling to/from, 200-201
PANTONE color, 113
paper size, 68, 78-79, 96, 296, 301
paper space. See also layout
described, 38
dimensioning in, 274
importance of understanding, 376
layout, relation to, 38
model space, switching to/from, 29-30,
40, 99-100, 197
plotting, 300-302, 317
selecting all objects in, 166
text, adding in, 236
viewport, 29-30, 38
zoom behavior in, 205-209
Partner Products & Services Web site, 15
password, assigning to drawing, 358,
371-372
Paste Special dialog box, 385
PASTEBLOCK command, 175
PASTECLIP command, 174, 175
PASTEORIG command, 175
PC3 files, 96, 293, 314, 315, 360
PDF (Portable Document Format),
380, 382-383
PEDIT command, 140, 183
pencil and paper technical drawing,
AutoCAD compared, 12
perspective, 3D, 218, 225
pin-bar drafting, 108
plan view, 222
PLINE command, 134, 136, 138-144, 286
Plot and Publish Job Complete
message, 69-70
Plot dialog box
accessing, 68
Apply To Layout button, 311
Help button, 314
Hide Paperspace Objects option, 316
Model tab, 299
More Options button, 68, 296-297
Plot Area option, 315
Plot Object Lineweights option, 308
Plot Offset option, 315
Plot Stamp On option, 315
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Plot dialog box (continued)
Plot Style Table (Pen Assignments) area,
305, 309, 310
Plot To File option, 314-315
Plot Upside-Down option, 316
Plot With Plot Styles option, 308
Preview button, 69, 298
Printer/Plotter area, 295-296, 314, 367
Shaded Viewport options, 315
Plot Screening and Fill
Patterns.dwg file, 307, 310
Plot Style Table Editor dialog box, 306
Plotter Configuration Editor dialog box,
314, 317
Plotter Manager Add-A-Plotter Wizard, 294
plotting. See also printer
area printable, 69, 80, 98
area to plot, specifying, 296, 315
area to plot, zooming to, 295
background, in, 316
border, 80-81
cartoon, facilitating using, 80
color, 113-114, 303, 304, 306-307, 310
convention, 316
Details Report, generating, 317
dimension, 266, 267, 307
dithering, 310
drawing limits, 68, 87, 296, 315
DWEF, 366-367, 369
ePlot feature, 366-368
file received from another user, 359
file, to, 314-315
grid bubble, 80
layout, 69, 297, 300-302, 309, 311
line, 70, 110, 137
LWT, 70, 110, 305, 307-310
model space, 68-70, 295, 299-300
monochrome, 297, 304, 310, 383, 388
offset, 69, 296, 315
orientation, 297
outsourcing, 311, 367
paper size, 68, 78-79, 96, 296, 301
paper space, 300-302, 317
paper type, 314
planning, 71-73
previewing, 69, 297, 298
raster image effect on speed, 352

saving drawing after, 70
scale, 69, 77, 296, 299-300, 301-302
screen, planning plot on, 72
screening, 303, 306
service bureau, 311, 367
setup, basing on existing drawing, 73
sheet set, 316
stamp, 315
style, 111-112, 297, 303-307, 317, 359
text, 80-81, 235, 241, 267
3D object, 315-316
troubleshooting, 316-317
upside-down, 316
viewport, 315, 316
PLT files, 311, 369
PMP files, 360
PNG files, 385
poché effect, 286
point
block base point, 324, 335, 336
break point, 186, 187
copy operation base point, 171, 175
described, 156-157
dimension origin point, 270, 272
DWF insertion point, 353
grab point, 126
hatch pick point, 283, 288, 289
image insertion point, 351
line endpoint, defining, 35, 128, 138,
141, 143
line start point, defining, 34, 137-138, 141
midpoint of object, finding when
snapping, 128
move operation base point, 172-173
rotation base point, 179
scale transformation base point, 179-180
stretch operation base point, 171, 175,
178, 196
style, 157-158
text insertion point, 238, 251
vertex point, 140
xref insertion point, 344
POINT command, 135, 156, 158
Point or option keyword required
message, 35
Point Style dialog box, 157-158
polar array pattern, 61, 180, 181
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polar coordinate, 124, 125
polar mode, 28-29, 123, 131, 176, 197
polar snap, 131-132
polygon
drawing, 56-59, 134, 136, 145-146
polyline, composed of, 136
selection area, 166, 167
polyline. See line
Portable Document Format (PDF),
380, 382-383
precision
accuracy versus, 122
angle, 131-132
annotation, achieving using, 123
coordinate entry, 123, 124-126
DDE, 123, 131
described, 122-123
dimension, 269
double floating-point, 209
DWEF, 353
editing object, when, 159, 171, 174
geometry, 123
importance of, 122, 375
measurement system, 74
moving object, when, 174
ortho mode, 131
OTRACK, 123
snap, 123, 126-131
tracking, polar, 123, 131
previewing
array, 62, 181
dimension, 266
font, 232
hatch, 66, 284, 290
plot, 69, 297, 298
selection, 166
Print Troubleshooter Windows feature, 317
printer
adding, 294
default, 293
driver, 292, 314, 385
nonsystem, 293
specifying, 68, 96, 293, 295
system printer, 292, 293
Printer Support File Pathe>Plot Style Table
Search Path, 305
printing. See plotting

Profiles feature, 20
projection, 3D, 218, 225
Properties palette

accessing, 106

anchoring, 213

dimension options, 275

hatch options, 290

introduced, 41

property display in, 197

text options, 240, 248, 252
Properties toolbar, 26, 27, 197
PSLTSCALE system variable, 82
PSPACE command, 99
PUBLISH command, 352, 357, 369-370, 372
PUBLISHTOWEB command, 357, 370
PURGE command, 334

ogo

QDIM command, 273
QLEADER command, 277-279
QNEW command, 84, 101-102
question mark (?)
help command, 165, 166
system variable command, 43
QuickCalc feature, 41, 80
Quickstart feature, 314
quotation mark () measurement unit
suffix, 126

o R o

RAL color, 113
raster image, 322, 349-352, 359-360,
379, 384
RAY command, 134, 136
RECTANG command, 53-54, 134, 136,
144-145
rectangle
array pattern, 61-62, 181
corner, rounding, 54-55
drawing, 53-55, 134, 136, 144-145
polyline, 136
rotating, 145
selection area, rectangular, 163-165, 166
text rectangle, 240, 241
Red Green Blue (RGB) color, 113
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REDRAW command, 210
REFEDIT command, 329, 346

Reference Manager, 347, 357, 364-365, 366

regeneration, 209-210
Reload Linetypes dialog box, 117
rendering, 3D, 215
resolution, screen, 17, 388
revision cloud, 135, 137, 154-156
Revit software, 15
RGB (Red Green Blue) color, 113
Rich Text Format (RTF) file, 243, 248,
380, 388
rollover highlighting, 166
Roman Simplex font, 231
ROTATE command, 169, 178-179
rotating
angle, specifying, 179
base point, 179
block, 328, 339, 341
copy of object, 179
DWEF, 353
ellipse rotation parameter, 151
grip, using, 190
rectangle, 145
text, 238-239
3D object, 224, 225
xref, 344
RTF (Rich Text Format) file, 243, 248,
380, 388
ruler, Tab and indent, 242, 246-248

oS e

Save Drawing As dialog box,
51, 100-101, 372
SAVEAS command, 382
SAVETIME system variable, 42
saving
drawing, 14, 51, 70, 84, 377-378
template, 100-101
scale
architectural drawing, 76-77
arrowhead, 92
block, 326, 328, 329
consistency, importance of, 77
copying object, scaling when, 180

dimension, 82, 92, 237, 263, 268-269
drawing scale, 76, 234
drawing scale factor, 76, 180, 234-235,
237, 376
DWEF, 353, 368
grip editing, using in scaling
operation, 190
hatch, 66, 180, 283, 287-288
image, 351
linetype, 82, 92-93
measurement system, 76
notation, 76
paper size, matching to, 79
plotting, 69, 77, 296, 299-300, 301-302
standard, industry-specific, 76-77
template, changing scale in drawing
created from, 49
text, 77, 92, 180, 234, 249
transformation, 179-180
viewport, 97, 208
xref, 344
Zoom command Scale option, 203
SCALE command, 169, 179-180
SCALETEXT command, 180, 249
screen
capture, 387-388
cleaning, 31
plot, planning on, 72
refreshing, 210
resolution, 17, 388
screening, 303, 306
scroll bar, turning on/off, 202
Security Options dialog box, 372
Select Color dialog box, 52-53, 113
Select File dialog box, 203
Select Image File dialog box, 350
Select Linetype dialog box, 114
Select Reference File dialog box, 343-344
Select Template dialog box, 83, 84, 213
selection

crossing object selection, 63-64, 163-165,

166, 167, 175-176
dimension, 260
editing, selection-first, 160, 161
erasing, 167, 168

www.it-ebooks.info


http://www.it-ebooks.info/

Index 4 05

EXTEND command Fence selection
mode, 184
lassoing object, 168
last object drawn, 166
layer, all objects on, 166
model space, all objects in, 166
moving selected object, 172
one-by-one selection, 162-163
paper space, all objects in, 166
polygon selection area, 166, 167
polyline selection area, 166
previewing, 166
rectangle selection area, 163-165, 166
removing object from selection set, 164
repeating previous selection, 166
rollover highlighting, 166
subobject, 165
Trim command Fence selection
mode, 184
window object selection, 163
windowing, implied, 163
sending drawing to another user
DWG file, 358-360, 365
email, using, 357, 358, 361, 363
ETRANSMIT command, using, 357,
359-362, 366, 381
font, 359, 360, 361, 364
FTP, using, 362-363
including dependent file set, 358, 359-360,
361-362, 364-365
multiple drawings, 361-362, 363
plot style, 359
plotting received drawing, 359
raster image, 359-360
sheet set, using, 360, 362
verifying received drawing, 363-364
xref, 348, 359, 364
zipping file set, 361-362, 363
Setup wizards, 85
SETVAR command, 43
SHADEMODE command, 219
sheet set
described, 313
layout, changing to sheet set, 99
plotting, 316
sending drawing to another user using,
360, 362
Sheet Set Manager palette, 22-23, 41, 362

shrinking object using STRETCH command,
176, 195
SHX (compiled SHape) font, 231, 361
SI (Systeme International d’Unités), 75
signature, digital, 358, 371-372
Snaglt software, 388
SNAPMODE system variable, 82
snapping
arc drawing, using in, 150
break operation, using in, 186
circle drawing, using in, 148
described, 28, 89
dimension, using when entering,
270, 271-272, 275, 278
DWEF, 353
grab point, 126
grid, to, 50
grip editing, using in, 192
hot spot, 89
interval, 50, 89, 90, 91
line drawing, using in, 126-128, 137
midpoint of object, finding, 128
moving object, using when, 174
offset operation, using in, 148
OSNAP, 29, 57, 123, 126-130, 132
OTRACK, 29
override, temporary, 126, 130, 132
point, using as snap location, 157
polar, 131-132
precision, 123, 126-131
stretch operation, using in, 65
text, 238, 239
turning on/off, 58, 67, 89, 91-92
zooming, behavior when, 90
SNAPUNIT system variable, 82
software, third-party, 15, 17, 30
solid
freeform, 215
primitive, 215
space. See model space; paper space;
workspace
Spacebar, using to enter command, 37
spelling checker, 253-254
SPLINE command, 135, 147, 152-154
SPLINEDIT command, 153
splitting object in two, 186-187
Standard Colors dialog box, 53
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Standard toolbar
Copy button, 175
Cut button, 175
DesignCenter button, 120
introduced, 25
Markup Set Manager button, 356
Match Properties button, 197
Paste button, 175
Plot button, 68
QNEW button, 84, 102
QuickCalc button, 80
Undo button, 65
Zoom Realtime button, 200
starting AutoCAD, 49
Startup dialog box, 85
status bar
Associated Standards File button, 30
Clean Screen button, 31
Communication Center button, 30
coordinate display, 27, 86, 124
customizing, 30
DUCS button, 29
DYN button, 29, 32
GRID button, 28
Lock/Unlock Toolbar Palette Positions
button, 30
LWT button, 29
Manage Xrefs button, 30

Maximize/Minimize Viewport button, 30

MODEL/PAPER button, 29-30, 40, 99,
300-301
ORTHO button, 28, 58
OSNAP button, 29, 57
OTRACK button, 29
POLAR tracking mode button, 28-29
SNAP button, 28, 50
Trusted Autodesk DWG button, 30
STB (Style TaBle) file, 304, 305, 306,
310, 359
STRETCH command
base point, 171, 175, 178, 196
compressing object using, 176, 195
crossing selection box, defining, 63-64,
175-176
dimension behavior when applying, 261
displacement, 171, 195

grip-editing operation, 191-192, 195-196

line, applying to, 176, 195-196
ortho mode, 65, 176, 178, 195, 197
snapping, using when, 65
undoing stretch operation, 65, 172
style
arrowhead, 258, 267
dimension, 93, 233, 261-269, 275, 345
family, 265
plot, 111-112, 297, 303-307, 317, 359
point, 157-158
secondary, 265
substyle, 265
table, 249-250, 304-306, 309, 310, 317
text, 230-233, 236, 267, 331, 345
3D visual style, 215, 219-221
Style TaBle (STB) file, 304, 305, 306,
310, 359
Styles toolbar, 25, 27, 264, 271
subobject, 165
Substituting message, 364
surface material, 3D, 215
symbol
block, grouping using, 323, 326, 327
table, 118, 120, 121
system requirement, 17, 212
system variable. See also specific system
variable
described, 42
listing all system variables, 43-44
setting, 43, 81, 92-93
storage location, 44
Systéme International d’Unités (SI), 75

o o

Tab and indent ruler, 242, 246-248
table

block table, 252, 322, 326

CTB file, 304, 305, 306-307, 308-309, 359

layer, 118

style, 249-250, 304-306, 309, 310, 317

symbol, 118, 120, 121

text, 249-253
Table Cell Format dialog box, 250
Table Style dialog box, 249, 250
TABLEEXPORT command, 253
TABLESTYLE command, 249
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tangent
circle, defining object tangent to, 147
spline, 153
TechSmith Snaglt software, 388
template
creating drawing based on, 49-50, 84,
101-102
creating template based on drawing,
84, 100-102
described, 83
dimension style, copying to, 263
file extension, 83
layout, creating from, 98
linetype, adding, 117
location, 102
measurement system, 85, 101
naming, 101, 102
plot style, 305
saving, 100-101
3D drawing, 214
workspace, 84
text. See also font
abbreviation, industry-specific, 254
aligning, 239, 331
AutoCAPS feature, 242
block attribute, 326, 329-334, 335
bullet, 245-246
case, changing, 243
case sensitivity, 113
color, 249
dimension, 233, 258, 259, 267-268,
275-276
drafting process, adding later in, 229
field, 244-245, 246, 252, 326, 329-334
Find And Replace utility, 243
front, bringing to, 244
geometry, annotating, 229
height, 233, 234-236, 241, 249, 267
importing, 243, 248, 253
indentation, 242, 243, 247, 248
In-Place Text Editor, 238, 241, 242,
245-246, 248
insertion point, 238, 251
justification, 237, 238, 241, 249, 331
leader, 279-280
line, inserting blank, 246
list, 245-248

masking, 244, 246
model space, adding in, 236
multiline, 236, 240
paper space, adding in, 236
paragraph, 230, 236
plotting, 80-81, 235, 241, 267
rectangle containing, imaginary, 240, 241
rotating, 238-239
RTF file format, 243, 248, 380, 388
scale, 77, 92, 180, 234, 249
single-line, 230, 236, 238-240
snap mode, 238, 239
spelling checker, 253-254
style, 230-233, 236, 267, 331, 345
symbol, entering, 243
tab, 242, 246-248
table, 249-253
TXT file format, 243, 380, 388
vocabulary, industry-specific, 254
wrap, 236, 237, 240-241, 242, 279
zooming, 231, 248
TEXT command, 230
Text Formatting toolbar, 241-242, 243, 251
Text Style dialog box, 230, 231, 232, 267
TEXTTOFRONT command, 244, 275
third-party software, 15, 17, 30
3D
arcball, 223, 224
AutoCAD LT support, 16
camera, 215, 218, 223
Dashboard, 214-218
edge effect, 221
engine, 20
light, ambient, 215
measurement system, specifying, 213
Modeling workspace, 19, 21, 212, 213
navigation, 215, 218-219, 222-223
orbit, 223-225, 316
panning, 215, 225
perspective, 218, 225
plotting, 315-316
projection, 218, 225
rendering, 215
rotation, 224, 225
solid, freeform, 215
solid, primitive, 215
style, visual, 215, 219-221
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3D (continued)
surface material, 215
switching to/from 2D environment,
22,214
system requirement, 17, 212
template, 214
version support, 18, 211-212, 223
view, 204, 222-223
wireframe, 219
zooming, 215, 225
3D House file, 217
3DFORBIT command, 223
3DORBIT command, 223-224, 316
tick mark, dimension, 258
TIFF files, 384
title bar, 24
title block
font, 231
layout, 38, 96-97
listing available title blocks, 97
panning, effect on title block display,
206, 207
plotting, 80-81
Xref, attaching as, 96
zooming, effect on title block display,
206, 207
TOLERANCE command, 269
tolerance, construction, 257, 269
Tool Palettes window, 41, 328-329
toolbar. See also specific toolbar
customizing, 26
position, locking, 30
Tools=>Attribute Extraction, 333
Tools=>Block Editor, 335
Tools=>DesignCenter, 120
Tools=>Folder Options=>View, 102
Tools=>Options=Display=>Colors, 385
Tools=>Options=Files>Template
Settings, 102
Tools=>Options=>System, 212
Tools=>Palettes=>Dashboard, 217
Tools=>Palettes=>External References, 350
Tools=>Security Options, 372
Tools=>Spelling, 253
Tools=>Wizards=>Create Layout, 95

Toolse>Workspaces=>AutoCAD Classic, 22
Tools>Workspaces=3D Modeling, 22
Tools=>Xref, 329
tooltip
accessing, 26
described, 26
input, dynamic, 29, 31, 36, 37, 191
Model tab, 38
OSNAP, 128
TRIM command, 169, 184-185
TTF (TrueType) font, 231, 361, 364
TXT file, 243, 380, 388

olf o

UCS (user coordinate system), 204, 219, 224
undo functionality
copy operation, 174
erase operation, 168
extend operation, 185
line edit, 34
move operation, 172
Standard toolbar Undo button, using, 65
stretch operation, 65, 172
trim operation, 185
unitless measurement system, 74
user coordinate system (UCS), 204, 219, 224
User’s Guide menu, 117

oo

Valid boundary not found message, 289
variable, system. See system variable
VBA (Visual Basic for Applications), 17
vector image, 322, 349, 350, 379
verb-noun editing, 160
version
AutoCAD LT overview, 15-16
file compatibility with older, 13-14, 17, 18
saving drawing in earlier, 14
3D support, 18, 211-212, 223
2006, 17-18
Windows version, support for older, 17
vertex point, 140
video card support, 212
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view

isometric, 222

layer snapshot, saving with, 204

orthographic, 222

pan, 200, 203, 204-205

plan, 222

3D, 204, 222-223

zoom, 200, 203, 204-205
VIEW command, 204
View Manager dialog box, 204-205
View=>Named Views, 204
View=>Orbit>Free Orbit, 224
Viewc>Redraw, 210
View=>Refresh, 102
Viewr>Regen, 210
Viewr>Regen All, 210
View=>3D Views>Viewpoint Presets, 223
View=>3D Views, 222
View Transitions dialog box, 203
View>Zoom>All, 51
ViewoZoom=>Previous, 208
VIEWPOINT command, 223
Viewpoint Presets dialog box, 223
viewport

described, 38

layout, 29, 97, 99

location, specifying, 97

locking, 208

maximizing/minimizing, 30, 209

model space, 29-30, 38

panning inside, 208

paper space, 29-30, 38

plotting, 315, 316

regeneration, 210

scale, 97, 208

zooming inside, 208
Viewports toolbar, 77
Visual Basic for Applications (VBA), 17
vocabulary, industry-specific, 254
VPMAX command, 209
VPMIN command, 209
VSM (Visual Styles Manager) palette,

220-221

VTOPTIONS command, 203
VuePrint software, 384
VueScan VuePrint software, 384

o[/ o

warning message display, customizing,
22,212
Web, publishing to, 352, 357, 369-370. See
also Design Web Format
Welding Fixture-1.dwg file, 95, 206
Wiley Publishing (AutoCAD and AutoCAD
LT All-In-One Desk Reference For
Dummies), 212
window
management, 24
object selection, 163
windowing, implied, 163
Windows
Clipboard, 174-175, 380, 385
Fonts applet, 364
Print Troubleshooter, 317
printer, system, 292, 293
Registry, system variable storage in, 44
version support, 12, 17
Windows MetaFile (WMF), 380, 383-384
WinZip software, 362
wireframe, 219
WMF (Windows MetakFile), 380, 383-384
Word, exchanging data with, 380
workspace
Classic, 21
described, 212
switching, 22, 25
template, 84
3D Modeling, 19, 21, 212, 213
Workspaces dialog box, 49, 212
Workspaces toolbar, 25, 27
Workstations dialog box, 22
WS_FTP software, 363

o X o
XCLIP command, 348
XLINE command, 134, 136
XNOTIFYTIME system variable, 342
XOPEN command, 345
xref (external reference)
attachment reference type, 343-344
binding, 347
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xref (external reference) (continued)
block, relation to, 322, 345
block versus, 342, 348-349
child drawing, 342
clipping, 348
described, 322, 341
detaching, 347
dimension style, 345
DWEF file, 352-353
editing xrefed drawing, 346
file, referencing, 343-347
image, raster, 350-351, 352
insertion point, 344
layer, 343, 345
linetype, 345
list, generating, 347
object, as named, 119
opening xrefed drawing, 345, 348
overlay reference type, 344
parent drawing, 342
path, 345, 346-347
policy, importance of developing, 347
reloading, 347
report, generating, 347
rotating, 344
scale, 344
sending drawing to another user,
including when, 348, 359, 364
text style, 345
title block, attaching as, 96
unloading, 347
update, automatic, 343
Xref Manager dialog box, 30, 342
XREFNOTIFY system variable, 342

o/ o

zipping file set, 361-362, 363
zooming

All option, 202

animation, 203

described, 59, 199

dragging, controlling using, 200

drawing limits, to, 87

DWG file involvement, 209-210

exiting zoom mode, 60

Extents option, 172, 201, 202

finding object lost on drawing area
using, 202

fly out option, 202

grid behavior when, 82, 90

LWT display, effect on, 110

maghnification, returning to original, 60

model space, behavior in, 205, 207-209

mouse, controlling using, 60, 201

Object option, 203

pan compared, 199-200

pan, toggling to/from, 200-201

paper space, behavior in, 205-209

Previous option, 203
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